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0.3 Changes History

Issue Revision : 2 .2 (5 June 2016) Version which lists all fef theories as well as ProofPower the-
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Issue 2.3 Removed dependency on ICL logo font

0.4 Changes Forecast

None.

1 GENERAL

1.1 Scope

This document contains listings of all the ProofPower release 0.4 theories which are used in the DRA
front end filter project RSRE 1C/6130.

1.2 Introduction

This document provides listings of all the theories in ProofPower release 0.4 and all the “fef” theories.
Some general library results are provided in work files wrk044 , wrk046 and wrk049 , which produce
theories fin thms, lib thms and wrk049 respectively. Theories fin thms and lib thms are supplied
with the ProofPower release 0.4. In addition, the theory cache thms is listed. System functions use
this theory to cache various definitions and theorems eg. labelled product definitions.
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2 THE THEORY basic hol

2.1 Parents

char

2.2 Children

cache ′fef sets combin one

2.3 Notes

This theory is a cache theory; its contents have not been listed.

3 THE THEORY bin rel

3.1 Parents

hol

3.2 Children

fun rel

3.3 Constants

$7→ ′a → ′b → ′a × ′b

$× ′a P → ′b P → ′a ↔ ′b

$↔ ′a P → ′b P → (′a ↔ ′b) P

Dom ′a ↔ ′b → ′a P

Ran ′a ↔ ′b → ′b P

Id ′a P → ′a ↔ ′a

Graph (′a → ′b) → ′a ↔ ′b

$o
9 (′a → ′b) → (′b → ′c) → ′a → ′c

$R o
9 R ′a ↔ ′b → ′b ↔ ′c → ′a ↔ ′c

$R o R ′b ↔ ′c → ′a ↔ ′b → ′a ↔ ′c

$⊳ ′a P → ′a ↔ ′b → ′a ↔ ′b

$⊲ ′a ↔ ′b → ′b P → ′a ↔ ′b

$−⊳ ′a P → ′a ↔ ′b → ′a ↔ ′b

$−⊲ ′a ↔ ′b → ′b P → ′a ↔ ′b

InvRel ′a ↔ ′b → ′b ↔ ′a

$Image ′a ↔ ′b → ′a P → ′b P

Reflexive (′a ↔ ′a) P

Symmetric (′a ↔ ′a) P

Transitive (′a ↔ ′a) P
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Injective (′a ↔ ′b) P

Surjective ′b P → (′a ↔ ′b) P

Total ′a P → (′a ↔ ′b) P

Functional (′a ↔ ′b) P

$⊕ ′a ↔ ′b → ′a ↔ ′b → ′a ↔ ′b

$+ ′a ↔ ′a → ′a ↔ ′a

$∗ ′a ↔ ′a → ′a ↔ ′a

RelCombine ′a ↔ ′b → ′a ↔ ′c → ′a ↔ (′b × ′c)

3.4 Aliases

o
9 $R o

9 R : ′b ↔ ′a → ′a ↔ ′c → ′b ↔ ′c

o $R o R : ′a ↔ ′c → ′b ↔ ′a → ′b ↔ ′c
∼ InvRel : ′b ↔ ′a → ′a ↔ ′b

3.5 Type Abbreviations

′a P
′a P

′a ↔ ′b ′a ↔ ′b

3.6 Fixity

Right Infix 240 :
R o R R o

9 R−⊲ ⊲ ↔ ⊕ o
9 −⊳ ⊳

Right Infix 280 :
Image

Right Infix 300 :
7→

Postfix 300 : ∗ + ∼

3.7 Definitions

7→ ⊢ $7→ = $,
× ⊢ ∀ x y• (x × y) = {(v , w)|v ∈ x ∧ w ∈ y}
↔ ⊢ ∀ x y• x ↔ y = P (x × y)
Dom ⊢ ∀ r• Dom r = {x |∃ y• (x , y) ∈ r}
Ran ⊢ ∀ r• Ran r = {y |∃ x• (x , y) ∈ r}
Id ⊢ ∀ s• Id s = {(x , y)|x = y ∧ x ∈ s}
Graph ⊢ ∀ f • Graph f = {(x , y)|y = f x}
o
9 ⊢ ∀ f g• f o

9 g = g o f

R o
9 R ⊢ ∀ r s• r o

9 s = {(x , z )|∃ y• (x , y) ∈ r ∧ (y , z ) ∈ s}
R o R ⊢ ∀ r s• r o s = s o

9 r

⊳ ⊢ ∀ a r• a ⊳ r = {(x , y)|x ∈ a ∧ (x , y) ∈ r}
⊲ ⊢ ∀ a r• r ⊲ a = {(x , y)|y ∈ a ∧ (x , y) ∈ r}
−⊳ ⊢ ∀ a r• a −⊳ r = {(x , y)|¬ x ∈ a ∧ (x , y) ∈ r}
−⊲ ⊢ ∀ a r• r −⊲ a = {(x , y)|¬ y ∈ a ∧ (x , y) ∈ r}
InvRel ⊢ ∀ r• r ∼ = {(x , y)|(y , x ) ∈ r}
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Image ⊢ ∀ r s• r Image s = {y |∃ x• x ∈ s ∧ (x , y) ∈ r}
Reflexive ⊢ Reflexive = {r |∀ x• (x , x ) ∈ r}
Symmetric ⊢ Symmetric = {r |∀ x y• (x , y) ∈ r ⇒ (y , x ) ∈ r}
Transitive ⊢ Transitive

= {r |∀ x y z• (x , y) ∈ r ∧ (y , z ) ∈ r ⇒ (x , z ) ∈ r}
Injective ⊢ Injective

= {r |∀ x y z• (x , z ) ∈ r ∧ (y , z ) ∈ r ⇒ x = y}
Surjective ⊢ ∀ s• Surjective s = {r |s = Ran r}
Total ⊢ ∀ s• Total s = {r |s = Dom r}
Functional ⊢ Functional

= {r |∀ x w z• (x , w) ∈ r ∧ (x , z ) ∈ r ⇒ w = z}
⊕ ⊢ ∀ r s• r ⊕ s = (Dom s −⊳ r) ∪ s
+ ⊢ ∀ r• r + =

⋂
{q |r ⊆ q ∧ q ∈ Transitive}

∗ ⊢ ∀ r

• r ∗

=
⋂

{q |r ⊆ q ∧ q ∈ Reflexive ∧ q ∈ Transitive}
RelCombine ⊢ ∀ f g

• RelCombine f g

= {(x , y , z )|(x , y) ∈ f ∧ (x , z ) ∈ g}

3.8 Theorems

rel ∈ in clauses
⊢ ∀ a b x x1 y z r r1 r2 s t q f

• (x 7→ y ∈ r ⇔ (x , y) ∈ r)
∧ ((x , y) ∈ (a × b) ⇔ x ∈ a ∧ y ∈ b)
∧ (r ∈ a ↔ b ⇔ r ⊆ (a × b))
∧ (x ∈ Dom r ⇔ (∃ y• (x , y) ∈ r))
∧ (y ∈ Ran r ⇔ (∃ x• (x , y) ∈ r))
∧ ((x , x1 ) ∈ Id a ⇔ x = x1 ∧ x ∈ a)
∧ ((x , y) ∈ Graph f ⇔ y = f x )
∧ ((x , z ) ∈ r o

9 s

⇔ (∃ y• (x , y) ∈ r ∧ (y , z ) ∈ s))
∧ ((x , z ) ∈ s o r ⇔ (x , z ) ∈ r o

9 s)
∧ ((x , y) ∈ a ⊳ r ⇔ x ∈ a ∧ (x , y) ∈ r)
∧ ((x , y) ∈ r ⊲ b ⇔ y ∈ b ∧ (x , y) ∈ r)
∧ ((x , y) ∈ a −⊳ r ⇔ ¬ x ∈ a ∧ (x , y) ∈ r)
∧ ((x , y) ∈ r −⊲ b ⇔ ¬ y ∈ b ∧ (x , y) ∈ r)
∧ ((y , x ) ∈ r ∼ ⇔ (x , y) ∈ r)
∧ (y ∈ r Image a ⇔ (∃ x• x ∈ a ∧ (x , y) ∈ r))
∧ (q ∈ Reflexive ⇔ (∀ x• (x , x ) ∈ q))
∧ (q ∈ Symmetric

⇔ (∀ x1 x2• (x1 , x2 ) ∈ q ⇒ (x2 , x1 ) ∈ q))
∧ (q ∈ Transitive

⇔ (∀ x1 x2 x3

• (x1 , x2 ) ∈ q ∧ (x2 , x3 ) ∈ q ⇒ (x1 , x3 ) ∈ q))
∧ (r ∈ Injective

⇔ (∀ x1 x2 y
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• (x1 , y) ∈ r ∧ (x2 , y) ∈ r ⇒ x1 = x2 ))
∧ (r ∈ Surjective b

⇔ (∀ y• y ∈ b ⇔ (∃ x• (x , y) ∈ r)))
∧ (r ∈ Total a

⇔ (∀ x• x ∈ a ⇔ (∃ y• (x , y) ∈ r)))
∧ (r ∈ Functional

⇔ (∀ x y1 y2

• (x , y1 ) ∈ r ∧ (x , y2 ) ∈ r ⇒ y1 = y2 ))
∧ ((x , y) ∈ r1 ⊕ r2

⇔ (x , y) ∈ (Dom r2 −⊳ r1 ) ∪ r2 )
∧ ((x , y , z ) ∈ RelCombine r t

⇔ (x , y) ∈ r ∧ (x , z ) ∈ t)
bin rel ext clauses

⊢ ∀ r1 r2

• (r1 ⊂ r2

⇔ (∀ x y• (x , y) ∈ r1 ⇒ (x , y) ∈ r2 )
∧ (∃ x y• ¬ (x , y) ∈ r1 ∧ (x , y) ∈ r2 ))

∧ (r1 ⊆ r2 ⇔ (∀ x y• (x , y) ∈ r1 ⇒ (x , y) ∈ r2 ))
∧ (r1 = r2 ⇔ (∀ x y• (x , y) ∈ r1 ⇔ (x , y) ∈ r2 ))

inv rel thm ⊢ ∀ f a b

• (f ∼ ∈ Functional ⇔ f ∈ Injective)
∧ (f ∼ ∈ Injective ⇔ f ∈ Functional)
∧ (f ∼ ∈ Surjective a ⇔ f ∈ Total a)
∧ (f ∼ ∈ Total b ⇔ f ∈ Surjective b)

bin rel ∅ universe thm
⊢ ∀ f g r0 r1 a b

• (Dom r0 = {} ⇔ r0 = {})
∧ (Ran r0 = {} ⇔ r0 = {})
∧ Dom {} = {}
∧ Ran {} = {}
∧ Dom Universe = Universe

∧ Ran Universe = Universe

∧ (Id r0 = {} ⇔ r0 = {})
∧ Id {} = {}
∧ (r0 ∼ = {} ⇔ r0 = {})
∧ {} ∼ = {}
∧ Universe ∼ = Universe

∧ r0 o
9 {} = {}

∧ {} o
9 r0 = {}

∧ ({} = r0 o
9 r1 ⇔ Ran r0 ∩ Dom r1 = {})

∧ (r0 o
9 r1 = {} ⇔ Ran r0 ∩ Dom r1 = {})

∧ RelCombine r0 {} = {}
∧ RelCombine {} r0 = {}
∧ r0 Image {} = {}
∧ {} Image a = {}
∧ f ⊕ {} = f

∧ {} ⊕ f = f

∧ (f ⊕ g = {} ⇔ f = {} ∧ g = {})
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∧ (f = {} ∧ g = {} ⇒ f ⊕ g = {})
∧ (f ⊕ g = {} ⇔ f = {} ∧ g = {})
∧ f ⊕ Universe = Universe

∧ Universe −⊳ r0 = {}
∧ a −⊳ {} = {}
∧ {} −⊳ r0 = r0

∧ Universe ⊳ r0 = r0

∧ a ⊳ {} = {}
∧ {} ⊳ r0 = {}
∧ r0 −⊲ Universe = {}
∧ {} −⊲ b = {}
∧ r0 −⊲ {} = r0

∧ r0 ⊲ Universe = r0

∧ {} ⊲ b = {}
∧ r0 ⊲ {} = {}

bin rel insert thm
⊢ ∀ a b r x xy y

• Dom (Insert (x , y) r) = Insert x (Dom r)
∧ Dom (Insert xy r) = Insert (Fst xy) (Dom r)
∧ Ran (Insert (x , y) r) = Insert y (Ran r)
∧ Ran (Insert xy r) = Insert (Snd xy) (Ran r)
∧ Id (Insert x a) = Insert (x , x ) (Id a)
∧ Insert (x , y) r Image a

= r Image a ∪ (if x ∈ a then {y} else {})
∧ Insert (x , y) r −⊲ b

= (r −⊲ b) ∪ (if ¬ y ∈ b then {(x , y)} else {})
∧ Insert (x , y) r ⊲ b

= (r ⊲ b) ∪ (if y ∈ b then {(x , y)} else {})
∧ a −⊳ Insert (x , y) r

= (a −⊳ r) ∪ (if ¬ x ∈ a then {(x , y)} else {})
∧ a ⊳ Insert (x , y) r

= (a ⊳ r) ∪ (if x ∈ a then {(x , y)} else {})
∧ Insert (x , y) r ∼ = Insert (y , x ) (r ∼)

4 THE THEORY cache’fef

4.1 Parents

basic hol

4.2 Children

fef004

4.3 Notes

This theory is a cache theory; its contents have not been listed.
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5 THE THEORY char

5.1 Parents

list

5.2 Children

basic hol

5.3 Constants

IsCharRep Worth → Bool

AbsChar Worth → Char

RepChar Char → Worth

5.4 Types

Char

5.5 Type Abbreviations

STRING Text

5.6 Definitions

IsCharRep
is char rep def

⊢ ∀ x• IsCharRep x ⇔ x < 256

CHAR
char def ⊢ ∃ f • TypeDefn IsCharRep f

AbsChar
RepChar
abs char rep char def

⊢ (∀ a• AbsChar (RepChar a) = a)
∧ (∀ r• IsCharRep r ⇔ RepChar (AbsChar r) = r)

6 THE THEORY combin

6.1 Parents

basic hol

6.2 Children

sum
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6.3 Constants

$o (′b → ′c) → (′a → ′b) → ′a → ′c

CombS (′a → ′b → ′c) → (′a → ′b) → ′a → ′c

CombK ′a → ′b → ′a

CombI ′a → ′a

6.4 Fixity

Right Infix 300 :
o

6.5 Definitions

o
o def ⊢ ∀ f g x• (f o g) x = f (g x )
CombS
comb s def ⊢ ∀ f g x• CombS f g x = f x (g x )
CombK
comb k def ⊢ ∀ x y• CombK x y = x

CombI
comb i def ⊢ ∀ x• CombI x = x

6.6 Theorems

s k thm ⊢ ∀ x• CombS CombK x = CombI

o assoc thm ⊢ ∀ f g h• f o g o h = (f o g) o h

o i thm ⊢ ∀ f • CombI o f = f ∧ f o CombI = f

7 THE THEORY dyadic

7.1 Parents

Z

7.2 Children

R

7.3 Constants

$̂ N → N → N

$dy times DYADIC → DYADIC → DYADIC

dy one DYADIC

$dy exp DYADIC → N → DYADIC

$dy less DYADIC → DYADIC → BOOL
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7.4 Type Abbreviations

DYADIC DYADIC

7.5 Fixity

Right Infix 210 :
dy less

Right Infix 310 :
dy exp dy times

Right Infix 320 :
̂

7.6 Definitions

̂ ⊢ (∀ i• i ̂ 0 = 1 ) ∧ (∀ i m• i ̂ (m + 1 ) = i ∗ i ̂ m)
dy times ⊢ ∀ (m, i) (n, j )

• (m, i) dy times (n, j ) = (2 ∗ m ∗ n + m + n, i + j )
dy one ⊢ dy one = (0 , NZ 0 )
dy exp ⊢ (∀ x• x dy exp 0 = dy one)

∧ (∀ x m• x dy exp (m + 1 ) = x dy times x dy exp m)
dy less ⊢ ∀ (m, i) (n, j )

• (m, i) dy less (n, j )
⇔ (∃ a b

• NZ a + i = NZ b + j

∧ 2 ̂ a ∗ (2 ∗ m + 1 ) < 2 ̂ b ∗ (2 ∗ n + 1 ))

7.7 Theorems

dy less irrefl thm
⊢ ∀ x• ¬ x dy less x

dy less antisym thm
⊢ ∀ x y• ¬ (x dy less y ∧ y dy less x )

dy less trans thm
⊢ ∀ x y z• x dy less y ∧ y dy less z ⇒ x dy less z

dy less trich thm
⊢ ∀ x y• ¬ x = y ⇒ x dy less y ∨ y dy less x

dy times comm thm
⊢ ∀ x y• x dy times y = y dy times x

dy times assoc thm
⊢ ∀ x y z

• (x dy times y) dy times z = x dy times y dy times z

dy times order thm
⊢ ∀ u x y

• x dy times u = u dy times x

∧ (u dy times x ) dy times y

= u dy times x dy times y
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∧ x dy times u dy times y

= u dy times x dy times y

dy times unit thm
⊢ ∀ x• x dy times dy one = x

dy times unit clauses
⊢ ∀ x• x dy times dy one = x ∧ dy one dy times x = x

dy exp clauses
⊢ ∀ x m n

• x dy exp (m + n) = (x dy exp m) dy times x dy exp n

∧ x dy exp 0 = dy one

∧ x dy exp 1 = x

∧ x dy exp 2 = x dy times x

∧ x dy exp 3 = x dy times x dy times x

dy times mono thm
⊢ ∀ x y z

• y dy less z ⇒ x dy times y dy less x dy times z

dy times mono thm1
⊢ ∀ x y z

• y dy less z ⇒ y dy times x dy less z dy times x

dy times mono thm2
⊢ ∀ x y v w

• x dy less y ∧ v dy less w

⇒ x dy times v dy less y dy times w

dy times mono ⇔ thm
⊢ ∀ x y z

• x dy times y dy less x dy times z ⇔ y dy less z

dy arch thm ⊢ ∀ x y• dy one dy less x ⇒ (∃ t• y dy less x dy exp t)
dy balance thm1

⊢ ∀ x• ∃ y• dy one dy less x dy times y

dy balance thm2
⊢ ∀ x• ∃ y• x dy times y dy less dy one

dy right dense thm
⊢ ∀ x y

• x dy less y

⇒ (∃ z

• x dy less x dy times z

∧ x dy times z dy less y)
dy less dense thm

⊢ ∀ x y• x dy less y ⇒ (∃ z• x dy less z ∧ z dy less y)
dy left dense thm

⊢ ∀ x y

• x dy less y

⇒ (∃ z

• x dy less y dy times z

∧ y dy times z dy less y)
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8 THE THEORY fef003

8.1 Parents

wrk049

8.2 Children

fef040 fef004

8.3 Constants

$glb Class → Class → Class

$lub Class → Class → Class

lattice top Class

lattice bottom
Class

$dominates Class → Class → BOOL

same ins Class

→ (′QUERY × Class) LIST ↔ (′QUERY × Class) LIST

same outs Class → (Class × ′DATA) LIST ↔ (Class × ′DATA) LIST

secure (′QUERY , ′DATA) BEHAVIOURS P

8.4 Types

Class

8.5 Type Abbreviations

(′QUERY , ′DATA) BEHAVIOURS
(′QUERY , ′DATA) BEHAVIOURS

8.6 Fixity

Right Infix 150 :
dominates

Right Infix 250 :
glb lub
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8.7 Definitions

dominates
lattice bottom
lattice top
lub
glb ⊢ ConstSpec

(λ
(dominates ′, lattice bottom ′, lattice top ′,

lub ′, glb ′)
• ∀ x y z

• dominates ′ x x

∧ (dominates ′ x y ∧ dominates ′ y x ⇒ x = y)
∧ (dominates ′ x y ∧ dominates ′ y z

⇒ dominates ′ x z )
∧ (∀ x• dominates ′ x lattice bottom ′)
∧ (∀ x• dominates ′ lattice top ′ x )
∧ (∀ x y z

• dominates ′ (lub ′ x y) x

∧ dominates ′ (lub ′ x y) y

∧ (dominates ′ z x ∧ dominates ′ z y

⇒ dominates ′ z (lub ′ x y)))
∧ (∀ x y z

• dominates ′ x (glb ′ x y)
∧ dominates ′ y (glb ′ x y)
∧ (dominates ′ x z ∧ dominates ′ y z

⇒ dominates ′ (glb ′ x y) z )))
($dominates, lattice bottom, lattice top, $lub,

$glb)
same ins ⊢ ∀ clear si1 si2

• (si1 , si2 ) ∈ same ins clear

⇔ (let v = {(q , c)|clear dominates c}
in si1 ↾ v = si2 ↾ v)

same outs ⊢ ∀ clear so1 so2

• (so1 , so2 ) ∈ same outs clear

⇔ (let v = {(c, d)|clear dominates c}
in so1 ↾ v = so2 ↾ v)

secure ⊢ ∀ bm

• bm ∈ secure

⇔ (∀ clear si1 si2

• (si1 , si2 ) ∈ same ins clear

⇒ (bm si1 , bm si2 ) ∈ same outs clear)

9 THE THEORY fef004

9.1 Parents

cache ′fef fef003
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9.2 Children

fef005

9.3 Constants

Num Worth P

Ide Ide P

I exponent Int → Worth

I mantissa Int → Worth

MkInt Worth → Worth → Int

F exponent Float → Worth

F mantissa Float → Worth

MkFloat Worth → Worth → Float

accessDenied Worth

rowClassTooLow
Worth

fieldClassOutOfRange
Worth

noNulls Worth

nonUniqueValues
Worth

nonUniformValues
Worth

ambiguousHaving
Worth

ambiguousEvaluate
Worth

noSuchDirectory
Worth

noSuchTable Worth

classChange Worth

downGrade Worth

underClassified
Worth

mayNotBeComplete
Worth

ambiguousUpdate
Worth

ambiguousColumn
Worth

noSuchColumn Worth

nullValue Worth

wrongType Worth

tooTall Worth

tooWide Worth

notCleared Worth

error Worth
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priceless Worth

sterling Worth

dinary Worth

worthless Worth

ExceptionVal Val

ClassVal Class → Val

CodeVal Code → Val

IntervalVal Interval → Val

TimeVal Time → Val

FloatVal Float → Val

IntVal Int → Val

StringVal Ide → Val

BoolVal Bool → Val

VoidVal Val

VI val ValuedItem → Val

VI worth ValuedItem → Worth

MkValuedItem Worth → Val → ValuedItem

NullItemItem NullItem → Item

ValuedItemItem
ValuedItem → Item

Dat item Data → Item

Dat class Data → Class

MkData Class → Item → Data

DataS Data P

DataUpdate Data → Update

ClassUpdate Class → Update

ItemUpdate Item → Update

isData Update → Bool

isClass Update → Bool

isItem Update → Bool

destData Update → Data

destClass Update → Class

destItem Update → Item

CS max ColSpec → Class

CS min ColSpec → Class

CS consGroup ColSpec → Worth

CS default ColSpec → Data

CS nullType ColSpec → Bool

CS sterlingType
ColSpec → Type

CS dinaryType
ColSpec → Type

CS posn ColSpec → Worth

CS ide ColSpec → Ide

MkColSpec Ide

→ Worth

→ Type

→ Type
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→ Bool

→ Data

→ Worth

→ Class

→ Class

→ ColSpec

R group Reference → Worth

R table Reference → Tab

MkReference Tab → Worth → Reference

CC referential
ColCon → Reference LIST

CC secondary ColCon → Bool

CC primary ColCon → Bool

CC classLimited
ColCon → Bool

CC unique ColCon → Bool

CC uniform ColCon → Bool

CC exist ColCon → Class

MkColCon Class

→ Bool

→ Bool

→ Bool

→ Bool

→ Bool

→ Reference LIST

→ ColCon

ColConS ColCon P

R data Row → Worth ↔ Data

R exist Row → Class

MkRow Class → Worth ↔ Data → Row

RowS Row P

TS rows TableSpec → Row LIST

TS cons TableSpec → Worth ↔ ColCon

TS colspecs TableSpec → ColSpec P

TS maxRow TableSpec → Class

TS class TableSpec → Class

MkTableSpec Class

→ Class

→ ColSpec P

→ Worth ↔ ColCon

→ Row LIST

→ TableSpec

TableSpecS TableSpec P

Dir class Directory → Class

Dir exist Directory → Class

Dir tables Directory → Ide ↔ TableSpec

MkDirectory Ide ↔ TableSpec → Class → Class → Directory

DirectoryS Directory P
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IdeL Tab P

StateS StateR P

isState StateR → Bool

isError ′a + ′Error → Bool

isVal ′a + ′Error → Bool

destError ′a + ′Error → ′Error

destVal ′a + ′Error → ′a

giveError ′Error → ′a + ′Error

giveVal ′a → ′a + ′Error

SelectEffect Select → Effect

UpdateEffect UpDate → Effect

DeleteEffect Delete → Effect

InsertEffect Insert → Effect

isSelect Effect → Bool

isUpdate Effect → Bool

isDelete Effect → Bool

isInsert Effect → Bool

destSelect Effect → Select

destUpdate Effect → UpDate

destDelete Effect → Delete

destInsert Effect → Insert

tabFromEffect
Effect → Tab

9.4 Aliases

null One : NullItem
monolean One : NullItem
boolean One : NullItem
chars One : NullItem
integer One : NullItem
floating One : NullItem
time One : NullItem
interval One : NullItem
class One : NullItem

9.5 Types

Int
Float
Time
Interval
Code
ValuedItem
Data
ColSpec
Reference
ColCon
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Row
TableSpec
Directory
State

9.6 Type Abbreviations

Char Char

String Ide

Num Worth

Bool Bool

Ide Ide

Error Worth

Worth Worth

Val Val

NullItem NullItem

Item Item

Update Update

Type Type

Errors Errors

Tab Tab

StateR StateR

Insert Insert

Delete Delete

UpDate UpDate

Select Select

Effect Effect

9.7 Definitions

Num ⊢ Num = Universe

Ide ⊢ Ide = Universe

Int ⊢ ∃ f • TypeDefn (λ x• T ) f

MkInt
I mantissa
I exponent ⊢ ∀ t x1 x2

• I mantissa (MkInt x1 x2 ) = x1

∧ I exponent (MkInt x1 x2 ) = x2

∧ MkInt (I mantissa t) (I exponent t) = t

Float ⊢ ∃ f • TypeDefn (λ x• T ) f

MkFloat
F mantissa
F exponent ⊢ ∀ t x1 x2

• F mantissa (MkFloat x1 x2 ) = x1

∧ F exponent (MkFloat x1 x2 ) = x2

∧ MkFloat (F mantissa t) (F exponent t) = t

error
notCleared
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tooWide
tooTall
wrongType
nullValue
noSuchColumn
ambiguousColumn
ambiguousUpdate
mayNotBeComplete
underClassified
downGrade
classChange
noSuchTable
noSuchDirectory
ambiguousEvaluate
ambiguousHaving
nonUniformValues
nonUniqueValues
noNulls
fieldClassOutOfRange
rowClassTooLow
accessDenied ⊢ error = 1

∧ notCleared = 2

∧ tooWide = 3

∧ tooTall = 4

∧ wrongType = 5

∧ nullValue = 6

∧ noSuchColumn = 7

∧ ambiguousColumn = 8

∧ ambiguousUpdate = 9

∧ mayNotBeComplete = 10

∧ underClassified = 11

∧ downGrade = 12

∧ classChange = 13

∧ noSuchTable = 14

∧ noSuchDirectory = 15

∧ ambiguousEvaluate = 16

∧ ambiguousHaving = 17

∧ nonUniformValues = 18

∧ nonUniqueValues = 19

∧ noNulls = 20

∧ fieldClassOutOfRange = 21

∧ rowClassTooLow = 22

∧ accessDenied = 23

worthless
dinary
sterling
priceless ⊢ worthless = 1

∧ dinary = 2
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∧ sterling = 3

∧ priceless = 4

VoidVal
BoolVal
StringVal
IntVal
FloatVal
TimeVal
IntervalVal
CodeVal
ClassVal
ExceptionVal ⊢ ∀ b s i f t n c cl

• VoidVal = InL class

∧ BoolVal b = InR (InL b)
∧ StringVal s = InR (InR (InL s))
∧ IntVal i = InR (InR (InR (InL i)))
∧ FloatVal f = InR (InR (InR (InR (InL f ))))
∧ TimeVal t = InR (InR (InR (InR (InR (InL t)))))
∧ IntervalVal n

= InR (InR (InR (InR (InR (InR (InL n))))))
∧ CodeVal c

= InR

(InR (InR (InR (InR (InR (InR (InL c)))))))
∧ ClassVal cl

= InR

(InR
(InR

(InR
(InR

(InR
(InR (InR (InL cl))))))))

∧ ExceptionVal

= InR

(InR
(InR

(InR
(InR

(InR
(InR

(InR
(InR

class))))))))
ValuedItem ⊢ ∃ f • TypeDefn (λ x• T ) f

MkValuedItem
VI worth
VI val ⊢ ∀ t x1 x2

• VI worth (MkValuedItem x1 x2 ) = x1

∧ VI val (MkValuedItem x1 x2 ) = x2
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∧ MkValuedItem (VI worth t) (VI val t) = t

ValuedItemItem
NullItemItem ⊢ ∀ v n

• ValuedItemItem v = InL v ∧ NullItemItem n = InR n

Data ⊢ ∃ f • TypeDefn (λ x• T ) f

MkData
Dat class
Dat item ⊢ ∀ t x1 x2

• Dat class (MkData x1 x2 ) = x1

∧ Dat item (MkData x1 x2 ) = x2

∧ MkData (Dat class t) (Dat item t) = t

DataS ⊢ DataS = Universe

ItemUpdate
ClassUpdate
DataUpdate ⊢ ∀ i c d

• ItemUpdate i = InL i

∧ ClassUpdate c = InR (InL c)
∧ DataUpdate d = InR (InR d)

isItem
isClass
isData ⊢ ∀ u

• (isItem u ⇔ (∃ i• u = ItemUpdate i))
∧ (isClass u ⇔ (∃ c• u = ClassUpdate c))
∧ (isData u ⇔ (∃ d• u = DataUpdate d))

destItem
destClass
destData ⊢ ConstSpec

(λ (destItem ′, destClass ′, destData ′)
• ∀ i c d

• destItem ′ (ItemUpdate i) = i

∧ destClass ′ (ClassUpdate c) = c

∧ destData ′ (DataUpdate d) = d)
(destItem, destClass, destData)

ColSpec ⊢ ∃ f • TypeDefn (λ x• T ) f

MkColSpec
CS ide
CS posn
CS dinaryType
CS sterlingType
CS nullType
CS default
CS consGroup
CS min
CS max ⊢ ∀ t x1 x2 x3 x4 x5 x6 x7 x8 x9

• CS ide (MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 ) = x1

∧ CS posn (MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x2

∧ CS dinaryType
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(MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x3

∧ CS sterlingType

(MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x4

∧ (CS nullType

(MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
⇔ x5 )

∧ CS default

(MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x6

∧ CS consGroup

(MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x7

∧ CS min (MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x8

∧ CS max (MkColSpec x1 x2 x3 x4 x5 x6 x7 x8 x9 )
= x9

∧ MkColSpec

(CS ide t)
(CS posn t)
(CS dinaryType t)
(CS sterlingType t)
(CS nullType t)
(CS default t)
(CS consGroup t)
(CS min t)
(CS max t)

= t

Reference ⊢ ∃ f • TypeDefn (λ x• T ) f

MkReference
R table
R group ⊢ ∀ t x1 x2

• R table (MkReference x1 x2 ) = x1

∧ R group (MkReference x1 x2 ) = x2

∧ MkReference (R table t) (R group t) = t

ColCon ⊢ ∃ f • TypeDefn (λ x• T ) f

MkColCon
CC exist
CC uniform
CC unique
CC classLimited
CC primary
CC secondary
CC referential

⊢ ∀ t x1 x2 x3 x4 x5 x6 x7

• CC exist (MkColCon x1 x2 x3 x4 x5 x6 x7 ) = x1

∧ (CC uniform (MkColCon x1 x2 x3 x4 x5 x6 x7 )

Page 24 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

⇔ x2 )
∧ (CC unique (MkColCon x1 x2 x3 x4 x5 x6 x7 )
⇔ x3 )

∧ (CC classLimited

(MkColCon x1 x2 x3 x4 x5 x6 x7 )
⇔ x4 )

∧ (CC primary (MkColCon x1 x2 x3 x4 x5 x6 x7 )
⇔ x5 )

∧ (CC secondary (MkColCon x1 x2 x3 x4 x5 x6 x7 )
⇔ x6 )

∧ CC referential (MkColCon x1 x2 x3 x4 x5 x6 x7 )
= x7

∧ MkColCon

(CC exist t)
(CC uniform t)
(CC unique t)
(CC classLimited t)
(CC primary t)
(CC secondary t)
(CC referential t)

= t

ColConS ⊢ ColConS = Universe

Row ⊢ ∃ f • TypeDefn (λ x• T ) f

MkRow
R exist
R data ⊢ ∀ t x1 x2

• R exist (MkRow x1 x2 ) = x1

∧ R data (MkRow x1 x2 ) = x2

∧ MkRow (R exist t) (R data t) = t

RowS ⊢ RowS = {r |let data = R data r in data ∈ Num 7→ DataS}
TableSpec ⊢ ∃ f • TypeDefn (λ x• T ) f

MkTableSpec
TS class
TS maxRow
TS colspecs
TS cons
TS rows ⊢ ∀ t x1 x2 x3 x4 x5

• TS class (MkTableSpec x1 x2 x3 x4 x5 ) = x1

∧ TS maxRow (MkTableSpec x1 x2 x3 x4 x5 ) = x2

∧ TS colspecs (MkTableSpec x1 x2 x3 x4 x5 ) = x3

∧ TS cons (MkTableSpec x1 x2 x3 x4 x5 ) = x4

∧ TS rows (MkTableSpec x1 x2 x3 x4 x5 ) = x5

∧ MkTableSpec

(TS class t)
(TS maxRow t)
(TS colspecs t)
(TS cons t)
(TS rows t)
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= t

TableSpecS ⊢ TableSpecS

= {ts
|let cns = TS cons ts and rows = TS rows ts

in cns ∈ Num 7→ ColConS

∧ (∀ r• r ∈l rows ⇒ r ∈ RowS )}
Directory ⊢ ∃ f • TypeDefn (λ x• T ) f

MkDirectory
Dir tables
Dir exist
Dir class ⊢ ∀ t x1 x2 x3

• Dir tables (MkDirectory x1 x2 x3 ) = x1

∧ Dir exist (MkDirectory x1 x2 x3 ) = x2

∧ Dir class (MkDirectory x1 x2 x3 ) = x3

∧ MkDirectory

(Dir tables t)
(Dir exist t)
(Dir class t)

= t

DirectoryS ⊢ DirectoryS = {d |Dir tables d ∈ Ide 7→ TableSpecS}
IdeL ⊢ IdeL = Universe

StateS ⊢ StateS = IdeL 7→ DirectoryS

isState ⊢ ∀ s• isState s ⇔ s ∈ StateS

state type def
⊢ ∃ f • TypeDefn isState f

giveVal
giveError
destVal
destError
isVal
isError ⊢ ConstSpec

(λ
(giveVal ′, giveError ′, destVal ′, destError ′,

isVal ′, isError ′)
• ∀ v e ve

• giveVal ′ v = InL v

∧ giveError ′ e = InR e

∧ destVal ′ (giveVal ′ v) = v

∧ destError ′ (giveError ′ e) = e

∧ (isVal ′ ve ⇔ (∃ v1• ve = giveVal ′ v1 ))
∧ (isError ′ ve
⇔ (∃ e1• ve = giveError ′ e1 )))

(giveVal , giveError , destVal , destError , isVal ,
isError)

InsertEffect
DeleteEffect
UpdateEffect
SelectEffect ⊢ ∀ i d u s
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• InsertEffect i = InL i

∧ DeleteEffect d = InR (InL d)
∧ UpdateEffect u = InR (InR (InL u))
∧ SelectEffect s = InR (InR (InR s))

isInsert
isDelete
isUpdate
isSelect ⊢ ∀ e

• (isInsert e ⇔ (∃ i• e = InsertEffect i))
∧ (isDelete e ⇔ (∃ d• e = DeleteEffect d))
∧ (isUpdate e ⇔ (∃ u• e = UpdateEffect u))
∧ (isSelect e ⇔ (∃ s• e = SelectEffect s))

destInsert
destDelete
destUpdate
destSelect ⊢ ConstSpec

(λ
(destInsert ′, destDelete ′, destUpdate ′,

destSelect ′)
• ∀ i d u s

• destInsert ′ (InsertEffect i) = i

∧ destDelete ′ (DeleteEffect d) = d

∧ destUpdate ′ (UpdateEffect u) = u

∧ destSelect ′ (SelectEffect s) = s)
(destInsert , destDelete, destUpdate, destSelect)

tabFromEffect
⊢ ConstSpec

(λ tabFromEffect ′

• ∀ i d u

• tabFromEffect ′ (InsertEffect i) = Fst i

∧ tabFromEffect ′ (DeleteEffect d) = Fst d

∧ tabFromEffect ′ (UpdateEffect u) = Fst u)
tabFromEffect

9.8 Theorems

dominates consistent
lattice bottom consistent
lattice top consistent
lub consistent
glb consistent

⊢ Consistent

(λ
(dominates ′, lattice bottom ′, lattice top ′,

lub ′, glb ′)
• ∀ x y z

• dominates ′ x x

∧ (dominates ′ x y ∧ dominates ′ y x ⇒ x = y)
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∧ (dominates ′ x y ∧ dominates ′ y z

⇒ dominates ′ x z )
∧ (∀ x• dominates ′ x lattice bottom ′)
∧ (∀ x• dominates ′ lattice top ′ x )
∧ (∀ x y z

• dominates ′ (lub ′ x y) x

∧ dominates ′ (lub ′ x y) y

∧ (dominates ′ z x ∧ dominates ′ z y

⇒ dominates ′ z (lub ′ x y)))
∧ (∀ x y z

• dominates ′ x (glb ′ x y)
∧ dominates ′ y (glb ′ x y)
∧ (dominates ′ x z ∧ dominates ′ y z

⇒ dominates ′ (glb ′ x y) z )))

10 THE THEORY fef005

10.1 Parents

fef004

10.2 Children

fef014

10.3 Constants

absState StateR → State

repState State → StateR

cleanColCons Class → TableSpec → Worth ↔ ColCon × ColSpec P

filterRow ColSpec P → Worth ↔ Data → Worth ↔ Data

Hidden Ide

dummyVal Val

replaceData Class → Data → Data

cleanRow Class → ColSpec P → Row → Row

cleanRows Class → ColSpec P → Row LIST → Row LIST

cleanTable Class → TableSpec → TableSpec

cleanDirectory
Class → Directory → Directory

hideR Class × StateR → StateR

hide Class × State → State

revealRow Class → TableSpec → Worth ↔ Worth

replaceRows TableSpec → Row LIST → TableSpec

changeSpec Tab → TableSpec → StateR → StateR

visibleCols Class → TableSpec → ColSpec P

tabExists Class → Tab → StateR → Bool

getTable Tab → StateR → TableSpec
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colDefaults Class → TableSpec → Worth ↔ Data → Worth ↔ Data

insertQuery
Class × Insert × StateR × TableSpec → StateR × Errors

deleteQuery
Class × Delete × StateR × TableSpec → StateR

updateField Class → Class → Update × Data → Data + Worth

updateRow Class → Class → Worth ↔ Update × Row → Row + Errors

updateQuery
Class × UpDate × StateR × TableSpec → StateR × Errors

updateStateR Class × (Effect × Errors) × StateR

→ StateR × Class × Select × Errors

updateState Class × (Effect × Errors) × State

→ State × Class × Select × Errors

10.4 Definitions

repState
absState ⊢ ConstSpec

(λ (repState ′, absState ′)
• (∀ a• absState ′ (repState ′ a) = a)

∧ (∀ r

• isState r ⇒ repState ′ (absState ′ r) = r)
∧ (∀ a1 a2

• repState ′ a1 = repState ′ a2 ⇔ a1 = a2 )
∧ (∀ r1 r2
• isState r1 ∧ isState r2

⇒ (absState ′ r1 = absState ′ r2
⇔ r1 = r2 ))

∧ (∀ s• isState (repState ′ s)))
(repState, absState)

cleanColCons ⊢ ∀ clear ts

• cleanColCons clear ts

= (let ccs

= TS cons ts

⊲ {cc|clear dominates CC exist cc}
in (ccs, {col |CS consGroup col ∈ Dom ccs}))

filterRow ⊢ ∀ cols ds

• filterRow cols ds

= {n|∃ c• c ∈ cols ∧ CS posn c = n} ⊳ ds

Hidden ⊢ T

dummyVal ⊢ dummyVal = StringVal Hidden

replaceData ⊢ ∀ clear d

• replaceData clear d

= (if ¬ clear dominates Dat class d

then

MkData

(Dat class d)
(ValuedItemItem
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(MkValuedItem worthless dummyVal))
else d)

cleanRow ⊢ ∀ clear cols r

• cleanRow clear cols r

= MkRow

(R exist r)
(filterRow cols (R data r)

o
9 Graph (replaceData clear))

cleanRows ⊢ ∀ clear cols rs

• cleanRows clear cols rs

= Map

(cleanRow clear cols)
(rs ↾ {r |clear dominates R exist r})

cleanTable ⊢ ∀ clear ts

• cleanTable clear ts

= (if ¬ clear dominates TS class ts

then

MkTableSpec

(TS class ts)
(TS class ts)
{}
{}
[]

else

(let (ccs, cols) = cleanColCons clear ts

in MkTableSpec

(TS class ts)
(TS maxRow ts)
cols

ccs

(cleanRows clear cols (TS rows ts))))
cleanDirectory

⊢ ∀ clear dir

• cleanDirectory clear dir

= MkDirectory

(if clear dominates Dir class dir

then

Dir tables dir o
9 Graph (cleanTable clear)

else {})
(Dir exist dir)
(Dir class dir)

hideR ⊢ ∀ clear s

• hideR (clear , s)
= (s ⊲ {dir |clear dominates Dir exist dir})

o
9 Graph (cleanDirectory clear)

hide ⊢ ∀ clear s

• hide (clear , s)
= absState (hideR (clear , repState s))
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revealRow ⊢ ∀ clear ts

• revealRow clear ts

= (let visiblerows

= {r |clear dominates R exist r}
in Squash

(Id
(Dom

(ListRel (TS rows ts)
⊲ visiblerows))))

replaceRows ⊢ ∀ ts rs

• replaceRows ts rs

= MkTableSpec

(TS class ts)
(TS maxRow ts)
(TS colspecs ts)
(TS cons ts)
rs

changeSpec ⊢ ∀ i ts s

• changeSpec i ts s

= (let dir = s @ Front i

in let dir ′

= MkDirectory

(Dir tables dir ⊕ {(Last i , ts)})
(Dir exist dir)
(Dir class dir)

in s ⊕ {(Front i , dir ′)})
visibleCols ⊢ ∀ clear ts

• visibleCols clear ts = Snd (cleanColCons clear ts)
tabExists ⊢ ∀ c i s

• tabExists c i s

⇔ Front i ∈ Dom s

∧ c dominates Dir exist (s @ Front i)
∧ c dominates Dir class (s @ Front i)
∧ Last i ∈ Dom (Dir tables (s @ Front i))

getTable ⊢ ∀ i s

• getTable i s = Dir tables (s @ Front i) @ Last i

colDefaults ⊢ ∀ clear ts ds

• colDefaults clear ts ds

= ds

⊕ {(n, d)
|∃ c

• ¬ c ∈ visibleCols clear ts

∧ n = CS posn c

∧ d = CS default c}
insertQuery

⊢ ∀ clear i ds s ts

• insertQuery (clear , (i , ds), s, ts)
= (let rl
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= Map

(MkRow clear o colDefaults clear ts)
ds

in if ¬ Elems rl ⊆ RowS

then (s, [ambiguousColumn])
else

(changeSpec
i

(replaceRows ts (TS rows ts @ rl))
s, []))

deleteQuery
⊢ ∀ clear i ns e s ts

• deleteQuery (clear , (i , ns), s, ts)
= (let ns ′ = revealRow clear ts Image ns

in let ns ′′

= ns ′

∩ {i
|R exist (Nth (TS rows ts) i) = clear}

in let rs

= Extract

(1 .. # (TS rows ts) \ ns ′′)
(TS rows ts)

in changeSpec i (replaceRows ts rs) s)
updateField ⊢ ∀ clear table class table d u

• updateField clear table class (u, table d)
= (if clear = table class

then

if isItem u

then

giveVal

(MkData (Dat class table d) (destItem u))
else if isClass u

then

if destClass u dominates Dat class table d

then

giveVal

(MkData

(destClass u)
(Dat item table d))

else giveError downGrade

else giveVal (destData u)
else if isItem u

then

if Dat class table d dominates clear

then

giveVal

(MkData (Dat class table d) (destItem u))
else giveError underClassified
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else giveError classChange)
updateRow ⊢ ∀ clear table class us r

• updateRow clear table class (us, r)
= (if ¬ us ∈ Functional

then giveError [ambiguousUpdate]
else

(let us ′

= RelCombine us (R data r)
o
9 Graph

(updateField clear table class)
in let es

= (us ′ ⊲ {x |isError x})
o
9 Graph destError

in if es = {}
then

giveVal

(MkRow

(R exist r)
(R data r ⊕ us ′ o

9 Graph destVal))
else giveError (RelList (Squash es))))

updateQuery
⊢ ∀ clear i us s ts

• updateQuery (clear , (i , us), s, ts)
= (let colnums

= {n
|∃ c

• c ∈ visibleCols clear ts

∧ CS posn c = n}
in if ¬ us ∈ Functional

then (s, [ambiguousUpdate])
else if ¬ Dom (

⋃
(Ran us)) ⊆ colnums

then (s, [noSuchColumn])
else

(let us ′ = revealRow clear ts ∼ o
9 us

in let pr

= RelCombine

us ′

(ListRel (TS rows ts))
o
9 Graph

(updateRow clear (TS class ts))
in let es

= (pr ⊲ {x |isError x})
o
9 Graph destError

in if es = {}
then

let rs

= RelList

(ListRel (TS rows ts)
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⊕ pr
o
9 Graph destVal)

in (changeSpec
i

(replaceRows ts rs)
s, [])

else (s, Flat (RelList (Squash es)))))
updateStateR ⊢ ∀ clear ef es s

• updateStateR (clear , (ef , es), s)
= (if isSelect ef

then (s, clear , destSelect ef , es)
else if ¬ es = []
then (s, clear , [], es)
else

(let i = tabFromEffect ef

in if tabExists clear i s

then

let ts = getTable i s

in if ¬ clear dominates TS class ts

then (s, clear , [], [accessDenied ])
else

(let (s ′, es ′)
= (if isInsert ef

then

insertQuery

(clear , destInsert ef , s,
ts)

else if isDelete ef

then

(deleteQuery

(clear ,
destDelete ef , s,
ts), [])

else

updateQuery

(clear , destUpdate ef , s,
ts))

in (s ′, clear , [], es ′))
else (s, clear , [], [noSuchTable])))

updateState ⊢ ∀ clear ef es s

• updateState (clear , (ef , es), s)
= (let (sr , out)

= updateStateR

(clear , (ef , es), repState s)
in (absState sr , out))
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11 THE THEORY fef006

11.1 Parents

fef014

11.2 Children

fef022 fef007

11.3 Constants

mkTf Hide → Process → Ustate → Stf

isstate State

SSQLam Am

iterate ((′QUERY × Class) × ′STATE → ′STATE × Class × ′DATA)
→ (′QUERY × Class) LIST × ′STATE

→ ′STATE × (Class × ′DATA) LIST

behaviours ((′QUERY × Class) × ′STATE → ′STATE × Class × ′DATA)
× ′STATE

→ (′QUERY , ′DATA) BEHAVIOURS

11.4 Type Abbreviations

Hide Hide

Process Process

Ustate Ustate

Stf Stf

Am Am

11.5 Definitions

mkTf ⊢ ∀ h p u q c s

• mkTf h p u ((q , c), s)
= u (c, p (q , c, h (c, s)), s)

isstate ⊢ true

SSQLam ⊢ SSQLam

= (mkTf hide processQuery updateState, isstate)
iterate ⊢ ConstSpec

(λ iterate ′

• ∀ s i si f

• iterate ′ f ([], s) = (s, [])
∧ (let sso = iterate ′ f (si , s)
in iterate ′ f (si @ [i ], s)
= (Fst (f (i , Fst sso)),
Snd sso @ [Snd (f (i , Fst sso))])))

iterate
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behaviours ⊢ ∀ tf istate si

• behaviours (tf , istate) si

= Snd (iterate tf (si , istate))

12 THE THEORY fef007

12.1 Parents

fef006

12.2 Children

fef009

12.3 Constants

secureHide Hide P

secureUpdate Hide ↔ Ustate

Lemma1 Bool

Lemma2 Bool

secureStf Stf P

SSQLtf Stf

Lemma3 Bool

secureItf Itf P

Lemma4 Bool

Lemma5 Bool

12.4 Type Abbreviations

Itf Itf

12.5 Definitions

secureHide ⊢ ∀ h

• h ∈ secureHide

⇔ (∀ c1 c2 s1 s2
• h (c1 , s1 ) = h (c1 , s2 ) ∧ c1 dominates c2

⇒ h (c2 , s1 ) = h (c2 , s2 ))
secureUpdate ⊢ ∀ h u

• (h, u) ∈ secureUpdate

⇔ (∀ c1 c2 s e

• (let s ′ = Fst (u (c1 , e, s))
in ¬ h (c2 , s) = h (c2 , s

′)
⇒ c2 dominates c1 ))

∧ (∀ c1 c2 s1 s2 e

• (let s ′1 = Fst (u (c2 , e, s1 ))
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and s ′2 = Fst (u (c2 , e, s2 ))
in h (c1 , s1 ) = h (c1 , s2 )

∧ c1 dominates c2
⇒ h (c1 , s

′
1 ) = h (c1 , s

′
2 )))

∧ (∀ c s1 s2 e

• (let o1 = Snd (u (c, e, s1 ))
and o2 = Snd (u (c, e, s2 ))
in h (c, s1 ) = h (c, s2 ) ⇒ o1 = o2 ))

∧ (∀ c s e• Fst (Snd (u (c, e, s))) = c)
Lemma1 ⊢ Lemma1

⇔ hide ∈ secureHide

∧ (hide, updateState) ∈ secureUpdate

Lemma2 ⊢ Lemma2

⇔ hide ∈ secureHide

∧ (hide, updateState) ∈ secureUpdate

⇒ behaviours SSQLam ∈ secure

secureStf ⊢ ∀ stf

• stf ∈ secureStf

⇔ (∀ s1 s2 i1 i2 c

• hide (c, s1 ) = hide (c, s2 )
∧ ([i1 ], [i2 ]) ∈ same ins c

⇒ (let (s ′1 , o1 ) = stf (i1 , s1 )
and (s ′2 , o2 ) = stf (i2 , s2 )
in hide (c, s ′1 ) = hide (c, s ′2 )
∧ ([o1 ], [o2 ]) ∈ same outs c))

∧ (∀ s i c

• ¬ c dominates Snd i

⇒ hide (c, s) = hide (c, Fst (stf (i , s)))
∧ ¬ c dominates Fst (Snd (stf (i , s))))

SSQLtf ⊢ SSQLtf = mkTf hide processQuery updateState

Lemma3 ⊢ Lemma3

⇔ hide ∈ secureHide

∧ (hide, updateState) ∈ secureUpdate

⇒ SSQLtf ∈ secureStf

secureItf ⊢ ∀ itf

• itf ∈ secureItf

⇔ (∀ s1 s2 si1 si2 c

• hide (c, s1 ) = hide (c, s2 )
∧ (si1 , si2 ) ∈ same ins c

⇒ (let (s ′1 , so1 ) = itf (si1 , s1 )
and (s ′2 , so2 ) = itf (si2 , s2 )
in hide (c, s ′1 ) = hide (c, s ′2 )
∧ (so1 , so2 ) ∈ same outs c))

Lemma4 ⊢ Lemma4

⇔ SSQLtf ∈ secureStf

⇒ iterate SSQLtf ∈ secureItf

Lemma5 ⊢ Lemma5

⇔ iterate SSQLtf ∈ secureItf
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⇒ behaviours SSQLam ∈ secure

12.6 Theorems

lemma2 thm ⊢ Lemma3 ∧ Lemma4 ∧ Lemma5 ⇒ Lemma2

lemma1 2 thm ⊢ Lemma1 ∧ Lemma2 ⇒ behaviours SSQLam ∈ secure

main thm ⊢ Lemma1 ∧ Lemma3 ∧ Lemma4 ∧ Lemma5

⇒ behaviours SSQLam ∈ secure

13 THE THEORY fef009

13.1 Parents

fef007

13.2 Children

fef010

13.3 Constants

iterate witness
((′QUERY × Class) × ′STATE → ′STATE × Class × ′DATA)
→ ′STATE

→ (′QUERY × Class) LIST

→ ′STATE × (Class × ′DATA) LIST

13.4 Definitions

iterate witness
⊢ ∀ s i si f

• iterate witness f s [] = (s, [])
∧ iterate witness f s (Cons i si)
= (Fst (f (i , Fst (iterate witness f s si))),
Snd (iterate witness f s si)

@ [Snd
(f

(i ,
Fst

(iterate witness

f

s

si)))])
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13.5 Theorems

Lemma3 ⊢ Lemma3

iterate consistent
⊢ Consistent

(λ iterate ′

• ∀ s i si f

• iterate ′ f ([], s) = (s, [])
∧ (let sso = iterate ′ f (si , s)
in iterate ′ f (si @ [i ], s)
= (Fst (f (i , Fst sso)),
Snd sso @ [Snd (f (i , Fst sso))])))

Lemma4 ⊢ Lemma4

Lemma5 ⊢ Lemma5

main thm1 ⊢ Lemma1 ⇒ behaviours SSQLam ∈ secure

14 THE THEORY fef010

14.1 Parents

fef009

14.2 Children

fef011 fef040

14.3 Constants

secureHideR (Class × StateR → StateR) P

14.4 Definitions

secureHideR ⊢ ∀ h

• h ∈ secureHideR

⇔ (∀ c1 c2 s1 s2
• h (c1 , s1 ) = h (c1 , s2 ) ∧ c1 dominates c2

⇒ h (c2 , s1 ) = h (c2 , s2 ))
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14.5 Theorems

repState consistent
absState consistent

⊢ Consistent

(λ (repState ′, absState ′)
• (∀ a• absState ′ (repState ′ a) = a)

∧ (∀ r

• isState r ⇒ repState ′ (absState ′ r) = r)
∧ (∀ a1 a2

• repState ′ a1 = repState ′ a2 ⇔ a1 = a2 )
∧ (∀ r1 r2
• isState r1 ∧ isState r2

⇒ (absState ′ r1 = absState ′ r2
⇔ r1 = r2 ))

∧ (∀ s• isState (repState ′ s)))
dir components

⊢ ∀ dir1 dir2
• dir1 = dir2

⇔ Dir tables dir1 = Dir tables dir2
∧ Dir exist dir1 = Dir exist dir2
∧ Dir class dir1 = Dir class dir2

tab components
⊢ ∀ t1 t2
• t1 = t2

⇔ TS class t1 = TS class t2
∧ TS maxRow t1 = TS maxRow t2
∧ TS colspecs t1 = TS colspecs t2
∧ TS cons t1 = TS cons t2
∧ TS rows t1 = TS rows t2

row components
⊢ ∀ r1 r2
• r1 = r2

⇔ R exist r1 = R exist r2
∧ R data r1 = R data r2

data components
⊢ ∀ d1 d2

• d1 = d2

⇔ Dat class d1 = Dat class d2

∧ Dat item d1 = Dat item d2

hideR hide lemma
⊢ hideR ∈ secureHideR

∧ (∀ clear s

• isState s ⇒ isState (hideR (clear , s)))
⇒ hide ∈ secureHide

replaceData lemma
⊢ ∀ c1 c2
• c1 dominates c2
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⇒ (∀ d1 d2

• replaceData c1 d1 = replaceData c1 d2

⇒ replaceData c2 d1 = replaceData c2 d2 )
cleanColCons lemma

⊢ ∀ c1 c2 t1 t2
• c1 dominates c2

∧ cleanColCons c1 t1 = cleanColCons c1 t2
⇒ cleanColCons c2 t1 = cleanColCons c2 t2

⊆ cleanColCons lemma
⊢ ∀ c1 c2 t

• c1 dominates c2
⇒ Fst (cleanColCons c2 t)

⊆ Fst (cleanColCons c1 t)
∧ Snd (cleanColCons c2 t)
⊆ Snd (cleanColCons c1 t)

⊆ cleanColCons lemma1
⊢ ∀ c1 c2 t col

• c1 dominates c2
⇒ col ∈ Snd (cleanColCons c2 t)
⇒ col ∈ Snd (cleanColCons c1 t)

cleanRow lemma
⊢ ∀ c1 c2
• c1 dominates c2

⇒ (∀ t1 t2 r1 r2
• cleanColCons c1 t1 = cleanColCons c1 t2

∧ cleanColCons c2 t1
= cleanColCons c2 t2

∧ cleanRow

c1
(Snd (cleanColCons c1 t1 ))
r1

= cleanRow

c1
(Snd (cleanColCons c1 t2 ))
r2

⇒ cleanRow

c2
(Snd (cleanColCons c2 t1 ))
r1

= cleanRow

c2
(Snd (cleanColCons c2 t2 ))
r2 )

cleanTable lemma
⊢ ∀ c1 c2
• c1 dominates c2

⇒ (∀ t1 t2
• cleanTable c1 t1 = cleanTable c1 t2
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⇒ cleanTable c2 t1 = cleanTable c2 t2 )
cleanDirectory lemma

⊢ ∀ c1 c2
• c1 dominates c2

⇒ (∀ d1 d2

• cleanDirectory c1 d1 = cleanDirectory c1 d2

⇒ cleanDirectory c2 d1

= cleanDirectory c2 d2 )
⊆ dir lemma ⊢ ∀ c1 c2 s x y

• c1 dominates c2
⇒ (x , y) ∈ s ⊲ {dir |c2 dominates Dir exist dir}
⇒ (x , y) ∈ s ⊲ {dir |c1 dominates Dir exist dir}

dir class preserved lemma
⊢ ∀ c c1 s s1 x z z 1
• cleanDirectory c1 z = cleanDirectory c1 z 1

∧ (x , z )
∈ s ⊲ {dir |c1 dominates Dir exist dir}

∧ (x , z 1 )
∈ s1 ⊲ {dir |c dominates Dir exist dir}

⇒ (x , z 1 )
∈ s1 ⊲ {dir |c1 dominates Dir exist dir}

secureHideR lemma
⊢ hideR ∈ secureHideR

cleanDir fun thm
⊢ ∀ clear• Graph (cleanDirectory clear) ∈ Functional

replaceData fun thm
⊢ ∀ clear• Graph (replaceData clear) ∈ Functional

cleanColCons fun thm
⊢ ∀ clear tab

• TS cons tab ∈ Functional

⇒ Fst (cleanColCons clear tab) ∈ Functional

tables fun thm
⊢ ∀ clear dir

• Dir tables dir ∈ Functional

⇒ Dir tables (cleanDirectory clear dir)
∈ Functional

hideR lemma ⊢ ∀ clear s• isState s ⇒ isState (hideR (clear , s))
secureHide lemma

⊢ hide ∈ secureHide

15 THE THEORY fef011

15.1 Parents

fef010
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15.2 Children

fef012

15.3 Theorems

destInsert consistent
destDelete consistent
destUpdate consistent
destSelect consistent

⊢ Consistent

(λ
(destInsert ′, destDelete ′, destUpdate ′,

destSelect ′)
• ∀ i d u s

• destInsert ′ (InsertEffect i) = i

∧ destDelete ′ (DeleteEffect d) = d

∧ destUpdate ′ (UpdateEffect u) = u

∧ destSelect ′ (SelectEffect s) = s)
tabFromEffect consistent

⊢ Consistent

(λ tabFromEffect ′

• ∀ i d u

• tabFromEffect ′ (InsertEffect i) = Fst i

∧ tabFromEffect ′ (DeleteEffect d) = Fst d

∧ tabFromEffect ′ (UpdateEffect u) = Fst u)
giveVal consistent
giveError consistent
destVal consistent
destError consistent
isVal consistent
isError consistent

⊢ Consistent

(λ
(giveVal ′, giveError ′, destVal ′, destError ′,

isVal ′, isError ′)
• ∀ v e ve

• giveVal ′ v = InL v

∧ giveError ′ e = InR e

∧ destVal ′ (giveVal ′ v) = v

∧ destError ′ (giveError ′ e) = e

∧ (isVal ′ ve ⇔ (∃ v1• ve = giveVal ′ v1 ))
∧ (isError ′ ve
⇔ (∃ e1• ve = giveError ′ e1 )))

giveVal eq thm
⊢ ∀ x y• giveVal x = giveVal y ⇔ x = y

giveError eq thm
⊢ ∀ x y• giveError x = giveError y ⇔ x = y
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¬isError giveVal thm
⊢ ∀ v• ¬ isError (giveVal v)

¬isVal giveError thm
⊢ ∀ e• ¬ isVal (giveError e)

query type ⊢ ∀ q

• isInsert q

∧ ¬ (isDelete q ∨ isUpdate q ∨ isSelect q)
∨ isDelete q

∧ ¬ (isInsert q ∨ isUpdate q ∨ isSelect q)
∨ isUpdate q

∧ ¬ (isInsert q ∨ isDelete q ∨ isSelect q)
∨ isSelect q

∧ ¬ (isInsert q ∨ isDelete q ∨ isUpdate q)
update type ⊢ ∀ u

• isItem u ∧ ¬ (isClass u ∨ isData u)
∨ isClass u ∧ ¬ (isItem u ∨ isData u)
∨ isData u ∧ ¬ (isItem u ∨ isClass u)

val or error type
⊢ ∀ v• isVal v ∧ ¬ isError v ∨ isError v ∧ ¬ isVal v

conjunct4 ⊢ ∀ c s e• Fst (Snd (updateState (c, e, s))) = c

isState lemma3
⊢ ∀ c s• isState (hideR (c, repState s))

hide eq lemma
⊢ ∀ c s1 s2
• hide (c, s1 ) = hide (c, s2 )

⇔ hideR (c, repState s1 )
= hideR (c, repState s2 )

tabExists lemma
⊢ ∀ c s1 s2
• hide (c, s1 ) = hide (c, s2 )

⇒ (∀ i

• tabExists c i (repState s1 )
⇔ tabExists c i (repState s2 ))

cleanTable insertQuery lemma
⊢ ∀ c t1 t2 s1 s2 i

• c dominates TS class t1
∧ c dominates TS class t2
∧ cleanTable c t1 = cleanTable c t2

⇒ Snd (insertQuery (c, i , s1 , t1 ))
= Snd (insertQuery (c, i , s2 , t2 ))

updateRow lemma
⊢ ∀ c t1 t2
• cleanTable c t1 = cleanTable c t2

⇒ c dominates TS class t1
∧ c dominates TS class t2

⇒ updateRow c (TS class t1 )
= updateRow c (TS class t2 )

isError updateField lemma
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⊢ ∀ c tc d1 d2 u

• isError (updateField c tc (u, d1 ))
∧ replaceData c d1 = replaceData c d2

⇒ updateField c tc (u, d1 )
= updateField c tc (u, d2 )

isError updateRow lemma
⊢ ∀ c r1 r2 t u

• isError (updateRow c (TS class t) (u, r1 ))
∧ isError (updateRow c (TS class t) (u, r2 ))
∧ cleanRow c (Snd (cleanColCons c t)) r1
= cleanRow c (Snd (cleanColCons c t)) r2

∧ Dom u

⊆ {n
|∃ c′• c′ ∈ visibleCols c t ∧ CS posn c′ = n}

⇒ updateRow c (TS class t) (u, r1 )
= updateRow c (TS class t) (u, r2 )

isVal updateRow lemma
⊢ ∀ c r1 r2 t u

• isVal (updateRow c (TS class t) (u, r1 ))
∧ cleanRow c (Snd (cleanColCons c t)) r1
= cleanRow c (Snd (cleanColCons c t)) r2

∧ Dom u

⊆ {n
|∃ c′• c′ ∈ visibleCols c t ∧ CS posn c′ = n}

⇒ isVal (updateRow c (TS class t) (u, r2 ))
isError ⇔ updateRow lemma

⊢ ∀ c r1 r2 t u

• cleanRow c (Snd (cleanColCons c t)) r1
= cleanRow c (Snd (cleanColCons c t)) r2

∧ Dom u

⊆ {n
|∃ c′• c′ ∈ visibleCols c t ∧ CS posn c′ = n}

⇒ (isError (updateRow c (TS class t) (u, r1 ))
⇔ isError (updateRow c (TS class t) (u, r2 )))

dom
⋃

ran lemma
⊢ ∀ x y u c t

• (x , y) ∈ u

∧ Dom (
⋃

(Ran u))
⊆ {n
|∃ c′

• c′ ∈ Snd (cleanColCons c t)
∧ CS posn c′ = n}

⇒ Dom y

⊆ {n
|∃ c′• c′ ∈ visibleCols c t ∧ CS posn c′ = n}

doms null lemma1
⊢ ∀ l last s u

• Dom (Squash (Id (Dom (ListRel l ⊲ s))) ∼ o
9 u)
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∩ Dom {(# l + 1 , last)}
= {}

doms null lemma2
⊢ ∀ l s u

• Dom

({(# (Squash (Id (Dom (ListRel l ⊲ s)))) + 1 ,
# l + 1 )} ∼

o
9 u)

∩ Dom (ListRel l)
= {}

squash doms lemma
⊢ ∀ l last s u n1 n2

• n1

∈ Dom

(((RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ s))) ∼

o
9 u)

(ListRel l)
o
9 Graph

(updateRow c (TS class t2 )))
⊲ {x |isError x})

o
9 Graph destError)

∧ n2

∈ Dom

(((RelCombine

({(#
(Squash

(Id
(Dom (ListRel l ⊲ s))))

+ 1 , # l + 1 )} ∼

o
9 u)

{(# l + 1 , last)}
o
9 Graph

(updateRow c (TS class t2 )))
⊲ {x |isError x})

o
9 Graph destError)

⇒ n2 > n1

cleanRows size lemma
⊢ ∀ c t1 t2
• cleanRows

c

(Snd (cleanColCons c t2 ))
(TS rows t1 )

= cleanRows
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c

(Snd (cleanColCons c t2 ))
(TS rows t2 )

⇒ #
(ListRel (TS rows t1 )

⊲ {r |c dominates R exist r})
= #
(ListRel (TS rows t2 )

⊲ {r |c dominates R exist r})
cleanRows errors or vals lemma

⊢ ∀ c t1 t2 u

• Dom (
⋃

(Ran u))
⊆ {n
|∃ c′

• c′ ∈ visibleCols c t2 ∧ CS posn c′ = n}
∧ cleanRows

c

(Snd (cleanColCons c t2 ))
(TS rows t1 )

= cleanRows

c

(Snd (cleanColCons c t2 ))
(TS rows t2 )

⇒ (((RelCombine

(revealRow c t1
∼ o

9 u)
(ListRel (TS rows t1 ))

o
9 Graph (updateRow c (TS class t2 )))

⊲ {x |isError x})
o
9 Graph destError

= {}
⇔ ((RelCombine

(revealRow c t2
∼ o

9 u)
(ListRel (TS rows t2 ))

o
9 Graph (updateRow c (TS class t2 )))

⊲ {x |isError x})
o
9 Graph destError

= {})
fun updateRow thm

⊢ ∀ c t• Graph (updateRow c (TS class t)) ∈ Functional

fun destError thm
⊢ Graph destError ∈ Functional

fin lemma1 ⊢ ∀ l r c t u

• u ∈ Functional

⇒ ((RelCombine

(Squash
(Id

(Dom

(ListRel l
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⊲ {r
|c

dominates R exist

r}))) ∼

o
9 u)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

∈ Finite

fin lemma2 ⊢ ∀ l last r c t u

• u ∈ Functional

⇒ ((RelCombine

({(#
(Squash

(Id
(Dom

(ListRel l ⊲ {r |c dominates R exist r}))))
+ 1 , # l + 1 )} ∼

o
9 u)

{(# l + 1 , last)}
o
9 Graph (updateRow c (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

∈ Finite

cleanTable updateQuery lemma
⊢ ∀ c t1 t2 s1 s2 u

• c dominates TS class t1
∧ c dominates TS class t2
∧ cleanTable c t1 = cleanTable c t2

⇒ Snd (updateQuery (c, u, s1 , t1 ))
= Snd (updateQuery (c, u, s2 , t2 ))

tabExists cleanTable lemma
⊢ ∀ c s1 s2
• hide (c, s1 ) = hide (c, s2 )

⇒ (∀ i

• tabExists c i (repState s1 )
⇒ cleanTable c (getTable i (repState s1 ))

= cleanTable

c

(getTable i (repState s2 ))
∧ (c

dominates TS class

(getTable i (repState s1 ))
⇔ c

dominates TS class

(getTable i (repState s2 ))))
conjunct3 ⊢ ∀ c s1 s2 e
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• hide (c, s1 ) = hide (c, s2 )
⇒ Snd (updateState (c, e, s1 ))
= Snd (updateState (c, e, s2 ))

16 THE THEORY fef012

16.1 Parents

fef011

16.2 Children

fef013

16.3 Theorems

destItem consistent
destClass consistent
destData consistent

⊢ Consistent

(λ (destItem ′, destClass ′, destData ′)
• ∀ i c d

• destItem ′ (ItemUpdate i) = i

∧ destClass ′ (ClassUpdate c) = c

∧ destData ′ (DataUpdate d) = d)
¬giveVal eq giveError thm

⊢ ∀ v e• ¬ giveVal v = giveError e

¬giveError eq giveVal thm
⊢ ∀ e v• ¬ giveError e = giveVal v

rel combine one lemma
⊢ ∀ l last s u

• RelCombine

(Squash (Id (Dom (ListRel l ⊲ s))) ∼ o
9 u)

(ListRel (l @ [last ]))
= RelCombine

(Squash (Id (Dom (ListRel l ⊲ s))) ∼ o
9 u)

(ListRel l)
rel combine null lemma

⊢ ∀ l last c t us

• ((RelCombine

(Squash
(Id

(Dom

(ListRel (l @ [last ])
⊲ {r
|c

dominates R exist
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r}))) ∼

o
9 us)

(ListRel (l @ [last ]))
o
9 Graph (updateRow c (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

= {}
⇒ ((RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r}))) ∼

o
9 us)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

= {}
dom rel combine null ⊆ lemma

⊢ ∀ l s u c t

• Dom

((RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r}))) ∼

o
9 u)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

⊆ Dom (ListRel l)
destVal fun thm

⊢ Graph destVal ∈ Functional

updateRow fun thm
⊢ ∀ c t• Graph (updateRow c (TS class t)) ∈ Functional

conjunct1 fun lemma
⊢ ∀ l s u c t

• u ∈ Functional

⇒ (RelCombine

(Squash
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(Id
(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r}))) ∼

o
9 u)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal

∈ Functional

conjunct1 lemma1
⊢ ∀ l last c u t

• u ∈ Functional

⇒ RelList

(ListRel (l @ [last ])
⊕ (RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r}))) ∼

o
9 u)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

= RelList

(ListRel l
⊕ (RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ {r
|c

dominates R exist r}))) ∼

o
9 u)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

@ [last ]
conjunct1 lemma2

⊢ ∀ c last l u us t

• us ∈ Functional
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∧ c dominates R exist last

∧ (#
(Squash

(Id
(Dom

(ListRel (l @ [last ])
⊲ {r
|c

dominates R exist

r})))), u)
∈ us

⇒ RelList

(ListRel (l @ [last ])
⊕ (RelCombine

(Squash
(Id

(Dom

(ListRel (l @ [last ])
⊲ {r
|c

dominates R exist

r}))) ∼

o
9 us)

(ListRel (l @ [last ]))
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

= RelList

(ListRel l
⊕ (RelCombine

(Squash
(Id

(Dom

(ListRel l
⊲ {r
|c

dominates R exist r}))) ∼

o
9 us)

(ListRel l)
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

@ [destVal
(updateRow c (TS class t) (u, last))]

insertRows lemma
⊢ ∀ c1 c2 t ds

• ¬ c2 dominates c1
⇒ cleanTable c2 t

= cleanTable

c2
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(replaceRows
t

(TS rows t

@ Map

(MkRow c1 o colDefaults c1 t)
ds))

insertQuery lemma
⊢ ∀ c1 c2 s i ds

• ¬ c2 dominates c1
∧ tabExists

c1
(tabFromEffect (InsertEffect (i , ds)))
(repState s)

⇒ hideR (c2 , repState s)
= hideR

(c2 ,
Fst

(insertQuery

(c1 ,
destInsert

(InsertEffect (i , ds)),
repState s,
getTable

(tabFromEffect

(InsertEffect
(i , ds)))

(repState s))))
deleteRows lemma

⊢ ∀ c1 c2 s t ns

• ¬ c2 dominates c1
⇒ cleanTable c2 t

= cleanTable

c2
(replaceRows

t

(Extract
(1 .. # (TS rows t)

\ revealRow c1 t Image ns

∩ {i
|R exist (Nth (TS rows t) i)

= c1})
(TS rows t)))

deleteQuery lemma
⊢ ∀ c1 c2 s i ns

• ¬ c2 dominates c1
∧ tabExists

c1
(tabFromEffect (DeleteEffect (i , ns)))
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(repState s)
⇒ hideR (c2 , repState s)
= hideR

(c2 ,
deleteQuery

(c1 ,
destDelete

(DeleteEffect (i , ns)),
repState s,
getTable

(tabFromEffect

(DeleteEffect (i , ns)))
(repState s)))

replaceData updateField lemma
⊢ ∀ c1 c2 d tc u

• c1 dominates tc ∧ c2 dominates tc

⇒ ¬ c2 dominates c1
∧ isVal (updateField c1 tc (u, d))

⇒ replaceData c2 d

= replaceData

c2
(destVal (updateField c1 tc (u, d)))

cleanRow updateRow lemma
⊢ ∀ c1 c2 r t u

• c1 dominates TS class t ∧ c2 dominates TS class t

⇒ ¬ c2 dominates c1
∧ isVal (updateRow c1 (TS class t) (u, r))

⇒ cleanRow c2 (Snd (cleanColCons c2 t)) r

= cleanRow

c2
(Snd (cleanColCons c2 t))
(destVal (updateRow c1 (TS class t) (u, r)))

updateRows lemma
⊢ ∀ c1 c2 s t us

• us ∈ Functional

∧ ¬ c2 dominates c1
∧ c1 dominates TS class t

∧ ((RelCombine

(revealRow c1 t ∼ o
9 us)

(ListRel (TS rows t))
o
9 Graph (updateRow c1 (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

= {}
⇒ cleanTable c2 t

= cleanTable

c2
(replaceRows
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t

(RelList
(ListRel (TS rows t)

⊕ (RelCombine

(revealRow c1 t ∼ o
9 us)

(ListRel (TS rows t))
o
9 Graph

(updateRow c1 (TS class t)))
o
9 Graph destVal)))

updateQuery lemma
⊢ ∀ c1 c2 s i us

• ¬ c2 dominates c1
∧ tabExists

c1
(tabFromEffect (UpdateEffect (i , us)))
(repState s)

∧ c1
dominates TS class

(getTable
(tabFromEffect (UpdateEffect (i , us)))
(repState s))

⇒ hideR (c2 , repState s)
= hideR

(c2 ,
Fst

(updateQuery

(c1 ,
destUpdate

(UpdateEffect (i , us)),
repState s,
getTable

(tabFromEffect

(UpdateEffect
(i , us)))

(repState s))))
conjunct1 ⊢ ∀ c1 c2 s e

• ¬ hideR (c2 , repState s)
= hideR

(c2 ,
Fst

(updateStateR
(c1 , e, repState s)))

⇒ c2 dominates c1

Page 55 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

17 THE THEORY fef013

17.1 Parents

fef012

17.2 Children

fef015

17.3 Theorems

cleanTable insertRows lemma
⊢ ∀ c1 c2 t1 t2 ds

• cleanTable c1 t1 = cleanTable c1 t2
∧ c1 dominates c2

⇒ cleanTable

c1
(replaceRows

t1
(TS rows t1

@ Map

(MkRow c2 o colDefaults c2 t1 )
ds))

= cleanTable

c1
(replaceRows

t2
(TS rows t2

@ Map

(MkRow c2 o colDefaults c2 t2 )
ds))

extract a single lemma
⊢ ∀ c l x

• Extract

(1 .. # (l @ [x ])
\ Squash

(Id
(Dom

(ListRel (l @ [x ])
⊲ {r
|c

dominates R exist

r})))
Image ns

∩ {i |R exist (Nth (l @ [x ]) i) = c})
(l @ [x ])
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= (if
# l + 1

∈ 1 .. # (l @ [x ])
\ Squash

(Id
(Dom

(ListRel (l @ [x ])
⊲ {r
|c

dominates R exist

r})))
Image ns

∩ {i |R exist (Nth (l @ [x ]) i) = c}
then

Extract

(1 .. # l

\ Squash

(Id
(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r})))
Image ns

∩ {i |R exist (Nth l i) = c})
l

@ [x ]
else

Extract

(1 .. # l

\ Squash

(Id
(Dom

(ListRel l
⊲ {r
|c

dominates R exist

r})))
Image ns

∩ {i |R exist (Nth l i) = c})
l)

map cleanRow lemma1
⊢ ∀ l1 l2 c1 c2 s

• c1 dominates c2
∧ Map

(cleanRow c1 s)
(l1 ↾ {r |c1 dominates R exist r})
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= Map

(cleanRow c1 s)
(l2 ↾ {r |c1 dominates R exist r})

⇒ Map

(cleanRow c2 s)
(l1 ↾ {r |c2 dominates R exist r})

= Map

(cleanRow c2 s)
(l2 ↾ {r |c2 dominates R exist r})

map cleanRow lemma2
⊢ ∀ l1 l2 c1 c2 s

• c1 dominates c2
∧ Map

(cleanRow c1 s)
(l1 ↾ {r |c1 dominates R exist r})

= Map

(cleanRow c1 s)
(l2 ↾ {r |c1 dominates R exist r})

⇒ # (ListRel l1 ⊲ {r |c2 dominates R exist r})
= # (ListRel l2 ⊲ {r |c2 dominates R exist r})

cleanTable deleteRows lemma
⊢ ∀ c1 c2 t1 t2 ns

• cleanTable c1 t1 = cleanTable c1 t2
∧ c1 dominates c2
∧ c2 dominates TS class t1

⇒ cleanTable

c1
(replaceRows

t1
(Extract

(1 .. # (TS rows t1 )
\ revealRow c2 t1 Image ns

∩ {i
|R exist (Nth (TS rows t1 ) i)

= c2})
(TS rows t1 )))

= cleanTable

c1
(replaceRows

t2
(Extract

(1 .. # (TS rows t2 )
\ revealRow c2 t2 Image ns

∩ {i
|R exist (Nth (TS rows t2 ) i)

= c2})
(TS rows t2 )))

replaceData updateField lemma
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⊢ ∀ c1 c2 d1 d2 t u

• c1 dominates c2
∧ replaceData c1 d1 = replaceData c1 d2

∧ isVal (updateField c2 (TS class t) (u, d1 ))
∧ isVal (updateField c2 (TS class t) (u, d2 ))

⇒ replaceData

c1
(destVal

(updateField c2 (TS class t) (u, d1 )))
= replaceData

c1
(destVal

(updateField c2 (TS class t) (u, d2 )))
cleanRow updateRow lemma1

⊢ ∀ c1 c2 r1 r2 t u

• c1 dominates c2
∧ Dom u

⊆ {n
|∃ c′

• c′ ∈ visibleCols c2 t ∧ CS posn c′ = n}
∧ cleanRow c1 (Snd (cleanColCons c1 t)) r1
= cleanRow c1 (Snd (cleanColCons c1 t)) r2

∧ isVal (updateRow c2 (TS class t) (u, r1 ))
∧ isVal (updateRow c2 (TS class t) (u, r2 ))

⇒ cleanRow

c1
(Snd (cleanColCons c1 t))
(destVal

(updateRow c2 (TS class t) (u, r1 )))
= cleanRow

c1
(Snd (cleanColCons c1 t))
(destVal

(updateRow c2 (TS class t) (u, r2 )))
inUpdates lemma

⊢ ∀ l1 l2 x 1 x 2 c us up

• R exist x 1 = R exist x 2

∧ # (ListRel l1 ⊲ {r |c dominates R exist r})
= # (ListRel l2 ⊲ {r |c dominates R exist r})

⇒ ((#
(Squash

(Id
(Dom

(ListRel (l1 @ [x 1 ])
⊲ {r
|c

dominates R exist

r})))), up)
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∈ us

⇔ (#
(Squash

(Id
(Dom

(ListRel (l2 @ [x 2 ])
⊲ {r
|c

dominates R exist

r})))), up)
∈ us)

cleanTable updateRows lemma
⊢ ∀ c1 c2 t1 t2 us

• us ∈ Functional

∧ Dom (
⋃

(Ran us))
⊆ {n
|∃ c

• c ∈ Snd (cleanColCons c2 t2 )
∧ CS posn c = n}

∧ ((RelCombine

(revealRow c2 t1
∼ o

9 us)
(ListRel (TS rows t1 ))

o
9 Graph (updateRow c2 (TS class t2 )))

⊲ {x |isError x})
o
9 Graph destError

= {}
∧ ((RelCombine

(revealRow c2 t2
∼ o

9 us)
(ListRel (TS rows t2 ))

o
9 Graph (updateRow c2 (TS class t2 )))

⊲ {x |isError x})
o
9 Graph destError

= {}
∧ cleanTable c1 t1 = cleanTable c1 t2
∧ c1 dominates c2
∧ c2 dominates TS class t1

⇒ cleanTable

c1
(replaceRows

t1
(RelList

(ListRel (TS rows t1 )
⊕ (RelCombine

(revealRow c2 t1
∼ o

9 us)
(ListRel (TS rows t1 ))

o
9 Graph

(updateRow
c2
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(TS class t1 )))
o
9 Graph destVal)))

= cleanTable

c1
(replaceRows

t2
(RelList

(ListRel (TS rows t2 )
⊕ (RelCombine

(revealRow c2 t2
∼ o

9 us)
(ListRel (TS rows t2 ))

o
9 Graph

(updateRow
c2
(TS class t2 )))

o
9 Graph destVal)))

tabExists lemma1
⊢ ∀ c1 c2 i s

• c1 dominates c2 ∧ tabExists c2 i s

⇒ tabExists c1 i s

tabExists cleanTable lemma1
⊢ ∀ c s1 s2
• hideR (c, repState s1 ) = hideR (c, repState s2 )

⇒ (∀ i

• tabExists c i (repState s1 )
⇒ cleanTable c (getTable i (repState s1 ))
= cleanTable c (getTable i (repState s2 )))

colDefaults lemma
⊢ ∀ c t1 t2
• c dominates TS class t1

∧ c dominates TS class t2
∧ cleanTable c t1 = cleanTable c t2

⇒ colDefaults c t1 = colDefaults c t2
conjunct2 ⊢ ∀ c1 c2 s1 s2 e

• hideR (c1 , repState s1 )
= hideR (c1 , repState s2 )

∧ c1 dominates c2
⇒ hideR

(c1 ,
Fst

(updateStateR
(c2 , e, repState s1 )))

= hideR

(c1 ,
Fst

(updateStateR
(c2 , e, repState s2 )))
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18 THE THEORY fef014

18.1 Parents

fef005

18.2 Children

fef006

18.3 Constants

destNullItem Item → Maybe

destValuedItem
Item → ValuedItem

isNullItem Item → Bool

isValuedItem Item → Bool

destClassVal Val → Class

destCodeVal Val → Code

destIntervalVal
Val → Interval

destTimeVal Val → Time

destFloatVal Val → Float

destIntVal Val → Int

destStringVal
Val → Op

destBoolVal Val → Bool

isClassVal Val → Bool

isCodeVal Val → Bool

isIntervalVal
Val → Bool

isTimeVal Val → Bool

isFloatVal Val → Bool

isIntVal Val → Bool

isStringVal Val → Bool

isBoolVal Val → Bool

G group GroupedResult → Tuple LIST

G res GroupedResult → Data LIST

MkGroupedResult
Data LIST → Tuple LIST → GroupedResult

E group Env → Tuple LIST

E row Env → Tuple

MkEnv Tuple → Tuple LIST → Env

timeNow Time

userClearance
Class

userDirectory
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Col

userName Op

lubl Class LIST → Class

glbl Class LIST → Class

$dominates w Worth → Worth → Bool

$lub w Worth → Worth → Worth

lub wl Errors → Worth

Equal Op

Plus Op

Or Op

And Op

Not Op

newData Class → Worth → Val → Data

lub data Data LIST → Class

lub wdata Data LIST → Worth

ExceptionData
Data LIST → Data

NullData Data LIST → Data

applyNot Data LIST → Data

applyAnd Data LIST → Data

applyOr Data LIST → Data

$intPlus Int → Int → Int

applyPlus Data LIST → Data

applyEqual Data LIST → Data

apply Op → Data LIST → Data

$∗1 (′x → ′y + Errors)
→ (′y → ′z + Errors)
→ ′x

→ ′z + Errors

$∗2
′x + Errors → (′x → ′y + Errors) → ′y + Errors

$∗3
′x + Errors

→ (′x → ′y → ′z + Errors)
→ ′y

→ ′z + Errors

$∗4 (′x → ′y + Errors) → (′y → ′z ) → ′x → ′z + Errors

$∗5
′x + Errors → (′x → ′y) → ′y + Errors

$∗6
′x + Errors × ′y + Errors

→ (′x → ′y → ′z )
→ ′z + Errors

$∗7
′x → (′x → ′y) + Errors → ′y + Errors

$list ∪ ′x LIST → ′x LIST → ′x LIST

$&1
′x + Errors → ′x + Errors → ′x LIST + Errors

$&2
′x + Errors → ′x LIST + Errors → ′x LIST + Errors

$&3
′x LIST + Errors → ′x + Errors → ′x LIST + Errors

$&4
′x LIST + Errors → ′x LIST + Errors → ′x LIST + Errors

seq Worth → ′x → ′x LIST

enseq (Worth → ′x + Errors) → ′x LIST

promote (′x → ′y + Errors) → ′x LIST → ′y LIST + Errors
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find ′x LIST → ′x → Worth + Errors

distinct ′x LIST → ′x LIST

noErrors Errors

one col Select → Data LIST + Errors

one result Data LIST → Data + Errors

make data Val → Data

fillTab Col → Col

fillCol Col → Col

getDir State → Col → Directory + Errors

getTab Directory → Op → TableSpec + Errors

getColPosn TableSpec → Op → Worth + Errors

getData Row → Worth → Data + Errors

lookup State → Col → TableSpec + Errors

isCleared Data → Bool

isNotCleared Data → Bool

checkComplete
Data LIST → Bool

check where complete
Bool → Bool → Data → Data + Errors

resultBool Data → Bool + Errors

take data Data → Data + Errors

resultClass Data → Class + Errors

extract Bool LIST → ′x LIST → ′x LIST

emptyTuple Tuple

emptyEnv Env

$star1 Tuple → Tuple → Tuple

$star2 Tuple → Tuple LIST → Tuple LIST

$star3 Tuple LIST → Tuple LIST → Tuple LIST

jay Tuple LIST → Tuple LIST LIST → Tuple LIST

join Tuple LIST LIST → Tuple LIST

$starstar1 Tuple → Tuple → Tuple

$starstar2 Tuple → Tuple LIST → Tuple LIST

denote code Code → Value

denote class Class → Value

denote interval
Interval → Value

denote time Time → Value

denote float Float → Value

denote string
Op → Value

denote integer
Int → Value

denote false Value

denote true Value

denote void Value

denote null Value

classification
Col spec → Value
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contents Col spec → Value

all binop Op → Value → Tuple list → Value

count all Value

set func all Op → Value → Value

binop Op → Value × Value → Value

monop Op → Value → Value

current time Value

clearance Value

user Value

denote col name
Op → Col name

denote table spec
Col → Table spec

denote col spec
Col → Col spec

correlate from
Op → Table spec → From spec

from Table spec → From spec

set class and value
Col name → Value → Value → Set clause

set class Col name → Value → Set clause

set value Col name → Value → Set clause

evaluate Select list

→ From spec LIST

→ Value

→ Col spec LIST

→ Value

→ Tuple list

distinct tuples
Select list

→ From spec LIST

→ Value

→ Col spec LIST

→ Value

→ Tuple list

all tuples Select list

→ From spec LIST

→ Value

→ Col spec LIST

→ Value

→ Tuple list

union Insert list → Insert list → Insert list

tuple Classified value LIST → Insert list

insert tuples
Tuple list → Insert list

classify default
Value → Classified value

classify Value → Value → Classified value
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select values
Value LIST → Select list

all columns Select list

select Tuple list → Query

update From spec

→ Set clause LIST

→ Value

→ Col spec LIST

→ Value

→ Query

delete From spec → Value → Query

insert Table spec → Col name LIST → Insert list → Query

Col spec Col spec → Col

Table spec Table spec → Col

projectTuples
State → Table spec → Col → Tuple LIST + Errors

$&5 (Op → Update + Errors)
→ (Op → Update + Errors)
→ Op

→ Update + Errors

$&6 (Op → Update + Errors)
→ (Op → Update + Errors) LIST

→ Op

→ Update + Errors

auxapply Col LIST → Tuple LIST → Env LIST → Env LIST

engroup Col spec LIST → Tuple LIST → Env LIST

colsInGroup TableSpec → Worth → Bool LIST

andBools Bool LIST → Bool

colposns TableSpec → Worth → ColSpec + Errors

colspecs TableSpec → Op → ColSpec + Errors

cons TableSpec → Worth → ColCon + Errors

$andb Bool + Errors → Bool → Bool + Errors

checkGroup TableSpec

→ (ColCon → Bool)
→ (TableSpec → Worth → Bool)
→ Bool

dataList Row → Data LIST

checkUniqueness
TableSpec → Worth → Bool

test Class LIST LIST → Bool

checkUniform TableSpec → Worth → Bool

seqErr Worth → ′x + Errors → ′x LIST + Errors

checkIntegrity
TableSpec → (TableSpec → Worth → Bool + Errors) → Bool

inRange Class LIST → ColSpec LIST → Bool

elem Worth → ′a LIST → ′a

checkFieldClasses
TableSpec → Worth → Bool + Errors
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classType Type

intervalType Type

timeType Type

floatingType Type

integerType Type

charsType Type

booleanType Type

monoleanType Type

rightType Item LIST → ColSpec LIST → Bool

checkType TableSpec → Worth → Bool + Errors

rightNull Item LIST → ColSpec LIST → Bool

checkNulls TableSpec → Worth → Bool + Errors

Col name Col name → Op

From spec From spec → State → Tuple LIST + Errors

From name From spec → Col

Num to Int Worth → Int

check where complete1
Bool + Errors → Bool → Data → Data + Errors

all false Bool LIST → Bool

same Bool LIST → Bool + Errors

Value monop (Value → State → Env → Data + Errors)
→ Value

→ State

→ Env

→ Data + Errors

Value binop (Value → State → Env → Data + Errors)
→ Value

→ State

→ Env

→ Data + Errors

Value set func all
(Value → State → Env → Data + Errors)
→ Value

→ State

→ Env

→ Data + Errors

Value all binop
(Tuple list → State → Env → Bool + Errors)
→ (Tuple list → State → Env → Select + Errors)
→ (Value → State → Env → Data + Errors)
→ Value

→ State

→ Env

→ Data + Errors

Value classification
Value → State → Env → Data + Errors

Valuep (Tuple list → State → Env → Bool + Errors)
→ (Tuple list → State → Env → Select + Errors)
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→ Value

→ State

→ Env

→ Data + Errors

Tuple list completep
(Value → State → Env → Data + Errors)
→ Tuple list

→ State

→ Env

→ Bool + Errors

Tuple list all tuples
(Value → State → Env → Data + Errors)
→ (Select list

→ State

→ Env

→ Col LIST

→ Data LIST + Errors)
→ Tuple list

→ State

→ Env

→ Select + Errors

Tuple list evaluate
(Value → State → Env → Data + Errors)
→ (Select list

→ State

→ Env

→ Col LIST

→ Data LIST + Errors)
→ Tuple list

→ State

→ Env

→ Select + Errors

Tuple listp (Value → State → Env → Data + Errors)
→ (Select list

→ State

→ Env

→ Col LIST

→ Data LIST + Errors)
→ Tuple list

→ State

→ Env

→ Select + Errors

Select listp
(Value → State → Env → Data + Errors)
→ Select list

→ State

→ Env

→ Col LIST
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→ Data LIST + Errors

Select list Select list

→ State

→ Env

→ Col LIST

→ Data LIST + Errors

Tuple list Tuple list → State → Env → Select + Errors

Tuple list complete
Tuple list → State → Env → Bool + Errors

Value Value → State → Env → Data + Errors

Set clause Set clause → State → Env → Op → Update + Errors

Classified value
Classified value → State → Env → Data + Errors

Insert list Insert list → State → Select + Errors

processIntegrity
TableSpec → Errors

processInsert
Class

→ Table spec

→ Col name LIST

→ Insert list

→ State

→ Effect + Errors

processDelete
From spec → Value → State → Effect + Errors

convert (Worth → Update + Errors) → (Worth ↔ Update) + Errors

updateRowList
Row LIST → Worth ↔ Worth ↔ Update → Row LIST

processUpdate
From spec

→ Set clause LIST

→ Value

→ Col spec LIST

→ Value

→ State

→ Effect + Errors

processSelect
Tuple list → State → Effect × Errors

nullUpdate Effect

processQuery
Query × Class × State → Effect × Errors

18.4 Aliases

true T : Bool
false F : Bool
maybe One : Maybe

∗ $∗1
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: (′b → ′a + Errors)
→ (′a → ′c + Errors)
→ ′b

→ ′c + Errors

∗ $∗2 : ′a + Errors → (′a → ′b + Errors) → ′b + Errors

∗ $∗3
: ′a + Errors

→ (′a → ′b → ′c + Errors)
→ ′b

→ ′c + Errors

∗ $∗4
: (′b → ′a + Errors) → (′a → ′c) → ′b → ′c + Errors

∗ $∗6
: ′a + Errors × ′b + Errors

→ (′a → ′b → ′c)
→ ′c + Errors

& $&1 : ′a + Errors → ′a + Errors → ′a LIST + Errors

& $&2

: ′a + Errors → ′a LIST + Errors → ′a LIST + Errors

& $&3

: ′a LIST + Errors → ′a + Errors → ′a LIST + Errors

& $&4

: ′a LIST + Errors

→ ′a LIST + Errors

→ ′a LIST + Errors

∗∗ $starstar1 : Tuple → Tuple → Tuple

∗∗ $starstar2 : Tuple → Tuple LIST → Tuple LIST

& $&5

: (Op → Update + Errors)
→ (Op → Update + Errors)
→ Op

→ Update + Errors

& $&6

: (Op → Update + Errors)
→ (Op → Update + Errors) LIST

→ Op

→ Update + Errors

18.5 Types

GroupedResult
Env
Value
Col spec
Table spec
Col name
From spec
Set clause
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Tuple list
Insert list
Classified value
Select list
Query

18.6 Type Abbreviations

Col Col

Tuple Tuple

Maybe Maybe

MaybeResult MaybeResult

Op Op

18.7 Fixity

Right Infix 40 :
andb

Right Infix 150 :
dominates wstarstar2 & &4

list ∪ star1 &1 &5

lub w star2 &2 &6

starstar1 star3 &3 ∗∗
Right Infix 300 :

intPlus ∗2 ∗4 ∗6
∗1 ∗3 ∗5 ∗7

18.8 Definitions

destValuedItem
destNullItem ⊢ ConstSpec

(λ (destValuedItem ′, destNullItem ′)
• ∀ v n

• destValuedItem ′ (ValuedItemItem v) = v

∧ destNullItem ′ (NullItemItem n) = n)
(destValuedItem, destNullItem)

isValuedItem
isNullItem ⊢ ∀ i

• (isValuedItem i ⇔ (∃ v• i = ValuedItemItem v))
∧ (isNullItem i ⇔ (∃ n• i = NullItemItem n))

destBoolVal
destStringVal
destIntVal
destFloatVal
destTimeVal
destIntervalVal
destCodeVal
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destClassVal ⊢ ConstSpec

(λ
(destBoolVal ′, destStringVal ′, destIntVal ′,

destFloatVal ′, destTimeVal ′,
destIntervalVal ′, destCodeVal ′,
destClassVal ′)

• ∀ b s i f t int c cl

• (destBoolVal ′ (BoolVal b) ⇔ b)
∧ destStringVal ′ (StringVal s) = s

∧ destIntVal ′ (IntVal i) = i

∧ destFloatVal ′ (FloatVal f ) = f

∧ destTimeVal ′ (TimeVal t) = t

∧ destIntervalVal ′ (IntervalVal int) = int

∧ destCodeVal ′ (CodeVal c) = c

∧ destClassVal ′ (ClassVal cl) = cl)
(destBoolVal , destStringVal , destIntVal ,

destFloatVal , destTimeVal , destIntervalVal ,
destCodeVal , destClassVal)

isBoolVal
isStringVal
isIntVal
isFloatVal
isTimeVal
isIntervalVal
isCodeVal
isClassVal ⊢ ∀ v

• (isBoolVal v ⇔ (∃ b• v = BoolVal b))
∧ (isStringVal v ⇔ (∃ s• v = StringVal s))
∧ (isIntVal v ⇔ (∃ i• v = IntVal i))
∧ (isFloatVal v ⇔ (∃ f • v = FloatVal f ))
∧ (isTimeVal v ⇔ (∃ t• v = TimeVal t))
∧ (isIntervalVal v
⇔ (∃ int• v = IntervalVal int))

∧ (isCodeVal v ⇔ (∃ c• v = CodeVal c))
∧ (isClassVal v ⇔ (∃ cl• v = ClassVal cl))

GroupedResult
⊢ ∃ f • TypeDefn (λ x• true) f

MkGroupedResult
G res
G group ⊢ ∀ t x1 x2

• G res (MkGroupedResult x1 x2 ) = x1

∧ G group (MkGroupedResult x1 x2 ) = x2

∧ MkGroupedResult (G res t) (G group t) = t

Env ⊢ ∃ f • TypeDefn (λ x• true) f

MkEnv
E row
E group ⊢ ∀ t x1 x2

• E row (MkEnv x1 x2 ) = x1
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∧ E group (MkEnv x1 x2 ) = x2

∧ MkEnv (E row t) (E group t) = t

userName
userDirectory
userClearance
timeNow ⊢ true

lubl ⊢ ∀ cl• lubl cl = Fold $lub cl lattice bottom

glbl ⊢ ∀ cl• glbl cl = Fold $glb cl lattice top

lub wl
lub w
dominates w ⊢ true

Not
And
Or
Plus
Equal ⊢ Not = ”Not”

∧ And = ”And”
∧ Or = ”Or”
∧ Plus = ”Plus”
∧ Equal = ”Equal”

newData ⊢ ∀ c w v

• newData c w v

= MkData c (ValuedItemItem (MkValuedItem w v))
lub data ⊢ ∀ dl

• lub data dl

= userClearance lub lubl (Map Dat class dl)
lub wdata ⊢ ∀ dl

• lub wdata dl

= lub wl

(Map (VI worth o destValuedItem o Dat item) dl)
ExceptionData

⊢ ∀ dl

• ExceptionData dl

= newData (lub data dl) worthless ExceptionVal

NullData ⊢ ∀ dl

• NullData dl

= MkData (lub data dl) (NullItemItem maybe)
applyNot ⊢ ∀ dl

• applyNot dl

= (if ¬ # dl = 1

then ExceptionData dl

else if isNullItem (Dat item (Head dl))
then Head dl

else

(let v

= VI val

(destValuedItem (Dat item (Head dl)))
in if isBoolVal v
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then

newData

(lub data dl)
(lub wdata dl)
(BoolVal (¬ destBoolVal v))

else ExceptionData dl))
applyAnd ⊢ ∀ dl

• applyAnd dl

= (if ¬ # dl = 2

then ExceptionData dl

else

(let d1 = Head dl and d2 = Head (Tail dl)
in if isValuedItem (Dat item d1 )
then

let v1
= VI val

(destValuedItem (Dat item d1 ))
in if isValuedItem (Dat item d2 )
then

let v2
= VI val

(destValuedItem
(Dat item d2 ))

in if isBoolVal v1 ∧ isBoolVal v2
then

newData

(lub data dl)
(lub wdata dl)
(BoolVal

(destBoolVal v1
∧ destBoolVal v2 ))

else if

isBoolVal v1
∧ (destBoolVal v1 ⇔ false)

then

newData

(lub data dl)
(lub wdata dl)
(BoolVal false)

else if

isBoolVal v2
∧ (destBoolVal v2 ⇔ false)

then

newData

(lub data dl)
(lub wdata dl)
(BoolVal false)

else ExceptionData dl
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else NullData dl

else NullData dl))
applyOr ⊢ ∀ dl

• applyOr dl

= (if ¬ # dl = 2

then ExceptionData dl

else

(let d1 = Head dl and d2 = Head (Tail dl)
in if isValuedItem (Dat item d1 )
then

let v1
= VI val

(destValuedItem (Dat item d1 ))
in if isValuedItem (Dat item d2 )
then

let v2
= VI val

(destValuedItem
(Dat item d2 ))

in if isBoolVal v1 ∧ isBoolVal v2
then

newData

(lub data dl)
(lub wdata dl)
(BoolVal

(destBoolVal v1
∨ destBoolVal v2 ))

else if

isBoolVal v1
∧ (destBoolVal v1 ⇔ true)

then

newData

(lub data dl)
(lub wdata dl)
(BoolVal true)

else if

isBoolVal v2
∧ (destBoolVal v2 ⇔ true)

then

newData

(lub data dl)
(lub wdata dl)
(BoolVal true)

else ExceptionData dl

else NullData dl

else NullData dl))
intPlus ⊢ true

applyPlus ⊢ ∀ dl
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• applyPlus dl

= (if ¬ # dl = 2

then ExceptionData dl

else

(let d1 = Head dl and d2 = Head (Tail dl)
in if

isNullItem (Dat item d1 )
∨ isNullItem (Dat item d2 )

then NullData dl

else

(let v1
= VI val

(destValuedItem (Dat item d1 ))
and v2

= VI val

(destValuedItem (Dat item d2 ))
in if isIntVal v1 ∧ isIntVal v2
then

newData

(lub data dl)
(lub wdata dl)
(IntVal

(destIntVal v1
intPlus destIntVal v2 ))

else ExceptionData dl)))
applyEqual ⊢ ∀ dl

• applyEqual dl

= (if ¬ # dl = 2

then ExceptionData dl

else

(let d1 = Head dl and d2 = Head (Tail dl)
in if

isNullItem (Dat item d1 )
∨ isNullItem (Dat item d2 )

then NullData dl

else

(let v1
= VI val

(destValuedItem (Dat item d1 ))
and v2

= VI val

(destValuedItem (Dat item d2 ))
in newData

(lub data dl)
(lub wdata dl)
(BoolVal (v1 = v2 )))))

apply ⊢ ConstSpec

(λ apply ′
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• ∀ dl

• apply ′ Not dl = applyNot dl

∧ apply ′ And dl = applyAnd dl

∧ apply ′ Or dl = applyOr dl

∧ apply ′ Plus dl = applyPlus dl

∧ apply ′ Equal dl = applyEqual dl)
apply

∗1 ⊢ ∀ f g x

• (f ∗ g) x

= (if isVal (f x )
then g (destVal (f x ))
else giveError (destError (f x )))

∗2 ⊢ ∀ x f

• x ∗ f

= (if isVal x

then f (destVal x )
else giveError (destError x ))

∗3 ⊢ ∀ x f y

• (x ∗ f ) y

= (if isVal x

then f (destVal x ) y

else giveError (destError x ))
∗4 ⊢ ∀ f g x

• (f ∗ g) x

= (if isVal (f x )
then giveVal (g (destVal (f x )))
else giveError (destError (f x )))

∗5 ⊢ ∀ x f

• x ∗5 f

= (if isVal x

then giveVal (f (destVal x ))
else giveError (destError x ))

∗6 ⊢ ∀ f x y

• (x , y) ∗ f

= (if isVal x

then

if isVal y

then giveVal (f (destVal x ) (destVal y))
else giveError (destError y)

else if isVal y

then giveError (destError x )
else giveError (destError x @ destError y))

∗7 ⊢ ∀ f x

• x ∗7 f

= (if isVal f

then giveVal (destVal f x )
else giveError (destError f ))

list ∪ ⊢ ConstSpec
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(λ $”list ∪′”
• ∀ l1
• $”list ∪′” l1 [] = l1

∧ (∀ l2 x

• $”list ∪′” l1 (l2 @ [x ])
= (if x ∈ Elems l1
then $”list ∪′” l1 l2
else $”list ∪′” l1 l2 @ [x ])))

$list ∪
&1 ⊢ ∀ x 1 x 2

• (x 1 & x 2 )
= (if isVal x 1

then

if isVal x 2

then giveVal ([destVal x 1 ] @ [destVal x 2 ])
else giveError (destError x 2 )

else if isVal x 2

then giveError (destError x 1 )
else giveError (destError x 1 @ destError x 2 ))

&2 ⊢ ∀ x xl

• (x & xl)
= (if isVal x

then

if isVal xl

then giveVal (Cons (destVal x ) (destVal xl))
else giveError (destError xl)

else if isVal xl

then giveError (destError x )
else giveError (destError x @ destError xl))

&3 ⊢ ∀ xl x

• (xl & x )
= (if isVal x

then

if isVal xl

then giveVal (destVal xl @ [destVal x ])
else giveError (destError xl)

else if isVal xl

then giveError (destError x )
else giveError (destError xl @ destError x ))

&4 ⊢ ∀ xl1 xl2
• (xl1 & xl2 )

= (if isVal xl1
then

if isVal xl2
then giveVal (destVal xl1 @ destVal xl2 )
else giveError (destError xl2 )

else if isVal xl2
then giveError (destError xl1 )
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else

giveError (destError xl1 @ destError xl2 ))
seq ⊢ ConstSpec

(λ seq ′

• ∀ n x

• seq ′ n x

= (if n = 0

then []
else Cons x (seq ′ (n − 1 ) x )))

seq

enseq ⊢ ∀ f

• enseq f

= RelList

{(i , j )
|1 ≤ i

∧ (∀ k• 1 ≤ k ∧ k ≤ i ⇒ isVal (f k))
∧ j = destVal (f i)}

promote ⊢ ConstSpec

(λ promote ′

• ∀ f s

• promote ′ f s

= (if s = []
then giveVal []
else f (Head s) & promote ′ f (Tail s)))

promote

find ⊢ ConstSpec

(λ find ′

• ∀ s e

• find ′ s e

= (if s = []
then giveError (seq 1 error)
else if Head s = e

then giveVal 1

else if isVal (find ′ (Tail s) e)
then

giveVal

(1 + destVal (find ′ (Tail s) e))
else find ′ (Tail s) e))

find

distinct ⊢ ConstSpec

(λ distinct ′

• distinct ′ [] = []
∧ (∀ x l

• distinct ′ (l @ [x ])
= (if x ∈ Elems l

then distinct ′ l

else distinct ′ l @ [x ])))
distinct
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noErrors ⊢ noErrors = []
one col ⊢ one col

= promote

(λ ds

• if # ds = 1

then giveVal (Head ds)
else giveError (seq 1 tooWide))

one result ⊢ ∀ ds

• one result ds

= (if # ds = 1

then giveVal (Head ds)
else giveError (seq 1 tooTall))

make data ⊢ ∀ v• make data v = newData userClearance worthless v

fillTab ⊢ ∀ i

• fillTab i

= (if # i = 1 then userDirectory @ i else i)
fillCol ⊢ ∀ i

• fillCol i

= (if # i = 2 then userDirectory @ i else i)
getDir ⊢ ∀ st tab

• getDir st tab

= (if tab ∈ Dom (repState st)
then giveVal (repState st @ tab)
else giveError (seq 1 noSuchDirectory))

getTab ⊢ ∀ dir i

• getTab dir i

= (if i ∈ Dom (Dir tables dir)
then giveVal (Dir tables dir @ i)
else giveError (seq 1 noSuchTable))

getColPosn ⊢ ∀ ts i

• getColPosn ts i

= (if
i

∈ {name

|∃ c• c ∈ TS colspecs ts ∧ CS ide c = name}
then

giveVal

(ǫ n

• ∃ c

• c ∈ TS colspecs ts

∧ CS ide c = i

∧ CS posn c = n)
else giveError (seq 1 noSuchColumn))

getData ⊢ ∀ r n

• getData r n

= (if n ∈ Dom (R data r)
then giveVal (R data r @ n)
else giveError (seq 1 noSuchColumn))
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lookup ⊢ ∀ st tab

• lookup st tab

= (let dir = getDir st (Front tab)
in if isVal dir

then getTab (destVal dir) (Last tab)
else giveError (destError dir))

isCleared ⊢ ∀ d

• isCleared d ⇔ userClearance dominates Dat class d

isNotCleared ⊢ ∀ d• isNotCleared d ⇔ ¬ isCleared d

checkComplete
⊢ (checkComplete [] ⇔ true)

∧ (∀ d tl

• checkComplete (Cons d tl)
⇔ (if isNotCleared d

then false

else checkComplete tl))
check where complete

⊢ ∀ comp b d

• check where complete comp b d

= (if comp

then giveVal d

else if isNotCleared d

then giveError (seq 1 notCleared)
else if isNullItem (Dat item d)
then giveVal d

else

(let v = VI val (destValuedItem (Dat item d))
in if isBoolVal v

then

if destBoolVal v ⇔ b

then giveError (seq 1 notCleared)
else giveVal d

else giveError (seq 1 wrongType)))
resultBool ⊢ ∀ d

• resultBool d

= (if isNotCleared d

then giveVal false

else if isNullItem (Dat item d)
then giveVal false

else

(let v = VI val (destValuedItem (Dat item d))
in if isBoolVal v

then giveVal (destBoolVal v)
else giveError (seq 1 wrongType)))

take data ⊢ ∀ d

• take data d

= (if isCleared d

then giveVal d
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else giveError (seq 1 notCleared))
resultClass ⊢ ∀ d

• resultClass d

= (let vi i

= (if isValuedItem i

then giveVal (destValuedItem i)
else giveError (seq 1 nullValue))

and valClass v

= (if isClassVal v

then giveVal (destClassVal v)
else giveError (seq 1 wrongType))

in ((take data d ∗5 Dat item) ∗ vi ∗5 VI val)
∗ valClass)

extract ⊢ ConstSpec

(λ extract ′

• ∀ bs s

• extract ′ bs s

= (if bs = []
then s

else if s = []
then s

else if Head bs ⇔ true

then

Cons

(Head s)
(extract ′ (Tail bs) (Tail s))

else extract ′ (Tail bs) (Tail s)))
extract

emptyTuple ⊢ ∀ c• emptyTuple c = giveError (seq 1 noSuchColumn)
emptyEnv ⊢ emptyEnv = MkEnv emptyTuple (seq 1 emptyTuple)
star1 ⊢ ∀ a b c

• (a star1 b) c

= (if a c = giveError (seq 1 noSuchColumn)
then b c

else if b c = giveError (seq 1 noSuchColumn)
then a c

else if isVal (a c) ∧ isVal (b c)
then giveError (seq 1 ambiguousColumn)
else if isError (a c) ∧ isError (b c)
then

giveError

(destError (a c) list ∪ destError (b c))
else if isError (a c)
then a c

else b c)
star2 ⊢ ConstSpec

(λ star2 ′

• ∀ a b
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• star2 ′ a b

= (if b = []
then []
else

Cons

(a star1 Head b)
(star2 ′ a (Tail b))))

$star2
star3 ⊢ ConstSpec

(λ star3 ′

• ∀ a b

• star3 ′ a b

= (if a = []
then []
else

(Head a star2 b) @ star3 ′ (Tail a) b))
$star3

jay ⊢ ConstSpec

(λ jay ′

• ∀ t s

• jay ′ t s

= (if s = []
then t

else jay ′ (t star3 Head s) (Tail s)))
jay

join ⊢ join = jay []
starstar1 ⊢ ∀ a b c

• (a ∗∗ b) c

= (if b c = giveError (seq 1 noSuchColumn)
then a c

else b c)
starstar2 ⊢ ConstSpec

(λ starstar2 ′

• ∀ a b

• starstar2 ′ a b

= (if b = []
then []
else

Cons

(a ∗∗ Head b)
(starstar2 ′ a (Tail b))))

$∗∗
insert
delete
update
select
all columns
select values
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classify
classify default
insert tuples
tuple
union
all tuples
distinct tuples
evaluate
set value
set class
set class and value
from
correlate from
denote col spec
denote table spec
denote col name
user
clearance
current time
monop
binop
set func all
count all
all binop
contents
classification
denote null
denote void
denote true
denote false
denote integer
denote string
denote float
denote time
denote interval
denote class
denote code ⊢ true

Col spec ⊢ ConstSpec

(λ Col spec′

• ∀ il

• Col spec′ (denote col spec il) = fillCol il)
Col spec

Table spec ⊢ ConstSpec

(λ Table spec′

• ∀ il

• Table spec′ (denote table spec il)
= fillTab il)

Table spec
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projectTuples
⊢ ∀ st ts cn

• projectTuples st ts cn

= (let table = Table spec ts

in let spec = lookup st table

in if isError spec

then giveError (destError spec)
else

(let coln c

= (if Front c = table

then

getColPosn

(destVal spec)
(Last c)

else if Front c = cn

then

getColPosn

(destVal spec)
(Last c)

else

giveError (seq 1 noSuchColumn))
in let entuple r

= giveVal (λ c• coln c ∗ getData r)
in promote

entuple

(TS rows (destVal spec))))
&5 ⊢ ∀ f g c

• (f & g) c

= (if
isError (f c) ∧ destError (f c) = seq 1 error

∨ isError (g c)
∧ destError (g c) = seq 1 error

then f c

else if

isClass (destVal (f c))
∧ isItem (destVal (g c))

then

giveVal

(DataUpdate

(MkData

(destClass (destVal (f c)))
(destItem (destVal (g c)))))

else if

isClass (destVal (g c))
∧ isItem (destVal (f c))

then

giveVal

(DataUpdate
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(MkData

(destClass (destVal (g c)))
(destItem (destVal (f c)))))

else giveError (seq 1 ambiguousUpdate))
&6 ⊢ ConstSpec

(λ &′
6

• ∀ f s

• &′
6 f s

= (if s = []
then f

else &′
6 (f & Head s) (Tail s)))

$&
auxapply ⊢ ConstSpec

(λ auxapply ′

• ∀ cs ts es

• auxapply ′ cs ts es

= (let add cs t e

= (if
promote t cs

= promote (E row e) cs

then

MkEnv (E row e) (E group e @ [t ])
else e)

in let adds cs t = Map (add cs t)
in if ts = []
then es

else

auxapply ′

cs

(Tail ts)
(adds cs (Head ts) es)))

auxapply

engroup ⊢ ∀ g ts

• engroup g ts

= auxapply

(Map (λ c• Col spec c) g)
ts

(Map (λ t• MkEnv t []) ts)
colsInGroup ⊢ true

andBools ⊢ ConstSpec

(λ andBools ′

• ∀ bs

• andBools ′ bs

⇔ (if # bs = 0

then true

else Head bs ∧ andBools ′ (Tail bs)))
andBools

colposns ⊢ ∀ t n
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• colposns t n

= (if ∃1 c• c ∈ TS colspecs t ∧ CS posn c = n

then

giveVal

(ǫ c• c ∈ TS colspecs t ∧ CS posn c = n)
else giveError (seq 1 noSuchColumn))

colspecs ⊢ ∀ t i

• colspecs t i

= (if ∃1 c• c ∈ TS colspecs t ∧ CS ide c = i

then

giveVal

(ǫ c• c ∈ TS colspecs t ∧ CS ide c = i)
else giveError (seq 1 noSuchColumn))

cons ⊢ ∀ t n

• cons t n

= (if ∃1 cc• (n, cc) ∈ TS cons t

then giveVal (TS cons t @ n)
else giveError (seq 1 error))

andb ⊢ ∀ be b

• (be andb b)
= (if isVal be

then giveVal (destVal be ∧ b)
else giveError (destError be))

checkGroup ⊢ ∀ ts cond check

• checkGroup ts cond check

⇔ andBools

(enseq
(λ n• cons ts n ∗5 cond andb check ts n))

dataList ⊢ ∀ r• dataList r = RelList (Squash (R data r))
checkUniqueness

⊢ ∀ ts n

• checkUniqueness ts n

⇔ (let key

= (let ii

= dataList
o
9 extract (colsInGroup ts n)
o
9 Map Dat item in TS rows o

9 Map ii)
in key ts = distinct (key ts))

test ⊢ ConstSpec

(λ test ′

• ∀ css

• test ′ css

⇔ (if # css = 0

then true

else if # (distinct (Head css)) = 1

then test ′ (Tail css)
else false))

test

Page 87 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

checkUniform ⊢ ∀ ts n

• checkUniform ts n

⇔ (let classes

= (let cc

= dataList
o
9 extract (colsInGroup ts n)
o
9 Map Dat class

in TS rows o
9 Map cc)

in test (classes ts))
seqErr ⊢ ∀ n xe

• seqErr n xe

= (if isVal xe

then giveVal (seq n (destVal xe))
else giveError (destError xe))

checkIntegrity
⊢ ∀ ts check

• checkIntegrity ts check

⇔ andBools (enseq (λ n• check ts n))
inRange ⊢ ConstSpec

(λ inRange ′

• ∀ cs css

• inRange ′ cs css

⇔ (let inRan cl c

⇔ cl dominates CS min c

∧ CS max c dominates cl

in if # cs = 0 ∨ # css = 0

then true

else

inRan (Head cs) (Head css)
∧ inRange ′ (Tail cs) (Tail css)))

inRange

elem ⊢ ∀ n xl• elem n xl = Nth xl n

checkFieldClasses
⊢ ∀ ts n

• checkFieldClasses ts n

= (let classes

= (TS rows
o
9 Map (dataList o

9 elem n o
9 Dat class))

ts

and cs = colposns ts n

in seqErr n cs ∗5 inRange classes)
monoleanType
booleanType
charsType
integerType
floatingType
timeType
intervalType
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classType ⊢ monoleanType = InL maybe

∧ booleanType = InR (InL maybe)
∧ charsType = InR (InR (InL maybe))
∧ integerType = InR (InR (InR (InL maybe)))
∧ floatingType = InR (InR (InR (InR (InL maybe))))
∧ timeType

= InR (InR (InR (InR (InR (InL maybe)))))
∧ intervalType

= InR (InR (InR (InR (InR (InR (InL maybe))))))
∧ classType

= InR (InR (InR (InR (InR (InR (InR maybe))))))
rightType ⊢ ConstSpec

(λ rightType ′

• ∀ is css

• rightType ′ is css

⇔ (let rightT i cs

⇔ (let right t v

⇔ t = monoleanType

∧ v = VoidVal

∨ t = booleanType

∧ isBoolVal v

∨ t = charsType

∧ isStringVal v

∨ t = integerType

∧ isIntVal v

∨ t = floatingType

∧ isFloatVal v

∨ t = timeType ∧ isTimeVal v

∨ t = intervalType

∧ isIntervalVal v

∨ t = classType

∧ isClassVal v

in if isNullItem i

then true

else

(let vi = destValuedItem i

in if VI worth vi = sterling

then

right

(CS sterlingType cs)
(VI val vi)

else

right

(CS dinaryType cs)
(VI val vi)))

in if # is = 0 ∨ # css = 0

then true

else
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rightT (Head is) (Head css)
∧ rightType ′ (Tail is) (Tail css)))

rightType

checkType ⊢ ∀ ts n

• checkType ts n

= (let itemList

= (TS rows
o
9 Map (dataList o

9 elem n o
9 Dat item))

ts

and cs = colposns ts n

in seqErr n cs ∗5 rightType itemList)
rightNull ⊢ ConstSpec

(λ rightNull ′

• ∀ is css

• rightNull ′ is css

⇔ (let rightN i cs

⇔ isNullItem i ∧ CS nullType cs

in if # is = 0 ∨ # css = 0

then true

else

rightN (Head is) (Head css)
∧ rightNull ′ (Tail is) (Tail css)))

rightNull

checkNulls ⊢ ∀ ts n

• checkNulls ts n

= (let itemList

= (TS rows
o
9 Map (dataList o

9 elem n o
9 Dat item))

ts

and cs = colposns ts n

in seqErr n cs ∗5 rightNull itemList)
Col name ⊢ ConstSpec

(λ Col name ′

• ∀ i• Col name ′ (denote col name i) = i)
Col name

From spec ⊢ ConstSpec

(λ From spec′

• ∀ t cn st

• From spec′ (from t) st

= projectTuples st t []
∧ From spec′ (correlate from cn t) st

= projectTuples st t (seq 1 cn))
From spec

From name ⊢ ConstSpec

(λ From name ′

• ∀ t cn

• From name ′ (from t) = Table spec t

∧ From name ′ (correlate from cn t)
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= Table spec t)
From name

Num to Int ⊢ true

check where complete1
⊢ ∀ be b d

• check where complete1 be b d

= (if isVal be

then check where complete (destVal be) b d

else giveError (destError be))
all false ⊢ ConstSpec

(λ all false ′

• ∀ bs

• all false ′ bs

⇔ (if # bs = 0

then true

else if Head bs ⇔ true

then false

else all false ′ (Tail bs)))
all false

same ⊢ ConstSpec

(λ same ′

• ∀ bs

• same ′ bs

= (if # bs = 0

then giveVal true

else if # bs = 1

then giveVal (Head bs)
else if

Head bs ⇔ destVal (same ′ (Tail bs))
then giveVal (Head bs)
else giveError (seq 1 ambiguousHaving)))

same

Value monop ⊢ ConstSpec

(λ Value monop ′

• ∀ value st e op v

• Value monop ′ value (monop op v) st e

= (let v ′ = value v st e

in if isVal v ′

then

giveVal (apply op (seq 1 (destVal v ′)))
else giveError (destError v ′)))

Value monop

Value binop ⊢ ConstSpec

(λ Value binop ′

• ∀ value st e op v1 v2
• Value binop ′ value (binop op (v1 , v2 )) st e

= (let v ′1 = value v1 st e

and v ′2 = value v2 st e
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in if isVal v ′1
then

if isVal v ′2
then

giveVal

(apply
op

[destVal v ′1 ; destVal v
′
2 ])

else giveError (destError v ′2 )
else if isVal v ′2
then giveError (destError v ′1 )
else

giveError

(destError v ′1 @ destError v ′2 )))
Value binop

Value set func all
⊢ ConstSpec

(λ Value set func all ′

• ∀ value st e op v

• Value set func all ′

value

(set func all op v)
st

e

= (let all res

= promote

(λ t

• value

v

st

(MkEnv t (E group e)))
(E group e)

in if isVal all res

then giveVal (apply op (destVal all res))
else giveError (destError all res)))

Value set func all

Value all binop
⊢ ConstSpec

(λ Value all binop ′

• ∀ t l c t l value st e op v tl

• Value all binop ′

t l c

t l

value

(all binop op v tl)
st

e

= (let tlc = t l c tl st e
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and calc

= (let ans = value v st e

in promote

(λ d

• if isVal ans

then

giveVal

(apply
op

([destVal ans]
@ [d ]))

else

giveError (destError ans)))
in (((t l tl st e ∗ one col) ∗ calc

∗5 apply And)
∗ take data)

∗ check where complete1 tlc true))
Value all binop

Value classification
⊢ ConstSpec

(λ Value classification ′

• ∀ st e cs

• Value classification ′

(classification cs)
st

e

= (let ce

= E row e (Col spec cs) ∗5 Dat class

in if isVal ce

then

giveVal

(make data (ClassVal (destVal ce)))
else giveError (destError ce)))

Value classification

Valuep ⊢ ConstSpec

(λ Value ′p
• ∀ t l c t l st e i s r m int cl c op v v1 v2

tl cs

• Value ′p t l c t l denote null st e

= giveVal

(MkData

userClearance

(NullItemItem maybe))
∧ Value ′p t l c t l denote void st e

= giveVal (make data VoidVal)
∧ Value ′p t l c t l denote true st e

= giveVal (make data (BoolVal true))
∧ Value ′p t l c t l denote false st e
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= giveVal (make data (BoolVal false))
∧ Value ′p

t l c

t l

(denote integer i)
st

e

= giveVal (make data (IntVal i))
∧ Value ′p t l c t l (denote string s) st e

= giveVal (make data (StringVal s))
∧ Value ′p t l c t l (denote float r) st e

= giveVal (make data (FloatVal r))
∧ Value ′p t l c t l (denote time m) st e

= giveVal (make data (TimeVal m))
∧ Value ′p

t l c

t l

(denote interval int)
st

e

= giveVal (make data (IntervalVal int))
∧ Value ′p t l c t l (denote class cl) st e

= giveVal (make data (ClassVal cl))
∧ Value ′p t l c t l (denote code c) st e

= giveVal (make data (CodeVal c))
∧ Value ′p t l c t l (monop op v) st e

= Value monop

(Value ′p t l c t l)

(monop op v)
st

e

∧ Value ′p
t l c

t l

(binop op (v1 , v2 ))
st

e

= Value binop

(Value ′p t l c t l)

(binop op (v1 , v2 ))
st

e

∧ Value ′p
t l c

t l

(set func all op v)
st
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e

= Value set func all

(Value ′p t l c t l)

(set func all op v)
st

e

∧ Value ′p t l c t l count all st e

= giveVal

(make data

(IntVal
(Num to Int (# (E group e)))))

∧ Value ′p
t l c

t l

(all binop op v tl)
st

e

= Value all binop

t l c

t l

(Value ′p t l c t l)

(all binop op v tl)
st

e

∧ Value ′p t l c t l (contents cs) st e

= E row e (Col spec cs)
∧ Value ′p

t l c

t l

(classification cs)
st

e

= Value classification

(classification cs)
st

e

∧ Value ′p t l c t l user st e

= giveVal

(make data (StringVal userName))
∧ Value ′p t l c t l clearance st e

= giveVal

(make data (ClassVal userClearance))
∧ Value ′p t l c t l current time st e

= giveVal (make data (TimeVal timeNow)))
Valuep

Tuple list completep
⊢ ConstSpec
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(λ Tuple list complete ′p
• ∀ value st e sel from list where group having

• Tuple list complete ′p
value

(all tuples

sel

from list

where

group

having)
st

e

= (let froms

= promote (λ fr• From spec fr st)
∗ join

and ws g

= promote

(λ t

• value where st (MkEnv t g)
∗5 isNotCleared)

g

in froms from list ∗ ws ∗5 all false)
∧ Tuple list complete ′p

value

(distinct tuples

sel

from list

where

group

having)
= Tuple list complete ′p
value

(all tuples

sel

from list

where

group

having)
∧ Tuple list complete ′p

value

(evaluate
sel

from list

where

group

having)
= Tuple list complete ′p
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value

(all tuples

sel

from list

where

group

having))
Tuple list completep

Tuple list all tuples
⊢ ConstSpec

(λ Tuple list all tuples ′

• ∀ value s l st e sel from list where group

having

• Tuple list all tuples ′

value

s l

(all tuples

sel

from list

where

group

having)
st

e

= (let froms

= promote (λ fr• From spec fr st)
∗ join

and selr env

= (let tabs = Map From name from list

in s l sel st env tabs)
and outer e

= Map

(λ ei

• MkEnv

(E row e ∗∗ E row ei)
(E row e ∗∗ E group ei))

and where filter ts

= (let ws g

= (let ev t

= (let elim

= (let eliminate

s

env

h

= promote

((((λ t• value h s (MkEnv t (E group env))) ∗ seq 1 )
∗ applyNot)

∗ resultBool)
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(E group env)
∗ same in eliminate st (MkEnv t g) having)

in if isError elim

then elim

else if

destVal elim ⇔ true

then giveVal false

else

value

where

st

(MkEnv t g)
∗ resultBool)

in promote ev g)
in ts ∗7 ws ts ∗5 extract)

in ((froms from list ∗ where filter

∗5 engroup group)
∗5 outer e)

∗ promote selr))
Tuple list all tuples

Tuple list evaluate
⊢ ConstSpec

(λ Tuple list evaluate ′

• ∀ value s l st e sel from list where group

having

• Tuple list evaluate ′

value

s l

(evaluate
sel

from list

where

group

having)
st

e

= (let froms

= promote (λ fr• From spec fr st)
∗ join

and selg env

= (let tabs = Map From name from list

in if isVal (s l sel st env tabs)
then

giveVal

(MkGroupedResult

(destVal
(s l sel st env tabs))

(E group env))

Page 98 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

else

giveError

(destError
(s l sel st env tabs)))

and outer e

= Map

(λ ei

• MkEnv

(E row e ∗∗ E row ei)
(E row e ∗∗ E group ei))

and ev grs

= (if
distinct (Map G group grs)
= Map G group (distinct grs)

then giveVal (Map G res grs)
else

giveError

(seq 1 ambiguousEvaluate))
and where filter ts

= (let ws g

= promote

(λ t

• value

where

st

(MkEnv t g)
∗ resultBool)

g

in ts ∗7 ws ts ∗5 extract)
in (((froms from list ∗ where filter

∗5 engroup group)
∗5 outer e)

∗ promote selg)
∗ ev))

Tuple list evaluate

Tuple listp ⊢ ConstSpec

(λ Tuple list ′p
• ∀ value s l st e sel from list where group

having

• Tuple list ′p
value

s l

(all tuples

sel

from list

where

group

having)
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st

e

= Tuple list all tuples

value

s l

(all tuples

sel

from list

where

group

having)
st

e

∧ Tuple list ′p
value

s l

(distinct tuples

sel

from list

where

group

having)
st

e

= Tuple list ′p
value

s l

(all tuples

sel

from list

where

group

having)
st

e

∗5 distinct

∧ Tuple list ′p
value

s l

(evaluate
sel

from list

where

group

having)
st

e

= Tuple list evaluate
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value

s l

(evaluate
sel

from list

where

group

having)
st

e)
Tuple listp

Select listp
⊢ ConstSpec

(λ Select list ′p
• ∀ value st e vl ts

• Select list ′p value all columns st e

= (let vals

= denote col spec
o
9 contents
o
9 (λ v• value v st e)

and col t

= enseq

(((lookup st t ∗ colposns)
∗ CS ide)

∗ (λ i• t @ [i ]))
in (Map col o

9 Flat) o
9 promote vals)

∧ Select list ′p
value

(select values vl)
st

e

ts

= promote (λ v• value v st e) vl)
Select listp

Value
Tuple list complete
Tuple list
Select list ⊢ ConstSpec

(λ
(Value ′, Tuple list complete ′, Tuple list ′,

Select list ′)
• Value ′

= Valuep Tuple list complete ′ Tuple list ′

∧ Tuple list complete ′

= Tuple list completep Value ′

∧ Tuple list ′

= Tuple listp Value ′ Select list ′

∧ Select list ′ = Select listp Value ′)
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(Value, Tuple list complete, Tuple list ,
Select list)

Set clause ⊢ ConstSpec

(λ Set clause ′

• ∀ st e col vv vc id

• Set clause ′ (set value col vv) st e id

= (let column = Col name col

and exp = Value vv st e

in if id = column

then exp ∗ take data ∗5 DataUpdate

else giveError (seq 1 error))
∧ Set clause ′ (set class col vc) st e id

= (let column = Col name col

and exp = Value vc st e

in if id = column

then exp ∗ resultClass ∗5 ClassUpdate

else giveError (seq 1 error))
∧ Set clause ′

(set class and value col vv vc)
st

e

id

= (let column = Col name col

and value

= Value vv st e ∗ take data

∗5 Dat item

and clas = Value vc st e ∗ resultClass

in if id = column

then

(clas, value) ∗ MkData ∗5 DataUpdate

else giveError (seq 1 error)))
Set clause

Classified value
⊢ ConstSpec

(λ Classified value ′

• ∀ st e v vc

• Classified value ′ (classify v vc) st e

= (let resv = Value v st e

and resc = Value vc st e

in (resc ∗ resultClass,
resv ∗ take data ∗5 Dat item)

∗ MkData)
∧ Classified value ′

(classify default v)
st

e

= (let combine c d

= MkData c (Dat item d)
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and newDat

= Value v st e

∗ (λ d

• if isCleared d

then giveVal d

else

giveError (seq 1 notCleared))
and newClass = userClearance

in newDat ∗5 combine newClass))
Classified value

Insert list ⊢ ConstSpec

(λ Insert list ′

• ∀ st tl cvl il1 il2
• Insert list ′ (insert tuples tl) st

= (let check d

= (let tlc

= Tuple list complete

tl

st

emptyEnv

in if isVal tlc

then

if destVal tlc ⇔ true

then giveVal d

else

giveError (seq 1 notCleared)
else

giveError (seq 1 notCleared))
in Tuple list tl st emptyEnv

∗ promote (promote take data))
∧ Insert list ′ (tuple cvl) st

= (let d or err

= promote

(λ cv

• Classified value

cv

st

emptyEnv)
cvl

in if isVal d or err

then giveVal (seq 1 (destVal d or err))
else giveError (destError d or err))

∧ Insert list ′ (union il1 il2 ) st

= (Insert list ′ il1 st

& Insert list ′ il2 st))
Insert list

processIntegrity
⊢ ∀ t
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• processIntegrity t

= (if checkGroup t CC uniform checkUniform ⇔ true

then noErrors

else seq 1 nonUniformValues)
@ (if

checkGroup t CC unique checkUniqueness

⇔ true

then noErrors

else seq 1 nonUniqueValues)
@ (if checkIntegrity t checkFieldClasses ⇔ true

then noErrors

else seq 1 fieldClassOutOfRange)
@ (if checkIntegrity t checkType ⇔ true

then noErrors

else seq 1 wrongType)
@ (if checkIntegrity t checkNulls ⇔ true

then noErrors

else seq 1 noNulls)
processInsert

⊢ ∀ c t cns il st

• processInsert c t cns il st

= (let spec = lookup st (Table spec t)
and givenNames = Map Col name cns

in let defaults

= (spec ∗ colposns) ∗ CS default

in let givenNums

= promote

((spec ∗ colspecs) ∗ CS posn)
givenNames

in let colNums

= Map

CS posn

(enseq (spec ∗ colposns))
in let map nums ds n

= (if isVal (find nums n)
then

giveVal

(n,
elem

(destVal
(find nums n))

ds)
else if isVal (defaults n)
then

giveVal

(n, destVal (defaults n))
else

giveError
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(destError (defaults n)))
in let addDefaults ds

= (if # givenNames = 0

then

promote

(map colNums ds)
colNums

else if isVal givenNums

then

promote

(map

(destVal givenNums)
ds)

colNums

else

giveError

(destError givenNums))
in let width ds

= (if # givenNames = 0

then

if # colNums = # ds

then giveVal ds

else

giveError (seq 1 tooWide)
else if # givenNames = # ds

then giveVal ds

else

giveError (seq 1 tooWide))
in let effect

= (if isVal spec

then

if

TS maxRow

(destVal spec)
dominates userClearance

then

giveError

(seq
1

rowClassTooLow)
else

Insert list il st

∗ promote

(width
∗ addDefaults

∗ Elems)
else

giveError

Page 105 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

(destError spec))
in if isError effect

then giveError (destError effect)
else

(let newSpec

= replaceRows

(destVal spec)
(TS rows (destVal spec)

@ Map

(MkRow c)
(destVal effect))

in let integrity

= processIntegrity

newSpec

in if ¬ # integrity = 0

then giveError integrity

else

giveVal

(InsertEffect
(Table spec t ,

destVal

effect))))
processDelete

⊢ ∀ f w st

• processDelete f w st

= (let table = From name f

in let spec = lookup st table

in let ts = From spec f st

in let where

= (if isVal ts

then

promote

(λ t

• Value

w

st

(MkEnv t (destVal ts)))
(destVal ts)

else giveError (destError ts))
in let whereBools

= where ∗ promote resultBool

in let complete

⇔ (if isError where

then true

else

checkComplete

(destVal where))
in let doomed
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= (if isError whereBools

then

giveError

(destError whereBools)
else

giveVal

(Dom

(ListRel
(destVal

whereBools)
⊲ {true})))

in if isError doomed

then giveError (destError doomed)
else if complete

then

giveVal

(DeleteEffect

(From name f ,
destVal doomed))

else

giveError

(seq 1 mayNotBeComplete))
convert ⊢ ∀ f

• convert f

= (if
∃ n

• isError (f n)
∧ ¬ destError (f n) = seq 1 error

then

giveError

(RelList
(Enumerate

(
⋃

{x
|∃ y

• isError (f y)
∧ ¬ destError (f y)

= seq 1 error

∧ x

= Elems

(destError
(f y))})))

else giveVal {(id , upd)|f id = giveVal upd})
updateRowList

⊢ ∀ rl nnu

• updateRowList rl nnu

= (let updateD (u, d)
= (if isItem u

Page 107 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

then MkData (Dat class d) (destItem u)
else if isClass u

then MkData (destClass u) (Dat item d)
else destData u)

in let updateR (nu, r)
= MkRow

(R exist r)
(R data r

⊕ RelCombine nu (R data r)
o
9 Graph updateD)

in RelList

(ListRel rl
⊕ RelCombine nnu (ListRel rl)
o
9 Graph updateR))

processUpdate
⊢ ∀ f ss w g h st

• processUpdate f ss w g h st

= (let table = From name f

in let spec = lookup st table

in let ts = From spec f st

in let whereResults

= (let ev e

= (let elim

= (let eliminate s env h

= promote

((((λ t

• Value

h

s

(MkEnv t (E group env)))
∗ seq 1 )

∗ applyNot)
∗ resultBool)

(E group env)
∗ same

in eliminate st e h)
in if isError elim

then

giveError (destError elim)
else if destVal elim ⇔ true

then

giveVal

(make data

(BoolVal false))
else Value w st e)

in if isVal ts

then

promote
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ev

(engroup g (destVal ts))
else giveError (destError ts))

in let whereBools

= whereResults ∗ promote resultBool

in let complete

⇔ (if isError whereResults

then true

else

checkComplete

(destVal whereResults))
in let sets e

= ((λ c

• giveError (seq 1 error))
& Map

(λ s• Set clause s st e)
ss)

in let getEnv n

= (if isVal ts

then

giveVal

(MkEnv

(Nth
(destVal ts)
n)

(destVal ts))
else

giveError (destError ts))
in let rowUpd n

= convert

(((spec ∗ colposns)
∗ CS ide)

∗ getEnv n

∗ sets)
in let where

= (if isError whereBools

then

giveError

(destError
whereBools)

else

giveVal

(Dom

(ListRel
(destVal

whereBools)
⊲ {true})))

in if isError where
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then

giveError (destError where)
else if complete

then

let us

= {(n, nu)
|n ∈ destVal where

∧ nu = rowUpd n}
in if

∃ pr

• pr ∈ us

∧ isError (Snd pr)
then

giveError

(RelList
(Enumerate

(
⋃

{x |∃ y• y ∈ us ∧ x = Elems (destError (Snd y))})))
else

(let ups

= {(n, nu)
|n

∈ destVal where

∧ nu

= destVal (rowUpd n)}
in let oldRows

= TS rows

(destVal
spec)

in let newSpec

= replaceRows

(destVal spec)
(updateRowList oldRows ups)

in let integrity

= processIntegrity newSpec

in if

¬ # integrity

= 0

then

giveError

integrity

else

giveVal

(UpdateEffect (table, ups)))
else

giveError

(seq 1 mayNotBeComplete))
processSelect
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⊢ ∀ tl st

• processSelect tl st

= (let retrieved = Tuple list tl st emptyEnv

and tlc = Tuple list complete tl st emptyEnv

in if isError retrieved

then (SelectEffect [], destError retrieved)
else if isVal tlc

then

if destVal tlc ⇔ true

then (SelectEffect (destVal retrieved), [])
else

(SelectEffect (destVal retrieved),
seq 1 mayNotBeComplete)

else (SelectEffect [], destError tlc))
nullUpdate ⊢ true

processQuery
⊢ ConstSpec

(λ processQuery ′

• ∀ c st t cns il f w ss g h tl

• processQuery ′ (insert t cns il , c, st)
= (let iorerr

= processInsert c t cns il st

in if isVal iorerr

then (destVal iorerr , [])
else (nullUpdate, destError iorerr))

∧ processQuery ′ (delete f w , c, st)
= (let dorerr = processDelete f w st

in if isVal dorerr

then (destVal dorerr , [])
else (nullUpdate, destError dorerr))

∧ processQuery ′

(update f ss w g h, c, st)
= (let uorerr

= processUpdate f ss w g h st

in if isVal uorerr

then (destVal uorerr , [])
else (nullUpdate, destError uorerr))

∧ processQuery ′ (select tl , c, st)
= processSelect tl st)

processQuery

19 THE THEORY fef015

19.1 Parents

fef013
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19.2 Theorems

updateStateR updateState lemma
⊢ (∀ clear s u

• isState s

⇒ isState (Fst (updateStateR (clear , u, s))))
⇒ (hide, updateState) ∈ secureUpdate

isState insertQuery lemma
⊢ ∀ c i ns s ts

• isState s ∧ tabExists c i s

⇒ isState

(Fst
(insertQuery

(c, (i , ds), s, getTable i s)))
isState deleteQuery lemma

⊢ ∀ c i ns s ts

• isState s ∧ tabExists c i s

⇒ isState

(deleteQuery (c, (i , ns), s, getTable i s))
isState updateRow lemma

⊢ ∀ r c tc u

• r ∈ RowS ∧ isVal (updateRow c tc (u, r))
⇒ destVal (updateRow c tc (u, r)) ∈ RowS

isState updateRows lemma
⊢ ∀ r c t u

• u ∈ Functional

∧ ((RelCombine

(revealRow c t ∼ o
9 u)

(ListRel (TS rows t))
o
9 Graph (updateRow c (TS class t)))

⊲ {x |isError x})
o
9 Graph destError

= {}
∧ (∀ r• r ∈l TS rows t ⇒ r ∈ RowS )

⇒ r

∈l RelList

(ListRel (TS rows t)
⊕ (RelCombine

(revealRow c t ∼ o
9 u)

(ListRel (TS rows t))
o
9 Graph (updateRow c (TS class t)))

o
9 Graph destVal)

⇒ r ∈ RowS

isState updateQuery lemma
⊢ ∀ c i us s ts

• isState s ∧ tabExists c i s

⇒ isState

(Fst
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(updateQuery

(c, (i , us), s, getTable i s)))
updateStateR lemma

⊢ ∀ clear s

• isState s

⇒ isState (Fst (updateStateR (clear , u, s)))
secureSSQL

⊢ behaviours SSQLam ∈ secure

20 THE THEORY fef021

20.1 Parents

fef024

20.2 Children

fef025

20.3 Constants

item sterling
Item → Item

class bottom Data → Data

set bottomd Worth ↔ Data → Worth ↔ Data

set bottomu Worth ↔ Update → Worth ↔ Update

StatetS State P

isStatet State → Bool

absStatet State → Statet
repStatet Statet → State

processQueryt

Process t
updateStatet

Ustatet
MkTf t Process t → Ustatet → tf t
TSQLtf tf t

20.4 Types

Statet

20.5 Type Abbreviations

Processt Process t
Ustatet Ustatet
tf t tf t
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20.6 Definitions

item sterling
⊢ ∀ i

• item sterling i

= (if isNullItem i

then i

else

(let v = destValuedItem i

in ValuedItemItem

(MkValuedItem sterling (VI val v))))
class bottom ⊢ ∀ d

• class bottom d

= (let i = Dat item d

in MkData lattice bottom (item sterling i))
set bottomd ⊢ ∀ nd

• set bottomd nd

= {(n, d)|n ∈ Dom nd ∧ d = class bottom (nd @ n)}
set bottomu ⊢ ∀ nu

• set bottomu nu

= {(n, u)
|n ∈ Dom nu

∧ u

= (let u ′ = nu @ n

in if isItem u ′

then

ItemUpdate

(item sterling (destItem u ′))
else if isClass u ′

then ClassUpdate lattice bottom

else

DataUpdate

(class bottom (destData u ′)))}
StatetS ⊢ StatetS

= {st
|∀ dir

• dir ∈ Ran (repState st)
⇒ Dir exist dir = lattice bottom

∧ Dir class dir = lattice bottom

∧ (∀ tab

• tab ∈ Ran (Dir tables dir)
⇒ TS class tab = lattice bottom

∧ TS maxRow tab = lattice bottom

∧ (∀ col

• col ∈ TS colspecs tab

⇒ CS min col = lattice bottom

∧ CS max col = lattice bottom

∧ (∀ cc
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• cc ∈ Ran (TS cons tab)
⇒ CC exist cc

= lattice bottom

∧ (∀ row

• row

∈ Elems

(TS rows tab)
⇒ R exist row

= lattice bottom

∧ (∀ data

• data

∈ Ran

(R data row)
⇒ Dat class

data

= lattice bottom

∧ isValuedItem

(Dat item data)
⇒ VI worth

(destValuedItem (Dat item data))
= sterling)))))}

isStatet ⊢ ∀ s• isStatet s ⇔ s ∈ StatetS
statet type def

⊢ ∃ f • TypeDefn isStatet f

repStatet
absStatet ⊢ ConstSpec

(λ (repState ′t , absState
′
t)

• (∀ a• absState ′t (repState ′t a) = a)
∧ (∀ r

• isStatet r

⇒ repState ′t (absState ′t r) = r)
∧ (∀ a1 a2

• repState ′t a1 = repState ′t a2

⇔ a1 = a2 )
∧ (∀ r1 r2
• isStatet r1 ∧ isStatet r2

⇒ (absState ′t r1 = absState ′t r2
⇔ r1 = r2 ))

∧ (∀ s• isStatet (repState ′t s)))
(repStatet , absStatet)

processQueryt

⊢ ∀ q s

• processQuery t (q , s)
= (let (ef , es)

= processQuery

(q , lattice bottom, repStatet s)
in let ef ′

= (if isInsert ef
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then

let (t , ndl) = destInsert ef

in InsertEffect

(t , Map set bottomd ndl)
else if isDelete ef

then ef

else if isUpdate ef

then

let (t , nnu) = destUpdate ef

in UpdateEffect

(t ,
{(n, nu)
|n ∈ Dom nnu

∧ nu

= set bottomu

(nnu @ n)})
else

(let dll = destSelect ef

in SelectEffect

(Map (Map class bottom) dll)))
in (ef ′, es))

updateStatet
⊢ ∀ efes s

• updateStatet (efes, s)
= (let (s ′, c, out)

= updateState

(lattice bottom, efes, repStatet s)
in (absStatet s ′, out))

MkTf t ⊢ ∀ p u q s• MkTf t p u (q , s) = u (p (q , s), s)
TSQLtf ⊢ TSQLtf = MkTf t processQuery t updateStatet

20.7 Theorems

repState consistent
absState consistent

⊢ Consistent

(λ (repState ′, absState ′)
• (∀ a• absState ′ (repState ′ a) = a)

∧ (∀ r

• isState r ⇒ repState ′ (absState ′ r) = r)
∧ (∀ a1 a2

• repState ′ a1 = repState ′ a2 ⇔ a1 = a2 )
∧ (∀ r1 r2
• isState r1 ∧ isState r2

⇒ (absState ′ r1 = absState ′ r2
⇔ r1 = r2 ))

∧ (∀ s• isState (repState ′ s)))
repStatet consistent
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absStatet consistent
⊢ Consistent

(λ (repState ′t , absState
′
t)

• (∀ a• absState ′t (repState ′t a) = a)
∧ (∀ r

• isStatet r

⇒ repState ′t (absState ′t r) = r)
∧ (∀ a1 a2

• repState ′t a1 = repState ′t a2

⇔ a1 = a2 )
∧ (∀ r1 r2
• isStatet r1 ∧ isStatet r2

⇒ (absState ′t r1 = absState ′t r2
⇔ r1 = r2 ))

∧ (∀ s• isStatet (repState ′t s)))

21 THE THEORY fef022

21.1 Parents

fef006

21.2 Children

fef024

21.3 Constants

mkTf f (′TSQL QUERY , ′ST ) DBMS TYPE

→ (′TSQL QUERY , ′PARS ) STP TYPE

→ ′PARS FILTER TYPE

→ ′ST TF TYPE

istatef (State → ′ST ) → ′ST

FE SWORD (State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

→ (′TSQL QUERY , ′PARS ) STP TYPE

→ ′PARS FILTER TYPE

→ (Query , ANSWER) BEHAVIOURS

ok to proceed
(′TSQL QUERY , ′ST ) DBMS TYPE

→ (′TSQL QUERY

× ′TSQL QUERY + Maybe

× ′PARS )
+ Errors

→ ′ST

→ Bool

subsys secureA
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(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ (′TSQL QUERY , ′PARS ) STP TYPE

subsys secureB
(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ (′TSQL QUERY , ′PARS ) STP TYPE

subsys secureC
(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ (′TSQL QUERY , ′PARS ) STP TYPE

subsys secureD
(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ (′TSQL QUERY , ′PARS ) STP TYPE

subsys secureE
(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ ((′TSQL QUERY , ′PARS ) STP TYPE

× ′PARS FILTER TYPE )
subsys secure

(State → ′ST )
→ (′TSQL QUERY , ′ST ) DBMS TYPE

↔ ((′TSQL QUERY , ′PARS ) STP TYPE

× ′PARS FILTER TYPE )

21.4 Type Abbreviations

ANSWER ANSWER

(′TSQL QUERY , ′ST ) DBMS TYPE
(′TSQL QUERY , ′ST ) DBMS TYPE

(′TSQL QUERY , ′PARS ) STP TYPE
(′TSQL QUERY , ′PARS ) STP TYPE

′PARS FILTER TYPE
′PARS FILTER TYPE

′ST TF TYPE ′ST TF TYPE

21.5 Definitions

mkTf f ⊢ ∀ dbms stp filter q c st

• mkTf f dbms stp filter ((q , c), st)
= (let res = stp (q , c)
in if isError res

then (st , c, [], destError res)
else

(let (dq , ocq , pars) = destVal res

in let (st ′, cks, errs)
= (if IsL ocq

Page 118 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

then dbms (OutL ocq , st)
else (st , [], []))

in if cks = [] ∧ errs = []
then

let (st ′′, ans2 ) = dbms (dq , st ′)
in (st ′′, c, filter (c, ans2 , pars))

else (st ′, c, [], [notCleared ])))
istatef ⊢ ∀ repr• istate f repr = repr isstate

FE SWORD ⊢ ∀ repr dbms stp filter

• FE SWORD repr dbms stp filter

= behaviours

(mkTf f dbms stp filter , istate f repr)
ok to proceed

⊢ ∀ dbms st stp res

• ok to proceed dbms stp res st

⇔ ¬ isError stp res

∧ (let (dq , ocq , pars) = destVal stp res

in IsL ocq

⇒ (let (cks, errs)
= Snd (dbms (OutL ocq , st))

in errs = [] ∧ cks = []))
subsys secureA

⊢ ∀ repr dbms stp

• (dbms, stp) ∈ subsys secureA repr

⇔ (∀ q c

• (let res = stp (q , c)
in let (dq , ocq , pars) = destVal (stp (q , c))
in let ok s ⇔ ok to proceed dbms res s

in ∀ s

• ∃1 s ′

• ok (repr s)
⇒ repr s ′

= Fst (dbms (dq , repr s))))
subsys secureB

⊢ ∀ repr dbms stp

• (dbms, stp) ∈ subsys secureB repr

⇔ (∀ q c

• (let res = stp (q , c)
in let (dq , ocq , pars) = destVal (stp (q , c))
in ∀ st1
• ¬ isError res ∧ IsL ocq

⇒ (let (st2 , cks, errs)
= dbms (OutL ocq , st1 )

in st2 = st1 ∧ errs = [])))
subsys secureC

⊢ ∀ repr dbms stp

• (dbms, stp) ∈ subsys secureC repr

⇔ (∀ q c
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• (let res = stp (q , c)
in let (dq , ocq , pars) = destVal (stp (q , c))
in let ok s ⇔ ok to proceed dbms res s

in ∀ c′ s ′ s d

• (repr s ′, d) = dbms (dq , repr s)
∧ ¬ hide (c′, s) = hide (c′, s ′)
∧ ¬ c′ dominates c

⇒ ¬ ok (repr s)))
subsys secureD

⊢ ∀ repr dbms stp

• (dbms, stp) ∈ subsys secureD repr

⇔ (∀ q c

• (let res = stp (q , c)
in let (dq , ocq , pars) = destVal (stp (q , c))
in let ok s ⇔ ok to proceed dbms res s

in ∀ c′ s1 s2 s ′1 s ′2 d1 d2

• hide (c, s1 ) = hide (c, s2 )
∧ (repr s ′1 , d1 )
= dbms (dq , repr s1 )

∧ (repr s ′2 , d2 )
= dbms (dq , repr s2 )

∧ c′ dominates c

∧ ¬ hide (c′, s ′1 )
= hide (c′, s ′2 )

⇒ ¬ ok (repr s1 )))
subsys secureE

⊢ ∀ repr dbms stp filter

• (dbms, stp, filter) ∈ subsys secureE repr

⇔ (∀ q c

• (let res = stp (q , c)
in let (dq , ocq , pars) = destVal (stp (q , c))
in let ok s ⇔ ok to proceed dbms res s

in ∀ s1 s2 s ′1 s ′2 d1 d2

• hide (c, s1 ) = hide (c, s2 )
∧ (repr s ′1 , d1 )
= dbms (dq , repr s1 )

∧ (repr s ′2 , d2 )
= dbms (dq , repr s2 )

∧ ¬ filter (c, d1 , pars)
= filter (c, d2 , pars)

⇒ ¬ ok (repr s1 )))
subsys secure

⊢ ∀ repr dbms stp filter

• (dbms, stp, filter) ∈ subsys secure repr

⇔ (dbms, stp)
∈ subsys secureA repr

∩ subsys secureB repr

∩ subsys secureC repr

Page 120 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

∩ subsys secureD repr

∧ (dbms, stp, filter) ∈ subsys secureE repr

22 THE THEORY fef024

22.1 Parents

fef022

22.2 Children

fef021

22.3 Constants

class of item
Item → Class

fill cols Class → Data LIST × Bool LIST → (Item × Class) LIST

fill row Bool × Class + Maybe × Bool LIST × Class

→ Data LIST

→ Class × Class × (Item × Class) LIST

fill table Bool × Class + Maybe × Bool LIST × Class × Select

→ (Class × Class × (Item × Class) LIST ) LIST

filter where row
Class × Class × (Item × Class) LIST

→ (Item × Class) LIST × Bool

filter table (Class × Class × (Item × Class) LIST ) LIST × Class

→ (Item × Class) LIST LIST × Bool

filter cols Class → (Item × Class) LIST → Data LIST

filter select
(Class × Class × (Item × Class) LIST ) LIST × Class

→ Select × Bool

outputFilter FILTER PARS FILTER TYPE

22.4 Type Abbreviations

FILTER PARSFILTER PARS
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22.5 Definitions

class of item
⊢ ∀ i

• class of item i

= destClassVal (VI val (destValuedItem i))
fill cols ⊢ ConstSpec

(λ fill cols ′

• ∀ d ds b bs clear

• fill cols ′ clear ([], []) = []
∧ fill cols ′ clear (Cons d ds, Cons b bs)
= (if b

then

let c

= class of item

(Dat item (Head ds))
in Cons

(Dat item d , c)
(fill cols ′ clear (Tail ds, bs))

else

Cons

(Dat item d , clear)
(fill cols ′ clear (ds, bs))))

fill cols

fill row ⊢ ∀ check where check rc check cols clear dl

• fill row

(check where, check rc, check cols, clear)
dl

= (let (where c, rest1 )
= (if check where

then

(class of item (Dat item (Head dl)),
Tail dl)

else (clear , dl))
in let (rc, rest2 )

= (if IsR check rc

then

(class of item

(Dat item (Head rest1 )),
Tail rest1 )

else (OutL check rc, rest1 ))
in (where c, rc,
fill cols clear (rest2 , check cols)))

fill table ⊢ ∀ check where check rc check cols clear dll

• fill table

(check where, check rc, check cols, clear , dll)
= Map

(fill row
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(check where, check rc, check cols, clear))
dll

filter where row
⊢ ∀ clear where c icl

• filter where row (clear , where c, icl)
= (icl , (¬ clear dominates where c))

filter table ⊢ ∀ h rest clear

• filter table ([], clear) = ([], false)
∧ filter table (Cons h rest , clear)
= (let (where c, rc, ics) = h

in if ¬ clear dominates rc

then filter table (rest , clear)
else

(let (fics, msg)
= filter where row

(clear , where c, ics)
in let (frest , msgs)

= filter table (rest , clear)
in if msg

then (frest , true)
else (Cons fics frest , msgs)))

filter cols ⊢ ∀ clear ic ics

• filter cols clear [] = []
∧ filter cols clear (Cons ic ics)
= (let (i , c) = ic

in if clear dominates c

then

Cons (MkData c i) (filter cols clear ics)
else

Cons

(MkData

c

(ValuedItemItem

(MkValuedItem

sterling

dummyVal)))
(filter cols clear ics))

filter select
⊢ ∀ table clear

• filter select (table, clear)
= (let (ftable, check)

= filter table (table, clear)
in (Map (filter cols clear) ftable, check))

outputFilter ⊢ ∀ cl dl errs cw cr cc

• outputFilter (cl , (dl , errs), cw , cr , cc)
= (if ¬ errs = []
then ([], errs)
else
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(let (ans, mnbc)
= filter select

(fill table (cw , cr , cc, cl , dl), cl)
in (ans,
(if mnbc

then [mayNotBeComplete]
else []))))

23 THE THEORY fef025

23.1 Parents

fef021

23.2 Children

fef028

23.3 Constants

MkDatat Val → Data

MkNullDatat Data

MkClassVal Class → Data

repr data Data → Data × Data × Data

Repr colCon ColCon → ColCon

ClassName Op → Op

DinaryName Op → Op

SterlingName Op → Op

RowExistNameOp → Op

rowExistCol Op → ColSpec

rowExistColCon
ColCon

f1 TableSpec → Worth → ColSpec + Maybe

ColNeeds TableSpec → Worth → Worth + Maybe

NextNum TableSpec → Worth → Worth

f2 TableSpec → ColSpec → ColSpec LIST

f3 TableSpec → Worth × Data → (Worth × Data) LIST

repr row TableSpec → Row → Row

repr table Op → TableSpec → TableSpec

repr dir Directory → Directory

reprState State → Statet
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23.4 Definitions

MkDatat ⊢ ∀ v• MkDatat v = newData lattice bottom sterling v

MkNullDatat ⊢ MkNullDatat

= MkData lattice bottom (NullItemItem maybe)
MkClassVal ⊢ ∀ c• MkClassVal c = MkDatat (ClassVal c)
repr data ⊢ ∀ d

• repr data d

= (let i = Dat item d

in let c = Dat class d

in if isNullItem i

then

(MkNullDatat , MkNullDatat , MkClassVal c)
else

(let v = destValuedItem i

in if VI worth v = sterling

then

(MkDatat (VI val v), MkNullDatat ,
MkClassVal c)

else if VI worth v = dinary

then

(MkNullDatat , MkDatat (VI val v),
MkClassVal c)

else

(MkNullDatat , MkNullDatat ,
MkClassVal c)))

Repr colCon ⊢ ∀ cc

• Repr colCon cc

= MkColCon

lattice bottom

(CC uniform cc)
(CC unique cc)
(CC classLimited cc)
(CC primary cc)
(CC secondary cc)
(CC referential cc)

RowExistName
SterlingName
DinaryName
ClassName ⊢ ConstSpec

(λ
(RowExistName ′, SterlingName ′, DinaryName ′,

ClassName ′)
• OneOne RowExistName ′

∧ OneOne SterlingName ′

∧ OneOne DinaryName ′

∧ OneOne ClassName ′

∧ (∀ f g x
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• {f ; g}
⊆ {RowExistName ′; SterlingName ′;
DinaryName ′; ClassName ′}

∧ f x = g x

⇒ f = g))
(RowExistName, SterlingName, DinaryName, ClassName)

rowExistCol ⊢ ∀ tab

• rowExistCol tab

= MkColSpec

(RowExistName tab)
1

monoleanType

classType

false

MkNullDatat

1

lattice bottom

lattice bottom

rowExistColCon
⊢ rowExistColCon

= MkColCon

lattice bottom

false

false

false

false

false

[]
f1 ⊢ ∀ t n

• f 1 t n

= (if ∃1 c• c ∈ TS colspecs t ∧ CS posn c = n

then

InL (ǫ c• c ∈ TS colspecs t ∧ CS posn c = n)
else InR maybe)

ColNeeds ⊢ ∀ t n

• ColNeeds t n

= (if IsL (f 1 t n)
then

let c = OutL (f 1 t n)
in let n ′

= (if CS dinaryType c = monoleanType

then 1

else 2 )
in let ans

= (if CS min c = CS max c

then n ′

else n ′ + 1 ) in InL ans

else InR (OutR (f 1 t n)))
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NextNum ⊢ ∀ t n

• NextNum t n

= 1

+ #
{i
|i < n

∧ IsL (ColNeeds t i)
∧ OutL (ColNeeds t i) = 3}

∗ 3

+ #
{i
|i < n

∧ IsL (ColNeeds t i)
∧ OutL (ColNeeds t i) = 2}

∗ 2

+ #
{i
|i < n

∧ IsL (ColNeeds t i)
∧ OutL (ColNeeds t i) = 1}

f2 ⊢ ∀ t cs

• f 2 t cs

= (let n = CS posn cs

in let rc

= (if TS class t = TS maxRow t

then 0

else 1 )
in let next = rc + NextNum t n

in let css
= MkColSpec

(SterlingName (CS ide cs))
next

monoleanType

(CS sterlingType cs)
(CS nullType cs)
(Fst (repr data (CS default cs)))
(rc + CS consGroup cs)
lattice bottom

lattice bottom

in let (l1 , next1 )
= (if

CS dinaryType cs = monoleanType

then ([css ], next + 1 )
else

([css ;
MkColSpec

(DinaryName

(CS ide cs))
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(next + 1 )
monoleanType

(CS dinaryType cs)
(CS nullType cs)
(Fst

(Snd
(repr data

(CS default cs))))
(rc

+ CS consGroup

cs)
lattice bottom

lattice bottom],
next + 2 ))

in if CS min cs = CS max cs

then l1
else

l1
@ [MkColSpec

(ClassName (CS ide cs))
next1
monoleanType

classType

(CS nullType cs)
(Snd

(Snd
(repr data

(CS default cs))))
(rc + CS consGroup cs)
lattice bottom

lattice bottom])
f3 ⊢ ∀ t n d

• f 3 t (n, d)
= (let rc

= (if TS class t = TS maxRow t

then 0

else 1 )
in let next = rc + NextNum t n

in let cs = OutL (f 1 t n)
in let d s = Fst (repr data d)
in let (l1 , next1 )

= (if
CS dinaryType cs = monoleanType

then ([(next , d s)], next + 1 )
else

([(next , d s);
(next + 1 ,

Fst

Page 128 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

(Snd
(repr data

d)))], next + 2 ))
in if CS min cs = CS max cs

then l1
else

l1
@ [(next1 ,

Snd (Snd (repr data d)))])
repr row ⊢ ∀ t r

• repr row t r

= MkRow

lattice bottom

(let prs = R data r

in let prs ′

= {pr ′

|∃ pr

• pr ∈ prs

∧ pr ′ ∈ Elems (f 3 t pr)}
in if TS class t = TS maxRow t

then prs ′

else

prs ′ ∪ {(1 , MkClassVal (R exist r))})
repr table ⊢ ∀ i t

• repr table i t

= (let css

= {cs ′

|∃ cs

• cs ∈ TS colspecs t

∧ cs ′ ∈ Elems (f 2 t cs)}
in let ccs

= {(n, cc)
|n ∈ Dom (TS cons t)

∧ cc = Repr colCon (TS cons t @ n)}
in let (css ′, ccs ′)

= (if TS class t = TS maxRow t

then (css, ccs)
else

(css ∪ {rowExistCol i},
{(1 , rowExistColCon)}

∪ {(n ′, cc′)
|∃ n cc

• (n, cc) ∈ ccs

∧ n ′ = n + 1

∧ cc′ = cc}))
in MkTableSpec

lattice bottom

lattice bottom
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css ′

ccs ′

(Map (repr row t) (TS rows t)))
repr dir ⊢ ∀ d

• repr dir d

= MkDirectory

{(id , tab)
|id ∈ Dom (Dir tables d)

∧ tab

= repr table id (Dir tables d @ id)}
lattice bottom

lattice bottom

reprState ⊢ ∀ s

• reprState s

= (let s ′ = repState s

in absStatet
(absState

{(i , dir)
|i ∈ Dom s ′

∧ dir = repr dir (s ′ @ i)}))

24 THE THEORY fef026

24.1 Parents

fef029

24.2 Children

fef031 fef032

24.3 Constants

DCS max DerColSpec → Class

DCS min DerColSpec → Class

DCS name DerColSpec → Col LIST

MkDerColSpec Col LIST → Class → Class → DerColSpec

DTS colSpecs DerTableSpec → DerColSpec LIST

DTS maxRow DerTableSpec → Class

DTS name DerTableSpec → Col LIST

MkDerTableSpec
Col LIST → Class → DerColSpec LIST → DerTableSpec

DTR cols DerTableRow → (Class × ValuedItem OPT ) LIST

DTR row DerTableRow → Class

DTR where DerTableRow → Class

MkDerTableRow
Class
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→ Class

→ (Class × ValuedItem OPT ) LIST

→ DerTableRow

DT rows DerTable → DerTableRow LIST

DT spec DerTable → DerTableSpec

MkDerTable DerTableSpec → DerTableRow LIST → DerTable

EM (Statet → DerTable LIST )
→ (Query → DerTable LIST → DerTable × Errors)
→ (Query × (DerTable × Errors) × Statet
→ Statet × ANSWER)

→ tf t
StateDirs State → (Class × Col × Directory) LIST

DirTables Directory → (Op × TableSpec) LIST

StateTables State → (Class × Col × Op × TableSpec) LIST

ColSpecd Col × Op × TableSpec → ColSpec → DerColSpec

TableSpecd Class × Col × Op × TableSpec → DerTableSpec

TableRowd TableSpec → Row → DerTableRow

Tabled Class × Col × Op × TableSpec → DerTable

Views State → DerTable LIST

Viewt Statet → DerTable LIST

GiveData DerTable → Select

is select Query → Bool

Actt (Query × (DerTable × Errors) × Statet → Statet)
→ Query × (DerTable × Errors) × Statet
→ Statet × ANSWER

HideDerTableRow
Class → DerTableRow → DerTableRow

HideDerTableData
Class → DerTableRow LIST → DerTableRow LIST

HideDerTable Class → DerTable → DerTable

RiskInputs Class

→ (DerTable LIST → DerTable × Errors)
→ DerTable LIST P

ConditionE (Query → DerTable LIST → DerTable × Errors)
→ Class

→ (Query × Query OPT × ′PARS ) RESULT P

STP secure E (Query → DerTable LIST → DerTable × Errors)
→ (Query , ′PARS ) STP TYPE P

EM1 (Query → DerTable LIST → DerTable × Errors)
→ (Query × (DerTable × Errors) × Statet
→ Statet)

→ tf t
Correct Compile

(Query → DerTable LIST → DerTable × Errors)
↔ (Query × (DerTable × Errors) × Statet
→ Statet)
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24.4 Types

DerColSpec
DerTableSpec
DerTableRow
DerTable

24.5 Definitions

DerColSpec ⊢ ∃ f • TypeDefn (λ x• true) f

MkDerColSpec
DCS name
DCS min
DCS max ⊢ ∀ t x1 x2 x3

• DCS name (MkDerColSpec x1 x2 x3 ) = x1

∧ DCS min (MkDerColSpec x1 x2 x3 ) = x2

∧ DCS max (MkDerColSpec x1 x2 x3 ) = x3

∧ MkDerColSpec

(DCS name t)
(DCS min t)
(DCS max t)

= t

DerTableSpec ⊢ ∃ f • TypeDefn (λ x• true) f

MkDerTableSpec
DTS name
DTS maxRow
DTS colSpecs ⊢ ∀ t x1 x2 x3

• DTS name (MkDerTableSpec x1 x2 x3 ) = x1

∧ DTS maxRow (MkDerTableSpec x1 x2 x3 ) = x2

∧ DTS colSpecs (MkDerTableSpec x1 x2 x3 ) = x3

∧ MkDerTableSpec

(DTS name t)
(DTS maxRow t)
(DTS colSpecs t)

= t

DerTableRow ⊢ ∃ f • TypeDefn (λ x• true) f

MkDerTableRow
DTR where
DTR row
DTR cols ⊢ ∀ t x1 x2 x3

• DTR where (MkDerTableRow x1 x2 x3 ) = x1

∧ DTR row (MkDerTableRow x1 x2 x3 ) = x2

∧ DTR cols (MkDerTableRow x1 x2 x3 ) = x3

∧ MkDerTableRow

(DTR where t)
(DTR row t)
(DTR cols t)

= t
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DerTable ⊢ ∃ f • TypeDefn (λ x• true) f

MkDerTable
DT spec
DT rows ⊢ ∀ t x1 x2

• DT spec (MkDerTable x1 x2 ) = x1

∧ DT rows (MkDerTable x1 x2 ) = x2

∧ MkDerTable (DT spec t) (DT rows t) = t

EM ⊢ ∀ view compile act query st

• EM view compile act (query , st)
= (let compute = compile query

in let viewed = view st

in let computed = compute viewed

in act (query , computed , st))
StateDirs ⊢ ConstSpec

(λ StateDirs ′

• ∀ s

• Elems (StateDirs ′ s)
= {(c, i , d)
|(i , d) ∈ repState s

∧ c = Dir exist d lub Dir class d})
StateDirs

DirTables ⊢ ConstSpec

(λ DirTables ′

• ∀ d• Elems (DirTables ′ d) = Dir tables d)
DirTables

StateTables ⊢ ∀ s

• StateTables s

= (let (cl , illdl) = Split (StateDirs s)
in let (ill , dl) = Split illdl

in let itll = Map DirTables dl

in let f c i it = (c, i , it)
in let g (c, i , its) = Map (f c i) its

in let h cl is itss

= Map

g

(Combine cl (Combine is itss))
in Flat (h cl ill itll))

ColSpecd ⊢ ∀ d name t name t cs

• ColSpecd (d name, t name, t) cs

= (let cc = TS cons t @ CS consGroup cs

in let tc name = [t name; CS ide cs]
in MkDerColSpec

[[CS ide cs]; tc name; d name @ tc name]
(CS min cs)
(CS max cs))

TableSpecd ⊢ ∀ c d name t name t

• TableSpecd (c, d name, t name, t)
= MkDerTableSpec
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[[t name]; d name @ [t name]]
(TS maxRow t)
(RelList

(Squash
{(n, cs)
|∃ cs ′

• cs ′ ∈ TS colspecs t

∧ cs

= ColSpecd
(d name, t name, t)
cs ′

∧ n = CS posn cs ′}))
TableRowd ⊢ ∀ t r

• TableRowd t r

= (let f d = (Dat class d , Dat item d)
in MkDerTableRow

lattice bottom

(R exist r)
(RelList

(Squash
{(n, ic)
|n ∈ Dom (R data r)

∧ ic = f (R data r @ n)})))
Tabled ⊢ ∀ c d name t name t

• Tabled (c, d name, t name, t)
= MkDerTable

(TableSpecd (c, d name, t name, t))
(Map (TableRowd t) (TS rows t))

Views ⊢ ∀ s• View s s = Map Tabled (StateTables s)
Viewt ⊢ ConstSpec

(λ View ′
t

• ∀ s t ss
• s t = reprState ss

⇒ View ′
t s t = View s ss)

View t

GiveData ⊢ ∀ dt

• GiveData dt

= (let class item c

= ValuedItemItem

(MkValuedItem sterling (ClassVal c))
in let item data i = MkData lattice bottom i

in let class data c

= item data (class item c)
in let cell cols (c, i)

= [class data c; item data i ]
in let row data r

= Flat

(Cons
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[class data (DTR where r);
class data (DTR row r)]

(Map cell cols (DTR cols r)))
in Map row data (DT rows dt))

is select ⊢ ∀ q• is select q ⇔ (∃ t• q = select t)
Actt ⊢ ∀ upd query dt errs st

• Act t upd (query , (dt , errs), st)
= (if ¬ errs = []
then (st , [], errs)
else if is select query

then (st , GiveData dt , errs)
else (upd (query , (dt , errs), st), [], []))

HideDerTableRow
⊢ ∀ cc r

• HideDerTableRow cc r

= (let d

= ValuedItemItem

(MkValuedItem sterling dummyVal)
in let hc (c, i)

= (if cc dominates c

then (c, i)
else (c, d))

in MkDerTableRow

(DTR where r)
(DTR row r)
(Map hc (DTR cols r)))

HideDerTableData
⊢ ∀ cc rs

• HideDerTableData cc rs

= (let okr = {r |cc dominates DTR row r}
in Map (HideDerTableRow cc) (rs ↾ okr))

HideDerTable ⊢ ∀ cc t

• HideDerTable cc t

= MkDerTable

(DT spec t)
(HideDerTableData cc (DT rows t))

RiskInputs ⊢ ∀ c f

• RiskInputs c f

= {ts
|∃ ts0
• Map (HideDerTable c) ts0

= Map (HideDerTable c) ts

∧ (¬ HideDerTable c (Fst (f ts0 ))
= HideDerTable c (Fst (f ts))

∨ ¬ Snd (f ts0 ) = Snd (f ts))}
ConditionE ⊢ ∀ compile cc

• ConditionE compile cc

= {stp res
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|isError stp res

∨ (let (dq , ocq , pars) = destVal stp res

in let dcomp = compile dq

in ∀ ri

• ri ∈ RiskInputs cc dcomp

⇒ IsL ocq

∧ is select (OutL ocq)
∧ (let ccomp = compile (OutL ocq)
in ¬ DT rows (Fst (ccomp ri))

= []
∨ ¬ Snd (ccomp ri) = []))}

STP secure E ⊢ ∀ compile

• STP secure E compile

= {stp|∀ q c• stp (q , c) ∈ ConditionE compile c}
EM1 ⊢ ∀ compile upd

• EM 1 compile upd = EM View t compile (Act t upd)
Correct Compile

⊢ Correct Compile

= {(compile, upd)|EM 1 compile upd = TSQLtf }

25 THE THEORY fef028

25.1 Parents

fef025

25.2 Children

fef029

25.3 Constants

case Value LIST → Value LIST → Value → Value

fold (′a × ′a → ′a) → ′a LIST → ′a

splice ′a LIST → ′b LIST → (′a × ′b) LIST

at2 ((′a × ′b) LIST → ′c) → ′a LIST × ′b LIST → ′c

at3 ((′a × ′b × ′c) LIST → ′d)
→ ′a LIST × ′b LIST × ′c LIST

→ ′d

at4 ((′a × ′b × ′c × ′d) LIST → ′e)
→ ′a LIST × ′b LIST × ′c LIST × ′d LIST

→ ′e

$dom Class → Class → Bool

invert ′a LIST LIST → ′a LIST LIST

split3 (′a × ′b × ′c) LIST → ′a LIST × ′b LIST × ′c LIST

split4 (′a × ′b × ′c × ′d) LIST

→ ′a LIST × ′b LIST × ′c LIST × ′d LIST
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split5 (′a × ′b × ′c × ′d × ′e) LIST

→ ′a LIST × ′b LIST × ′c LIST × ′d LIST × ′e LIST

CASE ′a → (′a → ′b OPT ) LIST → ′b

OTHERS (′a, ′b) WHEN CONST

Lift (′rep, ′abs) MK DEST → (′rep, ′abs, ′a) WHEN

LiftConstant ′abs → (′abs, ′a) WHEN CONST

ExceptionValue
′a RESULT → Errors

Exception Errors → ′a RESULT

OkValue ′a RESULT → ′a

Ok ′a → ′a RESULT

$WHEN exception
(Errors, ′a RESULT , ′b) WHEN

$WHEN ok (′a, ′a RESULT , ′b) WHEN

ListOk ′a RESULT LIST → ′a LIST RESULT

Try (′a → ′b RESULT ) → ′a RESULT → ′b RESULT

dest default TableSpecification → Worth × Col × Op

mk default Worth × Col × Op → TableSpecification

dest absolute
TableSpecification → Col × Op

mk absolute Col × Op → TableSpecification

$WHEN default
(Worth × Col × Op, TableSpecification, ′b) WHEN

$WHEN absolute
(Col × Op, TableSpecification, ′b) WHEN

c anyType SwordType

c codeType SwordType

c classType SwordType

dest intervalType
SwordType → Op

mk intervalType
Op → SwordType

dest timeType
SwordType → Op

mk timeType Op → SwordType

dest enumType
SwordType → Fixed × TableSpecification

mk enumType Fixed × TableSpecification → SwordType

dest fixedType
SwordType → Fixed × Fixed

mk fixedType Fixed × Fixed → SwordType

dest stringType
SwordType → Fixed × Fixed

mk stringType
Fixed × Fixed → SwordType

c booleanType
SwordType

c monoleanType

Page 137 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

SwordType

c nullType SwordType

WHEN anyType (SwordType, ′a) WHEN CONST

WHEN codeType
(SwordType, ′a) WHEN CONST

WHEN classType
(SwordType, ′a) WHEN CONST

$WHEN intervalType
(Op, SwordType, ′a) WHEN

$WHEN timeType
(Op, SwordType, ′a) WHEN

$WHEN enumType
(Fixed × TableSpecification, SwordType, ′a) WHEN

$WHEN fixedType
(Fixed × Fixed , SwordType, ′a) WHEN

$WHEN stringType
(Fixed × Fixed , SwordType, ′a) WHEN

WHEN booleanType
(SwordType, ′a) WHEN CONST

WHEN monoleanType
(SwordType, ′a) WHEN CONST

WHEN nullType
(SwordType, ′a) WHEN CONST

dest names SsqlName → Op

mk names Op → SsqlName

c anons SsqlName

$WHEN names(Op, SsqlName, ′a) WHEN

WHEN anons (SsqlName, ′a) WHEN CONST

dest namet TsqlName → Op

mk namet Op → TsqlName

c anont TsqlName

c nonet TsqlName

$WHEN namet(Op, TsqlName, ′a) WHEN

WHEN anont (TsqlName, ′a) WHEN CONST

WHEN nonet (TsqlName, ′a) WHEN CONST

dest constant
BoundInfo → Class

mk constant Class → BoundInfo

dest upb BoundInfo → Class

mk upb Class → BoundInfo

$WHEN constant
(Class, BoundInfo, ′a) WHEN

$WHEN upb (Class, BoundInfo, ′a) WHEN

sc col class SsqlCol → BoundInfo

sc col exist SsqlCol → Class

sc type field
SsqlCol → ColType

sc name SsqlCol → SsqlName
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MkSsqlCol SsqlName → ColType → Class → BoundInfo → SsqlCol

dest constanttc
TsqlClassName → Class

mk constanttc
Class → TsqlClassName

dest nametc
TsqlClassName → Op

mk nametc Op → TsqlClassName

c anontc TsqlClassName

$WHEN constanttc
(Class, TsqlClassName, ′a) WHEN

$WHEN nametc
(Op, TsqlClassName, ′a) WHEN

WHEN anontc

(TsqlClassName, ′a) WHEN CONST

tc class name
TsqlCol → TsqlClassName

tc dinary name
TsqlCol → TsqlName

tc sterling name
TsqlCol → TsqlName

MkTsqlCol TsqlName → TsqlName → TsqlClassName → TsqlCol

ti row class TableInfo → BoundInfo

ti table class
TableInfo → Class

ti table exist class
TableInfo → Class

MkTableInfo Class → Class → BoundInfo → TableInfo

ci index ConstraintInfo → Errors LIST

ci uniform ConstraintInfo → Errors LIST

ci unique ConstraintInfo → Errors LIST

ci lwb ConstraintInfo → Class LIST

ci null allowed
ConstraintInfo → Bool LIST

MkConstraintInfo
Bool LIST

→ Class LIST

→ Errors LIST

→ Errors LIST

→ Errors LIST

→ ConstraintInfo

dest specific
ColumnSpecification → TableSpecification × Op

mk specific TableSpecification × Op → ColumnSpecification

dest anonymous column
ColumnSpecification → Op

mk anonymous column
Op → ColumnSpecification
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$WHEN specific
(TableSpecification × Op, ColumnSpecification, ′a) WHEN

$WHEN anonymous column
(Op, ColumnSpecification, ′a) WHEN

c constant null
TsqlRepr

dest constant class
TsqlRepr → Class

mk constant class
Class → TsqlRepr

dest column TsqlRepr → Op × Op

mk column Op × Op → TsqlRepr

dest local identifier
TsqlRepr → Op

mk local identifier
Op → TsqlRepr

WHEN constant null
(TsqlRepr , ′a) WHEN CONST

$WHEN constant class
(Class, TsqlRepr , ′a) WHEN

$WHEN column (Op × Op, TsqlRepr , ′a) WHEN

$WHEN local identifier
(Op, TsqlRepr , ′a) WHEN

dest constantec
ExpClass → Class

mk constantec
Class → ExpClass

dest variable
ExpClass → Value × Class

mk variable Value × Class → ExpClass

$WHEN constantec
(Class, ExpClass, ′a) WHEN

$WHEN variable
(Value × Class, ExpClass, ′a) WHEN

dest simple InternalExpClass → ExpClass

mk simple ExpClass → InternalExpClass

dest ors InternalExpClass → Value LIST × ExpClass LIST

mk ors Value LIST × ExpClass LIST → InternalExpClass

dest ands InternalExpClass → Value LIST × ExpClass LIST

mk ands Value LIST × ExpClass LIST → InternalExpClass

$WHEN simple (ExpClass, InternalExpClass, ′a) WHEN

$WHEN ors (Value LIST × ExpClass LIST , InternalExpClass, ′a) WHEN

$WHEN ands (Value LIST × ExpClass LIST , InternalExpClass, ′a) WHEN

dest nametn
TableName → TableSpecification

mk nametn TableSpecification → TableName

c anontn TableName

$WHEN nametn
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(TableSpecification, TableName, ′a) WHEN

WHEN anontn

(TableName, ′a) WHEN CONST

td constraints
TableDetail → ConstraintInfo

td implementation
TableDetail → TsqlCol LIST

td rowClass TableDetail → TsqlClassName

td columns TableDetail → SsqlCol LIST

td info TableDetail → TableInfo

td genCorr TableDetail → Op

td corrName TableDetail → SsqlName

td tableName TableDetail → TableName

MkTableDetail
TableName

→ SsqlName

→ Op

→ TableInfo

→ SsqlCol LIST

→ TsqlClassName

→ TsqlCol LIST

→ ConstraintInfo

→ TableDetail

id cName IdentDetail → TsqlName

id vName IdentDetail → Op

id lubid IdentDetail → Class

id info IdentDetail → ExpType

id identName IdentDetail → Op

MkIdentDetail
Op → ExpType → Class → Op → TsqlName → IdentDetail

s identifiers
Scope → IdentDetail LIST

s tables Scope → TableDetail LIST

MkScope TableDetail LIST → IdentDetail LIST → Scope

pi clasf ParamInfo → Class

pi valp ParamInfo → Value

pi name ParamInfo → Op

MkParamInfo Op → Value → Class → ParamInfo

parameterTable
ST STACK → ParamInfo LIST

symbolTable ST STACK → Scope LIST

MkST STACK Scope LIST → ParamInfo LIST → ST STACK

25.4 Types

SsqlCol
TsqlCol
TableInfo
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ConstraintInfo
TableDetail
IdentDetail
Scope
ParamInfo
ST STACK

25.5 Type Abbreviations

Enum Fixed

Integer Fixed

Fixed Fixed
′a OPT ′a OPT

(′rep, ′abs) MK DEST
(′rep, ′abs) MK DEST

(′rep, ′abs, ′a) WHEN
(′rep, ′abs, ′a) WHEN

(′abs, ′a) WHEN CONST
(′abs, ′a) WHEN CONST

′a RESULT ′a RESULT

TableSpecification
TableSpecification

SwordType SwordType

SsqlName SsqlName

TsqlName TsqlName

ColType ColType

BoundInfo BoundInfo

TsqlClassName
TsqlClassName

ColumnSpecification
ColumnSpecification

TsqlRepr TsqlRepr

ExpType ExpType

ExpClass ExpClass

InternalExpClass
InternalExpClass

TableName TableName

25.6 Fixity

Binder : WHEN absolute WHEN local identifier
WHEN andsWHEN names
WHEN anonymous column WHEN namet
WHEN column WHEN nametc
WHEN constant WHEN nametn
WHEN constant class WHEN ok
WHEN constantec WHEN ors
WHEN constanttc WHEN simple
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WHEN default WHEN specific
WHEN enumType WHEN stringType
WHEN exception WHEN timeType
WHEN fixedType WHEN upb
WHEN intervalType WHEN variable

Right Infix 150 :
dom

25.7 Definitions

case ⊢ true

fold ⊢ ∀ f h t

• fold f (Cons h t)
= (if t = [] then h else f (h, fold f t))

splice ⊢ ∀ h1 h2 list1 list2

• splice [] [] = []
∧ splice [] (Cons h2 list2 ) = []
∧ splice (Cons h1 list1 ) [] = []
∧ splice (Cons h1 list1 ) (Cons h2 list2 )
= Cons (h1 , h2 ) (splice list1 list2 )

at2 ⊢ ∀ f as bs• at2 f (as, bs) = f (Combine as bs)
at3 ⊢ ∀ f as bs cs

• at3 f (as, bs, cs) = f (Combine as (Combine bs cs))
at4 ⊢ ∀ f as bs cs ds

• at4 f (as, bs, cs, ds)
= f (Combine as (Combine bs (Combine cs ds)))

dom ⊢ $dom = $dominates

invert ⊢ ∀ xs more

• invert (Cons xs more)
= (if more = []
then Map (λ x• [x ]) xs

else

Map

(λ (x , ys)• Cons x ys)
(Combine xs (invert more)))

split3 ⊢ ∀ abcs

• split3 abcs

= (let (as, bcs) = Split abcs in (as, Split bcs))
split4 ⊢ ∀ abcds

• split4 abcds

= (let (as, bcds) = Split abcds

in (as, split3 bcds))
split5 ⊢ ∀ abcdes

• split5 abcdes

= (let (as, bcdes) = Split abcdes

in (as, split4 bcdes))
CASE ⊢ ∀ a f fs

• CASE a (Cons f fs)
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= (if IsL (f a) then OutL (f a) else CASE a fs)
OTHERS ⊢ ∀ b a• OTHERS b a = InL b

Lift ⊢ ∀ mk dest f a

• Lift (mk , dest) f a

= (if mk (dest a) = a

then InL (f (dest a))
else InR maybe)

LiftConstant ⊢ ∀ con a abs

• LiftConstant con a abs

= (if abs = con then InL a else InR maybe)
OkValue
Ok
ExceptionValue
Exception ⊢ Ok = InL

∧ Exception = InR

∧ OkValue = OutL

∧ ExceptionValue = OutR

WHEN ok
WHEN exception

⊢ $WHEN ok = Lift (Ok , OkValue)
∧ $WHEN exception

= Lift (Exception, ExceptionValue)
ListOk ⊢ ∀ resl

• ListOk resl

= (if Fold $∧ (Map IsL resl) true

then InL (Map OutL resl)
else

(let folder res errs

= (if IsL res

then errs

else OutR res @ errs)
in InR (Fold folder resl [])))

Try ⊢ ∀ f

• Try f

= (λ a

• if isVal a

then f (destVal a)
else giveError (destError a))

dest absolute
mk absolute
dest default
mk default ⊢ mk absolute = InL

∧ mk default = InR

∧ dest absolute = OutL

∧ dest default = OutR

WHEN absolute
WHEN default⊢ $WHEN absolute = Lift (mk absolute, dest absolute)

∧ $WHEN default = Lift (mk default , dest default)

Page 144 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

c nullType
c monoleanType
c booleanType
dest stringType
mk stringType
dest fixedType
mk fixedType
dest enumType
mk enumType
dest timeType
mk timeType
dest intervalType
mk intervalType
c classType
c codeType
c anyType ⊢ c nullType = InL maybe

∧ c monoleanType = (InR o InL) maybe

∧ c booleanType = (InR o InR o InL) maybe

∧ mk stringType = InR o InR o InR o InL

∧ mk fixedType = InR o InR o InR o InR o InL

∧ mk enumType = InR o InR o InR o InR o InR o InL

∧ mk timeType

= InR o InR o InR o InR o InR o InR o InL

∧ mk intervalType

= InR o InR o InR o InR o InR o InR o InR o InL

∧ c classType

= (InR
o InR

o InR

o InR

o InR

o InR

o InR

o InR

o InL)
maybe

∧ c codeType

= (InR
o InR

o InR

o InR

o InR

o InR

o InR

o InR

o InR

o InL)
maybe
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∧ c anyType

= (InR
o InR

o InR

o InR

o InR

o InR

o InR

o InR

o InR

o InR)
maybe

∧ dest stringType = OutL o OutR o OutR o OutR

∧ dest fixedType = OutL o OutR o OutR o OutR o OutR

∧ dest enumType

= OutL o OutR o OutR o OutR o OutR o OutR

∧ dest timeType

= OutL o OutR o OutR o OutR o OutR o OutR o OutR

∧ dest intervalType

= OutL

o OutR

o OutR

o OutR

o OutR

o OutR

o OutR

o OutR

WHEN nullType
WHEN monoleanType
WHEN booleanType
WHEN stringType
WHEN fixedType
WHEN enumType
WHEN timeType
WHEN intervalType
WHEN classType
WHEN codeType
WHEN anyType ⊢ WHEN nullType = LiftConstant c nullType

∧ WHEN monoleanType = LiftConstant c monoleanType

∧ WHEN booleanType = LiftConstant c booleanType

∧ $WHEN stringType

= Lift (mk stringType, dest stringType)
∧ $WHEN fixedType

= Lift (mk fixedType, dest fixedType)
∧ $WHEN enumType

= Lift (mk enumType, dest enumType)
∧ $WHEN timeType

= Lift (mk timeType, dest timeType)
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∧ $WHEN intervalType

= Lift (mk intervalType, dest intervalType)
∧ WHEN classType = LiftConstant c classType

∧ WHEN codeType = LiftConstant c codeType

∧ WHEN anyType = LiftConstant c anyType

c anons

dest names
mk names ⊢ c anons = InL maybe

∧ mk names = InR

∧ dest names = OutR

WHEN anons

WHEN names ⊢ WHEN anons = LiftConstant c anons

∧ $WHEN names = Lift (mk names , dest names)
c nonet
c anont

dest namet
mk namet ⊢ c nonet = InL maybe

∧ c anont = (InR o InL) maybe

∧ mk namet = InR o InR

∧ dest namet = OutR o OutR

WHEN nonet
WHEN anont

WHEN namet ⊢ WHEN nonet = LiftConstant c nonet
∧ WHEN anont = LiftConstant c anont

∧ $WHEN namet = Lift (mk namet , dest namet)
dest upb
mk upb
dest constant
mk constant ⊢ mk upb = InL

∧ mk constant = InR

∧ dest upb = OutL

∧ dest constant = OutR

WHEN upb
WHEN constant

⊢ $WHEN upb = Lift (mk upb, dest upb)
∧ $WHEN constant

= Lift (mk constant , dest constant)
SsqlCol ⊢ ∃ f • TypeDefn (λ x• true) f

MkSsqlCol
sc name
sc type field
sc col exist
sc col class ⊢ ∀ t x1 x2 x3 x4

• sc name (MkSsqlCol x1 x2 x3 x4 ) = x1

∧ sc type field (MkSsqlCol x1 x2 x3 x4 ) = x2

∧ sc col exist (MkSsqlCol x1 x2 x3 x4 ) = x3

∧ sc col class (MkSsqlCol x1 x2 x3 x4 ) = x4

∧ MkSsqlCol
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(sc name t)
(sc type field t)
(sc col exist t)
(sc col class t)

= t

c anontc

dest nametc
mk nametc
dest constanttc
mk constanttc

⊢ c anont c = InL maybe

∧ mk namet c = InR o InL

∧ mk constant t c = InR o InR

∧ dest namet c = OutL o OutR

∧ dest constant t c = OutR o OutR

WHEN anontc

WHEN nametc
WHEN constanttc

⊢ WHEN anont c = LiftConstant c anont c

∧ $WHEN namet c
= Lift (mk namet c , dest namet c)

∧ $WHEN constant t c
= Lift (mk constant t c , dest constant t c)

TsqlCol ⊢ ∃ f • TypeDefn (λ x• true) f

MkTsqlCol
tc sterling name
tc dinary name
tc class name

⊢ ∀ t x1 x2 x3

• tc sterling name (MkTsqlCol x1 x2 x3 ) = x1

∧ tc dinary name (MkTsqlCol x1 x2 x3 ) = x2

∧ tc class name (MkTsqlCol x1 x2 x3 ) = x3

∧ MkTsqlCol

(tc sterling name t)
(tc dinary name t)
(tc class name t)

= t

TableInfo ⊢ ∃ f • TypeDefn (λ x• true) f

MkTableInfo
ti table exist class
ti table class
ti row class ⊢ ∀ t x1 x2 x3

• ti table exist class (MkTableInfo x1 x2 x3 ) = x1

∧ ti table class (MkTableInfo x1 x2 x3 ) = x2

∧ ti row class (MkTableInfo x1 x2 x3 ) = x3

∧ MkTableInfo

(ti table exist class t)
(ti table class t)
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(ti row class t)
= t

ConstraintInfo
⊢ ∃ f • TypeDefn (λ x• true) f

MkConstraintInfo
ci null allowed
ci lwb
ci unique
ci uniform
ci index ⊢ ∀ t x1 x2 x3 x4 x5

• ci null allowed (MkConstraintInfo x1 x2 x3 x4 x5 )
= x1

∧ ci lwb (MkConstraintInfo x1 x2 x3 x4 x5 ) = x2

∧ ci unique (MkConstraintInfo x1 x2 x3 x4 x5 )
= x3

∧ ci uniform (MkConstraintInfo x1 x2 x3 x4 x5 )
= x4

∧ ci index (MkConstraintInfo x1 x2 x3 x4 x5 ) = x5

∧ MkConstraintInfo

(ci null allowed t)
(ci lwb t)
(ci unique t)
(ci uniform t)
(ci index t)

= t

dest anonymous column
mk anonymous column
dest specific
mk specific ⊢ mk anonymous column = InL

∧ mk specific = InR

∧ dest anonymous column = OutL

∧ dest specific = OutR

WHEN anonymous column
WHEN specific

⊢ $WHEN anonymous column

= Lift

(mk anonymous column, dest anonymous column)
∧ $WHEN specific

= Lift (mk specific, dest specific)
dest local identifier
mk local identifier
dest column
mk column
dest constant class
mk constant class
c constant null

⊢ mk local identifier = InL

∧ mk column = InR o InL
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∧ mk constant class = InR o InR o InL

∧ c constant null = (InR o InR o InR) maybe

∧ dest local identifier = OutL

∧ dest column = OutL o OutR

∧ dest constant class = OutL o OutR o OutR

WHEN local identifier
WHEN column
WHEN constant class
WHEN constant null

⊢ $WHEN local identifier

= Lift

(mk local identifier , dest local identifier)
∧ $WHEN column = Lift (mk column, dest column)
∧ $WHEN constant class

= Lift (mk constant class, dest constant class)
∧ WHEN constant null = LiftConstant c constant null

dest variable
mk variable
dest constantec
mk constantec

⊢ mk variable = InL

∧ mk constantec = InR

∧ dest variable = OutL

∧ dest constantec = OutR

WHEN variable
WHEN constantec

⊢ $WHEN variable = Lift (mk variable, dest variable)
∧ $WHEN constantec
= Lift (mk constantec , dest constantec)

dest ands
mk ands
dest ors
mk ors
dest simple
mk simple ⊢ mk ands = InL

∧ mk ors = InR o InL

∧ mk simple = InR o InR

∧ dest ands = OutL

∧ dest ors = OutL o OutR

∧ dest simple = OutR o OutR

WHEN ands
WHEN ors
WHEN simple ⊢ $WHEN ands = Lift (mk ands, dest ands)

∧ $WHEN ors = Lift (mk ors, dest ors)
∧ $WHEN simple = Lift (mk simple, dest simple)

c anontn

dest nametn
mk nametn ⊢ c anont n = InL maybe
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∧ mk namet n = InR

∧ dest namet n = OutR

WHEN anontn

WHEN nametn
⊢ WHEN anont n = LiftConstant c anont n

∧ $WHEN namet n
= Lift (mk namet n , dest namet n)

TableDetail ⊢ ∃ f • TypeDefn (λ x• true) f

MkTableDetail
td tableName
td corrName
td genCorr
td info
td columns
td rowClass
td implementation
td constraints

⊢ ∀ t x1 x2 x3 x4 x5 x6 x7 x8

• td tableName

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x1

∧ td corrName

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x2

∧ td genCorr

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x3

∧ td info (MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x4

∧ td columns

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x5

∧ td rowClass

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x6

∧ td implementation

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x7

∧ td constraints

(MkTableDetail x1 x2 x3 x4 x5 x6 x7 x8 )
= x8

∧ MkTableDetail

(td tableName t)
(td corrName t)
(td genCorr t)
(td info t)
(td columns t)
(td rowClass t)
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(td implementation t)
(td constraints t)

= t

IdentDetail ⊢ ∃ f • TypeDefn (λ x• true) f

MkIdentDetail
id identName
id info
id lubid

id vName
id cName ⊢ ∀ t x1 x2 x3 x4 x5

• id identName (MkIdentDetail x1 x2 x3 x4 x5 ) = x1

∧ id info (MkIdentDetail x1 x2 x3 x4 x5 ) = x2

∧ id lubi d (MkIdentDetail x1 x2 x3 x4 x5 ) = x3

∧ id vName (MkIdentDetail x1 x2 x3 x4 x5 ) = x4

∧ id cName (MkIdentDetail x1 x2 x3 x4 x5 ) = x5

∧ MkIdentDetail

(id identName t)
(id info t)
(id lubi d t)
(id vName t)
(id cName t)

= t

Scope ⊢ ∃ f • TypeDefn (λ x• true) f

MkScope
s tables
s identifiers

⊢ ∀ t x1 x2

• s tables (MkScope x1 x2 ) = x1

∧ s identifiers (MkScope x1 x2 ) = x2

∧ MkScope (s tables t) (s identifiers t) = t

ParamInfo ⊢ ∃ f • TypeDefn (λ x• true) f

MkParamInfo
pi name
pi valp
pi clasf ⊢ ∀ t x1 x2 x3

• pi name (MkParamInfo x1 x2 x3 ) = x1

∧ pi valp (MkParamInfo x1 x2 x3 ) = x2

∧ pi clasf (MkParamInfo x1 x2 x3 ) = x3

∧ MkParamInfo

(pi name t)
(pi valp t)
(pi clasf t)

= t

ST STACK ⊢ ∃ f • TypeDefn (λ x• true) f

MkST STACK
symbolTable
parameterTable

⊢ ∀ t x1 x2
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• symbolTable (MkST STACK x1 x2 ) = x1

∧ parameterTable (MkST STACK x1 x2 ) = x2

∧ MkST STACK (symbolTable t) (parameterTable t)
= t

26 THE THEORY fef029

26.1 Parents

fef028

26.2 Children

fef026

26.3 Constants

emptyUnionList
Worth

ambiguousName
Worth

wrongScope Worth

noScope Worth

noSuchParameter
Worth

notSetFunction
Worth

notTriadic Worth

notDyadic Worth

notMonadic Worth

onlyInTriggers
Worth

notTrigger Worth

wrongWorth Worth

internalError
Worth

client clearance
TRANS STATE → Class

query constants class
TRANS STATE → Class

query class TRANS STATE → Class

st stack TRANS STATE → ST STACK

MkTRANS STATE
ST STACK → Class → Class → Class → TRANS STATE

default directory
Col

contextual data
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Op → Value × Class

unique name TRANS STATE → Op

timeFormatToInterval
Op → Op

check time Time × Op → Bool

check interval
Interval × Op → Bool

check floating
Float × Fixed × Fixed × Fixed → Bool

check fixed Fixed × Fixed × Fixed → Bool

check enum Fixed × Fixed × Table spec → Bool

init trans state
Class → TRANS STATE

findcolumn

ColumnSpecification × TableDetail LIST

→ (TableDetail × SsqlCol × TsqlCol) LIST

findident

ColumnSpecification × IdentDetail LIST

→ IdentDetail LIST

lookup column info look
ColumnSpecification × Scope LIST

→ (TableInfo × SsqlCol) RESULT

lookupcolumninf o

TRANS STATE

→ ColumnSpecification

→ (TableInfo × SsqlCol) RESULT

maxBound BoundInfo → Class

innermost Scope LIST → Scope LIST

lookup col spec class look
ColumnSpecification × Scope LIST

→ (TsqlRepr × Class) RESULT

lookupcolspecclass

TRANS STATE

→ Bool × ColumnSpecification

→ (TsqlRepr × Class) RESULT

lookup col spec dinary look
ColumnSpecification × Scope LIST → TsqlRepr RESULT

lookupcolspecdinary

TRANS STATE

→ Bool × ColumnSpecification

→ TsqlRepr RESULT

lookup col spec sterling look
ColumnSpecification × Scope LIST → TsqlRepr RESULT

lookupcolspecsterling

TRANS STATE

→ Bool × ColumnSpecification

→ TsqlRepr RESULT

lookuplocalcolimplementation
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TRANS STATE → TsqlCol LIST RESULT

lookuplocalcolinf o

TRANS STATE → SsqlCol LIST RESULT

lookuplocalcolspecclasses

TRANS STATE → (TsqlRepr × Class) LIST RESULT

lookuplocalcolspecsterlings

TRANS STATE → TsqlRepr LIST RESULT

lookuplocalrowclasses

TRANS STATE → TsqlRepr LIST RESULT

lookup column row class look
TRANS STATE

→ ColumnSpecification × Scope LIST

→ TsqlRepr RESULT

lookupcolumnrowclass

TRANS STATE

→ Bool × ColumnSpecification

→ TsqlRepr RESULT

lookup table row class look
TableSpecification × Scope LIST → TsqlRepr RESULT

lookuptablerowclass

TRANS STATE

→ Bool × TableSpecification

→ TsqlRepr RESULT

lookup table detail look
TableSpecification × Scope LIST → TableDetail RESULT

lookuptabledetail

TRANS STATE → TableSpecification → TableDetail RESULT

update top scope
TRANS STATE → Scope → TRANS STATE

enteridentif ier
TRANS STATE

→ Op × ExpType × Class

→ (TRANS STATE × Op × Op) RESULT

enteridentif erconstantclass
TRANS STATE

→ Op × ExpType × Class

→ (TRANS STATE × Op) RESULT

extractparameter

Op × ParamInfo LIST → ParamInfo LIST

enterparameter

TRANS STATE → Op × Value × Class → TRANS STATE RESULT

entercorrtable
TRANS STATE

→ Op

× TableName

× TableInfo

× SsqlCol LIST

× TsqlClassName
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× TsqlCol LIST

→ (TRANS STATE × Op) RESULT

entertable
TRANS STATE

→ TableName

× TableInfo

× SsqlCol LIST

× TsqlClassName

× TsqlCol LIST

→ (TRANS STATE × Op) RESULT

enter scope TRANS STATE → TRANS STATE

gettableinf o
TableSpecification

→ TableInfo

× ConstraintInfo

× SsqlCol LIST

× TsqlClassName

× TsqlCol LIST

lookuplocaltableinf o

TRANS STATE → TableInfo LIST RESULT

lookupparamdata

TRANS STATE → Op → (Value × Class) RESULT

in new scope (TRANS STATE → ′a → ′b) → TRANS STATE → ′a → ′b

repr col TsqlRepr → Col spec RESULT

all data columnslocal
TRANS STATE → Col spec LIST RESULT

binop type Op × ColType → SwordType RESULT

monop type Op × SwordType → SwordType RESULT

triop type Op × SwordType × ColType → SwordType RESULT

set func type
Op × SwordType → SwordType RESULT

check boolean
ExpType → ExpType RESULT

check type conversion
ColType → Maybe RESULT

convertcolspec
Col spec → ColumnSpecification

class column TRANS STATE → Col spec → (Col spec + Class) RESULT

denote name TsqlRepr → Value

column data test
TRANS STATE → Col spec → Value LIST RESULT

col exp ExpType → ColType RESULT

col target SsqlCol → TsqlCol RESULT

converttablespec
Table spec → TableSpecification

constant valuetype
Value → SwordType

convertssqltype
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Type → SwordType

convert tableSpecification backup
Col × Worth → Col RESULT

converttableSpecif cation
TableSpecification → Table spec RESULT

table name TableSpecification → Op

convertswordtype

SwordType → Type

converttype
Type → Type

denoteclassexp
ExpClass → Value

lubboundinf o

BoundInfo × BoundInfo → BoundInfo

lubexpclass

ExpClass × ExpClass → ExpClass

lubtype ColType → SwordType

lubcoltype

ColType × ColType → ColType

lubworth

Worth × Worth → Worth

lubexp ExpType × ExpType → ExpType

lubssqlname

SsqlName × SsqlName → SsqlName

lubssqlcol

SsqlCol × SsqlCol → SsqlCol

lubtableinf o

TableInfo × TableInfo → TableInfo

lubtsqlclassname

TsqlClassName × TsqlClassName → TsqlClassName

lubtsqlname

TsqlName × TsqlName → TsqlName

lubtsqlcol

TsqlCol × TsqlCol → TsqlCol

makesv TsqlCol × TsqlCol → Value LIST RESULT

remove constants
(Col spec + Class) LIST → Col spec LIST

remove nulls TsqlRepr LIST → TsqlRepr LIST

upper ExpClass → Class

make case Value × ExpClass → Value

simplifyands

Value LIST × ExpClass LIST → Value × ExpClass

simplifyors

Value LIST × ExpClass LIST → Value × ExpClass

constant valuedata
Value → Value

dinary columns
TRANS STATE → Col spec LIST → Col spec LIST RESULT
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sterling columns
TRANS STATE → Col spec LIST → Col spec LIST RESULT

tuple listmaxrowclass

TRANS STATE → Tuple list → ExpClass

upb row class
TableInfo → Class

valuedata
TRANS STATE → Value → Value

valuetype
TRANS STATE → Value → ExpType

valueclass
(TRANS STATE → Value → InternalExpClass RESULT )
→ TRANS STATE

→ Value

→ ExpClass RESULT

tuple listdata
TRANS STATE → Tuple list → Tuple list RESULT

tuple listtype
TRANS STATE → Tuple list → Tuple list RESULT

from specenter
TRANS STATE → From spec → From spec RESULT

select listtype
TRANS STATE → Select list → ExpType RESULT

select valuetype
TRANS STATE → Value → ExpType RESULT

tuple listinf o
TRANS STATE

→ Tuple list

→ (TableName × TableInfo × SsqlCol LIST ) RESULT

tuple listmake

TRANS STATE

→ Tuple list × TsqlClassName × TsqlCol LIST

→ Tuple list RESULT

from specinf o
TRANS STATE

→ From spec

→ (TableInfo
× SsqlCol LIST

× TsqlClassName

× TsqlCol LIST ) RESULT

select listinf o
TRANS STATE → Select list → SsqlCol LIST RESULT

select valueinf o
TRANS STATE → Value → SsqlCol RESULT

valueinf o
TRANS STATE → Value → SsqlCol RESULT

internal valueclass
TRANS STATE → Value → InternalExpClass RESULT
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tuple listclass
TRANS STATE → Tuple list → Tuple list

select listclass
TRANS STATE → Select list → Select list RESULT

select valueclass
TRANS STATE → Value → Value RESULT

select listmake

TRANS STATE

→ Select list × TsqlClassName × TsqlCol LIST

→ Value LIST RESULT

select valuemake

TRANS STATE → Value × TsqlCol LIST → Value LIST RESULT

make col TRANS STATE → Value × TsqlCol → Value LIST RESULT

makedinary
TRANS STATE → Value × ExpType → Value RESULT

makesterling
TRANS STATE → Value × ExpType → Value RESULT

select listdata
TRANS STATE → Select list → Select list RESULT

select valuedata
TRANS STATE → Value → Value RESULT

tuple listmakeouter

TRANS STATE

→ Tuple list × Bool × TsqlClassName × TsqlCol LIST

→ (Tuple list × Query LIST ) RESULT

tuple listouterinf o
TRANS STATE → Tuple list → Bool RESULT

transformselectquery

TRANS STATE

→ Query

→ (SsqlCol LIST
× Query

× Bool

× TsqlClassName

× TsqlCol LIST

× Query LIST ) RESULT

queryselectquery

TRANS STATE → Query → Query RESULT

STP (Query , FILTER PARS ) STP TYPE

26.4 Types

TRANS STATE

26.5 Definitions

internalError
wrongWorth
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notTrigger
onlyInTriggers
notMonadic
notDyadic
notTriadic
notSetFunction
noSuchParameter
noScope
wrongScope
ambiguousName
emptyUnionList

⊢ true

TRANS STATE ⊢ ∃ f • TypeDefn (λ x• true) f

MkTRANS STATE
st stack
query class
query constants class
client clearance

⊢ ∀ t x1 x2 x3 x4

• st stack (MkTRANS STATE x1 x2 x3 x4 ) = x1

∧ query class (MkTRANS STATE x1 x2 x3 x4 ) = x2

∧ query constants class

(MkTRANS STATE x1 x2 x3 x4 )
= x3

∧ client clearance (MkTRANS STATE x1 x2 x3 x4 )
= x4

∧ MkTRANS STATE

(st stack t)
(query class t)
(query constants class t)
(client clearance t)

= t

check enum
check fixed
check floating
check interval
check time
timeFormatToInterval
unique name
contextual data
default directory

⊢ true

init trans state
⊢ ∀ c

• init trans state c

= MkTRANS STATE (MkST STACK [] []) c c c

findcolumn

⊢ ∀ cs tdl

Page 160 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

• findco l umn (cs, tdl)
= (let look (n, td , scl , tcl)

= (let sctcl = splice scl tcl

in let sctcl ′

= sctcl

↾ {(sc, tc)
|sc name sc = mk names n}

in Map

(λ (sc, tc)• (td , sc, tc))
sctcl ′)

in let do1td td

= CASE

cs

[WHEN anonymous column col

• look

(col , td , td columns td ,
td implementation td);

WHEN specific (ts, col)
• CASE

(td tableName td)
[WHEN namet n ts

• look

(col , td ,
td columns td ,
td implementation

td);
OTHERS []]]

in Flat (Map do1td tdl))
findident

⊢ ∀ cs idl

• find i d en t (cs, idl)
= CASE

cs

[WHEN specific (t , c)• [];
WHEN anonymous column col

• idl ↾ {id |col = id identName id}]
lookup column info look

⊢ ConstSpec

(λ lookup column info look ′

• ∀ cs ti outer

• lookup column info look ′ (cs, [])
= Exception [noSuchColumn]

∧ lookup column info look ′

(cs, outer @ [ti ])
= (let t = s tables ti

in let tdsctcl

= findco l umn (cs, t)
in if tdsctcl = []
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then

lookup column info look ′

(cs, outer)
else if Tail tdsctcl = []
then

let (td , sc, tc) = Head tdsctcl

in Ok (td info td , sc)
else Exception [ambiguousName]))

lookup column info look

lookupcolumninf o

⊢ ∀ st cs

• lookupco l umnin f o st cs

= lookup column info look

(cs, symbolTable (st stack st))
maxBound ⊢ ∀ bi

• maxBound bi

= CASE bi [WHEN upb c• c; WHEN constant c• c]
innermost ⊢ ConstSpec

(λ innermost ′

• ∀ outer inner

• innermost ′ [] = []
∧ innermost ′ (outer @ [inner ])
= (let tds = s tables inner

in if tds = []
then innermost ′ outer @ [inner ]
else [inner ]))

innermost

lookup col spec class look
⊢ ConstSpec

(λ lookup col spec class look ′

• ∀ cs outer ti

• lookup col spec class look ′ (cs, [])
= Exception [noSuchColumn]

∧ lookup col spec class look ′

(cs, outer @ [ti ])
= (let (t , i)

= (s tables ti , s identifiers ti)
in let cds = findco l umn (cs, t)
and ids = find i d en t (cs, i)
in if ids = []
then

if cds = []
then

lookup col spec class look ′

(cs, outer)
else if Tail cds = []
then

let (td , sc, tc) = Head cds
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in let u

= maxBound

(sc col class sc)
in CASE

(tc class name tc)
[WHEN anont c

(Exception
[internalError ]);

WHEN namet c s

• Ok

(mk column

(td genCorr td ,
s), u);

WHEN constant t c c

• Ok

(mk constant class

c, u)]
else Exception [ambiguousName]

else if cds = [] ∧ Tail ids = []
then

let id = Head ids

in let cl = id lubi d id

in CASE

(id cName id)
[WHEN nonet

(Ok

(mk constant class

cl , cl)); WHEN anont (Exception [internalError ]);
WHEN namet s

• Ok

(mk local identifier

s, cl)]
else Exception [ambiguousName]))

lookup col spec class look

lookupcolspecclass

⊢ ∀ st flg cs

• lookupco l specc l a s s st (flg , cs)
= (if flg

then

lookup col spec class look

(cs, innermost (symbolTable (st stack st)))
else

lookup col spec class look

(cs, symbolTable (st stack st)))
lookup col spec dinary look

⊢ ConstSpec

(λ lookup col spec dinary look ′

• ∀ cs outer ti
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• lookup col spec dinary look ′ (cs, [])
= Exception [noSuchColumn]

∧ lookup col spec dinary look ′

(cs, outer @ [ti ])
= (let (t , i)

= (s tables ti , s identifiers ti)
in let cds = findco l umn (cs, t)
and ids = find i d en t (cs, i)
in if ids = []
then

if cds = []
then

lookup col spec dinary look ′

(cs, outer)
else if Tail cds = []
then

let (td , sc, tc) = Head cds

in CASE

(tc dinary name tc)
[WHEN nonet

(Exception
[internalError ]);

WHEN anont

(Exception
[internalError ]);

WHEN namet s

• Ok

(mk column

(td genCorr td ,
s))]

else Exception [ambiguousName]
else if cds = [] ∧ Tail ids = []
then

let id = Head ids

in let (st , w) = id info id

in if w = dinary

then

Ok

(mk local identifier

(id vName id))
else Ok c constant null

else Exception [ambiguousName]))
lookup col spec dinary look

lookupcolspecdinary

⊢ ∀ st flg cs

• lookupco l specd i nar y st (flg , cs)
= (if flg

then

Page 164 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

lookup col spec dinary look

(cs, innermost (symbolTable (st stack st)))
else

lookup col spec dinary look

(cs, symbolTable (st stack st)))
lookup col spec sterling look

⊢ ConstSpec

(λ lookup col spec sterling look ′

• ∀ cs outer ti

• lookup col spec sterling look ′ (cs, [])
= Exception [noSuchColumn]

∧ lookup col spec sterling look ′

(cs, outer @ [ti ])
= (let (t , i)

= (s tables ti , s identifiers ti)
in let cds = findco l umn (cs, t)
and ids = find i d en t (cs, i)
in if ids = []
then

if cds = []
then

lookup col spec sterling look ′

(cs, outer)
else if Tail cds = []
then

let (td , sc, tc) = Head cds

in CASE

(tc sterling name tc)
[WHEN nonet

(Exception
[internalError ]);

WHEN anont

(Exception
[internalError ]);

WHEN namet s

• Ok

(mk column

(td genCorr td ,
s))]

else Exception [ambiguousName]
else if cds = [] ∧ Tail ids = []
then

let id = Head ids

in let (st , w) = id info id

in if w = sterling

then

Ok

(mk local identifier
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(id vName id))
else Ok c constant null

else Exception [ambiguousName]))
lookup col spec sterling look

lookupcolspecsterling

⊢ ∀ st flg cs

• lookupco l specs t e r l i n g st (flg , cs)
= (if flg

then

lookup col spec sterling look

(cs, innermost (symbolTable (st stack st)))
else

lookup col spec sterling look

(cs, symbolTable (st stack st)))
lookuplocalcolimplementation

⊢ ∀ st

• lookup l oca l co l impl emen t a t i on

st

= (let extract implementation sc

= Fold

$@
(Map td implementation (s tables sc))
[]

in let trs

= Fold

$@
(Map

extract implementation

(innermost

(symbolTable (st stack st))))
[]

in if trs = []
then Exception [noScope]
else Ok trs)

lookuplocalcolinf o

⊢ ∀ st

• lookup l oca l co l i n f o st

= (let extract columns sc

= Fold $@ (Map td columns (s tables sc)) []
in let trs

= Fold

$@
(Map

extract columns

(innermost

(symbolTable (st stack st))))
[]

in if trs = []
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then Exception [noScope]
else Ok trs)

lookuplocalcolspecclasses

⊢ ∀ st

• lookup l oca l co l specc l a s s e s st

= (let look2 (corr , sc, tc)
= (let u = maxBound (sc col class sc)
in CASE

(tc class name tc)
[WHEN anont c

(Exception [internalError ]);
WHEN namet c s

• Ok (mk column (corr , s), u);
WHEN constant t c c

• Ok (mk constant class c, u)])
in let look1 td

= at3

(Map look2 )
(seq

(# (td columns td))
(td genCorr td), td columns td ,

td implementation td)
in let look sc

= Fold $@ (Map look1 (s tables sc)) []
in let trs

= Fold

$@
(Map

look

(innermost

(symbolTable

(st stack st))))
[]

in if trs = []
then Exception [noScope]
else ListOk trs)

lookuplocalcolspecsterlings

⊢ ∀ st

• lookup l oca l co l specs t e r l i n g s st

= (let look2 (corr , tc)
= CASE

(tc sterling name tc)
[WHEN nonet (Ok c constant null);

WHEN anont

(Exception [internalError ]);
WHEN namet s

• Ok (mk column (corr , s))]
in let look1 td
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= at2

(Map look2 )
(seq

(# (td columns td))
(td genCorr td),

td implementation td)
in let look sc

= Fold $@ (Map look1 (s tables sc)) []
in let trs

= Fold

$@
(Map

look

(innermost

(symbolTable

(st stack st))))
[]

in if trs = []
then Exception [noScope]
else ListOk trs)

lookuplocalrowclasses

⊢ ∀ st

• lookup l oca l r ow cl a s s e s st

= (let look1 td

= CASE

(td rowClass td)
[WHEN anont c

(Exception [internalError ]);
WHEN namet c s

• Ok

(mk column (td genCorr td , s));
WHEN constant t c c

• Ok (mk constant class c)]
in let look sc = Map look1 (s tables sc)
in let trs

= Fold

$@
(Map

look

(innermost

(symbolTable (st stack st))))
[]

in if trs = []
then Exception [noScope]
else ListOk trs)

lookup column row class look
⊢ ConstSpec

(λ lookup column row class look ′
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• ∀ st cs outer ti

• lookup column row class look ′ st (cs, [])
= Exception [noSuchColumn]

∧ lookup column row class look ′

st

(cs, outer @ [ti ])
= (let (t , i)

= (s tables ti , s identifiers ti)
in let cds = findco l umn (cs, t)
and ids = find i d en t (cs, i)
in if ids = []
then

if cds = []
then

lookup column row class look ′

st

(cs, outer)
else if Tail cds = []
then

let (td , sc, tc) = Head cds

in CASE

(td rowClass td)
[WHEN anont c

(Exception
[internalError ]);

WHEN namet c s

• Ok

(mk column

(td genCorr td ,
s)); WHEN constant t c c• Ok (mk constant class c)]

else Exception [ambiguousName]
else if cds = [] ∧ Tail ids = []
then

let id = Head ids

in Ok

(mk constant class

(query class st))
else Exception [ambiguousName]))

lookup column row class look

lookupcolumnrowclass

⊢ ∀ st flg cs

• lookupco l umnr ow cl a s s st (flg , cs)
= (if flg

then

lookup column row class look

st

(cs, innermost (symbolTable (st stack st)))
else
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lookup column row class look

st

(cs, symbolTable (st stack st)))
lookup table row class look

⊢ ConstSpec

(λ lookup table row class look ′

• ∀ ts outer ti

• lookup table row class look ′ (ts, [])
= Exception [noSuchTable]

∧ lookup table row class look ′

(ts, outer @ [ti ])
= (let look1 (ts, td)

= CASE

(td tableName td)
[WHEN anont n [];

WHEN namet n tn

• if ts = tn

then

CASE

(td rowClass td)
[WHEN anont c

[Exception
[internalError ]];

WHEN namet c s

• [Ok

(mk column

(td genCorr td , s))];
WHEN constant t c

c

• [Ok

(mk constant class

c)]]
else []]

in let (tds, ids)
= (s tables ti , s identifiers ti)

in let trs

= Fold

$@
(at2

(Map look1 )
(seq (# tds) ts, tds))

[]
in if trs = []
then

lookup table row class look ′

(ts, outer)
else if Tail trs = []
then Head trs
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else Exception [ambiguousName]))
lookup table row class look

lookuptablerowclass

⊢ ∀ st flg ts

• lookupt a b l e r ow cl a s s st (flg , ts)
= (if flg

then

lookup table row class look

(ts, innermost (symbolTable (st stack st)))
else

lookup table row class look

(ts, symbolTable (st stack st)))
lookup table detail look

⊢ ConstSpec

(λ lookup table detail look ′

• ∀ ts outer ti

• lookup table detail look ′ (ts, [])
= Exception [noSuchTable]

∧ lookup table detail look ′

(ts, outer @ [ti ])
= (let look1 (ts, td)

= CASE

(td tableName td)
[WHEN anont n [];

WHEN namet n tn

• if ts = tn

then [td ]
else []]

in let (tds, ids)
= (s tables ti , s identifiers ti)

in let tis

= Fold

$@
(at2

(Map look1 )
(seq (# tds) ts, tds))

[]
in if tis = []
then

lookup table detail look ′

(ts, outer)
else if Tail tis = []
then Ok (Head tis)
else Exception [ambiguousName]))

lookup table detail look

lookuptabledetail

⊢ ∀ st ts

• lookupt a b l ed e t a i l st ts
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= lookup table detail look

(ts, symbolTable (st stack st))
update top scope

⊢ ∀ st sc

• update top scope st sc

= (let stk = st stack st

in let symt = symbolTable stk

in let outer = Rev (Tail (Rev symt))
in let symt ′ = outer @ [sc]
in MkTRANS STATE

(MkST STACK symt ′ (parameterTable stk))
(query class st)
(query constants class st)
(client clearance st))

enteridentif ier
⊢ ∀ st name et up

• enter i d en t i f i e r st (name, et , up)
= (let fynd (n, id)

= (if n = id identName id

then [id ]
else [])

in let sl = symbolTable (st stack st)
in if sl = []
then Exception [noScope]
else

(let outer = Rev (Tail (Rev sl))
in let ti = Head (Rev sl)
in let (tds, ids)

= (s tables ti , s identifiers ti)
in if tds = []
then

let unv = unique name st

in let unc = unique name st

in let id

= MkIdentDetail

name

et

up

unv

(mk namet unc)
in if

¬ at2

(Map fynd)
(seq (# ids) name,

ids)
= []

then

Exception [ambiguousName]
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else

(let sc′

= MkScope

[]
(ids @ [id ])

in Ok

(update top scope

st

sc′, unv , unc))
else Exception [wrongScope]))

enteridentif erconstantclass
⊢ ∀ st name et clasf

• enter i d en t i f e r cons t an t c l a s s
st

(name, et , clasf )
= (let fynd (n, id)

= (if n = id identName id

then [id ]
else [])

in let sl = symbolTable (st stack st)
in if sl = []
then Exception [noScope]
else

(let outer = Rev (Tail (Rev sl))
in let ti = Head (Rev sl)
in let (tds, ids)

= (s tables ti , s identifiers ti)
in if tds = []
then

let unv = unique name st

in let id

= MkIdentDetail

name

et

clasf

unv

c anont

in if

¬ at2

(Map fynd)
(seq (# ids) name, ids)

= []
then Exception [ambiguousName]
else

(let sc′

= MkScope

[]
(ids @ [id ])
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in Ok

(update top scope st sc′,
unv))

else Exception [wrongScope]))
extractparameter

⊢ ∀ name l

• extractpar amet er (name, l)
= l ↾ {pi |pi name pi = name}

enterparameter

⊢ ∀ st name v clasf

• enterpar amet er st (name, v , clasf )
= (let sl = symbolTable (st stack st)
in let pt = parameterTable (st stack st)
in if sl = []
then Exception [noScope]
else if

extractpar amet er (name, pt) = []
then

Ok

(MkTRANS STATE

(MkST STACK

sl

(pt
@ [MkParamInfo

name

v

clasf ]))
(query class st)
(query constants class st)
(client clearance st))

else Exception [ambiguousName])
entercorrtable

⊢ ∀ st cn ts ti scs rcn tcs

• entercor r t ab l e
st

(cn, ts, ti , scs, rcn, tcs)
= (let sl = symbolTable (st stack st)
in if sl = []
then Exception [noScope]
else

(let outer = Rev (Tail (Rev sl))
in let t = Head (Rev sl)
in let (tds, ids)

= (s tables t , s identifiers t)
in if ids = []
then

let gc = unique name st

in let td
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= MkTableDetail

ts

(mk names cn)
gc

ti

scs

rcn

tcs

(MkConstraintInfo

[]
[]
[]
[]
[])

in let sc′

= MkScope (tds @ [td ]) []
in Ok

(update top scope st sc′, gc)
else Exception [wrongScope]))

entertable
⊢ ∀ st ts ti scs rcn tcs

• enter t a b l e st (ts, ti , scs, rcn, tcs)
= (let sl = symbolTable (st stack st)
in if sl = []
then Exception [noScope]
else

(let outer = Rev (Tail (Rev sl))
in let t = Head (Rev sl)
in let (tds, ids)

= (s tables t , s identifiers t)
in if ids = []
then

let gc = unique name st

in let td

= MkTableDetail

ts

c anons

gc

ti

scs

rcn

tcs

(MkConstraintInfo

[]
[]
[]
[]
[])
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in let sc′

= MkScope (tds @ [td ]) []
in Ok

(update top scope st sc′, gc)
else Exception [wrongScope]))

enter scope ⊢ ∀ st

• enter scope st

= (let stk = st stack st

in let symt = symbolTable stk

in let outer = Rev (Tail (Rev symt))
in let symt ′ = outer @ []
in MkTRANS STATE

(MkST STACK symt ′ (parameterTable stk))
(query class st)
(query constants class st)
(client clearance st))

gettableinf o
⊢ true

lookuplocaltableinf o

⊢ ∀ st

• lookup l oca l t a b l e i n f o st

= (let look sc = Map td info (s tables sc)
in let trs

= Fold

$@
(Map

look

(innermost

(symbolTable (st stack st))))
[]

in if trs = []
then Exception [noScope]
else Ok trs)

lookupparamdata

⊢ ∀ st name

• lookuppar amda t a st name

= (let infos

= extractpar amet er

(name, parameterTable (st stack st))
in if infos = []
then Exception [noSuchParameter ]
else if Tail infos = []
then

let info = Head infos

in Ok (pi valp info, pi clasf info)
else Exception [internalError ])

in new scope ⊢ ∀ what

• in new scope what
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= (λ st a• what (enter scope st) a)
repr col ⊢ ∀ tr

• repr col tr

= CASE

tr

[WHEN local identifier name

• Ok (denote col spec [name]);
WHEN column (corr , col)
• Ok (denote col spec [corr ; col ]);

WHEN constant class c

• Exception [internalError ];
WHEN constant null

(Exception [internalError ])]
all data columnslocal

⊢ ∀ st

• all data columns l oca l st

= Try

(ListOk o Map repr col)
(lookup l oca l co l specs t e r l i n g s

st)
check type conversion
check boolean
set func type
triop type
monop type
binop type ⊢ true

convertcolspec
⊢ ConstSpec

(λ convertco l spe
′
c

• ∀ il

• convertco l spe
′
c (denote col spec il)

= (let col = Head (Rev il)
in let dir = Head (Tail (Rev il))
in let tab = Tail (Tail (Rev il))
in mk specific

(mk absolute (tab, dir), col)))
convertco l spec

class column ⊢ ∀ st cs

• class column st cs

= (let csc

= lookupco l specc l a s s
st

(true, convertco l spec cs)
in if isVal csc

then

let (tr , lub cl) = destVal csc

in CASE

tr
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[WHEN local identifier name

• Ok (InL (denote col spec [name]));
WHEN column (gen corr , gen col)
• Ok

(InL
(denote col spec

[gen corr ; gen col ]));
WHEN constant class cl• Ok (InR cl);
WHEN constant null

(Exception [internalError ])]
else giveError (destError csc))

denote name ⊢ ∀ tr

• denote name tr

= CASE

tr

[WHEN local identifier s

• contents (denote col spec [s]);
WHEN column (cn, col)
• contents (denote col spec [cn; col ]);

WHEN constant class c• denote class c;
WHEN constant null denote null ]

column data test
⊢ ∀ st cs

• column data test st cs

= (let csc

= lookupco l specc l a s s
st

(true, convertco l spec cs)
in if isVal csc

then

let (tr , u) = destVal csc

in if client clearance st dom u

then Ok []
else

(let cc

= denote class

(client clearance st)
in Ok

[binop ”dom” (cc, denote name tr)])
else giveError (destError csc))

col exp ⊢ ∀ t w

• col exp (t , w)
= (if w = dinary

then Ok (c nullType, t)
else if w = sterling

then Ok (t , c nullType)
else if w = worthless

then Ok (t , c nullType)
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else Exception [wrongType])
col target ⊢ ∀ sc

• col target sc

= (let bound bi

= CASE

bi

[WHEN upb c• c anont c ;
WHEN constant c• mk constant t c c]

in let target ((s, d), c)
= (if s = c nullType ∧ d = c nullType

then Exception [internalError ]
else if d = c nullType

then Ok (MkTsqlCol c anont c nonet c)
else if s = c nullType

then Ok (MkTsqlCol c nonet c anont c)
else

Ok (MkTsqlCol c anont c anont c))
in target

(sc type field sc,
bound (sc col class sc)))

converttablespec
⊢ ConstSpec

(λ convert t a b l e spe
′
c

• ∀ il

• convert t a b l e spe
′
c

(denote table spec il)
= (let tab = Head (Rev il)
in let dir = Tail (Rev il)
in mk absolute (dir , tab)))

convert t a b l e spec
convertssqltype
constant valuetype

⊢ true

convert tableSpecification backup
⊢ ∀ d dirs n

• convert tableSpecification backup ([], 0 ) = Ok []
∧ convert tableSpecification backup

(Cons d dirs, 0 )
= Ok (Cons d dirs)

∧ convert tableSpecification backup ([], n + 1 )
= Exception [noSuchDirectory ]

∧ convert tableSpecification backup

(Cons d dirs, n + 1 )
= convert tableSpecification backup (dirs, n)

converttableSpecif cation
⊢ ∀ ts

• convert t a b l eS peci f ca t i on ts

= CASE
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ts

[WHEN absolute (directory , table)
• Ok

(denote table spec

(directory @ [table]));
WHEN default (up, directory , table)
• (let dir

= convert tableSpecification backup

(default directory , up)
in if isError dir

then giveError (destError dir)
else

Ok

(denote table spec

(destVal dir
@ directory

@ [table])))]
table name ⊢ ∀ ts

• table name ts

= (let dot s = s @ ”.”
in CASE

ts

[WHEN absolute (dir , tab)
• if dir = []
then tab

else Fold $@ (Map dot dir) [] @ tab;
WHEN default (up, dir , tab)
• if dir = []
then Flat (seq up ”−”) @ tab

else

Flat (seq up ”−”)
@ Fold $@ (Map dot dir) []
@ tab])

convertswordtype

⊢ true

converttype
⊢ ∀ t

• convert t y pe t

= convertsw or d t ype

(converts s q l t y pe t)
denoteclassexp

⊢ ∀ ec

• denotecl a s s ex p ec

= CASE

ec

[WHEN variable (v , c)• v ;
WHEN constantec c• denote class c]

lubboundinf o
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⊢ ∀ bi1 bi2

• lubbound i n f o (bi1 , bi2 )
= CASE

bi1

[WHEN upb c1

• CASE

bi2

[WHEN upb c2• mk upb (c1 lub c2 );
WHEN constant c2

• mk upb (c1 lub c2 )];
WHEN constant c1

• CASE

bi2

[WHEN upb c2• mk upb (c1 lub c2 );
WHEN constant c2

• if c1 = c2

then bi1

else mk upb (c1 lub c2 )]]
lubexpclass

⊢ ∀ ec1 ec2

• lubex pcl a s s (ec1 , ec2 )
= CASE

ec1

[WHEN variable (v1 , c1 )
• CASE

ec2

[WHEN variable (v2 , c2 )
• mk variable

(binop ”lub” (v1 , v2 ),
c1 lub c2 );

WHEN constantec c2

• mk variable

(binop
”lub”
(v1 ,

denote class c2 ),
c1 lub c2 )];

WHEN constantec c1

• CASE

ec2

[WHEN variable (v2 , c2 )
• mk variable

(binop
”lub”
(v2 ,

denote class c1 ),
c1 lub c2 );

WHEN constantec c2
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• mk constantec (c1 lub c2 )]]
lubtype ⊢ true

lubcoltype

⊢ ∀ s1 d1 s2 d2

• lubco l t y pe ((s1 , d1 ), s2 , d2 )
= (lubt y pe (s1 , s2 ), lubt y pe (d1 , d2 ))

lubworth

⊢ ∀ w1 w2

• lubwor t h (w1 , w2 )
= (if w1 = w2

then w1

else if w2 = worthless

then w1

else if w1 = worthless

then w2

else priceless)
lubexp ⊢ ∀ t1 w1 t2 w2

• lubex p ((t1 , w1 ), t2 , w2 )
= (lubt y pe (t1 , t2 ), lubwor t h (w1 , w2 ))

lubssqlname

⊢ ∀ sn1 sn2

• lubs s q l name (sn1 , sn2 )
= CASE

sn1

[WHEN names s1

• CASE

sn2

[WHEN names s2

• if s1 = s2

then sn1

else c anons ; OTHERS c anons ];
OTHERS c anons ]

lubssqlcol

⊢ ConstSpec

(λ lubs s q l co
′
l

• ∀ n1 t1 ce1 cc1 n2 t2 ce2 cc2

• lubs s q l co
′
l

(MkSsqlCol n1 t1 ce1 cc1 ,
MkSsqlCol n2 t2 ce2 cc2 )

= MkSsqlCol

(lubs s q l name (n1 , n2 ))
(lubco l t y pe (t1 , t2 ))
(ce1 lub ce2 )
(lubbound i n f o (cc1 , cc2 )))

lubs s q l co l
lubtableinf o

⊢ ConstSpec

(λ lubt a b l e i n f
′
o
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• ∀ tec1 tc1 rc1 tec2 tc2 rc2

• lubt a b l e i n f
′
o

(MkTableInfo tec1 tc1 rc1 ,
MkTableInfo tec2 tc2 rc2 )

= MkTableInfo

(tec1 lub tec2 )
(tc1 lub tc2 )
(lubbound i n f o (rc1 , rc2 )))

lubt a b l e i n f o
lubtsqlclassname

⊢ ∀ tcn1 tcn2

• lubt s q l c l a s sname (tcn1 , tcn2 )
= CASE

tcn1

[WHEN namet c s1

• CASE

tcn2

[WHEN namet c s2

• if s1 = s2

then tcn1

else c anont c ;
OTHERS c anont c ];

OTHERS c anont c ]
lubtsqlname

⊢ ∀ tn1 tn2

• lubt s q l name (tn1 , tn2 )
= CASE

tn1

[WHEN namet s1

• CASE

tn2

[WHEN namet s2

• if s1 = s2

then tn1

else c anont ; OTHERS c anont ];
WHEN nonet

(CASE
tn2

[WHEN nonet c nonet ;
OTHERS c anont ]);

OTHERS c anont ]
lubtsqlcol

⊢ ConstSpec

(λ lubt s q l co
′
l

• ∀ s1 d1 c1 s2 d2 c2

• lubt s q l co
′
l

(MkTsqlCol s1 d1 c1 , MkTsqlCol s2 d2 c2 )
= MkTsqlCol
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(lubt s q l name (s1 , s2 ))
(lubt s q l name (d1 , d2 ))
(lubt s q l c l a s sname (c1 , c2 )))

lubt s q l co l
makesv ⊢ ∀ f t

• makes v (f , t)
= (let data col (ftn, ttn)

= CASE

ftn

[WHEN nonet
(CASE

ttn

[WHEN nonet (Ok []);
WHEN anont

(Ok [denote null ]);
WHEN namet ts

• Exception

[internalError ]]);
WHEN anont

(CASE
ttn

[WHEN nonet
(Ok [denote null ]);

OTHERS

(Exception
[internalError ])]);

WHEN namet fs

• CASE

ttn

[WHEN anont

(Ok

[contents
(denote col spec

[fs])]);
WHEN namet ts

• Ok

[contents
(denote col spec

[fs])]; WHEN nonet (Exception [internalError ])]]
in let class col (fcn, tcn)

= CASE

fcn

[WHEN constant t c fc

• CASE

tcn

[WHEN constant t c tc

• if fc = tc

then Ok []
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else

Exception

[internalError ];
WHEN namet c tn

• Ok [denote class fc];
WHEN anont c

(Exception
[internalError ])];

WHEN namet c f

• CASE

tcn

[WHEN constant t c tc

• Exception

[internalError ];
WHEN namet c tn

• Ok

[contents
(denote col spec

[f ])];
WHEN anont c

(Ok

[contents
(denote col spec [f ])])];

WHEN anont c

(Exception [internalError ])]
in let ssv

= data col

(tc sterling name f ,
tc sterling name t)

in let dsv

= data col

(tc dinary name f ,
tc dinary name t)

in let csv

= class col

(tc class name f ,
tc class name t)

in if

isError ssv

∨ isError dsv

∨ isError csv

then Exception [internalError ]
else

Ok

(destVal ssv
@ destVal dsv

@ destVal csv))
remove constants
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⊢ ∀ x s

• remove constants [] = []
∧ remove constants (Cons x s)
= (if IsL x

then Cons (OutL x ) (remove constants s)
else remove constants s)

remove nulls ⊢ ∀ x trs

• remove nulls [] = []
∧ remove nulls (Cons x trs)
= CASE

x

[WHEN constant null (remove nulls trs);
OTHERS (Cons x (remove nulls trs))]

upper ⊢ ∀ ec

• upper ec

= CASE

ec

[WHEN variable (c, u)• u;
WHEN constantec u• u]

make case ⊢ ∀ data ec

• make case (data, ec)
= CASE

ec

[WHEN variable (c, u)
• case [data] [denote class lattice top] c;
WHEN constantec c

• case

[data]
[denote class lattice top]
(denote class c)]

simplifyands

⊢ ∀ vs cs

• simplifyand s (vs, cs)
= (let v = fold (binop And) vs

in let c

= case

[v ]
[fold

(binop ”lub”)
(Map denotecl a s s ex p cs)]

(fold
(binop ”glb”)
(at2 (Map make case) (vs, cs)))

in let u = fold (Uncurry $lub) (Map upper cs)
in (v , mk variable (c, u)))

simplifyors

⊢ ∀ vs cs

• simplifyor s (vs, cs)
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= (let v = fold (binop Or) vs

in let c

= case

[v ]
[fold

(binop ”glb”)
(Map denotecl a s s ex p cs)]

(fold
(binop ”lub”)
(at2 (Map make case) (vs, cs)))

in let u = fold (Uncurry $lub) (Map upper cs)
in (v , mk variable (c, u)))

constant valuedata
⊢ true

dinary columns
⊢ ∀ st css

• dinary columns st css

= (let look cs

= lookupco l specd i nar y
st

(false, convertco l spec cs)
in Try

(ListOk o Map repr col o remove nulls)
(ListOk (Map look css)))

sterling columns
⊢ ∀ st css

• sterling columns st css

= (let look cs

= lookupco l specs t e r l i n g
st

(false, convertco l spec cs)
in Try

(ListOk o Map repr col o remove nulls)
(ListOk (Map look css)))

tuple listmaxrowclass

⊢ ∀ st t

• tuple listmax r ow cl a s s st t

= mk constantec (client clearance st)
upb row class

⊢ ConstSpec

(λ upb row class ′

• ∀ tec tc rowc

• upb row class ′ (MkTableInfo tec tc rowc)
= CASE

rowc

[WHEN upb rc• rc; WHEN constant rc• rc])
upb row class

valuetype
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valuedata
⊢ true

valueclass
⊢ ∀ st ivc v

• valuecl a s s ivc st v

= (let x = ivc st v

in if isError x

then giveError (destError x )
else

Ok

(CASE
(destVal x )
[WHEN ands (datas, classes)

• (let (v , c)
= simplifyand s
(datas, classes) in c);

WHEN ors (datas, classes)
• (let (v , c)

= simplifyor s
(datas, classes) in c);

WHEN simple ec

• CASE

ec

[WHEN variable (exp, up)
• mk variable (exp, up);
WHEN constantec c

• mk constantec c]]))
queryselectquery

transformselectquery

tuple listouterinf o
tuple listmakeouter

select valuedata
select listdata
makesterling
makedinary
make col
select valuemake

select listmake

select valueclass
select listclass
tuple listclass
internal valueclass
valueinf o
select valueinf o
select listinf o
from specinf o
tuple listmake

tuple listinf o
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select valuetype
select listtype
from specenter
tuple listtype
tuple listdata

⊢ true

STP ⊢ ∀ q c

• STP (q , c)
= (let st = init trans state c

in let res

= transforms e l ect quer y st q

in if isError res

then giveError (destError res)
else

Ok

(let (scs, tq , scw , rc, tcs, chks)
= destVal res

in let dynamic tc

⇔ CASE

tc

[WHEN constant t c c• false;
OTHERS true]

in let cc

= Map

(dynamic o tc class name)
tcs

in let cr

= (if dynamic rc

then InL c

else InR maybe)
in let cq

= (if chks = []
then InR maybe

else InL (Head chks))
in (tq , cq , scw , cr , cc)))

27 THE THEORY fef031

27.1 Parents

fef034 fef026

27.2 Children

fef033
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27.3 Constants

Viewt secureE
Bool

outputFilter secureE
Bool

27.4 Definitions

Viewt secureE
⊢ View t secureE

⇔ (∀ c s1 s2

• hide (c, s1 ) = hide (c, s2 )
⇒ Map (HideDerTable c) (View t (reprState s1 ))
= Map

(HideDerTable c)
(View t (reprState s2 )))

outputFilter secureE
⊢ outputFilter secureE

⇔ (∀ q c t1 t2 dq ocq fps

• ¬ isError (STP (q , c))
∧ destVal (STP (q , c)) = (dq , ocq , fps)
∧ HideDerTable c t1 = HideDerTable c t2

⇒ outputFilter (c, (GiveData t1 , []), fps)
= outputFilter (c, (GiveData t2 , []), fps))

27.5 Theorems

map o lemma ⊢ ∀ f g list• Map f (Map g list) = Map (f o g) list

lub lemma ⊢ ∀ c• c lub c = c ∧ lubl [c] = c

dominates lub lemma
⊢ ∀ c1 c2 c3

• c1 dominates c2 lub c3

⇔ c1 dominates c2 ∧ c1 dominates c3

MkDerTable lemma
⊢ ∀ x1 x2 y1 y2

• MkDerTable x1 x2 = MkDerTable y1 y2

⇔ x1 = y1 ∧ x2 = y2

MkDerTableRow lemma
⊢ ∀ x1 x2 x3 y1 y2 y3

• MkDerTableRow x1 x2 x3 = MkDerTableRow y1 y2 y3

⇔ x1 = y1 ∧ x2 = y2 ∧ x3 = y3

Actt lemma ⊢ ∀ upd qdes

• Act t upd qdes

= (let (query , (dt , errs), st) = qdes

in if ¬ errs = []
then (st , [], errs)
else if is select query
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then (st , GiveData dt , errs)
else (upd (query , (dt , errs), st), [], []))

giveVal consistent
giveError consistent
destVal consistent
destError consistent
isVal consistent
isError consistent

⊢ Consistent

(λ
(giveVal ′, giveError ′, destVal ′, destError ′,

isVal ′, isError ′)
• ∀ v e ve

• giveVal ′ v = InL v

∧ giveError ′ e = InR e

∧ destVal ′ (giveVal ′ v) = v

∧ destError ′ (giveError ′ e) = e

∧ (isVal ′ ve ⇔ (∃ v1• ve = giveVal ′ v1 ))
∧ (isError ′ ve
⇔ (∃ e1• ve = giveError ′ e1 )))

EM SecureE Lemma1
∀ compile upd

• STP ∈ STP secure E compile

⇒ (EM 1 compile upd , STP , outputFilter)
∈ subsys secureE reprState

⊢ Correct Compile STP secure E ⇒ Subsys SecureE

EM SecureE Lemma2
View t secureE ,

outputFilter secureE ,
∀ t• GiveData t = [] ⇔ DT rows t = []

⊢ ∀ compile upd

• STP ∈ STP secure E compile

⇒ (EM 1 compile upd , STP , outputFilter)
∈ subsys secureE reprState

EM SecureE Lemma3
⊢ ∀ t• GiveData t = [] ⇔ DT rows t = []

EM SecureE thm
View t secureE , outputFilter secureE ⊢ EM SecureE

28 THE THEORY fef032

28.1 Parents

fef026

28.2 Children

fef033 fef034
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28.3 Constants

DenoteConstant
Class × ValuedItem OPT → VALUE COMP

MonOp (ValuedItem OPT → ValuedItem OPT )
→ VALUE COMP

→ VALUE COMP

ItemBool ValuedItem OPT → Bool

BoolItem Bool → ValuedItem OPT

ListAnd Bool LIST → Bool

ListOr Bool LIST → Bool

ComputeAnd Class

→ (Class × ValuedItem OPT ) LIST

→ Class × ValuedItem OPT

BinOpAnd Class → VALUE COMP LIST → VALUE COMP

ComputeOr Class

→ (Class × ValuedItem OPT ) LIST

→ Class × ValuedItem OPT

BinOpOr Class → VALUE COMP LIST → VALUE COMP

BinOp (ValuedItem OPT → ValuedItem OPT → ValuedItem OPT )
→ VALUE COMP

→ VALUE COMP

→ VALUE COMP

TriOp (ValuedItem OPT

→ ValuedItem OPT

→ ValuedItem OPT

→ ValuedItem OPT )
→ VALUE COMP

→ VALUE COMP

→ VALUE COMP

→ VALUE COMP

CheckList Class

→ ValuedItem OPT

→ ((Class × ValuedItem OPT ) × Class × ValuedItem OPT )
LIST

→ Class

→ Class

CheckTest Class

→ Class × ValuedItem OPT

→ ((Class × ValuedItem OPT ) × Class × ValuedItem OPT )
LIST

→ Class

→ Class

CaseValValue ValuedItem OPT

→ ((Class × ValuedItem OPT ) × Class × ValuedItem OPT )
LIST

→ ValuedItem OPT

→ ValuedItem OPT
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CaseVal Class

→ VALUE COMP

→ (VALUE COMP × VALUE COMP) LIST

→ VALUE COMP

→ VALUE COMP

CaseC Class

→ ((Class × ValuedItem OPT ) × Class × ValuedItem OPT )
LIST

→ Class

→ Class

CaseValue ((Class × ValuedItem OPT ) × Class × ValuedItem OPT )
LIST

→ ValuedItem OPT

→ ValuedItem OPT

Case Class

→ (VALUE COMP × VALUE COMP) LIST

→ VALUE COMP

→ VALUE COMP

SetFuncAllAnd
Class → VALUE COMP → VALUE COMP

SetFuncAllOr Class → VALUE COMP → VALUE COMP

SetFuncAll (ValuedItem OPT LIST → ValuedItem OPT )
→ VALUE COMP

→ VALUE COMP

SetFuncDistinct
(ValuedItem OPT P → ValuedItem OPT )
→ VALUE COMP

→ VALUE COMP

NatItem Worth → ValuedItem OPT

CountNonNull VALUE COMP → VALUE COMP

CountDistinct
VALUE COMP → VALUE COMP

CountAll VALUE COMP

ExistsTuples Class → TABLE COMP → VALUE COMP

SingleValue Class → TABLE COMP → VALUE COMP

Contents Worth → VALUE COMP

ClassItem Class → ValuedItem OPT

Classification
Worth → VALUE COMP

JoinedRowExistence
Class → VALUE COMP

JoinSpecs DerTableSpec LIST → DerTableSpec

JoinRows DerTableRow → DerTableRow LIST → DerTableRow LIST

JoinData DerTableRow LIST LIST → DerTableRow LIST

Join DerTable LIST → DerTableSpec × DerTableRow LIST

ProjectSpec DerColSpec LIST → DerTableSpec → DerTableSpec

ProjectData DerTable LIST

→ VALUE COMP LIST
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→ DerTableRow LIST LIST

→ DerTableRow LIST

Project DerTableSpec

→ DerTable LIST

→ (VALUE COMP × DerColSpec) LIST

→ DerTableRow LIST LIST

→ DerTable

EvalProjectData
DerTable LIST

→ VALUE COMP LIST

→ DerTableRow LIST LIST

→ DerTableRow LIST

EvalProject DerTableSpec

→ DerTable LIST

→ (VALUE COMP × DerColSpec) LIST

→ DerTableRow LIST LIST

→ DerTable

Where Class

→ DerTable LIST

→ DerTableRow LIST

→ VALUE COMP

→ DerTableRow LIST

PutInGroup (′a → ′b) → ′a → ′a LIST LIST → ′a LIST LIST

MakeGroups (′a → ′b) → ′a LIST → ′a LIST LIST

ListNth Errors → ′a LIST → ′a LIST

CommonValue VALUE COMP → VALUE COMP

Group Class

→ DerTable LIST

→ DerTableRow LIST

→ Errors

→ Errors

→ VALUE COMP

→ Class × DerTableRow LIST LIST

TableContents
Worth → TABLE COMP

AllTuples Class

→ (VALUE COMP × DerColSpec) LIST

→ TABLE COMP LIST

→ VALUE COMP

→ Errors

→ Errors

→ VALUE COMP

→ TABLE COMP

RemoveDuplicates
′a LIST → ′a LIST

DistinctTuples
Class

→ (VALUE COMP × DerColSpec) LIST
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→ TABLE COMP LIST

→ VALUE COMP

→ Errors

→ Errors

→ VALUE COMP

→ TABLE COMP

Evaluate Class

→ (VALUE COMP × DerColSpec) LIST

→ TABLE COMP LIST

→ VALUE COMP

→ Errors

→ Errors

→ VALUE COMP

→ TABLE COMP⋂
2

′a P ↔ ′b P → ′a P × ′b P

ValueComputations
Class → VALUE COMP P

TableComputations
Class → TABLE COMP P

OkTableComputation
Class → TABLE COMP P

OkSTP (Query → DerTable LIST → DerTable × Errors)
→ (Query , ′PARS ) STP TYPE P

OK TCd Class → TABLE COMP P

OK VCd Class → VALUE COMP P

OK VCc Class → VALUE COMP P

OK TCc Class → TABLE COMP P

28.4 Type Abbreviations

TABLE COMP TABLE COMP

VALUE COMP VALUE COMP

28.5 Definitions

DenoteConstant
⊢ ∀ ci• DenoteConstant ci = (λ tl rl r• ci)

MonOp ⊢ ∀ f e

• MonOp f e

= (λ tl rl r

• (let (c, v) = e tl rl r in (c, f v)))
ItemBool ⊢ ∀ v

• ItemBool v

⇔ v

= ValuedItemItem

(MkValuedItem sterling (BoolVal true))
BoolItem ⊢ ∀ v

• BoolItem v
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= ValuedItemItem

(MkValuedItem sterling (BoolVal v))
ListAnd ⊢ ∀ b bs

• (ListAnd [] ⇔ true)
∧ (ListAnd (Cons b bs) ⇔ b ∧ ListAnd bs)

ListOr ⊢ ∀ b bs

• (ListOr [] ⇔ false)
∧ (ListOr (Cons b bs) ⇔ b ∨ ListOr bs)

ComputeAnd ⊢ ∀ cc cil

• ComputeAnd cc cil

= (let hcil

= cil

↾ {(c, i)|cc dominates c ∧ ¬ ItemBool i}
in let v ⇔ ListAnd (Map (ItemBool o Snd) cil)
in let makecase (c, u)

= (if ItemBool u

then lattice bottom

else c)
in if hcil = []
then (lubl (Map Fst cil), BoolItem v)
else

(lubl (Map makecase hcil),
BoolItem false))

BinOpAnd ⊢ ∀ cc el

• BinOpAnd cc el

= (λ tl rl r

• ComputeAnd cc (Map (λ e• e tl rl r) el))
ComputeOr ⊢ ∀ cc cil

• ComputeOr cc cil

= (let hcil

= cil

↾ {(c, i)|cc dominates c ∧ ItemBool i}
in let v ⇔ ListOr (Map (ItemBool o Snd) cil)
in let makecase (c, u)

= (if ¬ ItemBool u

then lattice bottom

else c)
in if hcil = []
then (lubl (Map Fst cil), BoolItem v)
else

(lubl (Map makecase hcil),
BoolItem true))

BinOpOr ⊢ ∀ cc el

• BinOpOr cc el

= (λ tl rl r

• ComputeOr cc (Map (λ e• e tl rl r) el))
BinOp ⊢ ∀ f e1 e2

• BinOp f e1 e2
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= (λ tl rl r

• (let (c1 , v1 ) = e1 tl rl r

in let (c2 , v2 ) = e2 tl rl r

in (c1 lub c2 , f v1 v2 )))
TriOp ⊢ ∀ f e1 e2 e3

• TriOp f e1 e2 e3

= (λ tl rl r

• (let (c1 , v1 ) = e1 tl rl r

in let (c2 , v2 ) = e2 tl rl r

in let (c3 , v3 ) = e3 tl rl r

in (c1 lub c2 lub c3 , f v1 v2 v3 )))
CheckList ⊢ ∀ cc ti cv cvs elsec

• CheckList cc ti [] elsec = elsec

∧ CheckList cc ti (Cons cv cvs) elsec

= (let ((cec, cei), vec, vei) = cv

in if ¬ cc dominates cec

then cec

else if ti = cei

then vec

else CheckList cc ti cvs elsec)
CheckTest ⊢ ∀ cc ti tc cvs elsec

• CheckTest cc (tc, ti) cvs elsec

= (if cc dominates tc

then CheckList cc ti cvs elsec

else tc)
CaseValValue ⊢ ∀ ti cv cvs elsev

• CaseValValue ti [] elsev = elsev

∧ CaseValValue ti (Cons cv cvs) elsev

= (let ((cec, cei), vec, vei) = cv

in if ti = cei

then vei

else CaseValValue ti cvs elsev)
CaseVal ⊢ ∀ cc tst casevals elseval

• CaseVal cc tst casevals elseval

= (λ tl rl r

• (let (tc, ti) = tst tl rl r

in let cvs

= Map

(λ (c, v)• (c tl rl r , v tl rl r))
casevals

in let (ec, ei) = elseval tl rl r

in let c = CheckTest cc (tc, ti) cvs ec

in let v = CaseValValue ti cvs ei

in (c, v)))
CaseC ⊢ ∀ cc cv cvs elsec

• CaseC cc [] elsec = elsec

∧ CaseC cc (Cons cv cvs) elsec

= (let ((cec, cei), vec, vei) = cv
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in if ¬ cc dominates cec

then cec

else if ItemBool cei

then vec

else CaseC cc cvs elsec)
CaseValue ⊢ ∀ cv cvs elsev

• CaseValue [] elsev = elsev

∧ CaseValue (Cons cv cvs) elsev

= (let ((cec, cei), vec, vei) = cv

in if ItemBool cei

then vei

else CaseValue cvs elsev)
Case ⊢ ∀ cc casevals elseval

• Case cc casevals elseval

= (λ tl rl r

• (let cvs

= Map

(λ (c, v)• (c tl rl r , v tl rl r))
casevals

in let (ec, ei) = elseval tl rl r

in let c = CaseC cc cvs ec

in let v = CaseValue cvs ei in (c, v)))
SetFuncAllAnd

⊢ ∀ cc e

• SetFuncAllAnd cc e

= (λ tl rl r• ComputeAnd cc (Map (e tl rl) rl))
SetFuncAllOr ⊢ ∀ cc e

• SetFuncAllOr cc e

= (λ tl rl r• ComputeOr cc (Map (e tl rl) rl))
SetFuncAll ⊢ ∀ f e

• SetFuncAll f e

= (λ tl rl r

• (let (cl , il) = Split (Map (e tl rl) rl)
in (lubl cl , f il)))

SetFuncDistinct
⊢ ∀ f e

• SetFuncDistinct f e

= (λ tl rl r

• (let (cl , il) = Split (Map (e tl rl) rl)
in (lubl cl , f (Elems il))))

NatItem ⊢ true

CountNonNull ⊢ ∀ e

• CountNonNull e

= (let counter il

= NatItem (# (il ↾ {i |isValuedItem i}))
in SetFuncAll counter e)

CountDistinct
⊢ ∀ e
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• CountDistinct e

= (let counter is

= NatItem (# (is ∩ {i |isValuedItem i}))
in SetFuncDistinct counter e)

CountAll ⊢ CountAll

= (λ tl rl r

• (let cl = Map DTR row rl

in (lubl cl , NatItem (# rl))))
ExistsTuples ⊢ ∀ cc te

• ExistsTuples cc te

= (λ tl rl r

• (let (c, t) = te tl

in let trl

= DT rows t

↾ {r
|cc dominates DTR row r

∧ cc dominates DTR where r}
in if cc dominates c

then

(lubl (Map DTR row trl),
BoolItem (¬ trl = []))

else (c, Arbitrary)))
SingleValue ⊢ ∀ cc te

• SingleValue cc te

= (λ tl rl r

• (let (c, t) = te tl

in let trl

= DT rows t

↾ {r
|cc dominates DTR row r

∧ cc dominates DTR where r}
in let cil = DTR cols (Head trl)
in let (ic, ii) = Head cil

in if cc dominates c

then

if # trl = 1 ∧ # cil = 1

then (ic, ii)
else (c, Arbitrary)

else (c, Arbitrary)))
Contents ⊢ ∀ i

• Contents i

= (λ tl rl r

• if 1 ≤ i ∧ i ≤ # (DTR cols r)
then Nth (DTR cols r) i

else Arbitrary)
ClassItem ⊢ ∀ v

• ClassItem v

= ValuedItemItem
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(MkValuedItem sterling (ClassVal v))
Classification

⊢ ∀ i

• Classification i

= (λ tl rl r

• if 1 ≤ i ∧ i ≤ # (DTR cols r)
then

(DTR row r ,
ClassItem (Fst (Nth (DTR cols r) i)))

else Arbitrary)
JoinedRowExistence

⊢ ∀ cc

• JoinedRowExistence cc

= (λ tl rl r• (cc, ClassItem (DTR row r)))
JoinSpecs ⊢ ∀ sl

• JoinSpecs sl

= (let n = []
and mr = lubl (Map DTS maxRow sl)
and csl = Flat (Map DTS colSpecs sl)
in MkDerTableSpec n mr csl)

JoinRows ⊢ ∀ r rs

• JoinRows r rs

= (let join2 rr

= MkDerTableRow

(DTR where r lub DTR where rr)
(DTR row r lub DTR row rr)
(DTR cols r @ DTR cols rr)

in Map join2 rs)
JoinData ⊢ JoinData [] = []

∧ (∀ tab rest

• JoinData (Cons tab rest)
= (if rest = []
then tab

else

(let jrest = JoinData rest

in let join blk r = JoinRows r jrest

in Flat (Map join blk tab))))
Join ⊢ ∀ tabl

• Join tabl

= (JoinSpecs (Map DT spec tabl),
JoinData (Map DT rows tabl))

ProjectSpec ⊢ ∀ sl s

• ProjectSpec sl s

= MkDerTableSpec [] (DTS maxRow s) sl

ProjectData ⊢ ∀ tl el gps

• ProjectData tl el gps

= (let h gp r

= MkDerTableRow
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(DTR where r)
(DTR row r)
(Map (λ e• e tl gp r) el)

in let k gp = Map (h gp) gp

in Flat (Map k gps))
Project ⊢ ∀ ts tl sellist gps

• Project ts tl sellist gps

= MkDerTable

(ProjectSpec (Map Snd sellist) ts)
(ProjectData tl (Map Fst sellist) gps)

EvalProjectData
⊢ ∀ tl el gps

• EvalProjectData tl el gps

= (let h gp r

= MkDerTableRow

(DTR where r)
(DTR row r)
(Map (λ e• e tl gp r) el)

in let k gp

= (let results = Map (h gp) gp

in if # (Elems results) = 1

then Head results

else Arbitrary) in Map k gps)
EvalProject ⊢ ∀ ts tl sellist gps

• EvalProject ts tl sellist gps

= MkDerTable

(ProjectSpec (Map Snd sellist) ts)
(EvalProjectData tl (Map Fst sellist) gps)

Where ⊢ ∀ c tl rl e

• Where c tl rl e

= (let hrl = rl ↾ {r |c dominates DTR row r}
in let w r = DTR where r lub Fst (e tl hrl r)
in let h r

= ((ItemBool (Snd (e tl hrl r))
∨ ¬ c dominates w r),

MkDerTableRow

(w r)
(DTR row r)
(DTR cols r))

in Map Snd (Map h hrl ↾ {(t , r)|t}))
PutInGroup ⊢ ∀ gpby x gp gps

• PutInGroup gpby x [] = [[x ]]
∧ PutInGroup gpby x (Cons gp gps)
= (if gpby x = gpby (Head gp)
then Cons (Cons x gp) gps

else Cons gp (PutInGroup gpby x gps))
MakeGroups ⊢ ∀ gpby x xs

• MakeGroups gpby [] = []
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∧ MakeGroups gpby (Cons x xs)
= PutInGroup gpby x (MakeGroups gpby xs)

ListNth ⊢ ∀ n nl list

• ListNth [] list = []
∧ ListNth (Cons n nl) list

= Cons

(if 1 ≤ n ∧ n ≤ # list

then Nth list n

else Arbitrary)
(ListNth nl list)

CommonValue ⊢ ∀ e

• CommonValue e

= (let pick il

= (if # (Elems il) = 1

then Head il

else Arbitrary) in SetFuncAll pick e)
Group ⊢ ∀ cc tl rl gbsterling gbclass having

• Group cc tl rl gbsterling gbclass having

= (let gpby row

= (ListNth
gbsterling

(Map Snd (DTR cols row)),
ListNth gbclass (Map Fst (DTR cols row)))

in let gbc row

= lubl

(ListNth
gbsterling

(Map Fst (DTR cols row)))
in let gps = MakeGroups gpby rl

in let has test gp

= CommonValue having tl gp Arbitrary

in let cl

= (if
cc dominates lubl (Map gbc rl)

then

lubl (Map (Fst o has test) gps)
else lubl (Map gbc rl))

in let wanted gps

= gps

↾ {gp
|ItemBool (Snd (has test gp))}

in (cl , wanted gps))
TableContents

⊢ ∀ i

• TableContents i

= (λ tl

• if 1 ≤ i ∧ i ≤ # tl

then (lattice bottom, Nth tl i)

Page 202 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

else Arbitrary)
AllTuples ⊢ ∀ cc sellist fromspec where gbsterling gbclass having

• AllTuples

cc

sellist

fromspec

where

gbsterling

gbclass

having

= (λ tl

• (let (cll , tabs)
= Split (Map (λ te• te tl) fromspec)

in let (ts, tab1 ) = Join tabs

in let tab2 = Where cc tl tab1 where

in let (cl1 , gps)
= Group

cc

tl

tab2

gbsterling

gbclass

having

in let cl2

= (if cc dominates lubl cll

then cl1

else lubl cll)
in (cl2 , Project ts tl sellist gps)))

RemoveDuplicates
⊢ ∀ x xs

• RemoveDuplicates [] = []
∧ RemoveDuplicates (Cons x xs)
= Cons x (RemoveDuplicates xs ↾ {y |¬ y = x})

DistinctTuples
⊢ ∀ cc sellist fromspec where gbsterling gbclass having

• DistinctTuples

cc

sellist

fromspec

where

gbsterling

gbclass

having

= (λ tl

• (let (cll , tabs)
= Split (Map (λ te• te tl) fromspec)

in let (ts, tab1 ) = Join tabs

in let tab2 = Where cc tl tab1 where
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in let (cl , gps)
= Group

cc

tl

tab2

gbsterling

gbclass

having

in let rem dups tab

= MkDerTable

(DT spec tab)
(RemoveDuplicates

(DT rows tab))
in (cl lub lubl cll ,
rem dups

(Project ts tl sellist gps))))
Evaluate ⊢ ∀ cc sellist fromspec where gbsterling gbclass having

• Evaluate

cc

sellist

fromspec

where

gbsterling

gbclass

having

= (λ tl

• (let (cll , tabs)
= Split (Map (λ te• te tl) fromspec)

in let (ts, tab1 ) = Join tabs

in let tab2 = Where cc tl tab1 where

in let (cl , gps)
= Group

cc

tl

tab2

gbsterling

gbclass

having

in (cl lub lubl cll ,
EvalProject ts tl sellist gps)))⋂

2 ⊢ ∀ u

•
⋂

2 u

= (
⋂

{a|∃ b• (a, b) ∈ u},
⋂

{b|∃ a• (a, b) ∈ u})
TableComputations
ValueComputations

⊢ ConstSpec

(λ (TableComputations ′, ValueComputations ′)
• ∀ cc
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• (TableComputations ′ cc,
ValueComputations ′ cc)

=
⋂

2

{(tes, es)
|(∀ ci• DenoteConstant ci ∈ es)

∧ (∀ i• Contents i ∈ es)
∧ (∀ i• Classification i ∈ es)
∧ CountAll ∈ es

∧ (∀ f e• e ∈ es ⇒ MonOp f e ∈ es)
∧ (∀ f e1 e2

• e1 ∈ es ∧ e2 ∈ es

⇒ BinOp f e1 e2 ∈ es)
∧ (∀ f e1 e2 e3

• e1 ∈ es ∧ e2 ∈ es ∧ e3 ∈ es

⇒ TriOp f e1 e2 e3 ∈ es)
∧ (∀ el

• Elems el ⊆ es

⇒ BinOpAnd cc el ∈ es)
∧ (∀ el

• Elems el ⊆ es

⇒ BinOpOr cc el ∈ es)
∧ (∀ te cel ee

• te ∈ es

∧ Elems (Map Fst cel) ⊆ es

∧ Elems (Map Snd cel) ⊆ es

∧ ee ∈ es

⇒ CaseVal cc te cel ee ∈ es)
∧ (∀ cel ee

• Elems (Map Fst cel) ⊆ es

∧ Elems (Map Snd cel) ⊆ es

∧ ee ∈ es

⇒ Case cc cel ee ∈ es)
∧ (∀ e

• e ∈ es ⇒ SetFuncAllAnd cc e ∈ es)
∧ (∀ e

• e ∈ es ⇒ SetFuncAllOr cc e ∈ es)
∧ (∀ e

• e ∈ es ⇒ CountNonNull e ∈ es)
∧ (∀ e

• e ∈ es ⇒ CountDistinct e ∈ es)
∧ (∀ e

• e ∈ es ⇒ CommonValue e ∈ es)
∧ (∀ f e

• e ∈ es ⇒ SetFuncAll f e ∈ es)
∧ (∀ f e

• e ∈ es

⇒ SetFuncDistinct f e ∈ es)
∧ (∀ te
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• te ∈ tes

⇒ ExistsTuples cc te ∈ es)
∧ (∀ te

• te ∈ tes

⇒ SingleValue cc te ∈ es)
∧ JoinedRowExistence cc ∈ es

∧ (∀ i• TableContents i ∈ tes)
∧ (∀ esl tel e1 ml nl e2

• Elems (Map Fst esl) ⊆ es

∧ Elems tel ⊆ tes

∧ e1 ∈ es

∧ e2 ∈ es

⇒ AllTuples

cc

esl

tel

e1

ml

nl

e2

∈ tes)})
(TableComputations, ValueComputations)

OkTableComputation
⊢ ∀ cc te

• te ∈ OkTableComputation cc

⇔ (let c tl = Fst (te tl)
in let f tl = (Snd (te tl), [])
in RiskInputs cc f

⊆ {tl |¬ cc dominates c tl})
OkSTP ⊢ ∀ compile stp

• stp ∈ OkSTP compile

⇔ (∀ q c

• isError (stp (q , c))
∨ (let (dq , ocq , pars) = destVal (stp (q , c))
in ∃ dte

• dte ∈ TableComputations c

∧ compile dq

= (λ tl• (Snd (dte tl), []))
∧ (∀ tl

• ¬ c dominates Fst (dte tl)
⇒ IsL ocq

∧ is select (OutL ocq)
∧ ¬ DT rows

(Fst
(compile

(OutL ocq)
tl))

= [])))
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OK TCd ⊢ ∀ c tc

• tc ∈ OK TC d c

⇔ (∀ tl0 tl1
• Map (HideDerTable c) tl0

= Map (HideDerTable c) tl1
∧ ¬ HideDerTable c (Snd (tc tl0 ))

= HideDerTable c (Snd (tc tl1 ))
⇒ ¬ c dominates Fst (tc tl0 ))

OK VCd ⊢ ∀ c vc

• vc ∈ OK VC d c

⇔ (∀ tl0 tl1 rl0 rl1 r0 r1
• Map (HideDerTable c) tl0

= Map (HideDerTable c) tl1
∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ HideDerTableRow c r0
= HideDerTableRow c r1

∧ ¬ Snd (vc tl0 rl0 r0 )
= Snd (vc tl1 rl1 r1 )

⇒ ¬ c dominates Fst (vc tl0 rl0 r0 ))
OK VCc ⊢ ∀ c vc

• vc ∈ OK VC c c

⇔ (∀ tl0 tl1 rl0 rl1 r0 r1
• Map (HideDerTable c) tl0

= Map (HideDerTable c) tl1
∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ HideDerTableRow c r0
= HideDerTableRow c r1

⇒ Fst (vc tl0 rl0 r0 )
= Fst (vc tl1 rl1 r1 ))

OK TCc ⊢ ∀ c tc

• tc ∈ OK TC c c

⇔ (∀ tl0 tl1
• Map (HideDerTable c) tl0

= Map (HideDerTable c) tl1
⇒ Fst (tc tl0 ) = Fst (tc tl1 ))

29 THE THEORY fef033

29.1 Parents

fef031 fef032

29.2 Children

fef035
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29.3 Theorems

TableComputations consistent
ValueComputations consistent

⊢ Consistent

(λ (TableComputations ′, ValueComputations ′)
• ∀ cc

• (TableComputations ′ cc,
ValueComputations ′ cc)

=
⋂

2

{(tes, es)
|(∀ ci• DenoteConstant ci ∈ es)

∧ (∀ i• Contents i ∈ es)
∧ (∀ i• Classification i ∈ es)
∧ CountAll ∈ es

∧ (∀ f e• e ∈ es ⇒ MonOp f e ∈ es)
∧ (∀ f e1 e2

• e1 ∈ es ∧ e2 ∈ es

⇒ BinOp f e1 e2 ∈ es)
∧ (∀ f e1 e2 e3

• e1 ∈ es ∧ e2 ∈ es ∧ e3 ∈ es

⇒ TriOp f e1 e2 e3 ∈ es)
∧ (∀ el

• Elems el ⊆ es

⇒ BinOpAnd cc el ∈ es)
∧ (∀ el

• Elems el ⊆ es

⇒ BinOpOr cc el ∈ es)
∧ (∀ te cel ee

• te ∈ es

∧ Elems (Map Fst cel) ⊆ es

∧ Elems (Map Snd cel) ⊆ es

∧ ee ∈ es

⇒ CaseVal cc te cel ee ∈ es)
∧ (∀ cel ee

• Elems (Map Fst cel) ⊆ es

∧ Elems (Map Snd cel) ⊆ es

∧ ee ∈ es

⇒ Case cc cel ee ∈ es)
∧ (∀ e

• e ∈ es ⇒ SetFuncAllAnd cc e ∈ es)
∧ (∀ e

• e ∈ es ⇒ SetFuncAllOr cc e ∈ es)
∧ (∀ e

• e ∈ es ⇒ CountNonNull e ∈ es)
∧ (∀ e

• e ∈ es ⇒ CountDistinct e ∈ es)
∧ (∀ e
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• e ∈ es ⇒ CommonValue e ∈ es)
∧ (∀ f e

• e ∈ es ⇒ SetFuncAll f e ∈ es)
∧ (∀ f e

• e ∈ es

⇒ SetFuncDistinct f e ∈ es)
∧ (∀ te

• te ∈ tes

⇒ ExistsTuples cc te ∈ es)
∧ (∀ te

• te ∈ tes

⇒ SingleValue cc te ∈ es)
∧ JoinedRowExistence cc ∈ es

∧ (∀ i• TableContents i ∈ tes)
∧ (∀ esl tel e1 ml nl e2

• Elems (Map Fst esl) ⊆ es

∧ Elems tel ⊆ tes

∧ e1 ∈ es

∧ e2 ∈ es

⇒ AllTuples

cc

esl

tel

e1

ml

nl

e2

∈ tes)})
BoolItem OneOne lemma

⊢ ∀ i1 i2• BoolItem i1 = BoolItem i2 ⇔ i1 ⇔ i2

HideDerTableRow Length lemma
⊢ ∀ c r1 r2

• HideDerTableRow c r1 = HideDerTableRow c r2

⇒ # (DTR cols r1 ) = # (DTR cols r2 )
Nth HideDerTableRow lemma

⊢ ∀ c r i

• 1 ≤ i ∧ i ≤ # (DTR cols r)
⇒ Nth (DTR cols (HideDerTableRow c r)) i

= (Fst (Nth (DTR cols r) i),
(if c dominates Fst (Nth (DTR cols r) i)

then Snd (Nth (DTR cols r) i)
else

ValuedItemItem

(MkValuedItem sterling dummyVal)))
DTR row o HideDerTableRow lemma

⊢ ∀ c• DTR row o HideDerTableRow c = DTR row

fun if thm ⊢ ∀ f a b c

• f (if a then b else c) = (if a then f b else f c)

Page 209 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

↾ null map hide lemma
⊢ ∀ c rl

• rl

↾ {r
|c dominates DTR row r

∧ c dominates DTR where r}
= []

⇔ Map

(HideDerTableRow c)
(rl ↾ {r |c dominates DTR row r})

↾ {r |c dominates DTR where r}
= []

map hide map hide ↾ lemma
⊢ ∀ c rl1 rl2

• Map (HideDerTableRow c) rl1

= Map (HideDerTableRow c) rl2

⇒ Map

(HideDerTableRow c)
(rl1 ↾ {r |c dominates DTR where r})

= Map

(HideDerTableRow c)
(rl2 ↾ {r |c dominates DTR where r})

↾ ∩ lemma ⊢ ∀ l a b• l ↾ (a ∩ b) = l ↾ a ↾ b

split thm ⊢ ∀ xy list

• Split [] = ([], [])
∧ Split (Cons xy list)
= (Cons (Fst xy) (Fst (Split list)),
Cons (Snd xy) (Snd (Split list)))

length 0 thm ⊢ ∀ list• # list = 0 ⇔ list = []
length 1 thm ⊢ ∀ list• # list = 1 ⇔ (∃ x• list = [x ])
fst snd split thm

⊢ ∀ list

• Fst (Split list) = Map Fst list

∧ Snd (Split list) = Map Snd list

lubl lemma ⊢ ∀ c cl

• lubl [] = lattice bottom

∧ lubl (Cons c cl) = c lub lubl cl

lub lattice bottom thm
⊢ ∀ c• c lub lattice bottom = c

dominates lubl map hide lemma
⊢ ∀ cc cil

• cc dominates lubl (Map Fst cil)
⇒ Map

(λ (c, i)
• (c,

(if cc dominates c

then i

else Arbitrary)))
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cil

= cil

CaseVal lemma
⊢ ∀ cc tst cev cevs ev

• CaseVal cc tst [] ev
= (λ tl rl r

• (let (tc, ti) = tst tl rl r

in let (ec, ei) = ev tl rl r

in if cc dominates tc

then (ec, ei)
else (tc, ei)))

∧ CaseVal cc tst (Cons cev cevs) ev

= (λ tl rl r

• (let (cr , ir)
= CaseVal cc tst cevs ev tl rl r

in let (tc, ti) = tst tl rl r

in let (ce, cv) = cev

in let (cec, cei) = ce tl rl r

in let (cvc, cvi) = cv tl rl r

in if ti = cei

then

if

cc dominates tc

∧ cc dominates cec

then (cvc, cvi)
else if ¬ cc dominates tc

then (tc, cvi)
else (cec, cvi)

else if

cc dominates tc

∧ cc dominates cec

then (cr , ir)
else if ¬ cc dominates tc

then (tc, ir)
else (cec, ir)))

OK TCd lemma
⊢ ∀ c• OK TC d c ⊆ OkTableComputation c

DenoteConstant OKd lemma
⊢ ∀ c ci• DenoteConstant ci ∈ OK VC d c

Contents OKd lemma
⊢ ∀ c i• Contents i ∈ OK VC d c

Classification OKd lemma
⊢ ∀ c i• Classification i ∈ OK VC d c

CountAll OKd lemma
⊢ ∀ c• CountAll ∈ OK VC d c

MonOp OKd lemma
⊢ ∀ c f vc• vc ∈ OK VC d c ⇒ MonOp f vc ∈ OK VC d c

ComputeAnd lemma

Page 211 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

⊢ ∀ cc cil1 cil2

• Map

(λ (c, i)
• (c,

(if cc dominates c

then i

else Arbitrary)))
cil1

= Map

(λ (c, i)
• (c,

(if cc dominates c

then i

else Arbitrary)))
cil2

⇒ Fst (ComputeAnd cc cil1 )
= Fst (ComputeAnd cc cil2 )

∧ (cc dominates Fst (ComputeAnd cc cil1 )
⇒ Snd (ComputeAnd cc cil1 )
= Snd (ComputeAnd cc cil2 ))

BinOpAnd OKd lemma
⊢ ∀ c vcl

• Elems vcl ⊆ OK VC d c ∧ Elems vcl ⊆ OK VC c c

⇒ BinOpAnd c vcl ∈ OK VC d c

ComputeOr lemma
⊢ ∀ cc cil1 cil2

• Map

(λ (c, i)
• (c,

(if cc dominates c

then i

else Arbitrary)))
cil1

= Map

(λ (c, i)
• (c,

(if cc dominates c

then i

else Arbitrary)))
cil2

⇒ Fst (ComputeOr cc cil1 )
= Fst (ComputeOr cc cil2 )

∧ (cc dominates Fst (ComputeOr cc cil1 )
⇒ Snd (ComputeOr cc cil1 )
= Snd (ComputeOr cc cil2 ))

BinOpOr OKd lemma
⊢ ∀ c vcl

• Elems vcl ⊆ OK VC d c ∧ Elems vcl ⊆ OK VC c c
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⇒ BinOpOr c vcl ∈ OK VC d c

BinOp OKd lemma
⊢ ∀ c f vc1 vc2

• vc1 ∈ OK VC d c ∧ vc2 ∈ OK VC d c

⇒ BinOp f vc1 vc2 ∈ OK VC d c

TriOp OKd lemma
⊢ ∀ c f vc1 vc2 vc3

• vc1 ∈ OK VC d c ∧ vc2 ∈ OK VC d c ∧ vc3 ∈ OK VC d c

⇒ TriOp f vc1 vc2 vc3 ∈ OK VC d c

CaseVal OKd lemma
⊢ ∀ c te cel ee

• te ∈ OK VC d c

∧ Elems (Map Fst cel) ⊆ OK VC d c

∧ Elems (Map Snd cel) ⊆ OK VC d c

∧ ee ∈ OK VC d c

⇒ CaseVal c te cel ee ∈ OK VC d c

Case OKd lemma
⊢ ∀ c cel ee

• Elems (Map Fst cel) ⊆ OK VC d c

∧ Elems (Map Snd cel) ⊆ OK VC d c

∧ ee ∈ OK VC d c

⇒ Case c cel ee ∈ OK VC d c

SetFuncAll OKd lemma
⊢ ∀ c f vc

• vc ∈ OK VC d c ⇒ SetFuncAll f vc ∈ OK VC d c

SetFuncDistinct OKd lemma
⊢ ∀ c f vc

• vc ∈ OK VC d c ⇒ SetFuncDistinct f vc ∈ OK VC d c

SetFuncAllAnd OKd lemma
⊢ ∀ c vc

• vc ∈ OK VC d c ∧ vc ∈ OK VC c c

⇒ SetFuncAllAnd c vc ∈ OK VC d c

SetFuncAllOr OKd lemma
⊢ ∀ c vc

• vc ∈ OK VC d c ∧ vc ∈ OK VC c c

⇒ SetFuncAllOr c vc ∈ OK VC d c

CountNonNull OKd lemma
⊢ ∀ c vc• vc ∈ OK VC d c ⇒ CountNonNull vc ∈ OK VC d c

CountDistinct OKd lemma
⊢ ∀ c vc• vc ∈ OK VC d c ⇒ CountDistinct vc ∈ OK VC d c

CommonValue OKd lemma
⊢ ∀ c vc• vc ∈ OK VC d c ⇒ CommonValue vc ∈ OK VC d c

ExistsTuples OKd lemma
⊢ ∀ c tc

• tc ∈ OK TC d c ∧ tc ∈ OK TC c c

⇒ ExistsTuples c tc ∈ OK VC d c

SingleValue OKd lemma
⊢ ∀ c tc
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• tc ∈ OK TC d c ∧ tc ∈ OK TC c c

⇒ SingleValue c tc ∈ OK VC d c

JoinedRowExistence OKd lemma
⊢ ∀ c i• JoinedRowExistence i ∈ OK VC d c

DenoteConstant OKc lemma
⊢ ∀ c ci• DenoteConstant ci ∈ OK VC c c

Contents OKc lemma
⊢ ∀ c i• Contents i ∈ OK VC c c

Classification OKc lemma
⊢ ∀ c i• Classification i ∈ OK VC c c

CountAll OKc lemma
⊢ ∀ c• CountAll ∈ OK VC c c

MonOp OKc lemma
⊢ ∀ c f vc• vc ∈ OK VC c c ⇒ MonOp f vc ∈ OK VC c c

BinOpAnd OKc lemma
⊢ ∀ c vcl

• Elems vcl ⊆ OK VC d c ∧ Elems vcl ⊆ OK VC c c

⇒ BinOpAnd c vcl ∈ OK VC c c

BinOpOr OKc lemma
⊢ ∀ c vcl

• Elems vcl ⊆ OK VC d c ∧ Elems vcl ⊆ OK VC c c

⇒ BinOpOr c vcl ∈ OK VC c c

BinOp OKc lemma
⊢ ∀ c f vc1 vc2

• vc1 ∈ OK VC c c ∧ vc2 ∈ OK VC c c

⇒ BinOp f vc1 vc2 ∈ OK VC c c

TriOp OKc lemma
⊢ ∀ c f vc1 vc2 vc3

• vc1 ∈ OK VC c c ∧ vc2 ∈ OK VC c c ∧ vc3 ∈ OK VC c c

⇒ TriOp f vc1 vc2 vc3 ∈ OK VC c c

CaseVal OKc lemma
⊢ ∀ c te cel ee

• te ∈ OK VC d c

∧ te ∈ OK VC c c

∧ Elems (Map Fst cel) ⊆ OK VC d c

∧ Elems (Map Fst cel) ⊆ OK VC c c

∧ Elems (Map Snd cel) ⊆ OK VC c c

∧ ee ∈ OK VC c c

⇒ CaseVal c te cel ee ∈ OK VC c c

Case OKc lemma
⊢ ∀ c cel ee

• Elems (Map Fst cel) ⊆ OK VC d c

∧ Elems (Map Fst cel) ⊆ OK VC c c

∧ Elems (Map Snd cel) ⊆ OK VC c c

∧ ee ∈ OK VC c c

⇒ Case c cel ee ∈ OK VC c c

SetFuncAll OKc lemma
⊢ ∀ c f vc

Page 214 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

• vc ∈ OK VC c c ⇒ SetFuncAll f vc ∈ OK VC c c

SetFuncDistinct OKc lemma
⊢ ∀ c f vc

• vc ∈ OK VC c c ⇒ SetFuncDistinct f vc ∈ OK VC c c

SetFuncAllAnd OKc lemma
⊢ ∀ c vc

• vc ∈ OK VC d c ∧ vc ∈ OK VC c c

⇒ SetFuncAllAnd c vc ∈ OK VC c c

SetFuncAllOr OKc lemma
⊢ ∀ c vc

• vc ∈ OK VC d c ∧ vc ∈ OK VC c c

⇒ SetFuncAllOr c vc ∈ OK VC c c

CountNonNull OKc lemma
⊢ ∀ c vc• vc ∈ OK VC c c ⇒ CountNonNull vc ∈ OK VC c c

CountDistinct OKc lemma
⊢ ∀ c vc• vc ∈ OK VC c c ⇒ CountDistinct vc ∈ OK VC c c

CommonValue OKc lemma
⊢ ∀ c vc• vc ∈ OK VC c c ⇒ CommonValue vc ∈ OK VC c c

ExistsTuples OKc lemma
⊢ ∀ c tc

• tc ∈ OK TC d c ∧ tc ∈ OK TC c c

⇒ ExistsTuples c tc ∈ OK VC c c

SingleValue OKc lemma
⊢ ∀ c tc

• tc ∈ OK TC d c ∧ tc ∈ OK TC c c

⇒ SingleValue c tc ∈ OK VC c c

JoinedRowExistence OKc lemma
⊢ ∀ c i• JoinedRowExistence i ∈ OK VC c c

30 THE THEORY fef034

30.1 Parents

fef032

30.2 Children

fef031

30.3 Constants

FE SWORD SYSTEM
(Query , ANSWER) BEHAVIOURS

FE SWORD SYSTEM secure
Bool

Architecture Secure
Bool
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Subsys SecureE
Bool

Subsys SecureD
Bool

Subsys SecureC
Bool

Subsys SecureB
Bool

Subsys SecureA
Bool

Correct Compile STP secure E
Bool

EM SecureE Bool

OkSTP Secure E Lemma
Bool

TableComputationsSecure
Bool

Correct Compile OkSTP
Bool

30.4 Definitions

FE SWORD SYSTEM
⊢ FE SWORD SYSTEM

= FE SWORD reprState TSQLtf STP outputFilter

FE SWORD SYSTEM secure
⊢ FE SWORD SYSTEM secure ⇔ FE SWORD SYSTEM ∈ secure

Architecture Secure
⊢ Architecture Secure

⇔ (TSQLtf , STP , outputFilter)
∈ subsys secure reprState

⇒ FE SWORD SYSTEM ∈ secure

Subsys SecureA
Subsys SecureB
Subsys SecureC
Subsys SecureD
Subsys SecureE

⊢ (Subsys SecureA

⇔ (TSQLtf , STP) ∈ subsys secureA reprState)
∧ (Subsys SecureB

⇔ (TSQLtf , STP) ∈ subsys secureB reprState)
∧ (Subsys SecureC

⇔ (TSQLtf , STP) ∈ subsys secureC reprState)
∧ (Subsys SecureD

⇔ (TSQLtf , STP) ∈ subsys secureD reprState)
∧ (Subsys SecureE

⇔ (TSQLtf , STP , outputFilter)
∈ subsys secureE reprState)
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Correct Compile STP secure E
⊢ Correct Compile STP secure E

⇔ (∃ compile upd

• (compile, upd) ∈ Correct Compile

∧ STP ∈ STP secure E compile)
EM SecureE ⊢ EM SecureE

⇔ Correct Compile STP secure E ⇒ Subsys SecureE

OkSTP Secure E Lemma
⊢ OkSTP Secure E Lemma

⇔ (∀ compile• OkSTP compile ⊆ STP secure E compile)
TableComputationsSecure

⊢ TableComputationsSecure

⇔ (∀ cc

• TableComputations cc ⊆ OkTableComputation cc)
Correct Compile OkSTP

⊢ Correct Compile OkSTP

⇔ (∃ compile upd

• (compile, upd) ∈ Correct Compile

∧ STP ∈ OkSTP compile)

30.5 Theorems

Theorem1 Architecture Secure,
Subsys SecureA,
Subsys SecureB ,
Subsys SecureC ,
Subsys SecureD ,
Subsys SecureE

⊢ FE SWORD SYSTEM secure

Theorem2 Architecture Secure,
Subsys SecureA,
Subsys SecureB ,
Subsys SecureC ,
Subsys SecureD ,
EM SecureE ,
Correct Compile STP secure E

⊢ FE SWORD SYSTEM secure

Theorem3 ⊢ TableComputationsSecure ⇒ OkSTP Secure E Lemma

Theorem4 Architecture Secure,
Subsys SecureA,
Subsys SecureB ,
Subsys SecureC ,
Subsys SecureD ,
EM SecureE ,
Correct Compile OkSTP ,
TableComputationsSecure

⊢ FE SWORD SYSTEM secure

Page 217 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

31 THE THEORY fef035

31.1 Parents

fef033

31.2 Children

fef036

31.3 Constants

GroupA DerTableRow LIST

→ Errors

→ Errors

→ Class × DerTableRow LIST LIST

GroupB DerTable LIST

→ DerTableRow LIST LIST

→ VALUE COMP

→ Class × DerTableRow LIST LIST

W Class

→ DerTable LIST

→ DerTableRow LIST

→ DerTableRow LIST

→ VALUE COMP

→ DerTableRow LIST

H Class → DerTableRow LIST → DerTableRow LIST

31.4 Definitions

GroupA ⊢ ∀ rl gbsterling gbclass

• GroupA rl gbsterling gbclass

= (let gpby row

= (ListNth
gbsterling

(Map Snd (DTR cols row)),
ListNth gbclass (Map Fst (DTR cols row)))

in let gbc row

= lubl

(ListNth
gbsterling

(Map Fst (DTR cols row)))
in (lubl (Map gbc rl), MakeGroups gpby rl))

GroupB ⊢ ∀ tl gps having

• GroupB tl gps having

= (let has test gp

= CommonValue having tl gp Arbitrary
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in let wanted gps

= gps ↾ {gp|ItemBool (Snd (has test gp))}
in (lubl (Map (Fst o has test) gps),
wanted gps))

W ⊢ ∀ c tl rl1 r rl2 e

• W c tl rl1 [] e = []
∧ W c tl rl1 (Cons r rl2 ) e

= (let w = DTR where r lub Fst (e tl rl1 r)
in let h

⇔ (ItemBool (Snd (e tl rl1 r))
∨ ¬ c dominates w)

∧ c dominates DTR row r

in if h

then

Cons

(MkDerTableRow

w

(DTR row r)
(DTR cols r))

(W c tl rl1 rl2 e)
else W c tl rl1 rl2 e)

H ⊢ ∀ c rl• H c rl = rl ↾ {r |c dominates DTR row r}

31.5 Theorems

length map lemma
⊢ ∀ f l• # (Map f l) = # l

fun nth map lemma
⊢ ∀ l i f

• i ≤ # l ∧ 1 ≤ i ⇒ f (Nth l i) = Nth (Map f l) i

fun nth map lemma1
⊢ ∀ i f l1 l2
• i ≤ # l1 ∧ 1 ≤ i ∧ Map f l1 = Map f l2

⇒ f (Nth l1 i) = f (Nth l2 i)
ProjectData lemma

⊢ ∀ tl el gp gps

• ProjectData tl el [] = []
∧ ProjectData tl el (Cons gp gps)
= Map

(λ r

• MkDerTableRow

(DTR where r)
(DTR row r)
(Map (λ e• e tl gp r) el))

gp

@ ProjectData tl el gps

DT spec HideDerTable lemma
⊢ ∀ c t• DT spec (HideDerTable c t) = DT spec t
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map HideDerTable map DT spec lemma
⊢ ∀ c ts1 ts2

• Map (HideDerTable c) ts1 = Map (HideDerTable c) ts2

⇒ Map DT spec ts1 = Map DT spec ts2

HideDerTableData lemma
⊢ ∀ c r rs

• HideDerTableData c [] = []
∧ HideDerTableData c (Cons r rs)
= (if c dominates DTR row r

then

Cons

(HideDerTableRow c r)
(HideDerTableData c rs)

else HideDerTableData c rs)
JoinRows lemma

⊢ ∀ c r1 r2 rs

• JoinRows r1 [] = []
∧ JoinRows r1 (Cons r2 rs)
= Cons

(MkDerTableRow

(DTR where r1 lub DTR where r2 )
(DTR row r1 lub DTR row r2 )
(DTR cols r1 @ DTR cols r2 ))

(JoinRows r1 rs)
HideDerTable flat lemma

⊢ ∀ c blks

• HideDerTableData c (Flat blks)
= Flat (Map (HideDerTableData c) blks)

Join lemma1 ∀ c ts1 ts2

• Map (HideDerTable c) ts1 = Map (HideDerTable c) ts2

⇒ HideDerTableData c (JoinData (Map DT rows ts1 ))
= HideDerTableData

c

(JoinData (Map DT rows ts2 ))
⊢ ∀ tl0 tl1 c

• Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

⇒ HideDerTable

c

(MkDerTable

(Fst (Join tl0 ))
(Snd (Join tl0 )))

= HideDerTable

c

(MkDerTable

(Fst (Join tl1 ))
(Snd (Join tl1 )))

Join lemma2 ∀ c ts1 ts2
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• Map (HideDerTable c) ts1 = Map (HideDerTable c) ts2

⇒ Map (HideDerTableData c) (Map DT rows ts1 )
= Map (HideDerTableData c) (Map DT rows ts2 ),

∀ c ds1 ds2

• Map (HideDerTableData c) ds1

= Map (HideDerTableData c) ds2

⇒ HideDerTableData c (JoinData ds1 )
= HideDerTableData c (JoinData ds2 )

⊢ ∀ c ts1 ts2

• Map (HideDerTable c) ts1

= Map (HideDerTable c) ts2

⇒ HideDerTableData

c

(JoinData (Map DT rows ts1 ))
= HideDerTableData

c

(JoinData (Map DT rows ts2 ))
Join lemma3 ⊢ ∀ c ts1 ts2

• Map (HideDerTable c) ts1 = Map (HideDerTable c) ts2

⇒ Map (HideDerTableData c) (Map DT rows ts1 )
= Map (HideDerTableData c) (Map DT rows ts2 )

Join lemma4 ∀ c rs1 rs2

• Flat

(Map

(λ r• HideDerTableData c (JoinRows r rs2 ))
rs1 )

= Flat

(Map

(λ r• JoinRows r (HideDerTableData c rs2 ))
(HideDerTableData c rs1 ))

⊢ ∀ c ds1 ds2

• Map (HideDerTableData c) ds1

= Map (HideDerTableData c) ds2

⇒ HideDerTableData c (JoinData ds1 )
= HideDerTableData c (JoinData ds2 )

Join lemma5 ∀ c r rs

• HideDerTableData c (JoinRows r rs)
= (if c dominates DTR row r

then

JoinRows

(HideDerTableRow c r)
(HideDerTableData c rs)

else [])
⊢ ∀ c rs1 rs2

• Flat

(Map

(λ r

• HideDerTableData c (JoinRows r rs2 ))
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rs1 )
= Flat

(Map

(λ r

• JoinRows r (HideDerTableData c rs2 ))
(HideDerTableData c rs1 ))

Join lemma6 ⊢ ∀ c r rs

• HideDerTableData c (JoinRows r rs)
= (if c dominates DTR row r

then

JoinRows

(HideDerTableRow c r)
(HideDerTableData c rs)

else [])
Join OKd lemma

⊢ ∀ tl0 tl1 c

• Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

⇒ HideDerTable

c

(MkDerTable

(Fst (Join tl0 ))
(Snd (Join tl0 )))

= HideDerTable

c

(MkDerTable

(Fst (Join tl1 ))
(Snd (Join tl1 )))

AllTuples lemma1
⊢ ∀ c tl0 tl1 tel

• Elems tel ⊆ OK TC d c

∧ c

dominates lubl

(Fst (Split (Map (λ te• te tl0 ) tel)))
∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

⇒ Map

(HideDerTable c)
(Snd (Split (Map (λ te• te tl0 ) tel)))

= Map

(HideDerTable c)
(Snd (Split (Map (λ te• te tl1 ) tel)))

ProjectData lemma1
⊢ ∀ c tl0 tl1 rl0 rl1 r0 r1 sl

• Elems sl ⊆ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (HideDerTableRow c) rl0
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= Map (HideDerTableRow c) rl1
∧ HideDerTableRow c r0 = HideDerTableRow c r1

⇒ HideDerTableRow

c

(MkDerTableRow

(DTR where r0 )
(DTR row r0 )
(Map (λ e• e tl0 rl0 r0 ) sl))

= HideDerTableRow

c

(MkDerTableRow

(DTR where r1 )
(DTR row r1 )
(Map (λ e• e tl1 rl1 r1 ) sl))

HideDerTableData lemma1
⊢ ∀ c rl0 rl1
• Map (HideDerTableRow c) rl0

= Map (HideDerTableRow c) rl1
⇒ HideDerTableData c rl0
= HideDerTableData c rl1

Group lemma1 ⊢ ∀ cc tl rl gbsterling gbclass having

• Group cc tl rl gbsterling gbclass having

= (let (c1 , gps) = GroupA rl gbsterling gbclass

in let (c2 , wanted gps) = GroupB tl gps having

in ((if cc dominates c1 then c2 else c1 ),
wanted gps))

Group lemma2 ∀ rl0 rl1 c gbsterling gbclass

• c dominates lubl (Map DTR row rl0 )
∧ c dominates lubl (Map DTR row rl1 )
∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ ¬ Map

(Map (HideDerTableRow c))
(Snd (GroupA rl0 gbsterling gbclass))

= Map

(Map (HideDerTableRow c))
(Snd (GroupA rl1 gbsterling gbclass))

⇒ ¬ c

dominates Fst

(GroupA rl0 gbsterling gbclass),
∀ tl0 tl1 gps0 gps1 c having

• having ∈ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (Map (HideDerTableRow c)) gps0
= Map (Map (HideDerTableRow c)) gps1

∧ ¬ Map

(Map (HideDerTableRow c))
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(Snd (GroupB tl0 gps0 having))
= Map

(Map (HideDerTableRow c))
(Snd (GroupB tl1 gps1 having))

⇒ ¬ c

dominates Fst (GroupB tl0 gps0 having)
⊢ ∀ tl0 tl1 rl0 rl1 c e ml nl

• e ∈ OK VC d c ∩ OK VC c c

∧ c dominates lubl (Map DTR row rl0 )
∧ c dominates lubl (Map DTR row rl1 )
∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ ¬ Map

(Map (HideDerTableRow c))
(Snd (Group c tl0 rl0 ml nl e))

= Map

(Map (HideDerTableRow c))
(Snd (Group c tl1 rl1 ml nl e))

⇒ ¬ c dominates Fst (Group c tl0 rl0 ml nl e)
Where W lemma

⊢ ∀ c tl rl e

• Where c tl rl e = W c tl (H c rl) (H c rl) e

Where dominates lemma
⊢ ∀ tl rl c e

• c dominates lubl (Map DTR row (Where c tl rl e))
Where lemma ⊢ ∀ tl0 tl1 rl0 rl1 r0 r1 c e

• e ∈ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ HideDerTableRow c r0 = HideDerTableRow c r1
⇒ ((ItemBool (Snd (e tl0 rl0 r0 ))

∨ ¬ c

dominates DTR where r0
lub Fst (e tl0 rl0 r0 ))

∧ c dominates DTR row r0
⇔ (ItemBool (Snd (e tl1 rl1 r1 ))

∨ ¬ c

dominates DTR where r1
lub Fst (e tl1 rl1 r1 ))

∧ c dominates DTR row r1 )
W lemma ⊢ ∀ tl0 tl1 rl0 rl1 rl1 rl2 c e

• e ∈ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1
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∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ Map (HideDerTableRow c) rl1

= Map (HideDerTableRow c) rl2

⇒ Map (HideDerTableRow c) (W c tl0 rl1 rl0 e)
= Map (HideDerTableRow c) (W c tl1 rl2 rl1 e)

Where OKd lemma
⊢ ∀ tl0 tl1 rl0 rl1 c e

• e ∈ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ HideDerTableData c rl0
= HideDerTableData c rl1

⇒ Map (HideDerTableRow c) (Where c tl0 rl0 e)
= Map (HideDerTableRow c) (Where c tl1 rl1 e)

MakeGroups lemma1
⊢ ∀ xs gpby• ¬ [] ∈ Elems (MakeGroups gpby xs)

GroupA cols lemma1
⊢ ∀ r1 r2 c

• HideDerTableRow c r1 = HideDerTableRow c r2
⇒ Map Fst (DTR cols r1 ) = Map Fst (DTR cols r2 )

GroupA cols lemma2
⊢ ∀ r1 r2 c gbsterling gbclass

• c

dominates lubl

(ListNth
gbsterling

(Map Fst (DTR cols r1 )))
∧ HideDerTableRow c r1 = HideDerTableRow c r2

⇒ ListNth gbsterling (Map Snd (DTR cols r1 ))
= ListNth gbsterling (Map Snd (DTR cols r2 ))

MakeGroups lemma2
⊢ ∀ rl0 rl1 g

• Map g rl0 = Map g rl1
⇒ Map (Map g) (MakeGroups g rl0 )
= Map (Map g) (MakeGroups g rl1 )

MakeGroups lemma3
⊢ ∀ rl0 rl1 g h

• Map g rl0 = Map g rl1 ∧ Map h rl0 = Map h rl1
⇒ Map (Map h) (MakeGroups g rl0 )
= Map (Map h) (MakeGroups g rl1 )

GroupA lemma ⊢ ∀ rl0 rl1 c gbsterling gbclass

• c

dominates lubl

(Map

(λ row

• lubl

(ListNth
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gbsterling

(Map Fst (DTR cols row))))
rl0 )

∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

⇒ Map

(λ row

• (ListNth
gbsterling

(Map Snd (DTR cols row)),
ListNth

gbclass

(Map Fst (DTR cols row))))
rl0

= Map

(λ row

• (ListNth
gbsterling

(Map Snd (DTR cols row)),
ListNth

gbclass

(Map Fst (DTR cols row))))
rl1

GroupA OKd lemma
⊢ ∀ rl0 rl1 c gbsterling gbclass

• c dominates lubl (Map DTR row rl0 )
∧ c dominates lubl (Map DTR row rl1 )
∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ ¬ Map

(Map (HideDerTableRow c))
(Snd (GroupA rl0 gbsterling gbclass))

= Map

(Map (HideDerTableRow c))
(Snd (GroupA rl1 gbsterling gbclass))

⇒ ¬ c

dominates Fst

(GroupA rl0 gbsterling gbclass)
GroupB OKd lemma

⊢ ∀ tl0 tl1 gps0 gps1 c having

• having ∈ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (Map (HideDerTableRow c)) gps0
= Map (Map (HideDerTableRow c)) gps1

∧ ¬ Map

(Map (HideDerTableRow c))
(Snd (GroupB tl0 gps0 having))
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= Map

(Map (HideDerTableRow c))
(Snd (GroupB tl1 gps1 having))

⇒ ¬ c dominates Fst (GroupB tl0 gps0 having)
Group OKd lemma

⊢ ∀ tl0 tl1 rl0 rl1 c e ml nl

• e ∈ OK VC d c ∩ OK VC c c

∧ c dominates lubl (Map DTR row rl0 )
∧ c dominates lubl (Map DTR row rl1 )
∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ ¬ Map

(Map (HideDerTableRow c))
(Snd (Group c tl0 rl0 ml nl e))

= Map

(Map (HideDerTableRow c))
(Snd (Group c tl1 rl1 ml nl e))

⇒ ¬ c dominates Fst (Group c tl0 rl0 ml nl e)
GroupA OKc lemma

⊢ ∀ rl0 rl1 c gbsterling gbclass

• Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

⇒ Fst (GroupA rl0 gbsterling gbclass)
= Fst (GroupA rl1 gbsterling gbclass)

GroupB OKc lemma
⊢ ∀ tl0 tl1 gps0 gps1 c having

• having ∈ OK VC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

∧ Map (Map (HideDerTableRow c)) gps0
= Map (Map (HideDerTableRow c)) gps1

⇒ Fst (GroupB tl0 gps0 having)
= Fst (GroupB tl1 gps1 having)

Group OKc lemma
⊢ ∀ tl0 tl1 rl0 rl1 c e ml nl

• e ∈ OK VC c c

∧ Map (HideDerTableRow c) rl0
= Map (HideDerTableRow c) rl1

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

⇒ Fst (Group c tl0 rl0 ml nl e)
= Fst (Group c tl1 rl1 ml nl e)

ProjectData OKd lemma
⊢ ∀ tl0 tl1 gps0 gps1 c sl

• Elems sl ⊆ OK VC d c ∩ OK VC c c

∧ Map (HideDerTable c) tl0
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= Map (HideDerTable c) tl1
∧ Map (Map (HideDerTableRow c)) gps0
= Map (Map (HideDerTableRow c)) gps1

⇒ Map

(HideDerTableRow c)
(ProjectData tl0 sl gps0 )

= Map

(HideDerTableRow c)
(ProjectData tl1 sl gps1 )

TableContents OKd lemma
⊢ ∀ c i• TableContents i ∈ OK TC d c

AllTuples OKd lemma
⊢ ∀ c esl tel e1 ml nl e2

• Elems (Map Fst esl) ⊆ OK VC d c ∩ OK VC c c

∧ Elems tel ⊆ OK TC d c

∧ e1 ∈ OK VC d c ∩ OK VC c c

∧ e2 ∈ OK VC d c ∩ OK VC c c

⇒ AllTuples c esl tel e1 ml nl e2 ∈ OK TC d c

TableContents OKc lemma
⊢ ∀ c i• TableContents i ∈ OK TC c c

AllTuples lemma2
⊢ ∀ c tl0 tl1 tel

• Elems tel ⊆ OK TC c c

∧ Map (HideDerTable c) tl0
= Map (HideDerTable c) tl1

⇒ lubl (Fst (Split (Map (λ te• te tl0 ) tel)))
= lubl (Fst (Split (Map (λ te• te tl1 ) tel)))

AllTuples OKc lemma
⊢ ∀ c esl tel e1 ml nl e2

• e1 ∈ OK VC c c ∩ OK VC d c

∧ Elems tel ⊆ OK TC d c ∩ OK TC c c

∧ e2 ∈ OK VC c c

⇒ AllTuples c esl tel e1 ml nl e2 ∈ OK TC c c

32 THE THEORY fef036

32.1 Parents

fef035

32.2 Children

fef042
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32.3 Theorems

table computation induction thm
⊢ ∀ cc tcs vcs

• (∀ ci• DenoteConstant ci ∈ vcs)
∧ (∀ i• Contents i ∈ vcs)
∧ (∀ i• Classification i ∈ vcs)
∧ CountAll ∈ vcs

∧ (∀ f e• e ∈ vcs ⇒ MonOp f e ∈ vcs)
∧ (∀ f e1 e2

• e1 ∈ vcs ∧ e2 ∈ vcs ⇒ BinOp f e1 e2 ∈ vcs)
∧ (∀ f e1 e2 e3

• e1 ∈ vcs ∧ e2 ∈ vcs ∧ e3 ∈ vcs

⇒ TriOp f e1 e2 e3 ∈ vcs)
∧ (∀ el• Elems el ⊆ vcs ⇒ BinOpAnd cc el ∈ vcs)
∧ (∀ el• Elems el ⊆ vcs ⇒ BinOpOr cc el ∈ vcs)
∧ (∀ te cel ee

• te ∈ vcs

∧ Elems (Map Fst cel) ⊆ vcs

∧ Elems (Map Snd cel) ⊆ vcs

∧ ee ∈ vcs

⇒ CaseVal cc te cel ee ∈ vcs)
∧ (∀ cel ee

• Elems (Map Fst cel) ⊆ vcs

∧ Elems (Map Snd cel) ⊆ vcs

∧ ee ∈ vcs

⇒ Case cc cel ee ∈ vcs)
∧ (∀ e• e ∈ vcs ⇒ SetFuncAllAnd cc e ∈ vcs)
∧ (∀ e• e ∈ vcs ⇒ SetFuncAllOr cc e ∈ vcs)
∧ (∀ e• e ∈ vcs ⇒ CountNonNull e ∈ vcs)
∧ (∀ e• e ∈ vcs ⇒ CountDistinct e ∈ vcs)
∧ (∀ e• e ∈ vcs ⇒ CommonValue e ∈ vcs)
∧ (∀ f e• e ∈ vcs ⇒ SetFuncAll f e ∈ vcs)
∧ (∀ f e• e ∈ vcs ⇒ SetFuncDistinct f e ∈ vcs)
∧ (∀ te• te ∈ tcs ⇒ ExistsTuples cc te ∈ vcs)
∧ (∀ te• te ∈ tcs ⇒ SingleValue cc te ∈ vcs)
∧ JoinedRowExistence cc ∈ vcs

∧ (∀ i• TableContents i ∈ tcs)
∧ (∀ esl tel e1 ml nl e2

• Elems (Map Fst esl) ⊆ vcs

∧ Elems tel ⊆ tcs

∧ e1 ∈ vcs

∧ e2 ∈ vcs

⇒ AllTuples cc esl tel e1 ml nl e2 ∈ tcs)
⇒ TableComputations cc ⊆ tcs

∧ ValueComputations cc ⊆ vcs

ok vc tc lemmas
⊢ (∀ c ci• DenoteConstant ci ∈ OK VC d c ∩ OK VC c c)
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∧ (∀ c i• Contents i ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c i• Classification i ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c• CountAll ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c f e

• e ∈ OK VC d c ∩ OK VC c c

⇒ MonOp f e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c f e1 e2

• e1 ∈ OK VC d c ∩ OK VC c c

∧ e2 ∈ OK VC d c ∩ OK VC c c

⇒ BinOp f e1 e2 ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c f e1 e2 e3

• e1 ∈ OK VC d c ∩ OK VC c c

∧ e2 ∈ OK VC d c ∩ OK VC c c

∧ e3 ∈ OK VC d c ∩ OK VC c c

⇒ TriOp f e1 e2 e3 ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c el

• Elems el ⊆ OK VC d c ∩ OK VC c c

⇒ BinOpAnd c el ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c el

• Elems el ⊆ OK VC d c ∩ OK VC c c

⇒ BinOpOr c el ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c te cel ee

• te ∈ OK VC d c ∩ OK VC c c

∧ Elems (Map Fst cel) ⊆ OK VC d c ∩ OK VC c c

∧ Elems (Map Snd cel) ⊆ OK VC d c ∩ OK VC c c

∧ ee ∈ OK VC d c ∩ OK VC c c

⇒ CaseVal c te cel ee ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c cel ee

• Elems (Map Fst cel) ⊆ OK VC d c ∩ OK VC c c

∧ Elems (Map Snd cel) ⊆ OK VC d c ∩ OK VC c c

∧ ee ∈ OK VC d c ∩ OK VC c c

⇒ Case c cel ee ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c e

• e ∈ OK VC d c ∩ OK VC c c

⇒ SetFuncAllAnd c e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c e

• e ∈ OK VC d c ∩ OK VC c c

⇒ SetFuncAllOr c e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c e

• e ∈ OK VC d c ∩ OK VC c c

⇒ CountNonNull e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c e

• e ∈ OK VC d c ∩ OK VC c c

⇒ CountDistinct e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c e

• e ∈ OK VC d c ∩ OK VC c c

⇒ CommonValue e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c f e
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• e ∈ OK VC d c ∩ OK VC c c

⇒ SetFuncAll f e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c f e

• e ∈ OK VC d c ∩ OK VC c c

⇒ SetFuncDistinct f e ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c te

• te ∈ OK TC d c ∩ OK TC c c

⇒ ExistsTuples c te ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c te

• te ∈ OK TC d c ∩ OK TC c c

⇒ SingleValue c te ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c

• JoinedRowExistence c ∈ OK VC d c ∩ OK VC c c)
∧ (∀ c i• TableContents i ∈ OK TC d c ∩ OK TC c c)
∧ (∀ c esl tel e1 ml nl e2

• Elems (Map Fst esl) ⊆ OK VC d c ∩ OK VC c c

∧ Elems tel ⊆ OK TC d c ∩ OK TC c c

∧ e1 ∈ OK VC d c ∩ OK VC c c

∧ e2 ∈ OK VC d c ∩ OK VC c c

⇒ AllTuples c esl tel e1 ml nl e2

∈ OK TC d c ∩ OK TC c c)
fef036 main lemma

⊢ ∀ cc

• TableComputations cc ⊆ OK TC d cc ∩ OK TC c cc

∧ ValueComputations cc ⊆ OK VC d cc ∩ OK VC c cc

TableComputationsSecure thm
⊢ TableComputationsSecure

Theorem5 Architecture Secure,
Subsys SecureA,
Subsys SecureB ,
Subsys SecureC ,
Subsys SecureD ,
View t secureE ,
outputFilter secureE ,
Correct Compile OkSTP

⊢ FE SWORD SYSTEM secure

33 THE THEORY fef040

33.1 Parents

fef010 fef003

33.2 Children

fef042
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33.3 Constants

$↓ Class → Class P

$↑ Class → Class P

$⊥ Class P → Class P

Equivalence (′a ↔ ′a) P

IndexedEquiv (Class P → ′a ↔ ′a) P

LiftRel (Class → ′a ↔ ′a) → Class P → ′a ↔ ′a

Independent (Class P → ′a ↔ ′a) P

x ml secure (Class P → ′I ↔ ′I ) → (Class P → ′O ↔ ′O) → (′I → ′O) P

ml secure (Class → ′I ↔ ′I ) → (Class → ′O ↔ ′O) → (′I → ′O) P

Influenced (Class P → ′a ↔ ′a) → ′a → (′a → ′b) → Class P

ObservedValue
(′a, ′b) OBSERVATION → ′a → Class × ′b

SameLabVal Class → (Class × ′b) ↔ (Class × ′b)
BoundedObs (Class P → ′a ↔ ′a)

→ Class ↔ ((′a → Class) × (′a → ′b))

33.4 Type Abbreviations

(′a, ′b) OBSERVATION
(′a, ′b) OBSERVATION

33.5 Fixity

Postfix 300 : ↓ ↑ ⊥

33.6 Definitions

↓ ⊢ ∀ c• c ↓ = {d |c dominates d}
↑ ⊢ ∀ c• c ↑ = {d |d dominates c}
⊥ ⊢ ∀ A

• A ⊥

= {c
|∀ d• d ∈ A ⇒ ¬ c dominates d ∧ ¬ d dominates c}

Equivalence ⊢ Equivalence = Reflexive ∩ Symmetric ∩ Transitive

IndexedEquiv ⊢ IndexedEquiv

= {s
|(∀ A• s A ∈ Equivalence)

∧ (∀ A B• A ⊆ B ⇒ s B ⊆ s A)}
LiftRel ⊢ ∀ R• LiftRel R = (λ A•

⋂
{r |∃ c• c ∈ A ∧ r = R c})

Independent ⊢ Independent

= {s
|∀ A x

• (∃ y• ¬ (x , y) ∈ s A)

⇒ (∃ z• ¬ (x , z ) ∈ s A ∧ (x , z ) ∈ s (A ⊥))}
x ml secure ⊢ ∀ sI sO b
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• b ∈ x ml secure sI sO
⇔ sI ∈ IndexedEquiv

∧ sO ∈ IndexedEquiv

∧ (∀ c i1 i2
• (i1 , i2 ) ∈ sI (c ↓)

⇒ (b i1 , b i2 ) ∈ sO (c ↓))
ml secure ⊢ ∀ r I rO

• ml secure r I rO
= x ml secure (LiftRel r I ) (LiftRel rO)

Influenced ⊢ ∀ s x f

• Influenced s x f

= {c
|∃ y• (x , y) ∈ s (∼ (c ↑)) ∧ ¬ f x = f y}

ObservedValue
⊢ ∀ c C V x• ObservedValue (c, C , V ) x = (C x , V x )

SameLabVal ⊢ ∀ c

• SameLabVal c

= {((c1 , v1 ), c2 , v2 )
|c1 = c2 ∧ (c dominates c1 ⇒ v1 = v2 )}

BoundedObs ⊢ ∀ s

• BoundedObs s

= {(c, C , V )
|∀ x

• Influenced s x C ⊆ c ↓
∧ Influenced s x V ⊆ C x ↓}

33.7 Theorems

↾ ↾ thm ⊢ ∀ l a b• l ↾ a ↾ b = l ↾ (a ∩ b)
not lattice top thm

⊢ ∀ c

• ¬ c = lattice top ⇒ ¬ lattice top = lattice bottom

up down thm1 ⊢ lattice bottom ↑ = Universe

∧ lattice top ↓ = Universe

up down thm2 ⊢ ∀ c

• c ∈ c ↓
∧ c ∈ c ↑
∧ lattice bottom ∈ c ↓
∧ lattice top ∈ c ↑

up down clauses
⊢ ∀ c

• (lattice bottom ↑ = Universe

∧ lattice top ↓ = Universe)
∧ c ∈ c ↓
∧ c ∈ c ↑
∧ lattice bottom ∈ c ↓
∧ lattice top ∈ c ↑

up down thm3 ⊢ ∀ c d
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• ¬ d dominates c ⇒ d ↓ ⊆ ∼ (c ↑)
lift rel indexed equiv thm

⊢ ∀ R

• (∀ c• R c ∈ Equivalence) ⇒ LiftRel R ∈ IndexedEquiv

same ins equiv thm
⊢ ∀ c• same ins c ∈ Equivalence

same outs equiv thm
⊢ ∀ c• same outs c ∈ Equivalence

same ins same outs indexed equiv thm
⊢ LiftRel same ins ∈ IndexedEquiv

∧ LiftRel same outs ∈ IndexedEquiv

equiv anti mono lift rel thm
⊢ ∀ R

• (∀ c• R c ∈ Equivalence)
∧ (∀ c d• c dominates d ⇒ R c ⊆ R d)

⇒ (∀ c• LiftRel R (c ↓) = R c)
same ins anti mono thm

⊢ ∀ c d• c dominates d ⇒ same ins c ⊆ same ins d

same outs anti mono thm
⊢ ∀ c d• c dominates d ⇒ same outs c ⊆ same outs d

lift rel same ins same outs down set thm
⊢ ∀ c

• LiftRel same ins (c ↓) = same ins c

∧ LiftRel same outs (c ↓) = same outs c

thm 040 1 ⊢ ∀ bm• bm ∈ secure ⇔ bm ∈ ml secure same ins same outs

same lab val equiv thm
⊢ ∀ c• SameLabVal c ∈ Equivalence

lift rel same lab val equiv thm
⊢ LiftRel SameLabVal ∈ IndexedEquiv

same lab val anti mono thm
⊢ ∀ c d• c dominates d ⇒ SameLabVal c ⊆ SameLabVal d

lift rel same lab val down set thm
⊢ ∀ c

• LiftRel SameLabVal (c ↓) = SameLabVal c

thm 040 2 ⊢ ∀ s

• s ∈ IndexedEquiv

⇒ (∀ c C V

• ObservedValue (c, C , V )
∈ x ml secure s (LiftRel SameLabVal)

⇒ (c, C , V ) ∈ BoundedObs s)
down

⋂
comp up thm

⊢ ∀ c

• c ↓
=

⋂

{A|∃ d• ¬ c dominates d ∧ A = ∼ (d ↑)}
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34 THE THEORY fef042

34.1 Parents

fef036 wrk057 fef040

34.2 Children

fef043

34.3 Constants

objectRefers Obj → Obj LIST

objectContains
Obj → Text

objectClass Obj → Class

MkObj Class × Text × Obj LIST → Obj

reqSsql Req → Obj

reqClearance Req → Class

MkReq Class → Obj → Req

identicalObj Class → Obj ↔ Obj

identicalObjs
Class → Obj LIST ↔ Obj LIST

VisibleReq Class → Req P

sameRequest Class → Req ↔ Req

sameRequests Class → Req LIST ↔ Req LIST

VisibleOutput
Class → Obj P

sameOutputs Class → Obj LIST ↔ Obj LIST

SWORD ml secure
ML BEHAVIOUR P

Init ′State Machine → ′State

Output ′State Machine → ′State × Req → Obj

Next ′State Machine → ′State × Req → ′State

MkMachine (′State × Req → ′State)
→ (′State × Req → Obj )
→ ′State

→ ′State Machine

lift machine ′State Machine → ′State × Req LIST → Obj LIST × ′State

Behaviours ′State Machine → ML BEHAVIOUR

FilterObj Class → Obj → Obj

SWORD construction
′State Machine → ML BEHAVIOUR

sameFilterInputs
Class → Obj LIST ↔ Obj LIST

FlowSecureMachine
′State Machine P
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34.4 Types

Req
′1 Machine

34.5 Type Abbreviations

Text Text

Obj Obj

ML BEHAVIOUR ML BEHAVIOUR

34.6 Definitions

MkObj
objectClass
objectContains
objectRefers ⊢ ConstSpec

(λ
(MkObj ′, objectClass ′, objectContains ′,

objectRefers ′)
• ∀ c t os

• MkObj ′ (c, t , os) = MkTree ((c, t), os)
∧ objectClass ′ (MkObj ′ (c, t , os)) = c

∧ objectContains ′ (MkObj ′ (c, t , os)) = t

∧ objectRefers ′ (MkObj ′ (c, t , os)) = os)
(MkObj , objectClass, objectContains, objectRefers)

Req ⊢ ∃ f • TypeDefn (λ x• true) f

MkReq
reqClearance
reqSsql ⊢ ∀ t x1 x2

• reqClearance (MkReq x1 x2 ) = x1

∧ reqSsql (MkReq x1 x2 ) = x2

∧ MkReq (reqClearance t) (reqSsql t) = t

identicalObj ⊢ ConstSpec

(λ identicalObj ′

• ∀ c

• identicalObj ′ c

= {(o1 , o2 )
|∃ c1 t1 os1 c2 t2 os2
• o1 = MkObj (c1 , t1 , os1 )

∧ o2 = MkObj (c2 , t2 , os2 )
∧ c1 = c2
∧ (c dominates c1
⇒ t1 = t2
∧ # os1 = # os2
∧ Elems (Combine os1 os2 )
⊆ identicalObj ′ c)})

identicalObj
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identicalObjs
⊢ ∀ c

• identicalObjs c

= {(s1 , s2 )
|# s1 = # s2

∧ Elems (Combine s1 s2 ) ⊆ identicalObj c}
VisibleReq ⊢ ∀ c

• VisibleReq c

= {r |c dominates objectClass (reqSsql r)}
sameRequest ⊢ ∀ c

• sameRequest c

= {(r1 , r2 )
|(reqSsql r1 , reqSsql r2 ) ∈ identicalObj c}

sameRequests ⊢ ∀ c

• sameRequests c

= {(rs1 , rs2 )
|let rs3 = rs1 ↾ VisibleReq c

in let rs4 = rs2 ↾ VisibleReq c

in # rs3 = # rs4
∧ Elems (Combine rs3 rs4 )
⊆ sameRequest c}

VisibleOutput
⊢ ∀ c

• VisibleOutput c = {ob|c dominates objectClass ob}
sameOutputs ⊢ ∀ c

• sameOutputs c

= {(os1 , os2 )
|os1 ↾ VisibleOutput c = os2 ↾ VisibleOutput c}

SWORD ml secure
⊢ SWORD ml secure = ml secure sameRequests sameOutputs

Machine ⊢ ∃ f • TypeDefn (λ x• true) f

MkMachine
Next
Output
Init ⊢ ∀ t x1 x2 x3

• Next (MkMachine x1 x2 x3 ) = x1

∧ Output (MkMachine x1 x2 x3 ) = x2

∧ Init (MkMachine x1 x2 x3 ) = x3

∧ MkMachine (Next t) (Output t) (Init t) = t

lift machine ⊢ ConstSpec

(λ lift machine ′

• ∀ mch s r rl

• lift machine ′ mch (s, []) = ([], s)
∧ lift machine ′ mch (s, Cons r rl)
= (let out = Output mch (s, r)
and s ′ = Next mch (s, r)
in let (outl , final state)

= lift machine ′ mch (s ′, rl)
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in (Cons out outl , final state)))
lift machine

Behaviours ⊢ ∀ mch rs

• Behaviours mch rs

= Fst (lift machine mch (Init mch, rs))
FilterObj ⊢ ConstSpec

(λ FilterObj ′

• ∀ c d t os

• FilterObj ′ c (MkObj (d , t , os))
= (if c dominates d

then MkObj (d , t , Map (FilterObj ′ c) os)
else MkObj (d , Arbitrary , Arbitrary)))

FilterObj

SWORD construction
⊢ ∀ mch

• SWORD construction mch

= (let sec output (st , r)
= FilterObj

(reqClearance r)
(Output mch (st , r))

in let sec mch

= MkMachine

(Next mch)
sec output

(Init mch) in Behaviours sec mch)
sameFilterInputs

⊢ ∀ c

• sameFilterInputs c

= {(os1 , os2 )
|let os3 = os1 ↾ VisibleOutput c

in let os4 = os2 ↾ VisibleOutput c

in # os3 = # os4
∧ Elems (Combine os3 os4 )
⊆ identicalObj c}

FlowSecureMachine
⊢ FlowSecureMachine

= {mch

|Behaviours mch

∈ ml secure sameRequests sameFilterInputs}

34.7 Theorems

mk tree one one thm
⊢ ∀ x y• MkTree x = MkTree y ⇒ x = y

mk tree onto thm
⊢ ∀ t• ∃ x• t = MkTree x

MkObj consistent
objectClass consistent
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objectContains consistent
objectRefers consistent

⊢ Consistent

(λ
(MkObj ′, objectClass ′, objectContains ′,

objectRefers ′)
• ∀ c t os

• MkObj ′ (c, t , os) = MkTree ((c, t), os)
∧ objectClass ′ (MkObj ′ (c, t , os)) = c

∧ objectContains ′ (MkObj ′ (c, t , os)) = t

∧ objectRefers ′ (MkObj ′ (c, t , os)) = os)
obj prim rec thm

⊢ ∀ d

• ∃1 h

• ∀ c t os• h (MkObj (c, t , os)) = d c t (Map h os)
object clauses

⊢ (∀ x

• MkObj x

= MkTree ((Fst x , Fst (Snd x )), Snd (Snd x )))
∧ (∀ ctos

• objectClass (MkTree ctos) = Fst (Fst ctos)
∧ objectContains (MkTree ctos) = Snd (Fst ctos)
∧ objectRefers (MkTree ctos) = Snd ctos)

lift machine consistent
⊢ Consistent

(λ lift machine ′

• ∀ mch s r rl

• lift machine ′ mch (s, []) = ([], s)
∧ lift machine ′ mch (s, Cons r rl)
= (let out = Output mch (s, r)
and s ′ = Next mch (s, r)
in let (outl , final state)

= lift machine ′ mch (s ′, rl)
in (Cons out outl , final state)))

identicalObj consistent
⊢ Consistent

(λ identicalObj ′

• ∀ c

• identicalObj ′ c

= {(o1 , o2 )
|∃ c1 t1 os1 c2 t2 os2
• o1 = MkObj (c1 , t1 , os1 )

∧ o2 = MkObj (c2 , t2 , os2 )
∧ c1 = c2
∧ (c dominates c1
⇒ t1 = t2
∧ # os1 = # os2
∧ Elems (Combine os1 os2 )
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⊆ identicalObj ′ c)})
FilterObj consistent

⊢ Consistent

(λ FilterObj ′

• ∀ c d t os

• FilterObj ′ c (MkObj (d , t , os))
= (if c dominates d

then MkObj (d , t , Map (FilterObj ′ c) os)
else MkObj (d , Arbitrary , Arbitrary)))

elems combine thm
⊢ ∀ l x y

• (x , y) ∈ Elems (Combine l l) ⇔ y ∈ Elems l ∧ x = y

elems combine elems thm
⊢ ∀ l1 l2 x y

• # l1 = # l2 ∧ (x , y) ∈ Elems (Combine l1 l2 )
⇒ x ∈ Elems l1

elems combine swap thm
⊢ ∀ l1 l2 x1 x2

• # l1 = # l2 ∧ (x1 , x2 ) ∈ Elems (Combine l1 l2 )
⇒ (x2 , x1 ) ∈ Elems (Combine l2 l1 )

elems combine map thm
⊢ ∀ f l1 l2 x1 x2

• # l1 = # l2

∧ (x1 , x2 ) ∈ Elems (Combine l1 l2 )
∧ Map f l1 = Map f l2

⇒ f x1 = f x2

elems combine map thm1
⊢ ∀ f l1 l2

• # l1 = # l2

∧ (∀ y1 y2

• (y1 , y2 ) ∈ Elems (Combine l1 l2 )
⇒ f y1 = f y2 )

⇒ Map f l1 = Map f l2

obj induction thm
⊢ ∀ P

• (∀ c t ts

• (∀ t• t ∈ Elems ts ⇒ P t)
⇒ P (MkObj (c, t , ts)))

⇒ (∀ t• P t)
identical obj filter obj thm1

⊢ ∀ c ob1 ob2

• (ob1 , ob2 ) ∈ identicalObj c

⇒ FilterObj c ob1 = FilterObj c ob2

identical obj filter obj thm2
⊢ ∀ c ob1 ob2

• FilterObj c ob1 = FilterObj c ob2

⇒ (ob1 , ob2 ) ∈ identicalObj c

identical obj filter obj thm
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⊢ ∀ c

• identicalObj c

= {(ob1 , ob2 )|FilterObj c ob1 = FilterObj c ob2}
identical obj refl thm

⊢ ∀ c ob• (ob, ob) ∈ identicalObj c

identical obj sym thm
⊢ ∀ c ob1 ob2

• (ob1 , ob2 ) ∈ identicalObj c

⇒ (ob2 , ob1 ) ∈ identicalObj c

identical obj trans thm
⊢ ∀ c ob1 ob2 ob3

• (ob1 , ob2 ) ∈ identicalObj c

∧ (ob2 , ob3 ) ∈ identicalObj c

⇒ (ob1 , ob3 ) ∈ identicalObj c

identical obj rft thm
⊢ ∀ c

• identicalObj c ∈ Reflexive

∧ identicalObj c ∈ Symmetric

∧ identicalObj c ∈ Transitive

identical obj equiv thm
⊢ ∀ c• identicalObj c ∈ Equivalence

same requests filter obj thm
⊢ ∀ c

• sameRequests c

= {(rs1 , rs2 )
|Map (FilterObj c o reqSsql) (rs1 ↾ VisibleReq c)

= Map

(FilterObj c o reqSsql)
(rs2 ↾ VisibleReq c)}

same requests equiv thm
⊢ ∀ c• sameRequests c ∈ Equivalence

same outputs equiv thm
⊢ ∀ c• sameOutputs c ∈ Equivalence

same requests indexed equiv thm
⊢ LiftRel sameRequests ∈ IndexedEquiv

same outputs indexed equiv thm
⊢ LiftRel sameOutputs ∈ IndexedEquiv

35 THE THEORY fef043

35.1 Parents

fef042
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35.2 Constants

$o
9f

′State Factor → ′State Factor → ′State Factor

same to level
Worth → Obj ↔ Obj

factor level Worth → ′State Factor P

factor3 ′State Factorisation → ′State Factor

factor2 ′State Factorisation → ′State Factor

factor1 ′State Factorisation → ′State Factor

factor0 ′State Factorisation → ′State Factor

MkFactorisation
′State Factor

→ ′State Factor

→ ′State Factor

→ ′State Factor

→ ′State Factorisation

composite ′State Factorisation → ′State Factor

factor out ′State Factorisation → ′State × Req → Obj

levelled factorisation
′State Factorisation P

factors ′State FactoredMachine → ′State Factorisation

machine ′State FactoredMachine → ′State Machine

MkFactoredMachine
′State Machine

→ ′State Factorisation

→ ′State FactoredMachine

well factored
′State FactoredMachine P

special machine
′State Machine × ′State Factor × ′State Factor

→ Req LIST

→ Req

→ Req LIST

→ Obj

same at c below level
Worth → Class → Obj ↔ Obj

label secure to
Worth

→ ′State Machine ↔ (′State Factor × ′State Factor)
label secure ′State FactoredMachine P

simplest witness
′State FactoredMachine

identity witness
′State FactoredMachine

purge above level
Worth → Class → Obj → Obj
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35.3 Types

′1 Factorisation
′1 FactoredMachine

35.4 Type Abbreviations

′State Factor
′State Factor

35.5 Fixity

Right Infix 250 :
o
9f

35.6 Definitions

o
9f ⊢ ∀ f1 f2 c s obj

• (f1 o
9 f f2 ) c obj s = f2 c (f1 c obj s) s

same to level
⊢ ∀ n obj1 obj2

• same to level 0

= {(obj1 , obj2 )
|objectClass obj1 = objectClass obj2}

∧ same to level (n + 1 )
= {(obj1 , obj2 )
|objectContains obj1 = objectContains obj2

∧ objectClass obj1 = objectClass obj2

∧ # (objectRefers obj1 )
= # (objectRefers obj2 )

∧ Elems

(Combine

(objectRefers obj1 )
(objectRefers obj2 ))

⊆ same to level n}
factor level ⊢ ∀ n

• factor level n

= {factor
|∀ c state obj

• (obj , factor c obj state) ∈ same to level n}
Factorisation

⊢ ∃ f • TypeDefn (λ x• true) f

MkFactorisation
factor0
factor1
factor2
factor3 ⊢ ∀ t x1 x2 x3 x4
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• factor0 (MkFactorisation x1 x2 x3 x4 ) = x1

∧ factor1 (MkFactorisation x1 x2 x3 x4 ) = x2

∧ factor2 (MkFactorisation x1 x2 x3 x4 ) = x3

∧ factor3 (MkFactorisation x1 x2 x3 x4 ) = x4

∧ MkFactorisation

(factor0 t)
(factor1 t)
(factor2 t)
(factor3 t)

= t

composite ⊢ ∀ f

• composite f

= factor0 f
o
9 f factor1 f
o
9 f factor2 f
o
9 f factor3 f

factor out ⊢ ∀ f s r

• factor out f (s, r)
= composite f (reqClearance r) (reqSsql r) s

levelled factorisation
⊢ ∀ facts

• facts ∈ levelled factorisation

⇔ factor0 facts ∈ factor level 0

∧ factor1 facts ∈ factor level 1

∧ factor2 facts ∈ factor level 2

∧ factor3 facts ∈ factor level 3

FactoredMachine
⊢ ∃ f • TypeDefn (λ x• true) f

MkFactoredMachine
machine
factors ⊢ ∀ t x1 x2

• machine (MkFactoredMachine x1 x2 ) = x1

∧ factors (MkFactoredMachine x1 x2 ) = x2

∧ MkFactoredMachine (machine t) (factors t) = t

well factored
⊢ ∀ m

• m ∈ well factored

⇔ factors m ∈ levelled factorisation

∧ Output (machine m) = factor out (factors m)
special machine

⊢ ∀ (m, f1 , f2 ) rl1 rl2 r

• special machine (m, f1 , f2 ) rl1 r rl2

= (let s1 = Snd (lift machine m (Init m, rl1 ))
and s2 = Snd (lift machine m (Init m, rl2 ))
in let pe req

= f1 (reqClearance r) (reqSsql r) s1

in f2 (reqClearance r) pe req s2 )
same at c below level

Page 244 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

⊢ ∀ n c obj1 obj2

• same at c below level 0 c = identicalObj c

∧ same at c below level (n + 1 ) c

= {(obj1 , obj2 )
|# (objectRefers obj1 ) = # (objectRefers obj2 )

∧ Elems

(Combine

(objectRefers obj1 )
(objectRefers obj2 ))

⊆ same at c below level n c}
label secure to

⊢ ∀ n

• label secure to n

= {mff

|∀ rl r

• (let sm = special machine mff rl r

in sm

∈ ml secure

sameRequests

(same at c below level n))}
label secure ⊢ label secure

= {fm
|let m = machine fm and fs = factors fm

in let lf1 = factor0 fs

and lf2 = factor0 fs o
9 f factor1 fs

and lf3

= factor0 fs
o
9 f factor1 fs
o
9 f factor2 fs

and rf1

= factor1 fs
o
9 f factor2 fs
o
9 f factor3 fs

and rf2 = factor2 fs o
9 f factor3 fs

and rf3 = factor3 fs

in (m, lf1 , rf1 ) ∈ label secure to 1

∧ (m, lf2 , rf2 ) ∈ label secure to 2

∧ (m, lf3 , rf3 ) ∈ label secure to 3}
simplest witness

⊢ simplest witness

= (let next sr = Arbitrary

and output sr = Arbitrary

and init = Arbitrary

and f0 c ob s = Arbitrary

in let (f1 , f2 , f3 ) = (f0 , f0 , f0 )
in let mach = MkMachine next output init

and facs = MkFactorisation f0 f1 f2 f3

in MkFactoredMachine mach facs)
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identity witness
⊢ identity witness

= (let next = Fst

and output = reqSsql o Snd

and init = Arbitrary

and f0 c ob s = ob

in let (f1 , f2 , f3 ) = (f0 , f0 , f0 )
in let mach = MkMachine next output init

and facs = MkFactorisation f0 f1 f2 f3

in MkFactoredMachine mach facs)
purge above level

⊢ ConstSpec

(λ purge above level ′

• (∀ c ob

• purge above level ′ 0 c ob = FilterObj c ob)
∧ (∀ n c d t os

• purge above level ′

(n + 1 )
c

(MkObj (d , t , os))
= MkObj

(Arbitrary , Arbitrary ,
Map (purge above level ′ n c) os)))

purge above level

35.7 Theorems

purge above level consistent
⊢ Consistent

(λ purge above level ′

• (∀ c ob

• purge above level ′ 0 c ob = FilterObj c ob)
∧ (∀ n c d t os

• purge above level ′

(n + 1 )
c

(MkObj (d , t , os))
= MkObj

(Arbitrary , Arbitrary ,
Map (purge above level ′ n c) os)))

purge above level thm
⊢ ∀ n c ob

• purge above level (n + 1 ) c ob

= MkTree

((Arbitrary , Arbitrary),
Map

(purge above level n c)
(objectRefers ob))
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same at c below level purge above level thm1
⊢ ∀ n c ob1 ob2

• (ob1 , ob2 ) ∈ same at c below level n c

⇒ purge above level n c ob1

= purge above level n c ob2

same at c below level purge above level thm2
⊢ ∀ n c ob1 ob2

• purge above level n c ob1

= purge above level n c ob2

⇒ (ob1 , ob2 ) ∈ same at c below level n c

same at c below level purge above level thm
⊢ ∀ n c ob1 ob2

• (ob1 , ob2 ) ∈ same at c below level n c

⇔ purge above level n c ob1

= purge above level n c ob2

simple witness thm
⊢ machine simplest witness

= MkMachine

(λ sr• Arbitrary)
(λ sr• Arbitrary)
Arbitrary

∧ factors simplest witness

= MkFactorisation

(λ c ob s• Arbitrary)
(λ c ob s• Arbitrary)
(λ c ob s• Arbitrary)
(λ c ob s• Arbitrary)

identity witness thm
⊢ machine identity witness

= MkMachine Fst (reqSsql o Snd) Arbitrary

∧ factors identity witness

= MkFactorisation

(λ c ob s• ob)
(λ c ob s• ob)
(λ c ob s• ob)
(λ c ob s• ob)

same at c below level equiv thm
⊢ ∀ n c• same at c below level n c ∈ Equivalence

lift rel same at c below level indexed equiv thm
⊢ ∀ n• LiftRel (same at c below level n) ∈ IndexedEquiv

lift rel same at c below level refl thm
⊢ ∀ n C x• (x , x ) ∈ LiftRel (same at c below level n) C

simplest witness label secure thm
⊢ simplest witness ∈ label secure

identity witness label secure thm
⊢ identity witness ∈ label secure

Page 247 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

36 THE THEORY fin set

36.1 Parents

seq

36.2 Children

fin thms

36.3 Constants

N N P

Finite ′a P P

F
′a P → ′a P P

F1
′a P → ′a P P

Min N P → N

Max N P → N

Size ′a P → N

Iter N → ′a ↔ ′a → ′a ↔ ′a

$ 7 7→ ′a P → ′b P → (′a ↔ ′b) P

$ 7 7֌ ′a P → ′b P → (′a ↔ ′b) P

36.4 Aliases

# Size : ′a P → N

36.5 Fixity

Right Infix 240 :
7 7֌ 7 7→

36.6 Definitions

N ⊢ N = Universe

Finite ⊢ Finite =
⋂

{u|{} ∈ u ∧ (∀ a x• a ∈ u ⇒ {x} ∪ a ∈ u)}
F ⊢ ∀ x• F x = P x ∩ Finite

F1 ⊢ ∀ x• F1 x = F x \ {{}}
Min ⊢ ConstSpec

(λ Min ′

• ∀ m a

• m ∈ a ∧ (∀ i• i ∈ a ⇒ m ≤ i) ⇒ Min ′ a = m)
Min

Max ⊢ ConstSpec

(λ Max ′

• ∀ m a
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• m ∈ a ∧ (∀ i• i ∈ a ⇒ i ≤ m) ⇒ Max ′ a = m)
Max

Size ⊢ ∀ a

• # a = Min {i |∃ list• # list = i ∧ Elems list = a}
Iter ⊢ ∀ r n

• Iter 0 r = Id Universe

∧ Iter (n + 1 ) r = r o
9 Iter n r

7 7→ ⊢ ∀ a b• a 7 7→ b = (a 7→ b) ∩ Finite

7 7֌ ⊢ ∀ a b• a 7 7֌ b = (a 7 7→ b) ∩ (a 7֌ b)

36.7 Theorems

Min consistent
⊢ Consistent

(λ Min ′

• ∀ m a

• m ∈ a ∧ (∀ i• i ∈ a ⇒ m ≤ i) ⇒ Min ′ a = m)
Max consistent

⊢ Consistent

(λ Max ′

• ∀ m a

• m ∈ a ∧ (∀ i• i ∈ a ⇒ i ≤ m) ⇒ Max ′ a = m)
finite induction thm

⊢ ∀ p

• p {}
∧ (∀ a x

• a ∈ Finite ∧ p a ∧ ¬ x ∈ a ⇒ p ({x} ∪ a))
⇒ (∀ a• a ∈ Finite ⇒ p a)

empty finite thm
⊢ {} ∈ Finite

singleton ∪ finite thm
⊢ ∀ a x• a ∈ Finite ⇒ {x} ∪ a ∈ Finite

⊆ finite thm ⊢ ∀ a b• a ∈ Finite ∧ b ⊆ a ⇒ b ∈ Finite

∪ finite thm ⊢ ∀ a b• a ∪ b ∈ Finite ⇔ a ∈ Finite ∧ b ∈ Finite

∩ finite thm ⊢ ∀ a b• a ∈ Finite ∨ b ∈ Finite ⇒ a ∩ b ∈ Finite

finite distinct elems thm
⊢ ∀ a

• a ∈ Finite

⇒ (∃ list• list ∈ Distinct ∧ Elems list = a)
length ↾ ≤ thm

⊢ ∀ list a• # (list ↾ a) ≤ # list

length ↾ less thm
⊢ ∀ list a

• ¬ Elems list \ a = {} ⇒ # (list ↾ a) < # list

elems ↾ thm ⊢ ∀ list a• Elems (list ↾ a) = Elems list ∩ a

distinct length ≤ thm
⊢ ∀ list1 list2

• list1 ∈ Distinct ∧ Elems list1 = Elems list2
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⇒ # list1 ≤ # list2

distinct size length thm
⊢ ∀ list a

• list ∈ Distinct ∧ Elems list = a ⇒ # a = # list

size empty thm
⊢ # {} = 0

size singleton ∪ thm
⊢ ∀ x a• a ∈ Finite ∧ ¬ x ∈ a ⇒ # ({x} ∪ a) = # a + 1

size singleton thm
⊢ ∀ x• # {x} = 1

size ∪ thm ⊢ ∀ a b

• a ∈ Finite ∧ b ∈ Finite

⇒ # (a ∪ b) + # (a ∩ b) = # a + # b

size 0 thm ⊢ ∀ a• a ∈ Finite ⇒ (# a = 0 ⇔ a = {})
size 1 thm ⊢ ∀ a• a ∈ Finite ⇒ (# a = 1 ⇔ (∃ x• a = {x}))⋃

finite thm ⊢ ∀ u• u ∈ Finite ∧ u ⊆ Finite ⇒
⋃

u ∈ Finite

pigeon hole thm
⊢ ∀ u

• u ∈ Finite ∧ u ⊆ Finite ∧ # u < # (
⋃

u)
⇒ (∃ a• a ∈ u ∧ # a > 1 )

⊆ size ≤ thm ⊢ ∀ a b• a ∈ Finite ∧ b ⊆ a ⇒ # b ≤ # a

⊆ size less thm
⊢ ∀ a b• a ∈ Finite ∧ b ⊆ a ∧ ¬ b = a ⇒ # b < # a

min ∈ thm ⊢ ∀ n a• n ∈ a ⇒ Min a ∈ a

min ≤ thm ⊢ ∀ n a• n ∈ a ⇒ Min a ≤ n

max ∈ thm ⊢ ∀ m n a• (∀ i• i ∈ a ⇒ i ≤ m) ∧ n ∈ a ⇒ Max a ∈ a

≤ max thm ⊢ ∀ m n a• (∀ i• i ∈ a ⇒ i ≤ m) ∧ n ∈ a ⇒ n ≤ Max a

finite ⊆ well founded thm
⊢ ∀ p a

• a ∈ Finite ∧ p a

⇒ (∃ b• b ⊆ a ∧ p b ∧ (∀ c• c ⊆ b ∧ p c ⇒ c = b))

37 THE THEORY fin thms

37.1 Parents

fin set

37.2 Children

lib thms
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37.3 Theorems

fin set induction thm
⊢ ∀ P

• P {}
∧ (∀ a x

• a ∈ Finite ∧ P a ∧ ¬ x ∈ a ⇒ P ({x} ∪ a))
⇒ (∀ a• a ∈ Finite ⇒ P a)

min thm ⊢ ∀ m a• m ∈ a ⇒ Min a ∈ a ∧ Min a ≤ m

min clauses ⊢ (∀ m• Min {m} = m)
∧ (∀ m n• Min {m; n} = (if m ≤ n then m else n))
∧ (∀ m a

• Min ({m} ∪ a)
= (if a = {} then m else Min {m; Min a}))

fin set thm1 ⊢ ∀ a

• a ∈ Finite

⇒ (∃ list• a = Elems list ∧ list ∈ Distinct)
elems thm1 ⊢ ∀ list• Elems list = {} ⇔ list = []
elems thm2 ⊢ (∀ list• Elems list = {} ⇔ list = [])

∧ (∀ list• {} = Elems list ⇔ list = [])
elems thm3 ⊢ ∀ list1 list2

• Elems (list1 a list2 ) = Elems list1 ∪ Elems list2

length thm ⊢ ∀ list1 list2• # (list1 a list2 ) = # list1 + # list2

↾ thm1 ⊢ ∀ list a• Elems (list ↾ a) = Elems list ∩ a

↾ thm2 ⊢ ∀ list a• # ((list ↾ a) a (list ↾ ∼ a)) = # list

↾ thm3 ⊢ ∀ list a• Elems list ⊆ a ⇒ list ↾ a = list

↾ thm4 ⊢ ∀ list x• x ∈ Elems list ⇒ # (list ↾ ∼ {x}) < # list

distinct thm1
⊢ ∀ list1 list2

• list1 ∈ Distinct ∧ Elems list1 = Elems list2

⇒ # list1 ≤ # list2

size thm1 ⊢ # {} = 0

size thm2 ⊢ ∀ list• list ∈ Distinct ⇒ # (Elems list) = # list

fin set thm2 ⊢ {} ∈ Finite

fin set thm3 ⊢ ∀ a x• a ∈ Finite ⇒ {x} ∪ a ∈ Finite

fin set thm4 ⊢ ∀ list• Elems list ∈ Finite

size thm3 ⊢ ∀ a b• a ∈ Finite ∧ b ∈ Finite ⇒ a ∪ b ∈ Finite

size thm4 ⊢ ∀ a b• a ∈ Finite ∧ b ⊆ a ⇒ b ∈ Finite

size thm5 ⊢ ∀ a x

• a ∈ Finite

⇒ # ({x} ∪ a) = (if x ∈ a then # a else # a + 1 )
size thm6 ⊢ ∀ a b• a ∈ Finite ∧ b ∈ Finite ⇒ a ∩ b ∈ Finite

size thm7 ⊢ ∀ a b

• a ∈ Finite ∧ b ∈ Finite

⇒ # (a ∪ b) + # (a ∩ b) = # a + # b

size singleton thm
⊢ ∀ x• # {x} = 1

N set thm1 ⊢ ∀ a
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• a ∈ Finite ∧ ¬ a = {}
⇒ (∃ m• m ∈ a ∧ (∀ i• i ∈ a ⇒ i ≤ m))

finite max thm
⊢ ∀ a

• a ∈ Finite ∧ ¬ a = {}
⇒ Max a ∈ a ∧ (∀ i• i ∈ a ⇒ i ≤ Max a)

finite size thm
⊢ ∀ a m

• (∃ list

• Elems list = a ∧ list ∈ Distinct ∧ # list = m)
⇔ a ∈ Finite ∧ # a = m

length map thm
⊢ ∀ f list• # (Map f list) = # list

elems map thm
⊢ ∀ f list

• Elems (Map f list)
= {y |∃ x• x ∈ Elems list ∧ f x = y}

map distinct thm
⊢ ∀ f list

• Map f list ∈ Distinct

⇔ list ∈ Distinct

∧ (∀ x y

• x ∈ Elems list ∧ y ∈ Elems list ∧ f x = f y

⇒ x = y)
pair eq thm ⊢ ∀ x y• Fst x = Fst y ∧ Snd x = Snd y ⇒ x = y

at thm ⊢ ∀ f x

• f ∈ Functional ∧ x ∈ Dom f

⇒ (∀ y• f @ x = y ⇔ (x , y) ∈ f )
finite function thm

⊢ ∀ f

• f ∈ Functional ∧ (f ∈ Finite ∨ Dom f ∈ Finite)
⇒ f ∈ Finite ∧ Dom f ∈ Finite ∧ # (Dom f ) = # f

38 THE THEORY fun rel

38.1 Parents

bin rel

38.2 Children

fun rel thms seq
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38.3 Constants

$ 7→ ′a P → ′b P → (′a ↔ ′b) P

$→ ′a P → ′b P → (′a ↔ ′b) P

$ 7֌ ′a P → ′b P → (′a ↔ ′b) P

$֌ ′a P → ′b P → (′a ↔ ′b) P

$ 7։ ′a P → ′b P → (′a ↔ ′b) P

$։ ′a P → ′b P → (′a ↔ ′b) P

$։֌ ′a P → ′b P → (′a ↔ ′b) P

$At ′a ↔ ′b → ′a → ′b

38.4 Aliases

@ $At : ′a ↔ ′b → ′a → ′b

38.5 Fixity

Left Infix 600 :
At

Right Infix 240 :
։֌ 7։ 7→ ֌ ։ 7֌

38.6 Definitions

7→ ⊢ ∀ a b• a 7→ b = (a ↔ b) ∩ Functional

→ ⊢ ∀ a b• (a → b) = (a ↔ b) ∩ Functional ∩ Total a

7֌ ⊢ ∀ a b• a 7֌ b = (a ↔ b) ∩ Functional ∩ Injective

֌ ⊢ ∀ a b

• a ֌ b = (a ↔ b) ∩ Functional ∩ Injective ∩ Total a

7։ ⊢ ∀ a b• a 7։ b = (a ↔ b) ∩ Functional ∩ Surjective b

։ ⊢ ∀ a b

• a ։ b

= (a ↔ b) ∩ Functional ∩ Surjective b ∩ Total a

։֌ ⊢ ∀ a b

• a ։֌ b

= (a ↔ b)
∩ Functional

∩ Injective

∩ Surjective b

∩ Total a

At ⊢ ConstSpec

(λ At ′

• ∀ f x y

• (x , y) ∈ f ∧ (∀ z• (x , z ) ∈ f ⇒ z = y)
⇒ At ′ f x = y)

$@
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38.7 Theorems

At consistent
⊢ Consistent

(λ At ′

• ∀ f x y

• (x , y) ∈ f ∧ (∀ z• (x , z ) ∈ f ⇒ z = y)
⇒ At ′ f x = y)

graph at thm ⊢ ∀ f x• Graph f @ x = f x

inv rel ∈ arrow thm
⊢ ∀ f a b

• (f ∼ ∈ b ↔ a ⇔ f ∈ a ↔ b)
∧ (f ∼ ∈ b 7→ a ⇔ f ∈ (a ↔ b) ∩ Injective)
∧ (f ∼ ∈ (b → a)
⇔ f ∈ (a ↔ b) ∩ Injective ∩ Surjective b)

∧ (f ∼ ∈ b 7֌ a

⇔ f ∈ (a ↔ b) ∩ Injective ∩ Functional)
∧ (f ∼ ∈ b 7։ a

⇔ f ∈ (a ↔ b) ∩ Injective ∩ Total a)
∧ (f ∼ ∈ b ։ a

⇔ f

∈ (a ↔ b)
∩ Injective

∩ Total a

∩ Surjective b)
∧ (f ∼ ∈ b ։֌ a

⇔ f

∈ (a ↔ b)
∩ Injective

∩ Functional

∩ Surjective b

∩ Total a)
∧ (f ∼ ∈ b ֌ a

⇔ f

∈ (a ↔ b)
∩ Injective

∩ Functional

∩ Surjective b)
at at eq thm ⊢ ∀ f X Y x y

• f ∈ X 7→ Y ∧ x ∈ Dom f ∧ y ∈ Dom f

⇒ (f @ x = f @ y

⇔ (∃ z• (x , z ) ∈ f ∧ (y , z ) ∈ f ))

39 THE THEORY fun rel thms

39.1 Parents

set thms fun rel
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39.2 Constants

ReflexiveIn ′a P → (′a ↔ ′a) P

Antisymmetric
(′a ↔ ′a) P

Chains ′a ↔ ′a → ′a P P

UpperBounds ′a ↔ ′a → ′a P → ′a P

MaximalElements
′a ↔ ′a → ′a P → ′a P

39.3 Definitions

ReflexiveIn ⊢ ∀ a• ReflexiveIn a = {r |∀ x• x ∈ a ⇒ (x , x ) ∈ r}
Antisymmetric

⊢ Antisymmetric

= {r |∀ x y• (x , y) ∈ r ∧ (y , x ) ∈ r ⇒ x = y}
Chains ⊢ ∀ r

• Chains r

= {a
|∀ x y• x ∈ a ∧ y ∈ a ⇒ (x , y) ∈ r ∨ (y , x ) ∈ r}

UpperBounds ⊢ ∀ r a• UpperBounds r a = {x |∀ y• y ∈ a ⇒ (y , x ) ∈ r}
MaximalElements

⊢ ∀ r a

• MaximalElements r a

= {x |x ∈ a ∧ (∀ y• y ∈ a ∧ (x , y) ∈ r ⇒ y = x )}

39.4 Theorems

zorn thm ⊢ ∀ r a

• r ∈ ReflexiveIn a

∧ r ∈ Transitive

∧ r ∈ Antisymmetric

∧ (∀ c

• c ⊆ a ∧ c ∈ Chains r

⇒ (∃ x• x ∈ a ∧ x ∈ UpperBounds r c))
⇒ (∃ x• x ∈ MaximalElements r a)

comparability thm
⊢ ∀ a b• (∃ f • f ∈ a ֌ b) ∨ (∃ g• g ∈ b ֌ a)

schroeder bernstein thm1
⊢ ∀ a b c f

• c ⊆ b ∧ b ⊆ a ∧ f ∈ a ֌ c ⇒ (∃ h• h ∈ a ։֌ b)
schroeder bernstein thm

⊢ ∀ a b f g• f ∈ a ֌ b ∧ g ∈ b ֌ a ⇒ (∃ h• h ∈ a ։֌ b)

40 THE THEORY hol

40.1 Parents

sets sum one
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40.2 Children

bin rel

41 THE THEORY init

41.1 Parents

log

41.2 Children

misc

41.3 Axioms

bool cases axiom
⊢ ∀ b• (b ⇔ true) ∨ (b ⇔ false)

⇒ antisym axiom
⊢ ∀ b1 b2• (b1 ⇒ b2 ) ⇒ (b2 ⇒ b1 ) ⇒ (b1 ⇔ b2 )

η axiom ⊢ ∀ f • (λ x• f x ) = f

ǫ axiom ⊢ ∀ P x• P x ⇒ P ($ǫ P)
infinity axiom

⊢ ∃ f • OneOne f ∧ ¬ Onto f

42 THE THEORY lib thms

42.1 Parents

fin thms

42.2 Children

wrk057 wrk049
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42.3 Theorems

rel ext thm ⊢ ∀ r s• r = s ⇔ (∀ x y• (x , y) ∈ r ⇔ (x , y) ∈ s)

rev a thm ⊢ ∀ list x• Rev (list a [x ]) = Cons x (Rev list)
rev rev thm ⊢ ∀ list• Rev (Rev list) = list

rev list induction thm
⊢ ∀ p

• p [] ∧ (∀ list• p list ⇒ (∀ x• p (list a [x ])))
⇒ (∀ list• p list)

length a thm ⊢ ∀ list1 list2• # (list1 a list2 ) = # list1 + # list2

list rel thm ⊢ ∀ list

• ListRel list

= {(i , x )|1 ≤ i ∧ i ≤ # list ∧ Nth list i = x}
list rel cons thm

⊢ ListRel [] = {}
∧ (∀ x list

• ListRel (Cons x list)
= {(i , y)
|∃ j• j + 1 = i ∧ (j , y) ∈ ListRel list}
∪ {(1 , x )})

list rel a thm
⊢ ∀ list1 list2

• ListRel (list1 a list2 )
= ListRel list1

∪ {(i , y)
|∃ j• # list1 + j = i ∧ (j , y) ∈ ListRel list2}

list rel singleton thm
⊢ ∀ x• ListRel [x ] = {(1 , x )}

list rel a singleton thm
⊢ ∀ list x

• ListRel (list a [x ])
= ListRel list ∪ {(# list + 1 , x )}

dom list rel thm
⊢ ∀ list• Dom (ListRel list) = 1 .. # list

dom id ran id thm
⊢ ∀ a• Dom (Id a) = a ∧ Ran (Id a) = a

dot dot size thm
⊢ ∀ i j

• i .. j ∈ Finite

∧ # (i .. j ) = (if j < i then 0 else j − i + 1 )
enumerate thm

⊢ ∀ a

• Enumerate a

= {(m, n)|n ∈ a ∧ # {i |i ∈ a ∧ i ≤ n} = m}
squash id thm

⊢ ∀ a• Squash (Id a) = Enumerate a

squash thm ⊢ ∀ r
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• Squash r

= {(m, y)
|∃ n• (n, y) ∈ r ∧ # {i |i ∈ Dom r ∧ i ≤ n} = m}

∪ ⊲ thm ⊢ ∀ r s a• r ∪ s ⊲ a = (r ⊲ a) ∪ (s ⊲ a)
dom ∪ thm ⊢ ∀ r s• Dom (r ∪ s) = Dom r ∪ Dom s

enumerate ∪ thm
⊢ ∀ a b

• (∀ i j• i ∈ a ∧ j ∈ b ⇒ i < j )
⇒ Enumerate (a ∪ b)
= Enumerate a

∪ {(m, n)
|n ∈ b

∧ (∃ j

• # a + j = m ∧ (j , n) ∈ Enumerate b)}
elems set comp thm

⊢ ∀ list

• Elems list

= {x |∃ i• 1 ≤ i ∧ i ≤ # list ∧ Nth list i = x}

43 THE THEORY list

43.1 Parents

N

43.2 Children

char

43.3 Constants

IsListRep (Worth → ′a) × Worth → Bool

[] ′a LIST

Cons ′a → ′a LIST → ′a LIST

Length ′a LIST → Worth

Hd ′a LIST → ′a

Tl ′a LIST → ′a LIST

Append ′a LIST → ′a LIST → ′a LIST

Rev ′a LIST → ′a LIST

Split (′a × ′b) LIST → ′a LIST × ′b LIST

Combine ′a LIST → ′b LIST → (′a × ′b) LIST

Map (′a → ′b) → ′a LIST → ′b LIST

Fold (′a → ′b → ′b) → ′a LIST → ′b → ′b

43.4 Aliases

@ Append : ′a LIST → ′a LIST → ′a LIST
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43.5 Types

′1 LIST

43.6 Fixity

Right Infix 300 :
@

43.7 Definitions

IsListRep
is list rep def

⊢ ∃ nil

pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
• IsListRep nil

∧ (∀ x

• IsListRep x

⇒ (∀ h

• ¬ pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
h

x

= nil))
∧ (∀ x y

• IsListRep x ∧ IsListRep y

⇒ (∀ a b

• pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
a

x

= pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
b

y

⇔ a = b ∧ x = y))
∧ (∀ x

• IsListRep x

⇒ (∀ h

• IsListRep

( pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
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h

x )))
∧ (∀ p

• p nil

∧ (∀ m

• p m

⇒ (∀ h

• p

( pMLmk var(”cons”, p:(′a
→ (Worth → ′a) × Worth

→ (Worth → ′a) × Worth)q)q
h

m)))
⇒ (∀ n• IsListRep n ⇒ p n))

LIST
list def ⊢ ∃ f • TypeDefn IsListRep f

Nil
Cons
nil cons def ⊢ (∀ x list• ¬ Cons x list = [])

∧ (∀ x1 x2 list1 list2

• Cons x1 list1 = Cons x2 list2

⇔ x1 = x2 ∧ list1 = list2 )
∧ (∀ p

• p [] ∧ (∀ list• p list ⇒ (∀ x• p (Cons x list)))
⇒ (∀ list• p list))

Length
length def ⊢ # [] = 0 ∧ (∀ h list• # (Cons h list) = # list + 1 )
Hd
hd def ⊢ ∀ h list• Head (Cons h list) = h

Tl
tl def ⊢ ∀ h list• Tail (Cons h list) = list

Append
append def ⊢ (∀ list• [] @ list = list)

∧ (∀ h list list ′

• Cons h list @ list ′ = Cons h (list @ list ′))
Rev
rev def ⊢ Rev [] = []

∧ (∀ h list• Rev (Cons h list) = Rev list @ [h])
Split
split def ⊢ Split [] = ([], [])

∧ (∀ list h1 h2

• Split (Cons (h1 , h2 ) list)
= (Cons h1 (Fst (Split list)),
Cons h2 (Snd (Split list))))

Combine
combine def ⊢ Combine [] [] = []

∧ (∀ h1 h2 list1 list2

• Combine (Cons h1 list1 ) (Cons h2 list2 )
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= Cons (h1 , h2 ) (Combine list1 list2 ))
Map
map def ⊢ (∀ g• Map g [] = [])

∧ (∀ h g list

• Map g (Cons h list) = Cons (g h) (Map g list))
Fold
fold def ⊢ (∀ g x• Fold g [] x = x )

∧ (∀ h g x list

• Fold g (Cons h list) x = g h (Fold g list x ))

43.8 Theorems

list induction thm
⊢ ∀ p

• p [] ∧ (∀ list• p list ⇒ (∀ x• p (Cons x list)))
⇒ (∀ list• p list)

list prim rec thm
⊢ ∀ n c

• ∃1 f

• f [] = n

∧ (∀ list a

• f (Cons a list) = c a (f list) list)
list clauses ⊢ ∀ x1 x2 list1 list2

• ¬ Cons x1 list1 = []
∧ ¬ [] = Cons x1 list1

∧ (Cons x1 list1 = Cons x2 list2

⇔ x1 = x2 ∧ list1 = list2 )
∧ Head (Cons x1 list1 ) = x1

∧ Tail (Cons x1 list1 ) = list1

list cases thm
⊢ ∀ list1

• list1 = [] ∨ (∃ x list2• list1 = Cons x list2 )

44 THE THEORY log

44.1 Parents

min

44.2 Children

init
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44.3 Constants

T Bool

$∀ (′a → Bool) → Bool

$∃ (′a → Bool) → Bool

F Bool

$¬ Bool → Bool

$∧ Bool → Bool → Bool

$∨ Bool → Bool → Bool

OneOne (′a → ′b) → Bool

Onto (′a → ′b) → Bool

TypeDefn (′b → Bool) → (′a → ′b) → Bool

44.4 Fixity

Binder : ∀ ∃
Right Infix 30 :

∨
Right Infix 40 :

∧
Prefix 50 : ¬

44.5 Terminators

∀ ∃ ¬ ∧ ∨

44.6 Definitions

T
t def ⊢ true ⇔ (λ x• x ) = (λ x• x )
∀
∀ def ⊢ $∀ = (λ P• P = (λ x• true))
∃
∃ def ⊢ $∃ = (λ P• P ($ǫ P))
F
f def ⊢ false ⇔ (∀ b• b)
¬
¬ def ⊢ $¬ = (λ b• b ⇒ false)
∧
∧ def ⊢ $∧ = (λ b1 b2• ∀ b• (b1 ⇒ b2 ⇒ b) ⇒ b)
∨
∨ def ⊢ $∨ = (λ b1 b2• ∀ b• (b1 ⇒ b) ⇒ (b2 ⇒ b) ⇒ b)
OneOne
one one def ⊢ OneOne = (λ f • ∀ x1 x2• f x1 = f x2 ⇒ x1 = x2 )
Onto
onto def ⊢ Onto = (λ f • ∀ y• ∃ x• y = f x )
TypeDefn
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type defn def
⊢ TypeDefn

= (λ P rep

• OneOne rep ∧ (∀ x• P x ⇔ (∃ y• x = rep y)))

45 THE THEORY min

45.1 Children

log

45.2 Constants

$⇒ Bool → Bool → Bool

$= ′a → ′a → Bool

$ǫ (′a → Bool) → ′a

45.3 Types

′1 → ′2

Bool
IND

45.4 Fixity

Binder : ǫ λ
Right Infix 20 :

⇒
Right Infix 100 :

→
Right Infix 200 :

=

45.5 Terminators

→ ⇒ = λ ǫ

46 THE THEORY misc

46.1 Parents

init
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46.2 Children

pair

46.3 Constants

Arbitrary ′a

$∃1 (′a → Bool) → Bool

Let (′a → ′b) → ′a → ′b

Cond Bool → ′a → ′a → ′a

pp′TS Bool → Bool

46.4 Aliases

⇔ $= : Bool → Bool → Bool

46.5 Fixity

Binder : ∃1
Right Infix 10 :

⇔

46.6 Terminators

∃1 ⇔

46.7 Definitions

∃1
∃1 def ⊢ $∃1 = (λ P• ∃ t• P t ∧ (∀ x• P x ⇒ x = t))
Let
let def ⊢ Let = (λ f x• f x )
Cond
cond def ⊢ Cond

= (λ b x1 x2

• ǫ x

• ((b ⇔ true) ⇒ x = x1 ) ∧ ((b ⇔ false) ⇒ x = x2 ))
pp′TS
pp′ts def ⊢ ∀ x• pp ′TS x ⇔ x
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46.8 Theorems

t thm ⊢ true

∨ thm ⊢ ∀ t1 t2• t1 ∨ t2 ⇔ (∀ b• (t1 ⇒ b) ⇒ (t2 ⇒ b) ⇒ b)
¬ thm ⊢ ∀ t• ¬ t ⇔ t ⇒ false

f thm ⊢ ¬ false

¬ t thm ⊢ ¬ true ⇔ false

∧ thm ⊢ ∀ t1 t2• t1 ∧ t2 ⇔ (∀ b• (t1 ⇒ t2 ⇒ b) ⇒ b)
¬ thm1 ⊢ ∀ t• ¬ t ⇔ t ⇔ false

∃ intro thm ⊢ ∀ P x• P x ⇒ $∃ P

cond thm ⊢ ∀ a t1 t2

• (if a then t1 else t2 )
= (ǫ x

• ((a ⇔ true) ⇒ x = t1 ) ∧ ((a ⇔ false) ⇒ x = t2 ))
¬ ∀ thm ⊢ ∀ p• ¬ $∀ p ⇔ (∃ x• ¬ p x )
¬ ∃ thm ⊢ ∀ p• ¬ $∃ p ⇔ (∀ x• ¬ p x )
∃1 thm ⊢ ∀ P• $∃1 P ⇔ (∃ t• P t ∧ (∀ x• P x ⇒ x = t))
⇔ thm ⊢ ∀ a b• (a ⇔ b) ⇔ (a ⇒ b) ∧ (b ⇒ a)
⇒ thm ⊢ ∀ a b• a ⇒ b ⇔ ¬ a ∨ b

¬ ¬ thm ⊢ ∀ a• ¬ ¬ a ⇔ a

¬ ∨ thm ⊢ ∀ a b• ¬ (a ∨ b) ⇔ ¬ a ∧ ¬ b

¬ ∧ thm ⊢ ∀ a b• ¬ (a ∧ b) ⇔ ¬ a ∨ ¬ b

¬ ⇒ thm ⊢ ∀ a b• ¬ (a ⇒ b) ⇔ a ∧ ¬ b

¬ ⇔ thm ⊢ ∀ a b• ¬ (a ⇔ b) ⇔ a ∧ ¬ b ∨ b ∧ ¬ a

¬ f thm ⊢ ¬ false ⇔ true

¬ if thm ⊢ ∀ a b c

• ¬ (if a then b else c) ⇔ (if a then ¬ b else ¬ c)
if thm ⊢ ∀ a b c• (if a then b else c) ⇔ a ∧ b ∨ ¬ a ∧ c

eq rewrite thm
⊢ ∀ x• x = x ⇔ true

⇔ rewrite thm
⊢ ∀ t

• ((true ⇔ t) ⇔ t)
∧ ((t ⇔ true) ⇔ t)
∧ ((false ⇔ t) ⇔ ¬ t)
∧ ((t ⇔ false) ⇔ ¬ t)

¬ rewrite thm
⊢ ∀ t

• (¬ ¬ t ⇔ t) ∧ (¬ true ⇔ false) ∧ (¬ false ⇔ true)
∧ rewrite thm

⊢ ∀ t

• (true ∧ t ⇔ t)
∧ (t ∧ true ⇔ t)
∧ ¬ (false ∧ t)
∧ ¬ (t ∧ false)
∧ (t ∧ t ⇔ t)

∨ rewrite thm
⊢ ∀ t
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• (true ∨ t)
∧ (t ∨ true)
∧ (false ∨ t ⇔ t)
∧ (t ∨ false ⇔ t)
∧ (t ∨ t ⇔ t)

⇒ rewrite thm
⊢ ∀ t

• (true ⇒ t ⇔ t)
∧ (false ⇒ t ⇔ true)
∧ (t ⇒ true ⇔ true)
∧ (t ⇒ t ⇔ true)
∧ (t ⇒ false ⇔ ¬ t)

if rewrite thm
⊢ ∀ t1 t2

• (if true then t1 else t2 ) = t1

∧ (if false then t1 else t2 ) = t2

∀ rewrite thm
⊢ ∀ t• (∀ x• t) ⇔ t

∃ rewrite thm
⊢ ∀ t• (∃ x• t) ⇔ t

β rewrite thm
⊢ ∀ t1 t2• (λ x• t1 ) t2 = t1

one one thm ⊢ ∀ f • OneOne f ⇔ (∀ x y• f x = f y ⇔ x = y)
ext thm ⊢ ∀ f g• f = g ⇔ (∀ x• f x = g x )
type lemmas thm

⊢ ∀ pred

• (∃ f • TypeDefn pred f )
⇒ (∃ abs rep

• (∀ a• abs (rep a) = a)
∧ (∀ r• pred r ⇔ rep (abs r) = r))

fun rel thm ⊢ ∀ r

• (∃ f • ∀ x y• f x = y ⇔ r x y)
⇔ (∀ x• ∃ y• r x y ∧ (∀ z• r x z ⇒ z = y))

47 THE THEORY one

47.1 Parents

basic hol

47.2 Children

hol

47.3 Constants

IsOneRep BOOL → BOOL

One ONE

Page 266 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

47.4 Types

ONE

47.5 Definitions

IsOneRep
is one rep def

⊢ ∃ one• ∀ x• IsOneRep x ⇔ x ⇔ one

ONE
one def1 ⊢ ∃ f • TypeDefn IsOneRep f

One
one def ⊢ ∀ x• x = One

47.6 Theorems

one fns thm ⊢ ∀ f • f = (λ x• One)

48 THE THEORY orders

48.1 Parents

sets

48.2 Children

R

48.3 Constants

Irrefl ′a SET × (′a → ′a → BOOL) → BOOL

Antisym ′a SET × (′a → ′a → BOOL) → BOOL

Trans ′a SET × (′a → ′a → BOOL) → BOOL

StrictPartialOrder
′a SET × (′a → ′a → BOOL) → BOOL

Trich ′a SET × (′a → ′a → BOOL) → BOOL

StrictLinearOrder
′a SET × (′a → ′a → BOOL) → BOOL

$DenseIn ′a SET → ′a SET × (′a → ′a → BOOL) → BOOL

Dense ′a SET × (′a → ′a → BOOL) → BOOL

UpperBound ′a SET × (′a → ′a → BOOL) × ′a → BOOL

$HasSupremum ′a SET → ′a × ′a SET × (′a → ′a → BOOL) → BOOL

UnboundedAbove
′a SET × (′a → ′a → BOOL) → BOOL

UnboundedBelow
′a SET × (′a → ′a → BOOL) → BOOL

Complete ′a SET × (′a → ′a → BOOL) → BOOL

Cuts ′a SET × (′a → ′a → BOOL) → ′a SET SET

DownSet ′a SET × (′a → ′a → BOOL) × ′a → ′a SET

DownSets ′a SET × (′a → ′a → BOOL) × ′a SET → ′a SET SET
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48.4 Fixity

Right Infix 210 :
DenseIn HasSupremum << <<<

48.5 Definitions

Irrefl ⊢ ∀ X $<<• Irrefl (X , $<<) ⇔ (∀ x• x ∈ X ⇒ ¬ x << x )
Antisym ⊢ ∀ X $<<

• Antisym (X , $<<)
⇔ (∀ x y

• x ∈ X ∧ y ∈ X ∧ ¬ x = y ⇒ ¬ (x << y ∧ y << x ))
Trans ⊢ ∀ X $<<

• Trans (X , $<<)
⇔ (∀ x y z

• x ∈ X ∧ y ∈ X ∧ z ∈ X ∧ x << y ∧ y << z

⇒ x << z )
StrictPartialOrder

⊢ ∀ X $<<
• StrictPartialOrder (X , $<<)

⇔ Irrefl (X , $<<)
∧ Antisym (X , $<<)
∧ Trans (X , $<<)

Trich ⊢ ∀ X $<<
• Trich (X , $<<)

⇔ (∀ x y

• x ∈ X ∧ y ∈ X ∧ ¬ x = y ⇒ x << y ∨ y << x )
StrictLinearOrder

⊢ ∀ X $<<
• StrictLinearOrder (X , $<<)

⇔ StrictPartialOrder (X , $<<) ∧ Trich (X , $<<)
DenseIn ⊢ ∀ A X $<<

• A DenseIn (X , $<<)
⇔ (∀ x y

• x ∈ X ∧ y ∈ X ∧ x << y

⇒ (∃ a• a ∈ A ∧ x << a ∧ a << y))
Dense ⊢ ∀ X $<<• Dense (X , $<<) ⇔ X DenseIn (X , $<<)
UpperBound ⊢ ∀ A $<< x

• UpperBound (A, $<<, x ) ⇔ (∀ a• a ∈ A ⇒ a << x )
HasSupremum ⊢ ∀ A $<< x X

• A HasSupremum (x , X , $<<)
⇔ UpperBound (A, $<<, x )
∧ (∀ y

• y ∈ X ∧ UpperBound (A, $<<, y) ⇒ ¬ y << x )
UnboundedAbove

⊢ ∀ A $<<
• UnboundedAbove (A, $<<)

⇔ (∀ b• b ∈ A ⇒ (∃ c• c ∈ A ∧ b << c))
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UnboundedBelow
⊢ ∀ A $<<
• UnboundedBelow (A, $<<)

⇔ (∀ b• b ∈ A ⇒ (∃ c• c ∈ A ∧ c << b))
Complete ⊢ ∀ X $<<

• Complete (X , $<<)
⇔ (∀ A x

• ¬ A = {}
∧ A ⊆ X

∧ UnboundedAbove (A, $<<)
∧ x ∈ X

∧ UpperBound (A, $<<, x )
⇒ (∃ y• y ∈ X ∧ A HasSupremum (y , X , $<<)))

Cuts ⊢ ∀ X $<< A

• A ∈ Cuts (X , $<<)
⇔ A ⊆ X

∧ ¬ A = {}
∧ UnboundedAbove (A, $<<)
∧ (∃ x• x ∈ X ∧ UpperBound (A, $<<, x ))
∧ (∀ a b• a ∈ A ∧ b ∈ X ∧ b << a ⇒ b ∈ A)

DownSet ⊢ ∀ X $<< x• DownSet (X , $<<, x ) = {y |y ∈ X ∧ y << x}
DownSets ⊢ ∀ X $<< A s

• s ∈ DownSets (X , $<<, A)
⇔ (∃ x• x ∈ A ∧ s = DownSet (X , $<<, x ))

48.6 Theorems

⊂ irrefl thm ⊢ ∀ V • Irrefl (V , $⊂)
⊂ antisym thm

⊢ ∀ V • Antisym (V , $⊂)
⊂ trans thm ⊢ ∀ V • Trans (V , $⊂)
cuts trich thm

⊢ ∀ X $<<
• Trans (X , $<<) ∧ Trich (X , $<<)

⇒ Trich (Cuts (X , $<<), $⊂)
cuts strict partial order thm

⊢ ∀ X $<<• StrictPartialOrder (Cuts (X , $<<), $⊂)
cuts strict linear order thm

⊢ ∀ X $<<
• StrictLinearOrder (X , $<<)

⇒ StrictLinearOrder (Cuts (X , $<<), $⊂)
cuts complete thm

⊢ ∀ X $<<• Complete (Cuts (X , $<<), $⊂)
down sets cuts thm

⊢ ∀ X $<< A

• A ⊆ X

∧ Irrefl (X , $<<)
∧ Trans (X , $<<)
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∧ UnboundedBelow (A, $<<)
∧ A DenseIn (X , $<<)

⇒ DownSets (X , $<<, A) ⊆ Cuts (X , $<<)
down sets dense thm

⊢ ∀ X $<< A

• A ⊆ X

∧ StrictLinearOrder (X , $<<)
∧ UnboundedBelow (A, $<<)
∧ A DenseIn (X , $<<)

⇒ DownSets (X , $<<, A)
DenseIn (Cuts (X , $<<), $⊂)

dense superset thm
⊢ ∀ X $<< A B

• A ⊆ B ∧ B ⊆ X ∧ A DenseIn (X , $<<)
⇒ B DenseIn (X , $<<)

dense universe thm
⊢ ∀ X $<< A

• A ⊆ X ∧ A DenseIn (X , $<<) ⇒ Dense (X , $<<)
downset cut thm

⊢ ∀ X $<< a

• a ∈ X

∧ Trans (X , $<<)
∧ UnboundedBelow (X , $<<)
∧ X DenseIn (X , $<<)

⇒ DownSet (X , $<<, a) ∈ Cuts (X , $<<)
down sets less thm

⊢ ∀ X $<< a b

• a ∈ X ∧ b ∈ X ∧ StrictLinearOrder (X , $<<)
⇒ (DownSet (X , $<<, a) ⊂ DownSet (X , $<<, b)
⇔ a << b)

cuts unbounded above thm
⊢ ∀ X $<<
• Irrefl (X , $<<)

∧ Trans (X , $<<)
∧ UnboundedAbove (X , $<<)
∧ X DenseIn (X , $<<)

⇒ UnboundedAbove (Cuts (X , $<<), $⊂)
cuts unbounded below thm

⊢ ∀ X $<<
• Irrefl (X , $<<)

∧ Trans (X , $<<)
∧ UnboundedBelow (X , $<<)
∧ X DenseIn (X , $<<)

⇒ UnboundedBelow (Cuts (X , $<<), $⊂)
dense complete subset thm

⊢ ∀ X $<< A

• StrictLinearOrder (X , $<<)
∧ A ⊆ X
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∧ UnboundedAbove (X , $<<)
∧ UnboundedBelow (X , $<<)
∧ A DenseIn (X , $<<)
∧ Complete (A, $<<)

⇒ A = X

induced order irrefl thm
⊢ ∀ X $<< f

• (∀ a• f a ∈ X ) ∧ Irrefl (X , $<<)
⇒ Irrefl (Universe, (λ a b• f a << f b))

induced order antisym thm
⊢ ∀ X $<< f

• (∀ a• f a ∈ X ) ∧ Irrefl (X , $<<) ∧ Antisym (X , $<<)
⇒ Antisym (Universe, (λ a b• f a << f b))

induced order trans thm
⊢ ∀ X $<< f

• (∀ a• f a ∈ X ) ∧ Trans (X , $<<)
⇒ Trans (Universe, (λ a b• f a << f b))

induced order trich thm
⊢ ∀ X $<< f

• (∀ a• f a ∈ X ) ∧ OneOne f ∧ Trich (X , $<<)
⇒ Trich (Universe, (λ a b• f a << f b))

induced strict partial order thm
⊢ ∀ X $<< f

• (∀ a• f a ∈ X ) ∧ StrictPartialOrder (X , $<<)
⇒ StrictPartialOrder

(Universe, (λ a b• f a << f b))
induced strict linear order thm

⊢ ∀ X $<< f

• (∀ a• f a ∈ X )
∧ OneOne f

∧ StrictLinearOrder (X , $<<)
⇒ StrictLinearOrder

(Universe, (λ a b• f a << f b))
induced order complete thm

⊢ ∀ X $<< f

• (∀ a• f a ∈ X )
∧ OneOne f

∧ (∀ x• x ∈ X ⇒ (∃ a• x = f a))
∧ Complete (X , $<<)

⇒ Complete (Universe, (λ a b• f a << f b))
induced order dense thm

⊢ ∀ X $<< f A

• (∀ a• f a ∈ X )
∧ OneOne f

∧ (∀ x• x ∈ X ⇒ (∃ a• x = f a))
∧ {x |∃ a• a ∈ A ∧ x = f a} DenseIn (X , $<<)

⇒ A DenseIn (Universe, (λ a b• f a << f b))
induced order unbounded above thm
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⊢ ∀ X $<< f

• (∀ a• f a ∈ X )
∧ OneOne f

∧ (∀ x• x ∈ X ⇒ (∃ a• x = f a))
∧ UnboundedAbove (X , $<<)

⇒ UnboundedAbove (Universe, (λ a b• f a << f b))
induced order unbounded below thm

⊢ ∀ X $<< f

• (∀ a• f a ∈ X )
∧ OneOne f

∧ (∀ x• x ∈ X ⇒ (∃ a• x = f a))
∧ UnboundedBelow (X , $<<)

⇒ UnboundedBelow (Universe, (λ a b• f a << f b))

49 THE THEORY pair

49.1 Parents

misc

49.2 Children

N

49.3 Constants

IsPairRep (′a → ′b → Bool) → Bool

$, ′a → ′b → ′a × ′b

Fst ′a × ′b → ′a

Snd ′a × ′b → ′b

Uncurry (′a → ′b → ′c) → ′a × ′b → ′c

Curry (′a × ′b → ′c) → ′a → ′b → ′c

Pair (′a → ′b) × (′a → ′c) → ′a → ′b × ′c

49.4 Types

′1 × ′2

49.5 Fixity

Right Infix 150 :
, ×

49.6 Terminators

×
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49.7 Definitions

IsPairRep
is pair rep def

⊢ ∃ comma fst snd

• (∀ x y

• IsPairRep (comma x y)
∧ fst (comma x y) = x

∧ snd (comma x y) = y)
∧ (∀ x y a b

• comma a b = comma x y ⇔ a = x ∧ b = y)
∧ (∀ p• IsPairRep p ⇒ comma (fst p) (snd p) = p)

×
× def ⊢ ∃ f • TypeDefn IsPairRep f

comma def ⊢ ∃ fst snd

• (∀ x y• fst (x , y) = x ∧ snd (x , y) = y)
∧ (∀ x y a b• (a, b) = (x , y) ⇔ a = x ∧ b = y)
∧ (∀ p• (fst p, snd p) = p)

fst def ⊢ ∃ snd

• (∀ x y• Fst (x , y) = x ∧ snd (x , y) = y)
∧ (∀ x y a b• (a, b) = (x , y) ⇔ a = x ∧ b = y)
∧ (∀ p• (Fst p, snd p) = p)

,
Fst
Snd
pair ops def
snd def ⊢ (∀ x y• Fst (x , y) = x ∧ Snd (x , y) = y)

∧ (∀ x y a b• (a, b) = (x , y) ⇔ a = x ∧ b = y)
∧ (∀ p• (Fst p, Snd p) = p)

Uncurry
uncurry def ⊢ ∀ f x y• Uncurry f (x , y) = f x y

Curry
curry def ⊢ ∀ f x y• Curry f x y = f (x , y)
Pair
pair def ⊢ ∀ f g• Pair (f , g) = (λ x• (f x , g x ))

49.8 Theorems

pair clauses ⊢ ∀ x y a b p fu fc fg

• Fst (x , y) = x

∧ Snd (x , y) = y

∧ ((a, b) = (x , y) ⇔ a = x ∧ b = y)
∧ (Fst p, Snd p) = p

∧ Curry fc x y = fc (x , y)
∧ Uncurry fu (x , y) = fu x y

∧ Uncurry fu p = fu (Fst p) (Snd p)
∧ ((a, b) = p ⇔ a = Fst p ∧ b = Snd p)
∧ (p = (a, b) ⇔ Fst p = a ∧ Snd p = b)
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∧ Pair fg x = (Fst fg x , Snd fg x )

50 THE THEORY seq

50.1 Parents

fun rel

50.2 Children

fin set

50.3 Constants

Elems ′a LIST → ′a P

Distinct ′a LIST P

Lists ′a P → ′a LIST P

Lists1
′a P → ′a LIST P

InjLists ′a P → ′a LIST P

Nth ′a LIST → N → ′a

$.. N → N → N P

ListRel ′a LIST → N ↔ ′a

RelList N ↔ ′a → ′a LIST

Last ′a LIST → ′a

Front ′a LIST → ′a LIST

$↾ ′a LIST → ′a P → ′a LIST

Enumerate N P → N ↔ N

Squash N ↔ ′a → N ↔ ′a

Extract N P → ′a LIST → ′a LIST

$Prefix ′a LIST → ′a LIST → BOOL

$Suffix ′a LIST → ′a LIST → BOOL

$In ′a LIST → ′a LIST → BOOL

Flat ′a LIST LIST → ′a LIST

50.4 Aliases

# Length : ′a LIST → N

a Append : ′a LIST → ′a LIST → ′a LIST

Head Hd : ′a LIST → ′a

Tail Tl : ′a LIST → ′a LIST

50.5 Fixity

Left Infix 300 :
↾

Right Infix 290 :
..

Right Infix 300 :

In Prefix Suffix a
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50.6 Definitions

Elems ⊢ Elems [] = {}
∧ (∀ x l• Elems (Cons x l) = {x} ∪ Elems l)

Distinct ⊢ [] ∈ Distinct

∧ (∀ x l

• Cons x l ∈ Distinct

⇔ ¬ x ∈ Elems l ∧ l ∈ Distinct)
Lists ⊢ ∀ a• Lists a = {l |Elems l ⊆ a}
Lists1 ⊢ ∀ a• Lists1 a = Lists a \ {[]}
InjLists ⊢ ∀ a• InjLists a = Lists a ∩ Distinct

Nth ⊢ ∀ l x n

• Nth (Cons x l) n

= (if n = 1 then x else Nth l (n − 1 ))
.. ⊢ ∀ m n• m .. n = {i |m ≤ i ∧ i ≤ n}
ListRel ⊢ ∀ l• ListRel l = 1 .. # l ⊳ Graph (Nth l)
RelList ⊢ ConstSpec

(λ RelList ′• ∀ l• RelList ′ (ListRel l) = l)
RelList

Last ⊢ ∀ x l

• Last (Cons x l) = (if l = [] then x else Last l)
Front ⊢ ∀ x l

• Front (Cons x l)
= (if l = [] then [] else Cons x (Front l))

↾ ⊢ ∀ a x l

• [] ↾ a = []
∧ Cons x l ↾ a

= (if x ∈ a then Cons x (l ↾ a) else l ↾ a)
Enumerate ⊢ ∀ a

• Enumerate a

= {(i , j )
|∃ l

• j ∈ a

∧ l ∈ Distinct

∧ # l = i

∧ Elems l = a ∩ 0 .. j}
Squash ⊢ ∀ r• Squash r = Enumerate (Dom r) o

9 r

Extract ⊢ ∀ a l• Extract a l = RelList (Squash (a ⊳ ListRel l))

Prefix ⊢ ∀ s t• s Prefix t ⇔ (∃ v• s a v = t)

Suffix ⊢ ∀ s t• s Suffix t ⇔ (∃ u• u a s = t)

In ⊢ ∀ s t• s In t ⇔ (∃ u v• u a s a v = t)

Flat ⊢ ∀ e l• Flat [] = [] ∧ Flat (Cons e l) = e a Flat l
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51 THE THEORY sets

51.1 Parents

basic hol

51.2 Children

orders set thms Z hol

51.3 Constants

IsSetRep (′a → BOOL) → BOOL

$SetComp (′a → BOOL) → ′a SET

$∈ ′a → ′a SET → BOOL

{} ′a SET

Universe ′a SET

Insert ′a → ′a SET → ′a SET

∼ ′a SET → ′a SET

$∪ ′a SET → ′a SET → ′a SET

$∩ ′a SET → ′a SET → ′a SET

$\ ′a SET → ′a SET → ′a SET

$⊖ ′a SET → ′a SET → ′a SET

$⊆ ′a SET → ′a SET → BOOL

$⊂ ′a SET → ′a SET → BOOL⋃
′a SET SET → ′a SET⋂
′a SET SET → ′a SET

P
′a SET → ′a SET SET

51.4 Types

′1 SET

51.5 Fixity

Binder : SetComp
Left Infix 265 :

\
Right Infix 230 :

⊆ ∈ ⊂
Right Infix 250 :

⊖
Right Infix 260 :

∪
Right Infix 270 :

∩
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51.6 Definitions

IsSetRep
is set rep def

⊢ IsSetRep = (λ x• T )
SET
set def ⊢ ∃ f • TypeDefn IsSetRep f

SetComp
∈
set comp def ⊢ ∀ x p a b

• (x ∈ {v |p v} ⇔ p x )
∧ (a = b ⇔ (∀ x• x ∈ a ⇔ x ∈ b))

Empty
Universe
Insert
insert def ⊢ ∀ x y a

• ¬ x ∈ {}
∧ x ∈ Universe

∧ (x ∈ Insert y a ⇔ x = y ∨ x ∈ a)
∼
complement def

⊢ ∀ x a• x ∈ ∼ a ⇔ ¬ x ∈ a

∪
∪ def ⊢ ∀ x a b• x ∈ a ∪ b ⇔ x ∈ a ∨ x ∈ b

∩
∩ def ⊢ ∀ x a b• x ∈ a ∩ b ⇔ x ∈ a ∧ x ∈ b

\
set dif def ⊢ ∀ x a b• x ∈ a \ b ⇔ x ∈ a ∧ ¬ x ∈ b

⊖
⊖ def ⊢ ∀ x a b• x ∈ a ⊖ b ⇔ ¬ (x ∈ a ⇔ x ∈ b)
⊆
⊆ def ⊢ ∀ a b• a ⊆ b ⇔ (∀ x• x ∈ a ⇒ x ∈ b)
⊂
⊂ def ⊢ ∀ a b• a ⊂ b ⇔ a ⊆ b ∧ (∃ x• ¬ x ∈ a ∧ x ∈ b)⋃
⋃

def ⊢ ∀ x a• x ∈
⋃

a ⇔ (∃ s• x ∈ s ∧ s ∈ a)⋂
⋂

def ⊢ ∀ x a• x ∈
⋂

a ⇔ (∀ s• s ∈ a ⇒ x ∈ s)
P

P def ⊢ ∀ x a• x ∈ P a ⇔ x ⊆ a

51.7 Theorems

sets clauses ⊢ ∀ x y p q

• (x ∈ {} ⇔ F )
∧ (x ∈ Universe ⇔ T )
∧ (x ∈ {v |q} ⇔ q)
∧ (x ∈ {v |p v} ⇔ p x )
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∧ (x ∈ {v |v = y} ⇔ x = y)
∧ (x ∈ {y} ⇔ x = y)

complement clauses
⊢ (∀ x a• x ∈ ∼ a ⇔ ¬ x ∈ a)

∧ ∼ Universe = {}
∧ ∼ {} = Universe

∪ clauses ⊢ ∀ a

• a ∪ {} = a

∧ {} ∪ a = a

∧ a ∪ Universe = Universe

∧ Universe ∪ a = Universe

∧ a ∪ a = a

∩ clauses ⊢ ∀ a

• a ∩ {} = {}
∧ {} ∩ a = {}
∧ a ∩ Universe = a

∧ Universe ∩ a = a

∧ a ∩ a = a

set dif clauses
⊢ ∀ a

• a \ {} = a

∧ {} \ a = {}
∧ a \ Universe = {}
∧ Universe \ a = ∼ a

∧ a \ a = {}
⊖ clauses ⊢ ∀ a

• a ⊖ {} = a

∧ {} ⊖ a = a

∧ a ⊖ Universe = ∼ a

∧ Universe ⊖ a = ∼ a

∧ a ⊖ a = {}
⊆ clauses ⊢ ∀ a• a ⊆ a ∧ {} ⊆ a ∧ a ⊆ Universe

⊂ clauses ⊢ ∀ a• ¬ a ⊂ a ∧ ¬ a ⊂ {} ∧ {} ⊂ Universe⋃
clauses ⊢

⋃
{} = {} ∧

⋃
Universe = Universe⋂

clauses ⊢
⋂

{} = Universe ∧
⋂

Universe = {}
P clauses ⊢ ∀ a

• P {} = {{}}
∧ P Universe = Universe

∧ a ∈ P a

∧ {} ∈ P a

∅ clauses ⊢ ∀ x a

• {x |F} = {}
∧ ¬ x ∈ {}
∧ {} ∪ a = a

∧ a ∪ {} = a

∧ {} ∩ a = {}
∧ a ∩ {} = {}
∧ a \ {} = a
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∧ {} \ a = {}
∧ a ⊖ {} = a

∧ {} ⊖ a = a

∧ {} ⊆ a

∧ (a ⊆ {} ⇔ a = {})
∧ ({} ⊂ a ⇔ ¬ a = {})
∧ ¬ a ⊂ {}
∧ ¬ x ∈

⋃
{}

∧ x ∈
⋂

{}
∧ {} ∈ P a

∧ P {} = {{}}
∈ in clauses ⊢ (∀ x y a

• (x ∈ Universe ⇔ T )
∧ (x ∈ {} ⇔ F )
∧ (x ∈ Insert y a ⇔ x = y ∨ x ∈ a))

∧ (∀ x a b

• (x ∈ a ∪ b ⇔ x ∈ a ∨ x ∈ b)
∧ (x ∈ a ∩ b ⇔ x ∈ a ∧ x ∈ b)
∧ (x ∈ a \ b ⇔ x ∈ a ∧ ¬ x ∈ b)
∧ (x ∈ a ⊖ b ⇔ ¬ (x ∈ a ⇔ x ∈ b)))

∧ (∀ x a

• (x ∈
⋃

a ⇔ (∃ s• x ∈ s ∧ s ∈ a))
∧ (x ∈

⋂
a ⇔ (∀ s• s ∈ a ⇒ x ∈ s))

∧ (∀ x a• x ∈ P a ⇔ x ⊆ a))
sets ext clauses

⊢ ∀ a b

• (a ⊂ b

⇔ (∀ x• x ∈ a ⇒ x ∈ b)
∧ (∃ x• ¬ x ∈ a ∧ x ∈ b))

∧ (a ⊆ b ⇔ (∀ x• x ∈ a ⇒ x ∈ b))
∧ (a = b ⇔ (∀ x• x ∈ a ⇔ x ∈ b))

52 THE THEORY set thms

52.1 Parents

sets

52.2 Children

fun rel thms
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52.3 Constants

Nest ′a SET SET → BOOL

SubsetClosed ′a SET SET → BOOL

NestClosed ′a SET SET → BOOL

Maximal⊆
′a SET SET → ′a SET → BOOL

Choose ′a SET → ′a

52.4 Definitions

Nest ⊢ ∀ u• Nest u ⇔ (∀ a b• a ∈ u ∧ b ∈ u ⇒ a ⊆ b ∨ b ⊆ a)
SubsetClosed ⊢ ∀ u• SubsetClosed u ⇔ (∀ a b• a ∈ u ∧ b ⊆ a ⇒ b ∈ u)
NestClosed ⊢ ∀ u• NestClosed u ⇔ (∀ v• v ⊆ u ∧ Nest v ⇒

⋃
v ∈ u)

Maximal⊆ ⊢ ∀ u a

• Maximal⊆ u a

⇔ a ∈ u ∧ (∀ b• b ∈ u ∧ a ⊆ b ⇒ b = a)
Choose ⊢ ConstSpec

(λ Choose ′• ∀ a• ¬ a = {} ⇔ Choose ′ a ∈ a)
Choose

52.5 Theorems

Choose consistent
⊢ Consistent (λ Choose ′• ∀ a• ¬ a = {} ⇔ Choose ′ a ∈ a)

zorn thm1 ⊢ ∀ u

• ¬ u = {} ∧ SubsetClosed u ∧ NestClosed u

⇒ (∃ a• Maximal⊆ u a)

53 THE THEORY sum

53.1 Parents

combin

53.2 Children

hol

53.3 Constants

IsSumRep ′a × ′b × BOOL → BOOL

InL ′a → ′a + ′b

InR ′b → ′a + ′b

OutL ′a + ′b → ′a

OutR ′a + ′b → ′b

IsL ′a + ′b → BOOL

IsR ′a + ′b → BOOL
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53.4 Types

′1 + ′2

53.5 Fixity

Right Infix 300 :
+

53.6 Definitions

IsSumRep
is sum rep def

⊢ ∃ inl inr outl outr isl isr

• ∀ x1 x2 y1 y2 z

• IsSumRep (inl x1 )
∧ IsSumRep (inr y1 )
∧ (IsSumRep z

⇒ inl (outl z ) = z ∨ inr (outr z ) = z )
∧ (inl x1 = inl x2 ⇔ x1 = x2 )
∧ (inr y1 = inr y2 ⇔ y1 = y2 )
∧ ¬ inl x1 = inr y1

∧ ¬ inr y1 = inl x1

∧ outl (inl x1 ) = x1

∧ outr (inr y1 ) = y1

∧ (IsSumRep z ⇒ (isl z ⇔ inl (outl z ) = z ))
∧ (IsSumRep z ⇒ (isr z ⇔ inr (outr z ) = z ))

+
sum def ⊢ ∃ f • TypeDefn IsSumRep f

InL
InR
OutL
OutR
IsL
IsR
sum clauses ⊢ ∀ x1 x2 y1 y2 z

• (InL (OutL z ) = z ∨ InR (OutR z ) = z )
∧ (InL x1 = InL x2 ⇔ x1 = x2 )
∧ (InR y1 = InR y2 ⇔ y1 = y2 )
∧ ¬ InL x1 = InR y1

∧ ¬ InR y1 = InL x1

∧ OutL (InL x1 ) = x1

∧ OutR (InR y1 ) = y1

∧ (IsL z ⇔ InL (OutL z ) = z )
∧ (IsR z ⇔ InR (OutR z ) = z )
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53.7 Theorems

sum cases thm
⊢ ∀ x• (∃ y• x = InL y) ∨ (∃ z• x = InR z )

sum fns thm ⊢ ∀ f g• ∃1 h• h o InL = f ∧ h o InR = g

54 THE THEORY wrk049

54.1 Parents

lib thms

54.2 Children

fef003

54.3 Constants

$∈l
′a → ′a LIST → BOOL

54.4 Fixity

Right Infix 230 :
∈l

Postfix 300 : ∼

54.5 Axioms

fin enumerate ax
⊢ ∀ s

• s ∈ Finite

⇒ Enumerate s ∈ Finite ∧ # s = # (Enumerate s)
fin squash eq ax

⊢ ∀ r1 r2
• r1 ∈ Finite

∧ r2 ∈ Finite

∧ Squash r1 = Squash r2
⇒ # (Dom r1 ) = # (Dom r2 )

extract a single ax
⊢ ∀ l a x

• Extract a (l a [x ])
= (if # l + 1 ∈ a

then Extract a l a [x ]
else Extract a l)

rel list ⊕ ax1
⊢ ∀ r l x
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• r ∈ Functional ∧ Dom r ⊆ Dom (ListRel l)

⇒ RelList (ListRel (l a [x ]) ⊕ r)

= RelList (ListRel l ⊕ r) a [x ]
rel list ⊕ ax2

⊢ ∀ r l x y

• r ∈ Functional ∧ Dom r ⊆ Dom (ListRel l)
⇒ RelList

(ListRel (l a [x ]) ⊕ r ∪ {(# l + 1 , y)})

= RelList (ListRel l ⊕ r) a [y ]

54.6 Definitions

∈l ⊢ (∀ x• ¬ x ∈l [])
∧ (∀ h t x• x ∈l Cons h t ⇔ x = h ∨ x ∈l t)

54.7 Theorems

one one inv thm
⊢ ∀ f • OneOne f ⇒ (∃ g• ∀ x• g (f x ) = x )

fin set thm5 ⊢ ∀ x• {x} ∈ Finite

dom singleton thm
⊢ ∀ x• Dom {x} = {Fst x}

fin dom thm ⊢ ∀ r• r ∈ Finite ⇒ Dom r ∈ Finite

squash id fin thm
⊢ ∀ r• r ∈ Finite ⇒ Squash (Id (Dom r)) ∈ Finite

id singleton thm
⊢ ∀ x• Id {x} = {(x , x )}

id ∪ thm ⊢ ∀ a b• Id (a ∪ b) = Id a ∪ Id b

fin id thm ⊢ ∀ r• r ∈ Finite ⇒ Id r ∈ Finite

dom singleton thm1
⊢ ∀ x y a b• Dom x = {y} ∧ (a, b) ∈ x ⇒ a = y

set thm1 ⊢ ∀ n• {i |i = n ∧ i ≤ n} = {n}
squash single thm

⊢ ∀ r1 r2 n1 n2

• Dom r1 = {n1}
∧ Dom r2 = {n2}
∧ Ran r1 = Ran r2

⇒ Squash r1 = Squash r2
enumerate singleton thm

⊢ ∀ x• Enumerate {x} = {(1 , x )}
o
9 ∪ thm ⊢ ∀ a b r• a ∪ b o

9 r = (a o
9 r) ∪ (b o

9 r)
o
9 ∪ thm1 ⊢ ∀ a b r• r o

9 a ∪ b = (r o
9 a) ∪ (r o

9 b)
o
9 singleton thm

⊢ ∀ x 1 x 2• {x 1} o
9 {x 2} ∈ Finite

fin o
9 thm ⊢ ∀ r1 r2

• r1 ∈ Finite ∧ (r2 ∈ Functional ∨ r2 ∈ Finite)
⇒ r1 o

9 r2 ∈ Finite
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fin squash thm
⊢ ∀ r1• r1 ∈ Finite ⇒ Squash r1 ∈ Finite

rel combine ∪ thm
⊢ ∀ r1 r2 r3
• RelCombine r1 (r2 ∪ r3 )

= RelCombine r1 r2 ∪ RelCombine r1 r3
rel combine ∪ thm1

⊢ ∀ r1 r2 r3
• RelCombine (r1 ∪ r2 ) r3

= RelCombine r1 r3 ∪ RelCombine r2 r3
rel combine singleton thm

⊢ ∀ x 1 x 2• RelCombine {x 1} {x 2} ∈ Finite

fin rel combine thm
⊢ ∀ r1 r2
• r1 ∈ Finite ∧ r2 ∈ Finite

⇒ RelCombine r1 r2 ∈ Finite

fin ⊲ thm ⊢ ∀ r s• r ∈ Finite ⇒ r ⊲ s ∈ Finite

inv rel ∪ thm
⊢ ∀ a b• (a ∪ b) ∼ = a ∼ ∪ b ∼

inv rel singleton thm
⊢ ∀ x y• {(x , y)} ∼ = {(y , x )}

fin inv rel thm
⊢ ∀ r• r ∈ Finite ⇒ r ∼ ∈ Finite

squash null thm
⊢ Squash {} = {}

squash null thm1
⊢ ∀ r

• (Squash r = {} ⇔ r = {}) ∧ ({} = Squash r ⇔ r = {})
dom ∪ greater thm

⊢ ∀ r x y n

• (∀ i j• i ∈ Dom r ∧ j ∈ Dom x ⇒ j > i) ∧ (n, y) ∈ r

⇒ {i |i ∈ Dom r ∧ i ≤ n}
= {i |i ∈ Dom (r ∪ x ) ∧ i ≤ n}

squash ∪ thm ⊢ ∀ r1 r2 x y

• Squash r1 = Squash r2
∧ Squash x = Squash y

∧ r1 ∈ Finite

∧ r2 ∈ Finite

∧ x ∈ Finite

∧ y ∈ Finite

∧ (∀ i j• i ∈ Dom r1 ∧ j ∈ Dom x ⇒ j > i)
∧ (∀ i j• i ∈ Dom r2 ∧ j ∈ Dom y ⇒ j > i)

⇒ Squash (r1 ∪ x ) = Squash (r2 ∪ y)
map null thm ⊢ ∀ f l

• (Map f l = [] ⇔ l = []) ∧ ([] = Map f l ⇔ l = [])
¬ cons thm ⊢ ∀ l x• ¬ Cons x l = l

a Cons thm ⊢ ∀ a l• [a] a l = Cons a l

rel ext clauses
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⊢ ∀ a b

• (a ⊆ b ⇔ (∀ x y• (x , y) ∈ a ⇒ (x , y) ∈ b))
∧ (a = b ⇔ (∀ x y• (x , y) ∈ a ⇔ (x , y) ∈ b))

pair eq thm1 ⊢ ∀ x y• Fst x = Fst y ∧ Snd x = Snd y ⇔ x = y

rel thm ⊢ ∀ r r1 a b

• a o
9 Graph r = b o

9 Graph r

∧ (∀ x x 1• r x = r x 1 ⇒ r1 x = r1 x 1 )
⇒ a o

9 Graph r1 = b o
9 Graph r1

at thm1 ⊢ ∀ f x y• f ∈ Functional ∧ (x , y) ∈ f ⇒ f @ x = y
o
9 fun thm ⊢ ∀ f r

• f ∈ Functional ∧ Graph r ∈ Functional

⇒ f o
9 Graph r ∈ Functional

o
9 fun thm1 ⊢ ∀ r1 r2

• r1 ∈ Functional ∧ r2 ∈ Functional

⇒ r1 o
9 r2 ∈ Functional

rel combine fun thm
⊢ ∀ r1 r2
• r1 ∈ Functional ∧ r2 ∈ Functional

⇒ RelCombine r1 r2 ∈ Functional

list rel null thm
⊢ ListRel [] = {}

∪ null thm ⊢ ∀ a b• a ∪ b = {} ⇔ a = {} ∧ b = {}

map a thm ⊢ ∀ f x l• Map f (l a [x ]) = Map f l a [f x ]
o
9 graph null thm

⊢ ∀ r• {} o
9 Graph r = {}

⊲ null thm ⊢ ∀ r• {} ⊲ r = {}
o
9 null thm ⊢ ∀ r1 r2• {} = r1 o

9 r2 ⇔ Ran r1 ∩ Dom r2 = {}
o
9 null thm1 ⊢ ∀ r1 r2• r1 o

9 r2 = {} ⇔ Ran r1 ∩ Dom r2 = {}
dom null thm ⊢ ∀ r• Dom r = {} ⇔ r = {}
id dom null thm

⊢ Id (Dom {}) = {}
inv rel o

9 null thm
⊢ ∀ r• {} ∼ o

9 r = {}
rel combine null thm

⊢ ∀ r• RelCombine {} r = {}
rel combine null thm1

⊢ ∀ r• RelCombine r {} = {}
⊲ singleton thm

⊢ ∀ a b s

• {(a, b)} ⊲ s = (if b ∈ s then {(a, b)} else {})
list rel fun thm

⊢ ∀ l• ListRel l ∈ Functional

list rel ⊲ fun thm
⊢ ∀ l s• ListRel l ⊲ s ∈ Functional

rel combine null thm2
⊢ ∀ r1 r2
• Dom r1 ∩ Dom r2 = {} ⇒ RelCombine r1 r2 = {}

dom thm ⊢ ∀ x r• x ∈ Dom r ⇔ (∃ y• (x , y) ∈ r)
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ran thm ⊢ ∀ y r• y ∈ Ran r ⇔ (∃ x• (x , y) ∈ r)
fin list rel thm

⊢ ∀ l• ListRel l ∈ Finite

fin list rel ⊲ thm
⊢ ∀ l s• ListRel l ⊲ s ∈ Finite

length a one thm

⊢ ∀ l x• # (l a [x ]) = # l + 1

size list rel thm
⊢ ∀ l• # (ListRel l) = # l

size squash thm
⊢ ∀ r1 r2
• r1 ∈ Functional

∧ r2 ∈ Functional

∧ r1 ∈ Finite

∧ r2 ∈ Finite

∧ # r1 = # r2
⇒ # (Squash (Id (Dom r1 )))
= # (Squash (Id (Dom r2 )))

size squash id dom thm
⊢ ∀ l l ′ s

• # (ListRel l ⊲ s) = # (ListRel l ′ ⊲ s)
⇒ # (Squash (Id (Dom (ListRel l ⊲ s))))
= # (Squash (Id (Dom (ListRel l ′ ⊲ s))))

⊕ thm ⊢ ∀ x y r s

• (x , y) ∈ r ⊕ s

⇔ ¬ x ∈ Dom s ∧ (x , y) ∈ r ∨ (x , y) ∈ s

length single thm
⊢ ∀ x• # [x ] = 1

⊕ single ⊢ ∀ f x y a b

• (x , y) ∈ f ⊕ {(a, b)}
⇔ (x , y) = (a, b) ∨ (x , y) ∈ f ∧ ¬ x = a

set dif ∪ thm
⊢ ∀ a b c• a \ (b ∪ c) = (a \ b) ∩ (a \ c)

image ∪ thm ⊢ ∀ a b s• (a ∪ b) Image s = a Image s ∪ b Image s

∪ ∩ thm ⊢ ∀ a b c• (a ∪ b) ∩ c = a ∩ c ∪ b ∩ c

−⊳ thm ⊢ ∀ x y s r• (x , y) ∈ s −⊳ r ⇔ ¬ x ∈ s ∧ (x , y) ∈ r

−⊳ null thm ⊢ ∀ s• s −⊳ {} = {}
⊳ null thm ⊢ ∀ s• s ⊳ {} = {}
a ↾ thm ⊢ ∀ l1 l2 s• (l1 a l2 ) ↾ s = (l1 ↾ s) a (l2 ↾ s)

list rel a ⊲ thm
⊢ ∀ l x s

• ListRel (l a [x ]) ⊲ s

= (if x ∈ s

then (ListRel l ⊲ s) ∪ {(# (ListRel l) + 1 , x )}
else ListRel l ⊲ s)

size list rel a ⊲ thm
⊢ ∀ l x s
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• # (ListRel (l a [x ]) ⊲ s)
= (if x ∈ s

then # (ListRel l ⊲ s) + 1

else # (ListRel l ⊲ s))

squash a thm ⊢ ∀ l x s

• Squash (Id (Dom (ListRel (l a [x ]) ⊲ s)))
= (if ¬ x ∈ s

then Squash (Id (Dom (ListRel l ⊲ s)))
else

Squash (Id (Dom (ListRel l ⊲ s)))
∪ {(# (Squash (Id (Dom (ListRel l ⊲ s))))

+ 1 , # l + 1 )})
⊕ null thm ⊢ {} ⊕ {} = {}
⊳ ∪ thm ⊢ ∀ a b r• a ∪ b ⊳ r = (a ⊳ r) ∪ (b ⊳ r)

map a thm1 ⊢ ∀ f l1 l2

• Map f (l1 a l2 ) = Map f l1
a Map f l2

nth a thm ⊢ ∀ l x n

• n ∈ 1 .. # l + 1

⇒ Nth (l a [x ]) n

= (if n = # l + 1 then x else Nth l n)
nth length one thm

⊢ ∀ l last• Nth (l a [last ]) (# l + 1 ) = last

image single thm
⊢ ∀ a b s

• {(a, b)} Image s = (if a ∈ s then {b} else {})
length set def thm

⊢ ∀ l x• 1 .. # (l a [x ]) \ {# l + 1} = 1 .. # l

length ∩ thm ⊢ ∀ l s• ¬ # l + 1 ∈ s ∩ 1 .. # l

nth a thm1 ⊢ ∀ l x last

• x ∈ 1 .. # l ⇒ Nth (l a [last ]) x = Nth l x

¬ ≤ plus1 thm
⊢ ∀ m n• ¬ (m ≤ n ∧ m = n + 1 )

≤ plus one thm
⊢ ∀ l x• x ≤ # l ⇒ x ≤ # l + 1

⊕ single thm1
⊢ ∀ x y g• x ∈ Dom g ⇒ {(x , y)} ⊕ g = g

⊕ single thm2
⊢ ∀ x y g• ¬ x ∈ Dom g ⇒ {(x , y)} ⊕ g = {(x , y)} ∪ g

dot dot single thm
⊢ ∀ x n• x ∈ n .. n ⇔ x = n

a a thm ⊢ ∀ l x y• (l a [x ]) a [y ] = l a [x ] a [y ]
a a thm1 ⊢ ∀ l x y• (l a [x ]) a [y ] = l a [x ; y ]
list rel list thm

⊢ ∀ l s• ListRel l ⊲ s = {} ⇔ l ↾ s = []
list rel ⊕ thm
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⊢ ∀ l x s

• ListRel (l a [x ]) ⊕ s

= (ListRel l ⊕ s) ∪ ({(# l + 1 , x )} ⊕ s)
⊕ null thm1 ⊢ ∀ f g• f ⊕ g = {} ⇔ f = {} ∧ g = {}
⊕ null thm2 ⊢ ∀ f • f ⊕ {} = f

list rel null thm1
⊢ ∀ l• ListRel l = {} ⇔ l = []

list rel null thm2
⊢ ∀ l• {} = ListRel l ⇔ l = []

dot dot eq thm
⊢ ∀ n1 n2• 1 .. n1 = 1 .. n2 ⇔ n1 = n2

size list rel eq thm
⊢ ∀ l1 l2• ListRel l1 = ListRel l2 ⇒ # l1 = # l2

list rel a eq thm
⊢ ∀ l1 l2 x 1 x 2

• ListRel (l1 a [x 1 ]) = ListRel (l2 a [x 2 ])
⇒ ListRel l1 = ListRel l2 ∧ x 1 = x 2

list rel one one thm
⊢ OneOne ListRel

RelList consistent
⊢ Consistent

(λ RelList ′• ∀ l• RelList ′ (ListRel l) = l)
rel list null thm

⊢ RelList {} = []
distinct single thm

⊢ ∀ x• [x ] ∈ Distinct

elems a thm ⊢ ∀ l x• Elems (l a [x ]) = {x} ∪ Elems l

distinct a thm
⊢ ∀ l x

• l a [x ] ∈ Distinct ⇔ ¬ x ∈ Elems l ∧ l ∈ Distinct

size squash plus1 thm
⊢ ∀ l x s

• x ∈ s

⇒ # (Squash (Id (Dom (ListRel (l a [x ]) ⊲ s))))
= # (Squash (Id (Dom (ListRel l ⊲ s)))) + 1

size a one thm
⊢ ∀ l x s

• x ∈ s

⇒ (# (Squash (Id (Dom (ListRel (l a [x ]) ⊲ s)))),
# l + 1 )

∈ Squash (Id (Dom (ListRel (l a [x ]) ⊲ s)))
↾ null thm ⊢ ∀ l• l ↾ {} = []
↾ extract null thm

⊢ ∀ l s a• l ↾ s = [] ⇒ Extract a l ↾ s = []

∈l
a thm ⊢ ∀ x l1 l2• x ∈l l1

a l2 ⇔ x ∈l l1 ∨ x ∈l l2
∈l elems thm
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⊢ ∀ x l• x ∈l l ⇔ x ∈ Elems l

∈l extract thm
⊢ ∀ x a l• x ∈l Extract a l ⇒ x ∈l l

55 THE THEORY wrk057

55.1 Parents

lib thms

55.2 Children

fef042

55.3 Constants

FinitaryRecType
(′D → ′T )
↔ ((′D → ′T P) × (′T → N) × ((′T → ′y) → ′D → ′Y ))

LocalFunctional
((′T → ′y) → ′D → ′Y ) ↔ (′D → ′T P)

Tree (N × ′a) LIST P

Unparse (N × ′a) LIST → N → (N × ′a) LIST

MkTree ′a × ′a TREE LIST → ′a TREE

55.4 Types

′1 TREE

55.5 Definitions

FinitaryRecType
⊢ FinitaryRecType

= {(k , c, w , M )
|OneOne k

∧ (∀ t• ∃ x• c x ⊆ {z |w z < w t} ∧ t = k x )
∧ (∀ i g1 g2
• (∀ y• w y < i ⇒ g1 y = g2 y)

⇒ (∀ x

• c x ⊆ {y |w y < i} ⇒ M g1 x = M g2 x ))}
LocalFunctional

⊢ LocalFunctional

= {(M , c)
|∀ I g1 g2
• (∀ y• y ∈ I ⇒ g1 y = g2 y)

⇒ (∀ x• c x ⊆ I ⇒ M g1 x = M g2 x )}
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Tree ⊢ Tree

=
⋂

{A
|∀ lab trees

• Elems trees ⊆ A

⇒ Cons (# trees, lab) (Flat trees) ∈ A}
Unparse ⊢ ∀ i nv more

• Unparse [] i = []
∧ Unparse (Cons nv more) i

= (if i = 0

then []
else

Cons nv (Unparse more ((Fst nv + i) − 1 )))
TREE
tree def ⊢ ∃ f • TypeDefn (λ t• t ∈ Tree) f

MkTree ⊢ ConstSpec

(λ MkTree ′

• OneOne MkTree ′

∧ (∃ w

• ∀ t

• ∃ x

• (∀ z• z ∈ Elems (Snd x ) ⇒ w z < w t)
∧ t = MkTree ′ x ))

MkTree

55.6 Theorems

a empty thm ⊢ ∀ l1 l2• l1 a l2 = [] ⇔ l1 = [] ∧ l2 = []
flat empty thm

⊢ ∀ ls• Flat ls = [] ⇔ Elems ls ⊆ {[]}
append assoc thm

⊢ ∀ l1 l2 l3• (l1 a l2 ) a l3 = l1 a l2 a l3

flat append thm

⊢ ∀ ls1 ls2• Flat (ls1 a ls2 ) = Flat ls1 a Flat ls2

length append thm

⊢ ∀ ls1 ls2• # (ls1 a ls2 ) = # ls1 + # ls2

elems append thm

⊢ ∀ l1 l2• Elems (l1 a l2 ) = Elems l1 ∪ Elems l2

append empty thm

⊢ ∀ l• l a [] = l

append cancel thm

⊢ ∀ l1 l2 l3• l1 a l2 = l1 a l3 ⇔ l2 = l3

map map id thm
⊢ ∀ f g l

• (∀ x• x ∈ Elems l ⇒ f (g x ) = x )
⇒ Map f (Map g l) = l

length length flat thm
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⊢ ∀ ll l• l ∈ Elems ll ⇒ # l ≤ # (Flat ll)
elems map thm

⊢ ∀ f l

• Elems (Map f l) = {y |∃ x• x ∈ Elems l ∧ f x = y}
length 0 thm ⊢ ∀ l• # l = 0 ⇔ l = []
one one left inv thm

⊢ ∀ f • OneOne f ⇒ (∃ g• ∀ x• g (f x ) = x )
onto right inv thm

⊢ ∀ f • Onto f ⇒ (∃ g• ∀ y• f (g y) = y)
one one onto inv thm

⊢ ∀ f

• OneOne f ∧ Onto f

⇒ (∃ g• (∀ x• g (f x ) = x ) ∧ (∀ y• f (g y) = y))
fin rec type induction thm

⊢ ∀ k c w M

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∀ X • (∀ x• c x ⊆ X ⇒ k x ∈ X ) ⇒ (∀ t• t ∈ X ))
fin rec type induction thm1

⊢ ∀ k c w M

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∀ P

• (∀ x• (∀ t• t ∈ c x ⇒ P t) ⇒ P (k x ))
⇒ (∀ t• P t))

fin rec type prim rec lemma1
⊢ ∀ k c w

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∃ δ
• (∀ x• δ (k x ) = x )

∧ (∀ y• k (δ y) = y)
∧ (∀ d

• ∃ H

• (∀ y• H 0 y = d (δ y , M Arbitrary (δ y)))
∧ (∀ i y

• H (i + 1 ) y

= (if w y ≤ i

then H i y

else d (δ y , M (H i) (δ y))))
∧ (∀ j y• H (w y + j ) y = H (w y) y)))

fin rec type prim rec exists thm
⊢ ∀ k c w M

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∀ d• ∃ h• ∀ x• h (k x ) = d (x , M h x ))
fin rec type prim rec unique thm

⊢ ∀ k c w M

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∀ d h1 h2

• (∀ x• h1 (k x ) = d (x , M h1 x ))
∧ (∀ x• h2 (k x ) = d (x , M h2 x ))
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⇒ h1 = h2 )
fin rec type prim rec thm

⊢ ∀ k c w M

• (k , c, w , M ) ∈ FinitaryRecType

⇒ (∀ d• ∃1 h• ∀ x• h (k x ) = d x (M h x ))
local functional thm

⊢ ∀ c w M

• (M , c) ∈ LocalFunctional

⇒ (∀ i g1 g2
• (∀ y• w y < i ⇒ g1 y = g2 y)

⇒ (∀ x

• c x ⊆ {y |w y < i} ⇒ M g1 x = M g2 x ))
i local thm ⊢ ((λ f • f ), (λ x• {x})) ∈ LocalFunctional

k local thm ⊢ ((λ f x• {}), (λ x• {x})) ∈ LocalFunctional

× local thm ⊢ ∀ M 1 c1 M 2 c2
• (M 1 , c1 ) ∈ LocalFunctional

∧ (M 2 , c2 ) ∈ LocalFunctional

⇒ ((λ f (x , y)• (M 1 f x , M 2 f y)),
(λ (x , y)• c1 x ∪ c2 y))

∈ LocalFunctional

sum local thm
⊢ ∀ M 1 c1 M 2 c2
• (M 1 , c1 ) ∈ LocalFunctional

∧ (M 2 , c2 ) ∈ LocalFunctional

⇒ ((λ f x

• if IsL x

then M 1 f (OutL x )
else M 2 f (OutR x )),

(λ x

• if IsL x

then c1 (OutL x )
else c2 (OutR x )))

∈ LocalFunctional

list local thm
⊢ ∀ M c

• (M , c) ∈ LocalFunctional

⇒ ((λ f • Map (M f )), (λ x•
⋃

(Elems (Map c x ))))
∈ LocalFunctional

list local thm1
⊢ (Map, Elems) ∈ LocalFunctional

o snd local thm
⊢ ∀ M c

• (M , c) ∈ LocalFunctional

⇒ ((λ f • M f o Snd), c o Snd) ∈ LocalFunctional

o fst local thm
⊢ ∀ M c

• (M , c) ∈ LocalFunctional

⇒ ((λ f • M f o Fst), c o Fst) ∈ LocalFunctional
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tree induction lemma1
⊢ ∀ X

• (∀ x ts

• Elems ts ⊆ X ⇒ Cons (# ts, x ) (Flat ts) ∈ X )
⇒ Tree ⊆ X

tree induction lemma2
⊢ ∀ x ts

• Elems ts ⊆ Tree ⇒ Cons (# ts, x ) (Flat ts) ∈ Tree

tree induction lemma
⊢ ∀ X

• (∀ x ts

• Elems ts ⊆ Tree ∩ X

⇒ Cons (# ts, x ) (Flat ts) ∈ X )
⇒ Tree ⊆ X

tree induction tac lemma
⊢ ∀ P

• (∀ x ts

• (∀ t• t ∈ Elems ts ⇒ t ∈ Tree ∧ P t)
⇒ P (Cons (# ts, x ) (Flat ts)))

⇒ (∀ t• t ∈ Tree ⇒ P t)
tree cases lemma

⊢ ∀ t

• t ∈ Tree

⇒ (∃ x ts

• Elems ts ⊆ Tree ∧ t = Cons (# ts, x ) (Flat ts))
¬ empty list tree lemma

⊢ ¬ [] ∈ Tree

unparse thm ⊢ ∀ ts more

• Elems ts ⊆ Tree

⇒ Unparse (Flat ts a more) (# ts) = Flat ts

unparse thm1 ⊢ ∀ t more• t ∈ Tree ⇒ Unparse (t a more) 1 = t

tree cases lemma1
⊢ ∀ t

• t ∈ Tree

⇒ (∃1 (x , ts)
• Elems ts ⊆ Tree ∧ t = Cons (# ts, x ) (Flat ts))

leaf is a tree thm
⊢ ∀ x• [(0 , x )] ∈ Tree

MkTree consistent
⊢ Consistent

(λ MkTree ′

• OneOne MkTree ′

∧ (∃ w

• ∀ t

• ∃ x

• (∀ z• z ∈ Elems (Snd x ) ⇒ w z < w t)
∧ t = MkTree ′ x ))

tree local thm
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⊢ ((λ f • Map f o Snd), Elems o Snd) ∈ LocalFunctional

tree fin rec thm
⊢ ∃ w

• (MkTree, Elems o Snd , w , (λ f • Map f o Snd))
∈ FinitaryRecType

tree induction thm
⊢ ∀ P

• (∀ x

• (∀ t• t ∈ Elems (Snd x ) ⇒ P t) ⇒ P (MkTree x ))
⇒ (∀ t• P t)

tree prim rec thm
⊢ ∀ d• ∃1 h• ∀ x• h (MkTree x ) = d x (Map h (Snd x ))

56 THE THEORY R

56.1 Parents

orders dyadic

56.2 Constants

Is R Rep DYADIC SET → BOOL

$<R R → R → BOOL

$≤R R → R → BOOL

$>R R → R → BOOL

$≥R R → R → BOOL

Sup R SET → R

1R R

0R R

$+R R → R → R

∼R R → R

$−R R → R → R

NR N → R

AbsR R → R

$∗R R → R → R

$/R R → R → R

$/N N → N → R

$−1
R → R

$̂N R → N → R

ZR Z → R

$̂Z R → Z → R

Float N → Z → Z → R

MaxR R LIST → R

MinR R LIST → R
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56.3 Aliases

< $<R : R → R → BOOL

≤ $≤R : R → R → BOOL

> $>R : R → R → BOOL

≥ $≥R : R → R → BOOL

+ $+R : R → R → R

∼ ∼R : R → R

− $−R : R → R → R

Abs AbsR : R → R

∗ $∗R : R → R → R

/ $/R : R → R → R

/ $/N : N → N → R

̂ $̂N : R → N → R

̂ $̂Z : R → Z → R

56.4 Types

R

56.5 Fixity

Left Infix 305 :
−R

Left Infix 315 :
/ /N /R

Right Infix 210 :
<R >R ≤R ≥R

Right Infix 300 :
+R

Right Infix 310 :
∗R

Right Infix 320 :
̂N ̂Z

Postfix 320 : −1

56.6 Definitions

Is R Rep ⊢ ∀ a• Is R Rep a ⇔ a ∈ Cuts (Universe, $dy less)
R

R def ⊢ ∃ f • TypeDefn Is R Rep f

<R ⊢ ConstSpec

(λ <′
R

• StrictLinearOrder (Universe, <′
R)

∧ UnboundedBelow (Universe, <′
R)

∧ UnboundedAbove (Universe, <′
R)

∧ Complete (Universe, <′
R)
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∧ (∃ ι
• (∀ a b• <′

R (ι a) (ι b) ⇔ a dy less b)
∧ {x |∃ a• ι a = x}
DenseIn (Universe, <′

R)))
$<

≤R ⊢ ∀ x y• x ≤ y ⇔ x < y ∨ x = y

>R ⊢ ∀ x y• x > y ⇔ y < x

≥R ⊢ ∀ x y• x ≥ y ⇔ y ≤ x

Sup ⊢ ConstSpec

(λ Sup ′

• ∀ A

• ¬ A = {} ∧ (∃ b• ∀ x• x ∈ A ⇒ x ≤ b)
⇒ (∀ x• x ∈ A ⇒ x ≤ Sup ′ A)
∧ (∀ b

• (∀ x• x ∈ A ⇒ x ≤ b) ⇒ Sup ′ A ≤ b))
Sup

+R

0R
1R ⊢ ConstSpec

(λ (+′
R, 0

′
R, 1

′
R)

• (∀ x y z

• +′
R (+′

R x y) z = +′
R x (+′

R y z ))
∧ (∀ x y• +′

R x y = +′
R y x )

∧ (∀ x• +′
R x 0 ′

R = x )
∧ (∀ x• ∃ y• +′

R x y = 0 ′
R)

∧ (∀ x y z• y < z ⇒ +′
R x y < +′

R x z )
∧ 0 ′

R < 1 ′
R)

($+, 0R, 1R)
∼R ⊢ ConstSpec (λ ∼′

R• ∀ x• x + ∼′
R x = 0R) ∼

−R ⊢ ∀ x y• x − y = x + ∼ y

NR ⊢ 0 . = 0R ∧ (∀ m• NR (m + 1 ) = NR m + 1R)
AbsR ⊢ ∀ x• Abs x = (if 0 . ≤ x then x else ∼ x )
∗R ⊢ ConstSpec

(λ ∗′R
• (∀ x y z

• ∗′R (∗′R x y) z = ∗′R x (∗′R y z ))
∧ (∀ x• ∗′R x 1 . = x )
∧ (∀ x y z

• ∗′R x (y + z ) = ∗′R x y + ∗′R x z )
∧ (∀ x y• ∗′R x y = ∗′R y x )
∧ (∀ x y• 0 . < x ∧ 0 . < y ⇒ 0 . < ∗′R x y))

$∗
/R ⊢ ConstSpec

(λ /′R
• (∀ y z• ¬ z = 0 . ⇒ /′R (y ∗ z ) z = y)

∧ (∀ x y z

• ¬ z = 0 . ⇒ /′R (x ∗ y) z = x ∗ /′R y z ))
$/
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/N ⊢ ∀ m n• m / n = NR m / NR n
−1 ⊢ ∀ x• x −1 = 1 . / x

̂N ⊢ (∀ x• x ̂ 0 = 1 .) ∧ (∀ x m• x ̂ (m + 1 ) = x ∗ x ̂ m)
ZR ⊢ ConstSpec

(λ $”ZR′”
• $”ZR′” (NZ 0 ) = 0 .

∧ $”ZR′” (NZ 1 ) = 1 .
∧ (∀ i j

• $”ZR′” (i + j ) = $”ZR′” i + $”ZR′” j ))
ZR

̂Z ⊢ ConstSpec

(λ ̂′Z
• ∀ x m

• ̂′Z x (NZ m) = x ̂ m

∧ ̂′Z x (∼ (NZ (m + 1 )))
= (x ̂ (m + 1 )) −1 )

$̂
Float ⊢ ∀ m p e• Float m p e = NR m ∗ 10 . ̂ (e + ∼ p)
MaxR ⊢ ConstSpec

(λ Max ′
R

• (∀ x• Max ′
R [x ] = x )

∧ (∀ x y L

• Max ′
R (Cons x (Cons y L))

= (if x < Max ′
R (Cons y L)

then Max ′
R (Cons y L)

else x )))
MaxR

MinR ⊢ ConstSpec

(λ Min ′
R

• (∀ x• Min ′
R [x ] = x )

∧ (∀ x y L

• Min ′
R (Cons x (Cons y L))

= (if x > Min ′
R (Cons y L)

then Min ′
R (Cons y L)

else x )))
MinR

56.7 Theorems

dy less order lemmas thm
⊢ StrictLinearOrder (Universe, $dy less)

∧ UnboundedBelow (Universe, $dy less)
∧ UnboundedAbove (Universe, $dy less)
∧ Universe DenseIn (Universe, $dy less)

is R rep consistent thm
⊢ ∃ a• Is R Rep a

<R consistent
⊢ Consistent
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(λ <′
R

• StrictLinearOrder (Universe, <′
R)

∧ UnboundedBelow (Universe, <′
R)

∧ UnboundedAbove (Universe, <′
R)

∧ Complete (Universe, <′
R)

∧ (∃ ι
• (∀ a b• <′

R (ι a) (ι b) ⇔ a dy less b)
∧ {x |∃ a• ι a = x}
DenseIn (Universe, <′

R)))
R unbounded below thm

⊢ ∀ x• ∃ y• y < x

R unbounded above thm
⊢ ∀ x• ∃ y• x < y

R less irrefl thm
⊢ ∀ x• ¬ x < x

R less antisym thm
⊢ ∀ x y• ¬ (x < y ∧ y < x )

R less trans thm
⊢ ∀ x y z• x < y ∧ y < z ⇒ x < z

R less cases thm
⊢ ∀ x y• x < y ∨ x = y ∨ y < x

R ≤ cases thm
⊢ ∀ x y• x ≤ y ∨ y ≤ x

R ≤ less cases thm
⊢ ∀ x y• x ≤ y ∨ y < x

R eq ≤ thm ⊢ ∀ x y• x = y ⇔ x ≤ y ∧ y ≤ x

R ≤ antisym thm
⊢ ∀ x y• x ≤ y ∧ y ≤ x ⇒ x = y

R less ≤ trans thm
⊢ ∀ x y z• x < y ∧ y ≤ z ⇒ x < z

R ≤ less trans thm
⊢ ∀ x y z• x ≤ y ∧ y < z ⇒ x < z

R ≤ refl thm ⊢ ∀ x• x ≤ x

R ≤ trans thm
⊢ ∀ x y z• x ≤ y ∧ y ≤ z ⇒ x ≤ z

R ≤ ¬ less thm
⊢ ∀ x y• x ≤ y ⇔ ¬ y < x

R ¬ ≤ less thm
⊢ ∀ x y• ¬ x ≤ y ⇔ y < x

R less ¬ eq thm
⊢ ∀ x y• x < y ⇒ ¬ x = y

R less dense thm
⊢ ∀ x y• x < y ⇒ (∃ z• x < z ∧ z < y)

R complete thm
⊢ ∀ A

• ¬ A = {} ∧ (∃ b• ∀ x• x ∈ A ⇒ x ≤ b)
⇒ (∃ s

• (∀ x• x ∈ A ⇒ x ≤ s)
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∧ (∀ b• (∀ x• x ∈ A ⇒ x ≤ b) ⇒ s ≤ b))
Sup consistent

⊢ Consistent

(λ Sup ′

• ∀ A

• ¬ A = {} ∧ (∃ b• ∀ x• x ∈ A ⇒ x ≤ b)
⇒ (∀ x• x ∈ A ⇒ x ≤ Sup ′ A)
∧ (∀ b

• (∀ x• x ∈ A ⇒ x ≤ b) ⇒ Sup ′ A ≤ b))
R sup thm ⊢ ∀ A a

• ¬ A = {} ∧ (∀ x• x ∈ A ⇒ x ≤ a)
⇒ (∀ x• x ∈ A ⇒ x ≤ Sup A)
∧ (∀ b• (∀ x• x ∈ A ⇒ x ≤ b) ⇒ Sup A ≤ b)

R less sup thm
⊢ ∀ A

• ¬ A = {} ∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
⇒ (∀ x• x < Sup A ⇔ (∃ y• y ∈ A ∧ x < y))

R less sup bc thm
⊢ ∀ A x

• ¬ A = {}
∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
∧ (∃ y• y ∈ A ∧ x < y)

⇒ x < Sup A

R ≤ sup thm ⊢ ∀ A a

• ¬ A = {} ∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
⇒ (∀ x

• x ≤ Sup A

⇔ (∀ y• (∀ z• z ∈ A ⇒ z ≤ y) ⇒ x ≤ y))
R ≤ sup bc thm

⊢ ∀ A a x

• ¬ A = {}
∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
∧ (∀ y• (∀ z• z ∈ A ⇒ z ≤ y) ⇒ x ≤ y)

⇒ x ≤ Sup A

R ∈ ≤ sup bc thm
⊢ ∀ A x• x ∈ A ∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a) ⇒ x ≤ Sup A

R ⊆ sup thm ⊢ ∀ A B

• ¬ A = {}
∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
∧ ¬ B = {}
∧ (∃ b• ∀ y• y ∈ B ⇒ y ≤ b)
∧ A ⊆ B

⇒ Sup A ≤ Sup B

R sup ≤ bc thm
⊢ ∀ A a x

• ¬ A = {}
∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
∧ (∀ y• y ∈ A ⇒ y ≤ x )
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⇒ Sup A ≤ x

R sup less bc thm
⊢ ∀ A x z

• ¬ A = {}
∧ (∃ a• ∀ x• x ∈ A ⇒ x ≤ a)
∧ (∀ y• y ∈ A ⇒ y ≤ x )
∧ x < z

⇒ Sup A < z

R sup eq bc thm
⊢ ∀ A a s

• ¬ A = {}
∧ (∀ x• x ∈ A ⇒ x ≤ s)
∧ (∀ x• (∀ y• y ∈ A ⇒ y ≤ x ) ⇒ s ≤ x )

⇒ Sup A = s

R eq sup bc thm
⊢ ∀ A a s

• ¬ A = {}
∧ (∀ x• x ∈ A ⇒ x ≤ s)
∧ (∀ x• (∀ y• y ∈ A ⇒ y ≤ x ) ⇒ s ≤ x )

⇒ s = Sup A

R less sup ∈ thm
⊢ ∀ A a

• ¬ A = {} ∧ (∀ x• x ∈ A ⇒ x ≤ a) ∧ ¬ Sup A ∈ A

⇒ (∀ x

• x < Sup A ⇒ (∃ y• x < y ∧ y < Sup A ∧ y ∈ A))
+R consistent
0R consistent
1R consistent

⊢ Consistent

(λ (+′
R, 0

′
R, 1

′
R)

• (∀ x y z

• +′
R (+′

R x y) z = +′
R x (+′

R y z ))
∧ (∀ x y• +′

R x y = +′
R y x )

∧ (∀ x• +′
R x 0 ′

R = x )
∧ (∀ x• ∃ y• +′

R x y = 0 ′
R)

∧ (∀ x y z• y < z ⇒ +′
R x y < +′

R x z )
∧ 0 ′

R < 1 ′
R)

∼R consistent
⊢ Consistent (λ ∼′

R• ∀ x• x + ∼′
R x = 0R)

R plus assoc thm
⊢ ∀ x y z• (x + y) + z = x + y + z

R plus comm thm
⊢ ∀ x y• x + y = y + x

R plus unit thm
⊢ ∀ x• x + 0R = x

R plus mono thm
⊢ ∀ x y z• y < z ⇒ x + y < x + z

R plus assoc thm1
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⊢ ∀ x y z• x + y + z = (x + y) + z

R plus mono thm1
⊢ ∀ x y z• y < z ⇒ y + x < z + x

R plus mono thm2
⊢ ∀ x y s t• x < y ∧ s < t ⇒ x + s < y + t

R plus 0 thm ⊢ ∀ x• x + 0 . = x ∧ 0 . + x = x

R 0 1 thm ⊢ 0R = 0 . ∧ 1R = 1 .
R plus order thm

⊢ ∀ x y z

• y + x = x + y

∧ (x + y) + z = x + y + z

∧ y + x + z = x + y + z

R plus minus thm
⊢ ∀ x• x + ∼ x = 0 . ∧ ∼ x + x = 0 .

R eq thm ⊢ ∀ x y• x = y ⇔ x + ∼ y = 0 .
NR plus homomorphism thm

⊢ ∀ m n• NR (m + n) = NR m + NR n

R minus clauses
⊢ ∀ x y

• ∼ (∼ x ) = x

∧ x + ∼ x = 0 .
∧ ∼ x + x = 0 .
∧ ∼ (x + y) = ∼ x + ∼ y

∧ ∼ 0 . = 0 .
R minus eq thm

⊢ ∀ x y• ∼ x = ∼ y ⇔ x = y

NR 0 less thm
⊢ ∀ m• 0 . < NR (m + 1 )

NR one one thm
⊢ ∀ m n• NR m = NR n ⇔ m = n

R plus clauses
⊢ ∀ x y z

• (x + z = y + z ⇔ x = y)
∧ (z + x = y + z ⇔ x = y)
∧ (x + z = z + y ⇔ x = y)
∧ (z + x = z + y ⇔ x = y)
∧ (x + z = z ⇔ x = 0 .)
∧ (z + x = z ⇔ x = 0 .)
∧ (z = z + y ⇔ y = 0 .)
∧ (z = y + z ⇔ y = 0 .)
∧ x + 0 . = x

∧ 0 . + x = x

∧ ¬ 1 . = 0 .
∧ ¬ 0 . = 1 .

R less less 0 thm
⊢ ∀ x y• x < y ⇔ x + ∼ y < 0 .

R less clauses
⊢ ∀ x y z
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• (x + z < y + z ⇔ x < y)
∧ (z + x < y + z ⇔ x < y)
∧ (x + z < z + y ⇔ x < y)
∧ (z + x < z + y ⇔ x < y)
∧ (x + z < z ⇔ x < 0 .)
∧ (z + x < z ⇔ x < 0 .)
∧ (x < z + x ⇔ 0 . < z )
∧ (x < x + z ⇔ 0 . < z )
∧ ¬ x < x

∧ 0 . < 1 .
∧ ¬ 1 . < 0 .

R less 0 less thm
⊢ ∀ x y• x < y ⇔ 0 . < y + ∼ x

R ≤ clauses ⊢ ∀ x y z

• (x + z ≤ y + z ⇔ x ≤ y)
∧ (z + x ≤ y + z ⇔ x ≤ y)
∧ (x + z ≤ z + y ⇔ x ≤ y)
∧ (z + x ≤ z + y ⇔ x ≤ y)
∧ (x + z ≤ z ⇔ x ≤ 0 .)
∧ (z + x ≤ z ⇔ x ≤ 0 .)
∧ (x ≤ z + x ⇔ 0 . ≤ z )
∧ (x ≤ x + z ⇔ 0 . ≤ z )
∧ x ≤ x

∧ 0 . ≤ 1 .
∧ ¬ 1 . ≤ 0 .

R ≤ ≤ 0 thm ⊢ ∀ x y• x ≤ y ⇔ x + ∼ y ≤ 0 .
R ≤ 0 ≤ thm ⊢ ∀ x y• x ≤ y ⇔ 0 . ≤ y + ∼ x

NR less thm ⊢ ∀ m n• NR m < NR n ⇔ m < n

R less strong dense thm
⊢ ∀ x y• x < y ⇒ (∃ d• 0 . < d ∧ x + d < y)

NR ≤ thm ⊢ ∀ m n• NR m ≤ NR n ⇔ m ≤ n

R sup plus thm
⊢ ∀ A a x

• ¬ A = {} ∧ (∀ x• x ∈ A ⇒ x ≤ a)
⇒ Sup A + x = Sup {t |∃ a• a ∈ A ∧ t < a + x}

R sup plus sup thm
⊢ ∀ A a B b

• ¬ A = {}
∧ (∀ x• x ∈ A ⇒ x ≤ a)
∧ ¬ B = {}
∧ (∀ y• y ∈ B ⇒ y ≤ b)

⇒ Sup A + Sup B

= Sup {t |∃ a b• a ∈ A ∧ b ∈ B ∧ t < a + b}
R delta induction thm

⊢ ∀ x p

• (∃ d

• 0 . < d

∧ (∃ e
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• d < e ∧ (∀ t• x < t ∧ t < x + e ⇒ p t))
∧ (∀ s• x < s ∧ p s ⇒ p (s + d)))

⇒ (∀ y• x < y ⇒ p y)
R ord pres strict thm

⊢ ∀ f

• (∀ x y• x < y ⇒ f x < f y)
⇒ (∀ x y• f x < f y ⇒ x < y)

R add hom 0 thm
⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y) ⇒ (∀ x• f 0 . = 0 .)
R add hom minus thm

⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• f (∼ x ) = ∼ (f x ))

R add hom extension thm
⊢ ∀ f

• (∀ x y• 0 . ≤ x ∧ 0 . ≤ y ⇒ f (x + y) = f x + f y)
∧ (∀ x• 0 . ≤ x ⇒ f (∼ x ) = ∼ (f x ))

⇒ (∀ x y• f (x + y) = f x + f y)
R monoid delta dense thm

⊢ ∀ G d

• 0 . ∈ G

∧ (∀ g h• g ∈ G ∧ h ∈ G ⇒ g + h ∈ G)
∧ d ∈ G

∧ 0 . < d

⇒ (∀ x

• 0 . < x ⇒ (∃ g• g ∈ G ∧ g ≤ x ∧ x < g + d))
R monoid dense thm

⊢ ∀ G

• 0 . ∈ G

∧ (∀ g h• g ∈ G ∧ h ∈ G ⇒ g + h ∈ G)
∧ (∀ x• 0 . < x ⇒ (∃ g• g ∈ G ∧ 0 . < g ∧ g < x ))

⇒ (∀ x y

• 0 . < x ∧ x < y ⇒ (∃ g• g ∈ G ∧ x < g ∧ g < y))
R subgroup dense thm

⊢ ∀ G

• 0 . ∈ G

∧ (∀ g h• g ∈ G ∧ h ∈ G ⇒ g + h ∈ G)
∧ (∀ g• g ∈ G ⇒ ∼ g ∈ G)
∧ (∀ x• 0 . < x ⇒ (∃ g• g ∈ G ∧ 0 . < g ∧ g < x ))

⇒ (∀ x y• x < y ⇒ (∃ g• g ∈ G ∧ x < g ∧ g < y))
R semigroup dense thm

⊢ ∀ G

• (∀ g h• g ∈ G ∧ h ∈ G ⇒ g + h ∈ G)
∧ (∀ x• 0 . < x ⇒ (∃ g• g ∈ G ∧ 0 . < g ∧ g < x ))

⇒ (∀ x y

• 0 . < x ∧ x < y ⇒ (∃ g• g ∈ G ∧ x < g ∧ g < y))
R add hom image group thm
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⊢ ∀ f I

• (∀ x y• f (x + y) = f x + f y)
∧ I = {b|∃ a• b = f a}

⇒ 0 . ∈ I

∧ (∀ g h• g ∈ I ∧ h ∈ I ⇒ g + h ∈ I )
∧ (∀ g• g ∈ I ⇒ ∼ g ∈ I )

R add hom kernel group thm
⊢ ∀ f K

• (∀ x y• f (x + y) = f x + f y) ∧ K = {a|f a = 0 .}
⇒ 0 . ∈ K

∧ (∀ g h• g ∈ K ∧ h ∈ K ⇒ g + h ∈ K )
∧ (∀ g• g ∈ K ⇒ ∼ g ∈ K )

R opah thm ⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ (∀ x y• x < y ⇒ f x < f y)
R opah strict thm

⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ (∀ x y• f x < f y ⇒ x < y)
R opah one one thm

⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ OneOne f

R opah dense image thm
⊢ ∀ f e

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )
∧ 0 . < e

⇒ (∃ d• 0 . < d ∧ f d < e)
R opah onto thm

⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ Onto f

R opah inverse add hom thm
⊢ ∀ f g

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )
∧ (∀ x• g (f x ) = x )
∧ (∀ x• f (g x ) = x )

⇒ (∀ x y• g (x + y) = g x + g y)
∧ (∀ x• 0 . < x ⇒ 0 . < g x )

R opah inverse thm
⊢ ∀ f

• (∀ x y• f (x + y) = f x + f y)
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∧ (∀ x• 0 . < x ⇒ 0 . < f x )
⇒ (∃ g

• (∀ x• g (f x ) = x )
∧ (∀ x• f (g x ) = x )
∧ (∀ x y• g (x + y) = g x + g y)
∧ (∀ x• 0 . < x ⇒ 0 . < g x ))

R copah id thm
⊢ ∃ ι
• (∀ x• ι x = x )

∧ (∀ x y• ι (x + y) = ι x + ι y)
∧ (∀ x• 0 . < x ⇒ 0 . < ι x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• ι (f x ) = f (ι x )))

R copah double thm
⊢ ∃ α
• (∀ x• α x = x + x )

∧ (∀ x y• α (x + y) = α x + α y)
∧ (∀ x• 0 . < x ⇒ 0 . < α x )
∧ (∀ x• 0 . < x ⇒ x < α x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• α (f x ) = f (α x )))

R copah halve thm
⊢ ∃ β
• (∀ x• β x + β x = x )

∧ (∀ x y• β (x + y) = β x + β y)
∧ (∀ x• 0 . < x ⇒ 0 . < β x )
∧ (∀ x• 0 . < x ⇒ β x < x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• β (f x ) = f (β x )))

R copah comp thm
⊢ ∀ α β
• (∀ x y• α (x + y) = α x + α y)

∧ (∀ x• 0 . < x ⇒ 0 . < α x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• α (f x ) = f (α x )))

∧ (∀ x y• β (x + y) = β x + β y)
∧ (∀ x• 0 . < x ⇒ 0 . < β x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• β (f x ) = f (β x )))

⇒ (∃ γ
• (∀ x• γ x = α (β x ))

∧ (∀ x• 0 . < x ⇒ 0 . < γ x )
∧ (∀ x y• γ (x + y) = γ x + γ y)
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∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• γ (f x ) = f (γ x ))))

R copah sum thm
⊢ ∀ α β
• (∀ x y• α (x + y) = α x + α y)

∧ (∀ x• 0 . < x ⇒ 0 . < α x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• α (f x ) = f (α x )))

∧ (∀ x y• β (x + y) = β x + β y)
∧ (∀ x• 0 . < x ⇒ 0 . < β x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• β (f x ) = f (β x )))

⇒ (∃ γ
• (∀ x• γ x = α x + β x )

∧ (∀ x• 0 . < x ⇒ 0 . < γ x )
∧ (∀ x y• γ (x + y) = γ x + γ y)
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• γ (f x ) = f (γ x ))))

R halve closed dense thm
⊢ ∀ A e

• 0 . < e

∧ e ∈ A

∧ (∀ y• y ∈ A ⇒ (∃ z• z ∈ A ∧ z + z = y))
⇒ (∀ d• 0 . < d ⇒ (∃ a• a ∈ A ∧ 0 . < a ∧ a < d))

R copah dense thm
⊢ ∀ d x y

• 0 . < d ∧ 0 . < x ∧ x < y

⇒ (∃ γ
• (∀ x y• γ (x + y) = γ x + γ y)

∧ (∀ x• 0 . < x ⇒ 0 . < γ x )
∧ (∀ f

• (∀ x y• f (x + y) = f x + f y)
⇒ (∀ x• γ (f x ) = f (γ x )))

∧ x < γ d

∧ γ d < y)
R opah extension thm1

⊢ ∀ f

• (∀ x y• 0 . < x ∧ 0 . < y ⇒ f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ (∃ φ
• φ 0 . = 0 .

∧ (∀ x• 0 . < x ⇒ φ x = f x )
∧ (∀ x y

• 0 . ≤ x ∧ 0 . ≤ y ⇒ φ (x + y) = φ x + φ y))
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R opah extension thm2
⊢ ∀ f

• f 0 . = 0 .
∧ (∀ x y

• 0 . ≤ x ∧ 0 . ≤ y ⇒ f (x + y) = f x + f y)
⇒ (∃ ψ
• (∀ x• 0 . ≤ x ⇒ ψ x = f x )

∧ (∀ x y• ψ (x + y) = ψ x + ψ y))
R opah extension thm

⊢ ∀ f

• (∀ x y• 0 . < x ∧ 0 . < y ⇒ f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )

⇒ (∃ φ
• (∀ x• 0 . < x ⇒ φ x = f x )

∧ (∀ x y• φ (x + y) = φ x + φ y)
∧ (∀ x• 0 . < x ⇒ 0 . < φ x ))

R opah order thm
⊢ ∀ f g d

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )
∧ (∀ x y• g (x + y) = g x + g y)
∧ (∀ x• 0 . < x ⇒ 0 . < g x )
∧ 0 . < d

∧ f d < g d

⇒ (∀ x• 0 . < x ⇒ f x < g x )
R opah eq thm

⊢ ∀ f g d

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )
∧ (∀ x y• g (x + y) = g x + g y)
∧ (∀ x• 0 . < x ⇒ 0 . < g x )
∧ 0 . < d

∧ f d = g d

⇒ f = g

R opah complete thm
⊢ ∀ d e

• 0 . < d ∧ 0 . < e

⇒ (∃ f

• (∀ x y• f (x + y) = f x + f y)
∧ (∀ x• 0 . < x ⇒ 0 . < f x )
∧ f d = e)

∗R consistent
⊢ Consistent

(λ ∗′R
• (∀ x y z

• ∗′R (∗′R x y) z = ∗′R x (∗′R y z ))
∧ (∀ x• ∗′R x 1 . = x )
∧ (∀ x y z
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• ∗′R x (y + z ) = ∗′R x y + ∗′R x z )
∧ (∀ x y• ∗′R x y = ∗′R y x )
∧ (∀ x y• 0 . < x ∧ 0 . < y ⇒ 0 . < ∗′R x y))

R times assoc thm
⊢ ∀ x y z• (x ∗ y) ∗ z = x ∗ y ∗ z

R times comm thm
⊢ ∀ x y• x ∗ y = y ∗ x

R times unit thm
⊢ ∀ x• x ∗ 1 . = x

R 0 less 0 less times thm
⊢ ∀ x y• 0 . < x ∧ 0 . < y ⇒ 0 . < x ∗ y

R times assoc thm1
⊢ ∀ x y z• x ∗ y ∗ z = (x ∗ y) ∗ z

R times plus distrib thm
⊢ ∀ x y z

• x ∗ (y + z ) = x ∗ y + x ∗ z

∧ (x + y) ∗ z = x ∗ z + y ∗ z

R times order thm
⊢ ∀ x y z

• y ∗ x = x ∗ y

∧ (x ∗ y) ∗ z = x ∗ y ∗ z

∧ y ∗ x ∗ z = x ∗ y ∗ z

R times 0 thm
⊢ ∀ x• x ∗ 0 . = 0 . ∧ 0 . ∗ x = 0 .

R times 1 thm
⊢ ∀ x• x ∗ 1 . = x ∧ 1 . ∗ x = x

NR times homomorphism thm
⊢ ∀ m n• NR (m ∗ n) = NR m ∗ NR n

R times minus thm
⊢ ∀ x y

• ∼ x ∗ y = ∼ (x ∗ y)
∧ x ∗ ∼ y = ∼ (x ∗ y)
∧ ∼ x ∗ ∼ y = x ∗ y

/R consistent
⊢ Consistent

(λ /′R
• (∀ y z• ¬ z = 0 . ⇒ /′R (y ∗ z ) z = y)

∧ (∀ x y z

• ¬ z = 0 . ⇒ /′R (x ∗ y) z = x ∗ /′R y z ))
R over times recip thm

⊢ ∀ z• ¬ z = 0 . ⇒ (∀ x• x / z = x ∗ z −1 )
R times recip thm

⊢ ∀ z• ¬ z = 0 . ⇒ z ∗ z −1 = 1 .
R eq recip thm

⊢ ∀ z• ¬ z = 0 . ⇒ (∀ y• y = z ⇔ y ∗ z −1 = 1 .)
R times cancel thm

⊢ ∀ x y z• ¬ z = 0 . ⇒ (x ∗ z = y ∗ z ⇔ x = y)
R times eq 0 thm
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⊢ ∀ x y• x ∗ y = 0 . ⇔ x = 0 . ∨ y = 0 .
R times clauses

⊢ ∀ x

• 0 . ∗ x = 0 . ∧ x ∗ 0 . = 0 . ∧ x ∗ 1 . = x ∧ 1 . ∗ x = x

R times mono ⇔ thm
⊢ ∀ x• 0 . < x ⇒ (∀ y z• y < z ⇔ x ∗ y < x ∗ z )

R times mono thm
⊢ ∀ x y z• 0 . < x ∧ y < z ⇒ x ∗ y < x ∗ z

R 0 ≤ 0 ≤ times thm
⊢ ∀ x y• 0 . ≤ x ∧ 0 . ≤ y ⇒ 0 . ≤ x ∗ y

R ¬ recip 0 thm
⊢ ∀ z• ¬ z = 0 . ⇒ ¬ z −1 = 0 .

R recip clauses
⊢ (1 . −1 = 1 .

∧ (∀ w

• ¬ w = 0 .
⇒ w −1 −1 = w

∧ w ∗ w −1 = 1 .
∧ w −1 ∗ w = 1 .))

∧ (∀ w z

• ¬ w = 0 . ∧ ¬ z = 0 .
⇒ (w ∗ z ) −1 = w −1 ∗ z −1 )

R cross mult eq thm
⊢ ∀ w z

• ¬ w = 0 . ∧ ¬ z = 0 .
⇒ (∀ x y• x / w = y / z ⇔ x ∗ z = w ∗ y)

R less ¬ eq 0 thm
⊢ ∀ z• 0 . < z ⇒ ¬ z = 0 .

R 0 less 0 less recip thm
⊢ ∀ z• 0 . < z ⇒ 0 . < z −1

R cross mult less thm
⊢ ∀ w z

• 0 . < w ∧ 0 . < z

⇒ (∀ x y• x / w < y / z ⇔ x ∗ z < w ∗ y)
R over cancel eq thm

⊢ ∀ w z

• ¬ w = 0 . ∧ ¬ z = 0 .
⇒ (∀ x• (x ∗ z ) / (w ∗ z ) = x / w)

R over plus over thm
⊢ ∀ x y u v

• ¬ u = 0 . ∧ ¬ v = 0 .
⇒ x / u + y / v = (x ∗ v + y ∗ u) / (u ∗ v)

R 0 over thm ⊢ ∀ z• ¬ z = 0 . ⇒ 0 . / z = 0 .
R over 1 thm ⊢ ∀ x• x / 1 . = x

NR plus homomorphism thm1
⊢ ∀ m n• NR m + NR n = NR (m + n)

NR times homomorphism thm1
⊢ ∀ m n• NR m ∗ NR n = NR (m ∗ n)
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R frac cross mult eq thm
⊢ ∀ m n i j

• i / (m + 1 ) = j / (n + 1 )
⇔ i ∗ (n + 1 ) = j ∗ (m + 1 )

R frac cancel eq thm
⊢ ∀ i m n

• (i ∗ (n + 1 )) / ((m + 1 ) ∗ (n + 1 )) = i / (m + 1 )
R frac 0 thm ⊢ ∀ m• 0 / (m + 1 ) = 0 .
R frac N thm ⊢ ∀ i• i / 1 = NR i

R frac plus frac thm
⊢ ∀ i j k m n

• i / (m + 1 ) + j / (n + 1 )
= (i ∗ (n + 1 ) + j ∗ (m + 1 ))
/ ((m + 1 ) ∗ (n + 1 ))

R frac minus frac thm
⊢ ∀ i j k m n

• j ∗ (m + 1 ) ≤ i ∗ (n + 1 )
⇒ i / (m + 1 ) + ∼ (j / (n + 1 ))
= (i ∗ (n + 1 ) − j ∗ (m + 1 ))
/ ((m + 1 ) ∗ (n + 1 ))

R frac minus frac thm1
⊢ ∀ i j m n

• i ∗ (n + 1 ) ≤ j ∗ (m + 1 )
⇒ i / (m + 1 ) + ∼ (j / (n + 1 ))
= ∼
((j ∗ (m + 1 ) − i ∗ (n + 1 ))

/ ((m + 1 ) ∗ (n + 1 )))
R over times over thm

⊢ ∀ x y u v

• ¬ u = 0 . ∧ ¬ v = 0 .
⇒ x / u ∗ y / v = (x ∗ y) / (u ∗ v)

R frac times frac thm
⊢ ∀ i j m n

• i / (m + 1 ) ∗ j / (n + 1 )
= (i ∗ j ) / ((m + 1 ) ∗ (n + 1 ))

R over recip thm
⊢ ∀ u v• ¬ u = 0 . ∧ ¬ v = 0 . ⇒ (u / v) −1 = v / u

R frac recip thm
⊢ ∀ m n• ((m + 1 ) / (n + 1 )) −1 = (n + 1 ) / (m + 1 )

R minus recip thm
⊢ ∀ z• ¬ z = 0 . ⇒ ∼ z −1 = ∼ (z −1 )

R over eq 0 thm
⊢ ∀ u v• ¬ u = 0 . ∧ ¬ v = 0 . ⇒ ¬ u / v = 0 .

R over over over thm
⊢ ∀ x y u v

• ¬ u = 0 . ∧ ¬ v = 0 . ∧ ¬ y = 0 .
⇒ x / u / (y / v) = (x ∗ v) / (u ∗ y)

R frac less frac thm
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⊢ ∀ i j m n

• i / (m + 1 ) < j / (n + 1 )
⇔ i ∗ (n + 1 ) < j ∗ (m + 1 )

R minus frac less frac thm
⊢ ∀ i j m n• ∼ (i / (m + 1 )) < j / (n + 1 ) ⇔ 0 < i + j

R frac less minus frac thm
⊢ ∀ i j m n• ¬ i / (m + 1 ) < ∼ (j / (n + 1 ))

R 0 ≤ frac thm
⊢ ∀ i m• 0 . ≤ i / (m + 1 )

R abs frac thm
⊢ ∀ i m• Abs (i / (m + 1 )) = i / (m + 1 )

R abs minus thm
⊢ ∀ x• Abs (∼ x ) = Abs x

MaxR consistent
⊢ Consistent

(λ Max ′
R

• (∀ x• Max ′
R [x ] = x )

∧ (∀ x y L

• Max ′
R (Cons x (Cons y L))

= (if x < Max ′
R (Cons y L)

then Max ′
R (Cons y L)

else x )))
MinR consistent

⊢ Consistent

(λ Min ′
R

• (∀ x• Min ′
R [x ] = x )

∧ (∀ x y L

• Min ′
R (Cons x (Cons y L))

= (if x > Min ′
R (Cons y L)

then Min ′
R (Cons y L)

else x )))
R max cons thm

⊢ ∀ x L

• MaxR (Cons x L)
= (if L = []
then x

else if x < MaxR L

then MaxR L

else x )
R max conv thm

⊢ ∀ x y L

• MaxR (Cons x (Cons y L))
= (if x < y

then MaxR (Cons y L)
else MaxR (Cons x L))

R min cons thm
⊢ ∀ x L

• MinR (Cons x L)
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= (if L = []
then x

else if MinR L < x

then MinR L

else x )
R min conv thm

⊢ ∀ x y L

• MinR (Cons x (Cons y L))
= (if x < y

then MinR (Cons x L)
else MinR (Cons y L))

̂Z consistent
⊢ Consistent

(λ ̂′Z
• ∀ x m

• ̂′Z x (NZ m) = x ̂ m

∧ ̂′Z x (∼ (NZ (m + 1 )))
= (x ̂ (m + 1 )) −1 )

ZR consistent
⊢ Consistent

(λ $”ZR′”
• $”ZR′” (NZ 0 ) = 0 .

∧ $”ZR′” (NZ 1 ) = 1 .
∧ (∀ i j

• $”ZR′” (i + j ) = $”ZR′” i + $”ZR′” j ))
ZR plus homomorphism thm

⊢ ∀ i j• ZR (i + j ) = ZR i + ZR j

ZR minus thm ⊢ ∀ i• ZR (∼ i) = ∼ (ZR i)
ZR NZ thm ⊢ ∀ m• ZR (NZ m) = NR m ∧ ZR (∼ (NZ m)) = ∼ (NR m)
ZR times homomorphism thm

⊢ ∀ i j• ZR (i ∗ j ) = ZR i ∗ ZR j

57 THE THEORY N

57.1 Parents

pair

57.2 Children

list
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57.3 Constants

Is N Rep IND → Bool

Zero Worth

Suc Worth → Worth

$+ Worth → Worth → Worth

$≤ Worth → Worth → Bool

$≥ Worth → Worth → Bool

$< Worth → Worth → Bool

$> Worth → Worth → Bool

$∗ Worth → Worth → Worth

$Mod Worth → Worth → Worth

$Div Worth → Worth → Worth

$− Worth → Worth → Worth

57.4 Types

Worth

57.5 Fixity

Left Infix 305 :
−

Left Infix 315 :
Div Mod

Right Infix 210 :
< > ≤ ≥

Right Infix 300 :
+

Right Infix 310 :
∗

57.6 Definitions

Is N Rep
is N rep def ⊢ ∃ zero suc

• (Is N Rep zero

∧ (∀ n• Is N Rep n ⇒ Is N Rep (suc n)))
∧ (∀ n• Is N Rep n ⇒ ¬ suc n = zero)
∧ OneOne suc

∧ (∀ p

• p zero ∧ (∀ m• p m ⇒ p (suc m))
⇒ (∀ n• Is N Rep n ⇒ p n))

N

N def ⊢ ∃ f • TypeDefn Is N Rep f

Zero
Suc
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zero suc def ⊢ (∀ n• ¬ Suc n = Zero)
∧ OneOne Suc

∧ (∀ p

• p Zero ∧ (∀ m• p m ⇒ p (Suc m)) ⇒ (∀ n• p n))
+
plus def ⊢ ∀ m n

• 0 + n = n

∧ (m + 1 ) + n = (m + n) + 1

∧ Suc m = m + 1

≤
≤ def ⊢ ∀ m n• m ≤ n ⇔ (∃ i• m + i = n)
≥
≥ def ⊢ ∀ m n• m ≥ n ⇔ n ≤ m

<
less def ⊢ ∀ m n• m < n ⇔ m + 1 ≤ n

>
greater def ⊢ ∀ m n• m > n ⇔ n < m

∗
times def ⊢ ∀ m n• 0 ∗ n = 0 ∧ (m + 1 ) ∗ n = m ∗ n + n

Mod
mod def ⊢ ∀ m n

• 0 < n

⇒ 0 Mod n = 0

∧ (m + 1 ) Mod n

= (if m Mod n + 1 < n

then m Mod n + 1

else 0 )
Div
div def ⊢ ∀ m n

• 0 < n

⇒ 0 Div n = 0

∧ (m + 1 ) Div n

= (if m Mod n + 1 < n

then m Div n

else m Div n + 1 )
−
minus def ⊢ ∀ m n• (m + n) − n = m

57.7 Theorems

induction thm
⊢ ∀ p• p 0 ∧ (∀ m• p m ⇒ p (m + 1 )) ⇒ (∀ n• p n)

¬ plus1 thm ⊢ ∀ n• ¬ n + 1 = 0

one one plus1 thm
⊢ ∀ x1 x2• x1 + 1 = x2 + 1 ⇒ x1 = x2

prim rec thm ⊢ ∀ z s• ∃1 f • f 0 = z ∧ (∀ n• f (n + 1 ) = s (f n) n)
plus assoc thm

⊢ ∀ i m n• (i + m) + n = i + m + n
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plus assoc thm1
⊢ ∀ i m n• i + m + n = (i + m) + n

plus comm thm
⊢ ∀ m n• m + n = n + m

plus order thm
⊢ ∀ i m n

• m + i = i + m

∧ (i + m) + n = i + m + n

∧ m + i + n = i + m + n

plus clauses ⊢ ∀ m n i

• (m + i = n + i ⇔ m = n)
∧ (i + m = n + i ⇔ m = n)
∧ (m + i = i + n ⇔ m = n)
∧ (i + m = i + n ⇔ m = n)
∧ (m + i = i ⇔ m = 0 )
∧ (i + m = i ⇔ m = 0 )
∧ (i = i + n ⇔ n = 0 )
∧ (i = n + i ⇔ n = 0 )
∧ (m + i = 0 ⇔ m = 0 ∧ i = 0 )
∧ (0 = m + i ⇔ m = 0 ∧ i = 0 )
∧ (m + 0 = m ∧ 0 + m = m)
∧ ¬ 1 = 0

∧ ¬ 0 = 1

≤ trans thm ⊢ ∀ m i n• m ≤ i ∧ i ≤ n ⇒ m ≤ n

less trans thm
⊢ ∀ m i n• m < i ∧ i < n ⇒ m < n

≤ clauses ⊢ ∀ m n i

• (m + i ≤ n + i ⇔ m ≤ n)
∧ (i + m ≤ n + i ⇔ m ≤ n)
∧ (m + i ≤ i + n ⇔ m ≤ n)
∧ (i + m ≤ i + n ⇔ m ≤ n)
∧ (m + i ≤ i ⇔ m = 0 )
∧ (i + m ≤ i ⇔ m = 0 )
∧ (m + i ≤ 0 ⇔ m = 0 ∧ i = 0 )
∧ (m ≤ 0 ⇔ m = 0 )
∧ m ≤ m + i

∧ m ≤ i + m

∧ m ≤ m

∧ 0 ≤ m

∧ ¬ 1 ≤ 0

less clauses ⊢ ∀ m n i

• (m + i < n + i ⇔ m < n)
∧ (i + m < n + i ⇔ m < n)
∧ (m + i < i + n ⇔ m < n)
∧ (i + m < i + n ⇔ m < n)
∧ (m < m + i ⇔ 0 < i)
∧ (m < i + m ⇔ 0 < i)
∧ ¬ m + i < m
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∧ ¬ m + i < i

∧ ¬ m < 0

∧ ¬ m < m

∧ 0 < m + 1

∧ 0 < 1 + m

∧ 0 < 1

N cases thm ⊢ ∀ m• m = 0 ∨ (∃ i• m = i + 1 )
≤ cases thm ⊢ ∀ m n• m ≤ n ∨ n ≤ m

≤ plus1 thm ⊢ ∀ m n• m ≤ n + 1 ⇔ m = n + 1 ∨ m ≤ n

plus1 ≤ thm ⊢ ∀ m n• m + 1 ≤ n ⇔ m ≤ n ∧ ¬ m = n

¬ plus1 ≤ thm
⊢ ∀ m n• ¬ m + 1 ≤ n ⇔ n ≤ m

less cases thm
⊢ ∀ m n• m < n ∨ m = n ∨ n < m

¬ less plus1 thm
⊢ ∀ m n• ¬ m < n + 1 ⇔ n < m

less plus1 thm
⊢ ∀ m n• m < n + 1 ⇔ m = n ∨ m < n

plus1 less thm
⊢ ∀ m n• m + 1 < n ⇔ m < n ∧ ¬ m + 1 = n

≤ antisym thm
⊢ ∀ m n• m ≤ n ∧ n ≤ m ⇔ m = n

less irrefl thm
⊢ ∀ m n• ¬ (m < n ∧ n < m)

cov induction thm
⊢ ∀ p• (∀ n• (∀ m• m < n ⇒ p m) ⇒ p n) ⇒ (∀ n• p n)

less well order thm
⊢ ∀ p• (∃ i• p i) ⇔ (∃ m• p m ∧ (∀ i• p i ⇒ ¬ i < m))

¬ less thm ⊢ ∀ m n• ¬ m < n ⇔ n ≤ m

¬ ≤ thm ⊢ ∀ m n• ¬ m ≤ n ⇔ n < m

≤ well order thm
⊢ ∀ p• (∃ i• p i) ⇔ (∃ m• p m ∧ (∀ i• p i ⇒ m ≤ i))

≤ least upper bound thm
⊢ ∀ p

• (∃ i• p i) ∧ (∃ n• ∀ j• p j ⇒ j ≤ n)
⇔ (∃ m• p m ∧ (∀ j• p j ⇒ j ≤ m))

minimum ¬ thm
⊢ ∀ p b

• p 0 ∧ ¬ p b

⇒ (∃ m• (∀ n• n ≤ m ⇒ p n) ∧ ¬ p (m + 1 ))
times comm thm

⊢ ∀ m n• m ∗ n = n ∗ m

times assoc thm
⊢ ∀ i m n• (i ∗ m) ∗ n = i ∗ m ∗ n

times plus distrib thm
⊢ ∀ i m n

• (i + m) ∗ n = i ∗ n + m ∗ n

∧ i ∗ (m + n) = i ∗ m + i ∗ n
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times clauses
⊢ ∀ m• m ∗ 0 = 0 ∧ 0 ∗ m = 0 ∧ m ∗ 1 = m ∧ 1 ∗ m = m

mod less thm ⊢ ∀ m n• 0 < n ⇒ m Mod n < n

div mod thm ⊢ ∀ m n• 0 < n ⇒ m = m Div n ∗ n + m Mod n

div mod unique thm
⊢ ∀ m n d r

• r < n ⇒ m = d ∗ n + r ⇒ d = m Div n ∧ r = m Mod n

minus clauses
⊢ ∀ m n

• m − m = 0

∧ m − 0 = m

∧ (m + n) − n = m

∧ (m + n) − m = n

58 THE THEORY Z

58.1 Parents

sets

58.2 Children

dyadic

58.3 Constants

Is Z Rep (N × N) SET → BOOL

NZ N → Z

$∼Z Z → Z

$+Z Z → Z → Z

$−Z Z → Z → Z

$∗Z Z → Z → Z

$≤Z Z → Z → BOOL

$<Z Z → Z → BOOL

$≥Z Z → Z → BOOL

$>Z Z → Z → BOOL

$AbsZ Z → Z

$ModZ Z → Z → Z

$DivZ Z → Z → Z
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58.4 Aliases

+ $+Z : Z → Z → Z

− $−Z : Z → Z → Z

∼ $∼Z : Z → Z

∗ $∗Z : Z → Z → Z

≤ $≤Z : Z → Z → BOOL

< $<Z : Z → Z → BOOL

≥ $≥Z : Z → Z → BOOL

> $>Z : Z → Z → BOOL

Abs $AbsZ : Z → Z

Div $DivZ : Z → Z → Z

Mod $ModZ : Z → Z → Z

58.5 Types

Z

58.6 Fixity

Left Infix 305 :
−Z

Left Infix 315 :
DivZ ModZ

Right Infix 210 :
<Z >Z ≤Z ≥Z

Right Infix 300 :
+Z

Right Infix 310 :
∗Z

Prefix 350 : AbsZ ∼Z

58.7 Definitions

Is Z Rep ⊢ ∀ a• Is Z Rep a ⇔ (∃ m n• a = {(x , y)|m + y = n + x})
Z

Z def ⊢ ∃ f • TypeDefn Is Z Rep f

+Z

∼Z

NZ ⊢ ConstSpec

(λ (+′
Z , ∼

′
Z , $”NZ

′”)
• (∀ i j k

• +′
Z (+′

Z i j ) k = +′
Z i (+′

Z j k)
∧ +′

Z i j = +′
Z j i

∧ +′
Z i (∼′

Z i) = $”NZ′” 0

∧ +′
Z i ($”NZ′” 0 ) = i)

∧ (∀ m n
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• +′
Z ($”NZ′” m) ($”NZ′” n)
= $”NZ′” (m + n))

∧ OneOne $”NZ′”
∧ (∀ i

• ∃ m• i = $”NZ′” m ∨ i = ∼′
Z ($”NZ′” m)))

($+, ∼, NZ)
−Z ⊢ ∀ i j• i − j = i + ∼ j

∗Z ⊢ ConstSpec

(λ ∗′Z
• ∀ i j k

• ∗′Z i (j + k) = ∗′Z i j + ∗′Z i k

∧ ∗′Z i (NZ 1 ) = i)
$∗

≤Z ⊢ ∀ i j• i ≤ j ⇔ (∃ m• i + NZ m = j )
<Z ⊢ ∀ i j• i < j ⇔ i + NZ 1 ≤ j

≥Z ⊢ ∀ i j• i ≥ j ⇔ j ≤ i

>Z ⊢ ∀ i j• i > j ⇔ j < i

AbsZ ⊢ ∀ i• Abs i = (if NZ 0 ≤ i then i else ∼ i)
DivZ

ModZ ⊢ ConstSpec

(λ (Div ′Z , Mod ′
Z )

• ∀ i j

• ¬ j = NZ 0

⇒ i = Div ′Z i j ∗ j + Mod ′
Z i j

∧ NZ 0 ≤ Mod ′
Z i j

∧ Mod ′
Z i j < Abs j )

($Div , $Mod)

58.8 Theorems

is Z rep consistent thm
⊢ ∃ a• Is Z Rep a

+Z consistent
∼Z consistent
NZ consistent

⊢ Consistent

(λ (+′
Z , ∼

′
Z , $”NZ

′”)
• (∀ i j k

• +′
Z (+′

Z i j ) k = +′
Z i (+′

Z j k)
∧ +′

Z i j = +′
Z j i

∧ +′
Z i (∼′

Z i) = $”NZ′” 0

∧ +′
Z i ($”NZ′” 0 ) = i)

∧ (∀ m n

• +′
Z ($”NZ′” m) ($”NZ′” n)
= $”NZ′” (m + n))

∧ OneOne $”NZ′”
∧ (∀ i

• ∃ m• i = $”NZ′” m ∨ i = ∼′
Z ($”NZ′” m)))

Page 319 of 358



Lemma 1
DRA FRONT END FILTER PROJECT

ProofPower Theory Listings

Ref: DS/FMU/FEF/017
Issue: Revision:2 .2
Date: 5 June 2016

Z plus comm thm
⊢ ∀ i j• i + j = j + i

Z plus assoc thm
⊢ ∀ i j k• (i + j ) + k = i + j + k

Z plus assoc thm1
⊢ ∀ i j k• i + j + k = (i + j ) + k

Z plus order thm
⊢ ∀ i j k

• j + i = i + j

∧ (i + j ) + k = i + j + k

∧ j + i + k = i + j + k

Z cases thm ⊢ ∀ i• ∃ m• i = NZ m ∨ i = ∼ (NZ m)
Z plus0 thm ⊢ ∀ i• i + NZ 0 = i ∧ NZ 0 + i = i

Z plus minus thm
⊢ ∀ i• i + ∼ i = NZ 0 ∧ ∼ i + i = NZ 0

Z eq thm ⊢ ∀ i j• i = j ⇔ i + ∼ j = NZ 0

NZ plus homomorphism thm
⊢ ∀ m n• NZ (m + n) = NZ m + NZ n

Z minus clauses
⊢ ∀ i j

• ∼ (∼ i) = i

∧ i + ∼ i = NZ 0

∧ ∼ i + i = NZ 0

∧ ∼ (i + j ) = ∼ i + ∼ j

∧ ∼ (NZ 0 ) = NZ 0

Z cases thm1 ⊢ ∀ i• ∃ m• i = NZ m ∨ i = ∼ (NZ (m + 1 ))
Z induction thm

⊢ ∀ p

• p (NZ 1 )
∧ (∀ i• p i ⇒ p (∼ i))
∧ (∀ i j• p i ∧ p j ⇒ p (i + j ))

⇒ (∀ i• p i)
NZ one one thm

⊢ ∀ m n• NZ m = NZ n ⇔ m = n

Z plus clauses
⊢ ∀ i j k

• (i + k = j + k ⇔ i = j )
∧ (k + i = j + k ⇔ i = j )
∧ (i + k = k + j ⇔ i = j )
∧ (k + i = k + j ⇔ i = j )
∧ (i + k = k ⇔ i = NZ 0 )
∧ (k + i = k ⇔ i = NZ 0 )
∧ (k = k + j ⇔ j = NZ 0 )
∧ (k = j + k ⇔ j = NZ 0 )
∧ i + NZ 0 = i

∧ NZ 0 + i = i

∧ ¬ NZ 1 = NZ 0

∧ ¬ NZ 0 = NZ 1
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Z ≤ ≤ 0 thm ⊢ ∀ i j• i ≤ j ⇔ i + ∼ j ≤ NZ 0

Z minus ≤ thm
⊢ ∀ i j• ∼ i ≤ ∼ j ⇔ j ≤ i

Z ≤ minus thm
⊢ ∀ i j• i ≤ j ⇔ ∼ j ≤ ∼ i

Z ≤ clauses ⊢ ∀ i j k

• (i + k ≤ j + k ⇔ i ≤ j )
∧ (k + i ≤ j + k ⇔ i ≤ j )
∧ (i + k ≤ k + j ⇔ i ≤ j )
∧ (k + i ≤ k + j ⇔ i ≤ j )
∧ (i + k ≤ k ⇔ i ≤ NZ 0 )
∧ (k + i ≤ k ⇔ i ≤ NZ 0 )
∧ (k ≤ k + j ⇔ NZ 0 ≤ j )
∧ (k ≤ j + k ⇔ NZ 0 ≤ j )
∧ i ≤ i

∧ ¬ NZ 1 ≤ NZ 0

∧ NZ 0 ≤ NZ 1

NZ ≤ thm ⊢ ∀ m n• NZ m ≤ NZ n ⇔ m ≤ n

∗Z consistent
⊢ Consistent

(λ ∗′Z
• ∀ i j k

• ∗′Z i (j + k) = ∗′Z i j + ∗′Z i k

∧ ∗′Z i (NZ 1 ) = i)
NZ times homomorphism thm

⊢ ∀ m n• NZ (m ∗ n) = NZ m ∗ NZ n

Z times minus thm
⊢ ∀ i j

• ∼ i ∗ j = ∼ (i ∗ j )
∧ i ∗ ∼ j = ∼ (i ∗ j )
∧ ∼ i ∗ ∼ j = i ∗ j

Z times comm thm
⊢ ∀ i j• i ∗ j = j ∗ i

Z times assoc thm
⊢ ∀ i j k• (i ∗ j ) ∗ k = i ∗ j ∗ k

DivZ consistent
ModZ consistent

⊢ Consistent

(λ (Div ′Z , Mod ′
Z )

• ∀ i j

• ¬ j = NZ 0

⇒ i = Div ′Z i j ∗ j + Mod ′
Z i j

∧ NZ 0 ≤ Mod ′
Z i j

∧ Mod ′
Z i j < Abs j )

NZ plus homomorphism thm1
⊢ ∀ m n• NZ m + NZ n = NZ (m + n)

Z N induction thm
⊢ ∀ p
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• p (NZ 0 ) ∧ (∀ i• NZ 0 ≤ i ∧ p i ⇒ p (i + NZ 1 ))
⇒ (∀ m• NZ 0 ≤ m ⇒ p m)

Z N plus thm ⊢ ∀ i j• NZ 0 ≤ i ∧ NZ 0 ≤ j ⇒ NZ 0 ≤ i + j

Z N plus1 thm
⊢ ∀ i• NZ 0 ≤ i ⇒ NZ 0 ≤ i + NZ 1

Z minus thm ⊢ ∀ i j

• ∼ (∼ i) = i

∧ i + ∼ i = NZ 0

∧ ∼ i + i = NZ 0

∧ ∼ (i + j ) = ∼ i + ∼ j

∧ ∼ (NZ 0 ) = NZ 0

Z N cases thm
⊢ ∀ i

• NZ 0 ≤ i

⇒ i = NZ 0 ∨ (∃ j• NZ 0 ≤ j ∧ i = j + NZ 1 )
Z N ¬ minus thm

⊢ ∀ i• NZ 0 ≤ i ⇒ i = NZ 0 ∨ ¬ NZ 0 ≤ ∼ i

Z ¬ N thm ⊢ ∀ i• ¬ NZ 0 ≤ i ⇒ NZ 0 ≤ ∼ i

Z plus eq thm
⊢ ∀ i j k• i + j = k ⇔ i = k + ∼ j

Z N ¬ plus1 thm
⊢ ∀ i• NZ 0 ≤ i ⇒ ¬ i + NZ 1 = NZ 0

Z times assoc thm1
⊢ ∀ i j k• i ∗ j ∗ k = (i ∗ j ) ∗ k

Z times order thm
⊢ ∀ i j k

• j ∗ i = i ∗ j

∧ (i ∗ j ) ∗ k = i ∗ j ∗ k

∧ j ∗ i ∗ k = i ∗ j ∗ k

NZ times homomorphism thm1
⊢ ∀ m n• NZ m ∗ NZ n = NZ (m ∗ n)

Z times1 thm ⊢ ∀ i• i ∗ NZ 1 = i ∧ NZ 1 ∗ i = i

Z times plus distrib thm
⊢ ∀ i j k

• i ∗ (j + k) = i ∗ j + i ∗ k

∧ (i + j ) ∗ k = i ∗ k + j ∗ k

Z times0 thm ⊢ ∀ i• NZ 0 ∗ i = NZ 0 ∧ i ∗ NZ 0 = NZ 0

Z eq thm1 ⊢ ∀ i j• i = j ⇔ ∼ i + j = NZ 0

Z times eq 0 thm
⊢ ∀ i j• i ∗ j = NZ 0 ⇔ i = NZ 0 ∨ j = NZ 0

Z times clauses
⊢ ∀ i j

• NZ 0 ∗ i = NZ 0

∧ i ∗ NZ 0 = NZ 0

∧ i ∗ NZ 1 = i

∧ NZ 1 ∗ i = i

Z N times thm
⊢ ∀ i j• NZ 0 ≤ i ∧ NZ 0 ≤ j ⇒ NZ 0 ≤ i ∗ j
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Z ≤ trans thm
⊢ ∀ i j k• i ≤ j ∧ j ≤ k ⇒ i ≤ k

Z ≤ cases thm
⊢ ∀ i j• i ≤ j ∨ j ≤ i

Z ≤ refl thm ⊢ ∀ i• i ≤ i

Z ≤ ≤ 0 thm1 ⊢ ∀ i j• i ≤ j ⇔ NZ 0 ≤ j + ∼ i

Z ≤ antisym thm
⊢ ∀ i j• i ≤ j ∧ j ≤ i ⇒ i = j

Z less trans thm
⊢ ∀ i j k• i < j ∧ j < k ⇒ i < k

Z less irrefl thm
⊢ ∀ i j• ¬ (i < j ∧ j < i)

Z less cases thm
⊢ ∀ i j• i < j ∨ i = j ∨ j < i

NZ less thm ⊢ ∀ m n• NZ m < NZ n ⇔ m < n

Z less less 0 thm
⊢ ∀ i j• i < j ⇔ i + ∼ j < NZ 0

Z less less 0 thm1
⊢ ∀ i j• i < j ⇔ NZ 0 < j + ∼ i

Z minus less thm
⊢ ∀ i j• ∼ i < ∼ j ⇔ j < i

Z ¬ less thm ⊢ ∀ i j• ¬ i < j ⇔ j ≤ i

Z ¬ ≤ thm ⊢ ∀ i j• ¬ i ≤ j ⇔ j < i

Z ≤ less eq thm
⊢ ∀ i j• i ≤ j ⇔ i < j ∨ i = j

Z less ≤ trans thm
⊢ ∀ i j k• i < j ∧ j ≤ k ⇒ i < k

Z ≤ less trans thm
⊢ ∀ i j k• i ≤ j ∧ j < k ⇒ i < k

Z minus N ≤ thm
⊢ ∀ i m• i + ∼ (NZ m) ≤ i

Z ≤ plus N thm
⊢ ∀ i m• i ≤ i + NZ m

Z ∈ N thm ⊢ ∀ i• NZ 0 ≤ i ⇔ (∃ m• i = NZ m)
Z less clauses

⊢ ∀ i j k

• (i + k < j + k ⇔ i < j )
∧ (k + i < j + k ⇔ i < j )
∧ (i + k < k + j ⇔ i < j )
∧ (k + i < k + j ⇔ i < j )
∧ (i + k < k ⇔ i < NZ 0 )
∧ (k + i < k ⇔ i < NZ 0 )
∧ (i < k + i ⇔ NZ 0 < k)
∧ (i < i + k ⇔ NZ 0 < k)
∧ ¬ i < i

∧ NZ 0 < NZ 1

∧ ¬ NZ 1 < NZ 0

Z N abs thm ⊢ ∀ m• Abs (NZ m) = NZ m ∧ Abs (∼ (NZ m)) = NZ m
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Z abs thm ⊢ ∀ i• NZ 0 ≤ i ⇒ Abs i = i ∧ Abs (∼ i) = i

Z abs N thm ⊢ ∀ i• NZ 0 ≤ Abs i

Z abs eq 0 thm
⊢ ∀ i• Abs i = NZ 0 ⇔ i = NZ 0

Z abs minus thm
⊢ ∀ i• Abs (∼ i) = Abs i

Z N abs minus thm
⊢ ∀ i j

• NZ 0 ≤ i ∧ NZ 0 ≤ j ∧ j ≤ i ⇒ Abs (i + ∼ j ) ≤ i

Z abs times thm
⊢ ∀ i j• Abs (i ∗ j ) = Abs i ∗ Abs j

Z abs plus thm
⊢ ∀ i j• Abs (i + j ) ≤ Abs i + Abs j

Z div mod unique lemma1
⊢ ∀ i j• NZ 0 ≤ i ∧ NZ 0 ≤ j ∧ i ∗ j < j ⇒ i = NZ 0

Z div mod unique lemma2
⊢ ∀ j d r

• ¬ j = NZ 0

⇒ d ∗ j + r = NZ 0 ∧ NZ 0 ≤ r ∧ r < Abs j

⇒ d = NZ 0 ∧ r = NZ 0

Z div mod unique lemma3
⊢ ∀ i j d r D R

• ¬ j = NZ 0

⇒ D ∗ j + R = d ∗ j + r

∧ NZ 0 ≤ r

∧ r ≤ R

∧ R < Abs j

⇒ D = d ∧ R = r

Z div mod unique thm
⊢ ∀ i j d r

• ¬ j = NZ 0

⇒ (i = d ∗ j + r ∧ NZ 0 ≤ r ∧ r < Abs j

⇔ d = i Div j ∧ r = i Mod j )
Z ≤ induction thm

⊢ ∀ j p

• p j ∧ (∀ i• j ≤ i ∧ p i ⇒ p (i + NZ 1 ))
⇒ (∀ i• j ≤ i ⇒ p i)

Z cov induction thm
⊢ ∀ j p

• (∀ i• j ≤ i ∧ (∀ k• j ≤ k ∧ k < i ⇒ p k) ⇒ p i)
⇒ (∀ i• j ≤ i ⇒ p i)

Z fun ∃ thm ⊢ ∀ f g z

• (∀ x• g (f x ) = x ) ∧ (∀ y• f (g y) = y)
⇒ (∃1 h

• h (NZ 0 ) = z

∧ (∀ i• h (i + NZ 1 ) = f (h i))
∧ (∀ i• h (i − NZ 1 ) = g (h i)))
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